WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument manufactured by it to be free from defects in material and workmanship impairing its usefulness under normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any instrument or defective parts, when returned prepaid to us, and which our examination discloses to have been defective. The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in MICROMERITICS instruments and other products were chosen after extensive testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization to return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are made by persons other than its own authorized service personnel unless such work is authorized in writing by MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their respective brand names or trade names. We, therefore, make no express or implied warranty as to such products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary practice, the repair or replacement of such of his products that may prove defective in workmanship or materials. Service charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our entire liability in respect to such products, except as an authorized person of MICROMERITICS may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the discretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including, but not limited to the implied warranties of merchantability or fitness for use.
# TABLE OF CONTENTS

## 1. GENERAL INFORMATION

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization of the Manual</td>
<td>1-1</td>
</tr>
<tr>
<td>Conventions</td>
<td>1-3</td>
</tr>
<tr>
<td>Online Manual</td>
<td>1-4</td>
</tr>
<tr>
<td>Using Bookmarks</td>
<td>1-4</td>
</tr>
<tr>
<td>Using the Table of Contents, Index, and other Links</td>
<td>1-6</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>1-6</td>
</tr>
<tr>
<td>Index</td>
<td>1-7</td>
</tr>
<tr>
<td>Cross References</td>
<td>1-7</td>
</tr>
<tr>
<td>Using the Find Command</td>
<td>1-8</td>
</tr>
<tr>
<td>Printing</td>
<td>1-9</td>
</tr>
<tr>
<td>Equipment Description</td>
<td>1-10</td>
</tr>
<tr>
<td>Gas Requirements</td>
<td>1-11</td>
</tr>
<tr>
<td>Analysis Program</td>
<td>1-11</td>
</tr>
<tr>
<td>Report System</td>
<td>1-11</td>
</tr>
<tr>
<td>Specifications</td>
<td>1-12</td>
</tr>
</tbody>
</table>

## 2. INSTALLATION

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unpacking and Inspection</td>
<td>2-1</td>
</tr>
<tr>
<td>Lifting the Analyzer</td>
<td>2-1</td>
</tr>
<tr>
<td>Equipment Damage or Loss During Shipment</td>
<td>2-1</td>
</tr>
<tr>
<td>Equipment Return</td>
<td>2-2</td>
</tr>
<tr>
<td>Setting up the Analyzer</td>
<td>2-3</td>
</tr>
<tr>
<td>Installing the Vacuum Pumps</td>
<td>2-3</td>
</tr>
<tr>
<td>Oil-Based Systems</td>
<td>2-3</td>
</tr>
<tr>
<td>Dry Systems</td>
<td>2-4</td>
</tr>
<tr>
<td>Verifying Line Voltage Selection</td>
<td>2-5</td>
</tr>
<tr>
<td>Installing the Cold Trap Tubes</td>
<td>2-5</td>
</tr>
<tr>
<td>Installing Saturation Pressure (Psat) Tube</td>
<td>2-6</td>
</tr>
<tr>
<td>Selecting the Computer Power Input</td>
<td>2-7</td>
</tr>
<tr>
<td>Connecting the Gas Supply</td>
<td>2-8</td>
</tr>
<tr>
<td>Connecting a Regulator to the Gas Bottle</td>
<td>2-8</td>
</tr>
<tr>
<td>Connecting the Gas Delivery Tubing to the Analyzer</td>
<td>2-9</td>
</tr>
<tr>
<td>Connecting Cables and Power Cords</td>
<td>2-10</td>
</tr>
<tr>
<td>Turning On the System</td>
<td>2-11</td>
</tr>
<tr>
<td>Turning Off the System</td>
<td>2-11</td>
</tr>
<tr>
<td>Installing the Analysis Program</td>
<td>2-12</td>
</tr>
<tr>
<td>Initial Installation</td>
<td>2-12</td>
</tr>
<tr>
<td>Using the Setup Program for Other Functions</td>
<td>2-15</td>
</tr>
<tr>
<td>Installing Subsequent Software Versions</td>
<td>2-16</td>
</tr>
<tr>
<td>Adding an Analyzer</td>
<td>2-17</td>
</tr>
<tr>
<td>Moving an Analyzer from one PC to another PC</td>
<td>2-18</td>
</tr>
</tbody>
</table>
### 3. USER INTERFACE

- Controls, Indicators, and Connectors ........................................... 3-1  
  - Front Panel ........................................................................ 3-1  
  - Side Panel .......................................................................... 3-4  
    - Upper .................................................................................. 3-4  
    - Lower .............................................................................. 3-5  
  - Rear Panel ........................................................................... 3-6  
- Using the Software ........................................................................ 3-7  
  - Shortcut Menus ....................................................................... 3-7  
  - Shortcut Keys ......................................................................... 3-7  
  - Dialog Boxes .......................................................................... 3-9  
  - Selecting Files ......................................................................... 3-11  
  - File Name Conventions ............................................................ 3-13  
- Menu Structure ........................................................................... 3-14  
  - Windows Menu ........................................................................ 3-15  
  - Help Menu ............................................................................. 3-15

### 4. OPERATIONAL PROCEDURES

- Specifying Sample File Defaults .................................................. 4-1  
  - Basic Format .......................................................................... 4-2  
  - Advanced Format ..................................................................... 4-4  
- Creating Sample Information Files ............................................... 4-6  
  - Advanced Format ..................................................................... 4-6  
  - Basic and Restricted Formats ..................................................... 4-8  
- Defining Parameter Files ............................................................. 4-9  
  - Sample Tube .......................................................................... 4-9  
  - Degas Conditions ..................................................................... 4-10  
  - Analysis Conditions ................................................................. 4-11  
  - Adsorptive Properties ............................................................... 4-13  
  - Report Options ........................................................................ 4-14  
- Preparing Samples ........................................................................ 4-16  
  - Choosing Sample Tubes ......................................................... 4-16  
  - Cleaning and Labeling Sample Tubes ....................................... 4-17  
  - Determining Amount of Sample to Use .................................... 4-20  
  - Determining the Mass of the Sample ....................................... 4-20  
  - Degassing the Sample .............................................................. 4-22  
  - Transferring the Degassed Sample to the Analysis Port .......... 4-24  
- Installing Dewars .......................................................................... 4-26  
  - Precautions ............................................................................. 4-26  
  - Cold Trap Dewar ...................................................................... 4-26  
  - Analysis Dewar ........................................................................ 4-28
5. **FILE MENU**

<table>
<thead>
<tr>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performing an Analysis</td>
<td>4-29</td>
</tr>
<tr>
<td>Printing File Contents</td>
<td>4-31</td>
</tr>
<tr>
<td>Listing File Statistics</td>
<td>4-32</td>
</tr>
<tr>
<td>Exporting Isotherm Data</td>
<td>4-33</td>
</tr>
<tr>
<td>Generating Graph Overlays</td>
<td>4-34</td>
</tr>
<tr>
<td>Multiple Samples Overlay</td>
<td>4-34</td>
</tr>
<tr>
<td>Multiple Graphs Overlay</td>
<td>4-37</td>
</tr>
</tbody>
</table>

| Open                                  | 5-3  |
| Sample Information                    | 5-5  |
| Advanced Format                       | 5-6  |
| Basic Format                          | 5-9  |
| Restricted Format                     | 5-11 |
| Sample Tube                           | 5-12 |
| Degas Conditions                      | 5-14 |
| Analysis Conditions                   | 5-16 |
| Adsorptive Properties                 | 5-31 |

| Report Options                        | 5-35 |
| Summary Report                        | 5-38 |
| Isotherm Report Options                | 5-40 |
| BET/Langmuir Surface Area Report Options | 5-42 |
| Freundlich Isotherm                    | 5-45 |
| Temkin Isotherm                        | 5-47 |
| t-Plot Report Options                  | 5-49 |
| Alpha-S Plot                           | 5-55 |
| f-Ratio Plot                           | 5-58 |
| BJH Adsorption/Desorption Report Options | 5-60 |
| Dollimore-Heal Adsorption/Desorption Report Options | 5-69 |
| Horvath-Kawazoe Report Options         | 5-70 |
| DFT Pore Size                          | 5-77 |
| Surface Energy                         | 5-80 |
| Dubinin Report Options                 | 5-81 |
| MP-Method Report Options               | 5-86 |
| Options Report                         | 5-90 |
| Sample Log Report                      | 5-90 |
| Validation Report                      | 5-91 |
| Collected/Entered Data                 | 5-92 |

| Save                                  | 5-94 |
| Save As                               | 5-95 |
| Sample and Parameter Files            | 5-95 |
| t-Curve and Alpha-S Files             | 5-96 |
| Save All                              | 5-96 |
| Close                                 | 5-96 |
| Close All                             | 5-97 |
| Print                                 | 5-98 |
| List                                  | 5-99 |
6. UNIT MENU

Description .......................................................... 6-1
Sample Analysis ..................................................... 6-3
Start Degas .......................................................... 6-8
Enable Manual Control ............................................. 6-9
Show Instrument Schematic ...................................... 6-12
Show Status .......................................................... 6-13
Show Instrument Log ............................................... 6-14
Unit Configuration ................................................. 6-16
Diagnostics ............................................................ 6-18
Calibration ..............................................................
  Vacuum Gauge ..................................................... 6-20
  Pressure Zero ....................................................... 6-21
  Pressure Scale ..................................................... 6-21
  Temperature ......................................................... 6-22
  Volume ..................................................................... 6-22
Save to File ............................................................ 6-25
Load from File .......................................................... 6-25
Degas ......................................................................
  Enable Manual Control ........................................... 6-26
  Show Instrument Schematic ..................................... 6-27
  Show Status .......................................................... 6-28
  Calibrate Pressure Zero ......................................... 6-29
  Calibrate Pressure Scale ........................................ 6-29
  Calibrate Vacuum Gauge ....................................... 6-30
  Calibrate Servo ...................................................... 6-30
Service Test .......................................................... 6-31

7. REPORTS MENU

Description .......................................................... 7-1
Start Report .......................................................... 7-3
Close Reports ........................................................ 7-5
Open Report ........................................................... 7-5
SPC Report Options ................................................ 7-6
Regression Report ................................................... 7-7
Control Chart ........................................................ 7-11
Heat of Adsorption ............................................... 7-14
Rate of Adsorption (ROA) ........................................ 7-17
Printed Reports ....................................................... 7-18
  Header ................................................................. 7-18
Onscreen Reports .................................................... 7-18
  Tool Bar .............................................................. 7-19
8. OPTIONS MENU

Description ................................................................. 8-1
Option Presentation ..................................................... 8-2
   Advanced ............................................................... 8-2
   Basic ................................................................. 8-3
   Restricted ............................................................. 8-3
Sample Defaults ......................................................... 8-4
   Basic Format .......................................................... 8-5
   Advanced Format ...................................................... 8-7
Units ................................................................. 8-12
Graph Grid Lines ..................................................... 8-12
Live Graph ............................................................ 8-13
Parameter Files Directory ............................................. 8-13
Service Test Mode ...................................................... 8-14

9. TROUBLESHOOTING AND MAINTENANCE

Troubleshooting .......................................................... 9-1
Preventive Maintenance ............................................... 9-3
   Lubricating the Elevator Screw .................................... 9-4
   Checking the Analysis Port Dewar .................................. 9-4
   Replacing the Sample Tube O-ring ................................. 9-5
   Replacing the Port Filters ........................................... 9-6
      Analysis Port ......................................................... 9-6
      Degas Port .......................................................... 9-7
   Replacing the Vacuum Pump Exhaust Filter ....................... 9-7
   Inspecting and Changing Vacuum Pump Fluid .................... 9-9
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inspecting Fluid</strong></td>
<td>9-9</td>
</tr>
<tr>
<td><strong>Changing Fluid</strong></td>
<td>9-9</td>
</tr>
<tr>
<td>Replacing the Alumina in the Oil Vapor Traps</td>
<td>9-11</td>
</tr>
<tr>
<td>Cleaning the Cold Trap Tubes</td>
<td>9-14</td>
</tr>
<tr>
<td>Calibrating the Manifold Temperature Sensor</td>
<td>9-15</td>
</tr>
<tr>
<td>Performing a Leak Test</td>
<td>9-16</td>
</tr>
<tr>
<td>Cleaning and Verifying the Gas Line</td>
<td>9-19</td>
</tr>
<tr>
<td><strong>Routine Maintenance</strong></td>
<td>9-22</td>
</tr>
<tr>
<td>Cleaning the Analyzer</td>
<td>9-22</td>
</tr>
<tr>
<td>Calibrating the Pressure Offset</td>
<td>9-22</td>
</tr>
<tr>
<td>Calibrating the Pressure Scale</td>
<td>9-23</td>
</tr>
<tr>
<td><strong>10. ORDERING INFORMATION</strong></td>
<td></td>
</tr>
<tr>
<td>Analysis System Components and Accessories</td>
<td>10-1</td>
</tr>
<tr>
<td>Sample Tubes and Components</td>
<td>10-4</td>
</tr>
<tr>
<td>1/4-in., 3/8-in, and 1/2-in Sample Tubes</td>
<td>10-4</td>
</tr>
<tr>
<td>22-mm Sample Tube Kit</td>
<td>10-5</td>
</tr>
<tr>
<td>Cold Trap Tubes and Components</td>
<td>10-6</td>
</tr>
<tr>
<td><strong>A. FORMS</strong></td>
<td></td>
</tr>
<tr>
<td>ASAP Series Sample Data Worksheet</td>
<td>A-3</td>
</tr>
<tr>
<td><strong>B. ERROR MESSAGES</strong></td>
<td></td>
</tr>
<tr>
<td>2200 and 2400 Series</td>
<td>B-1</td>
</tr>
<tr>
<td>2500 Series</td>
<td>B-13</td>
</tr>
<tr>
<td>4000 Series</td>
<td>B-19</td>
</tr>
<tr>
<td>6200 Series</td>
<td>B-37</td>
</tr>
<tr>
<td>6500 Series</td>
<td>B-41</td>
</tr>
<tr>
<td><strong>C. CALCULATIONS</strong></td>
<td></td>
</tr>
<tr>
<td>Saturation Pressure (Po)</td>
<td>C-1</td>
</tr>
<tr>
<td>Relative Pressure</td>
<td>C-1</td>
</tr>
<tr>
<td>Free Space</td>
<td>C-3</td>
</tr>
<tr>
<td>Equations of State</td>
<td>C-4</td>
</tr>
<tr>
<td>Quantity Adsorbed</td>
<td>C-5</td>
</tr>
<tr>
<td>Equilibration</td>
<td>C-6</td>
</tr>
<tr>
<td>Thermal Transpiration Correction</td>
<td>C-7</td>
</tr>
<tr>
<td>BET Surface Area</td>
<td>C-8</td>
</tr>
<tr>
<td>Langmuir Surface Area</td>
<td>C-9</td>
</tr>
<tr>
<td>t-Plot</td>
<td>C-11</td>
</tr>
<tr>
<td>BJH Pore Volume and Area Distribution</td>
<td>C-13</td>
</tr>
<tr>
<td>Explanation of Terms</td>
<td>C-13</td>
</tr>
<tr>
<td>Calculations</td>
<td>C-14</td>
</tr>
<tr>
<td>Compendium of Variables</td>
<td>C-21</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Horvath-Kawazoe</td>
<td>C-22</td>
</tr>
<tr>
<td>Slot Pore Geometry (original HK)</td>
<td>C-22</td>
</tr>
<tr>
<td>Cylinder Pore Geometry (Saito/Foley)</td>
<td>C-23</td>
</tr>
<tr>
<td>Sphere Pore Geometry (Cheng/Yang)</td>
<td>C-24</td>
</tr>
<tr>
<td>Cheng/Yang Correction</td>
<td>C-25</td>
</tr>
<tr>
<td>Interaction Parameter</td>
<td>C-26</td>
</tr>
<tr>
<td>Additional Calculations</td>
<td>C-27</td>
</tr>
<tr>
<td>Interaction Parameter Components</td>
<td>C-28</td>
</tr>
<tr>
<td>Dubinin-Radushkevich</td>
<td>C-30</td>
</tr>
<tr>
<td>Dubinin-Astakhov</td>
<td>C-32</td>
</tr>
<tr>
<td>MP-Method</td>
<td>C-36</td>
</tr>
<tr>
<td>Freundlich Isotherm</td>
<td>C-38</td>
</tr>
<tr>
<td>Temkin Isotherm</td>
<td>C-39</td>
</tr>
<tr>
<td>DFT (Density Functional Theory)</td>
<td>C-40</td>
</tr>
<tr>
<td>The Integral Equation of Adsorption</td>
<td>C-40</td>
</tr>
<tr>
<td>Application to Surface Energy Distribution</td>
<td>C-41</td>
</tr>
<tr>
<td>Application to Pore Size Distribution</td>
<td>C-41</td>
</tr>
<tr>
<td>Performing the Deconvolution</td>
<td>C-41</td>
</tr>
<tr>
<td>Regularization</td>
<td>C-42</td>
</tr>
<tr>
<td>Heat of Adsorption</td>
<td>C-43</td>
</tr>
<tr>
<td>Summary Report</td>
<td>C-43</td>
</tr>
<tr>
<td>SPC Report Variables</td>
<td>C-45</td>
</tr>
<tr>
<td>Regressions Chart Variables</td>
<td>C-45</td>
</tr>
<tr>
<td>Control Chart Variables</td>
<td>C-46</td>
</tr>
</tbody>
</table>

**D. TESTING FOR LEAKS**

Testing Individual Valves                                           D-1
Analysis Valves                                                      D-1
  Valves 3 and P1 through P6                                          D-4
  Valves PS, 5, and 7                                                 D-4
  Valves 1, 2, 8, 9, 10, 11, and PV                                    D-5
Degas Valves                                                         D-7
What To Do If You Detect a Leaking Valve                              D-8
Removing Differential Pressure from a Leaking Valve                   D-8
Repairing or Replacing a Leaking Valve                                D-8
  Repairing Valves on the Analysis Manifold                            D-8
  Replacing Valves on the Degas and Gas Inlet Manifold                 D-10
Valve Data Test Sheet                                                 D-11

**E. CALCULATING FREE-SPACE VALUES FOR MICROPOROUS ANALYSES**

**F. DEFAULT FILES AND SYSTEM FILES**
G. DFT MODELS

Models Based on Statistical Thermodynamics. ........................................... G-1
  Theoretical Background ................................................................. G-1
  Molecular Simulation Methods ......................................................... G-2
    Molecular Dynamics Method ....................................................... G-2
    Monte Carlo Method ................................................................. G-2
  Density Functional Formulation ..................................................... G-3
    Non-Local Density Functional Theory with Density-Independent Weights . G-7
    Non-Local Density Functional Theory with Density-Dependent Weights. G-7
Models Based on Classical Theories .................................................... G-13
  Surface Energy .............................................................................. G-13
  Pore Size ....................................................................................... G-13
Models Included ................................................................................ G-14
  Kelvin Equation with Halsey Thickness Curve ................................... G-14
  Kelvin Equation with Harkins and Jura Thickness Curve ..................... G-14
  Kelvin Equation with Broekhoff-de Boer Thickness Curve .................... G-15
References. ...................................................................................... G-16
1. GENERAL INFORMATION

This manual describes how to install and operate the ASAP (Accelerated Surface Area and Porosimetry) 2020 System. It includes instructions for the following ASAP 2020 systems:

- Standard Physisorption System
- Multigas System
- Micropore System
- 1-mmHg System
- 0.1-mmHg System

Organization of the Manual

The manual is divided into the following chapters:

Chapter 1  General Information
Provides a general description of the ASAP 2020 system as well as its specifications.

Chapter 2  INSTALLATION
Describes how to unpack, inspect, and install the ASAP 2020 analyzer.

Chapter 3  USER INTERFACE
Provides basic instrument and software interface.

Chapter 4  OPERATIONAL PROCEDURES
Provides step-by-step instructions for operating the ASAP 2020.

Chapter 5  FILE MENU
Provides a description of the commands on the File menu.

Chapter 6  UNIT MENU
Provides a description of the commands on the Unit menu.

Chapter 7  REPORTS MENU
Provides a description of the commands on the Reports menu and samples of reports.
Chapter 8  OPTIONS MENU
Provides a description of the commands on the Options menu.

Chapter 9  TROUBLESHOOTING AND MAINTENANCE
Provides instructions for troubleshooting hardware problems and for performing routine maintenance procedures.

Chapter 10  ORDERING INFORMATION
Provides part numbers and descriptions of the ASAP 2020 System components and accessories.

Appendix A  ASAP Series Sample Data Worksheet
Contains a form to assist you in determining the sample mass.

Appendix B  ERROR MESSAGES
Lists the error messages that may be displayed in the analysis program; includes a cause and action for each.

Appendix C  CALCULATIONS
Contains the calculations used by the system to produce reports.

Appendix D  TESTING FOR LEAKS
Describes the procedure for manually testing each valve for leaks.

Appendix E  CALCULATING FREE-SPACE VALUES FOR MICROPOROUS ANALYSES
Provides instructions for obtaining free-space values to use in micropore analyses.

Appendix F  DEFAULT FILES AND SYSTEM FILES
Provides default files shipped with the software.

Appendix G  DFT MODELS
Provides information on DFT models.

Index  INDEX
Provides quick access to a subject matter.
Conventions

This manual uses the symbols shown below to identify notes of importance, cautions, and warnings.

- **Notes**: contain a tip or important information pertinent to the subject matter.

- **Cautions**: contain information to help you prevent actions which could damage the instrument.

- **Warnings**: contain information to help you prevent actions which could cause personal injury.
Online Manual

For your convenience, the Operator’s Manual is available online. You can access the manual by selecting Help, then Operator’s Manual from the analysis program main menu. The manual appears in an Adobe® Acrobat® Reader®.

Following are some tips to help you quickly locate the information you need in the manual. Refer to the Adobe Acrobat Help system (click the Help button on the Acrobat menu) for more information on the Acrobat features you can use while viewing the manual.

Using Bookmarks

Click the Bookmarks tab to list and access the topics included in the manual.

You can use the + and − buttons next to topics as they are used in Windows Explorer to expand or collapse the topic list.
To display a topic, click the topic name in the Bookmarks section. The related information appears in the topic pane of the window as shown in the following example.
Using the Table of Contents, Index, and other Links

Links provide direct access to selected information. All links appear in blue type. Links are contained in:

- the table of contents
- index entries
- cross-references within the manual

Table of Contents

To display the table of contents, click Table of Contents in the Bookmarks section. When the table of contents is displayed, you can click an entry to display its associated page. For example, clicking Using the Software in the table of contents, displays the page containing information about the software.

The analysis program operates in the Windows environment and requires familiarity with standard Windows operations such as using the mouse, menus, and dialog boxes. While this manual provides brief instructions for such standard operations, you may have to refer to your Windows documentation or to its online help system to clarify functions which are specific to Windows.

Shortcut Menus

Shortcut menus (sometimes referred to as context-sensitive menus or pop-up menus) are available for certain components on the instrument schematic when in manual mode, and for
Index

To use the index in the online manual, click the Bookmarks tab, scroll down to INDEX (the last topic in Bookmarks), then click the + button to expand the index. The letters A through Z are displayed. Click a letter to display its corresponding index entries as shown in the following example.

After you display the entries, locate the item of interest and click on the page reference to access the information.

Cross References

Cross-references work in the same manner. In the example below, clicking on the cross-reference, FILE MENU (shown on the screen in blue type) will display the first page of the chapter describing the commands found on the File menu.

**FILE MENU**

Provides a description of the commands available on the File menu.
Using the Find Command

The Adobe Acrobat **Find** command provides another method of easily accessing specific information. For example, suppose you want to know how the **Save as** command works. You could select **Edit > Find** from the Adobe Acrobat menu, then enter **Save as** in the Find dialog. The following example shows the results.

![Find Command Example](image)

**Save As**

Save As enables you to:

- save a sample or parameter file in the active window under a different name. This option is useful for making a duplicate copy of a file that you can modify as desired without changing the original one. The original file remains open when you use this function, so be sure to open the new file before making any changes.
- save a subset (parameter) of the sample file in the active window as a standalone parameter file. For example, select Analysis Conditions from the Save As menu to create a standalone parameter file of the analysis conditions portion of the active sample file.
Printing

You can print the entire manual, a selected page, or range of pages. There are several options for printing. You can:

- Select the printer icon ( ) on the Adobe Acrobat toolbar.
  A standard Print dialog is displayed. Select the page(s) to print, then click OK. When using this option (or the next one), be sure to enter the page number(s) displayed in Adobe Acrobat; do not use the page number(s) listed in the footer(s) of the manual.

- Select File > Print.
  A standard Print dialog is displayed. Select the page(s) to print, then click OK.

- Click the Thumbnails tab.
  Thumbnails of manual pages are displayed.
  a. Click the pages you want to print.
  b. Right-click to display a shortcut menu, then select Print Pages.
  c. A standard Print dialog is displayed; click OK.
The ASAP 2020 analyzer is equipped with two independent vacuum systems — one for sample preparation and one for sample analysis. Having two separate systems, as well as separate preparation ports, allows sample preparation and sample analysis to occur concurrently without interruption. Inline cold traps are located between the vacuum pump and the manifold in both the analysis and the degas systems. The sample saturation pressure (Psat) tube is located next to the sample analysis port. Gas inlet ports and cable connections are located conveniently on the side panel of the analyzer for easy access.

The ASAP 2020 is equipped with an elevator that raises and lowers the analysis bath fluid Dewar automatically. A removable shield to enclose the Dewar is also included for safety purposes.

The ASAP 2020 system includes Micromeritics’ Isothermal Jackets for the sample tube. The Isothermal Jacket maintains a stable thermal profile along the full length of the sample and Psat tubes.
Gas Requirements

Compressed gases are required for analyses performed by the ASAP 2020 analyzer. Gas bottles or an outlet from a central source should be located near the analyzer.

Appropriate two-stage regulators which have been leak-checked and specially cleaned are required. Pressure relief valves should be set to no more than 30 psig (200 kPag). Gas regulators are available from Micromeritics; refer to Ordering Information, page 10-1.

Analysis Program

The ASAP 2020 analysis program is designed to operate in a Windows Vista, Windows XP, or Windows 7 Professional environment. The Windows environment provides a user-friendly interface for performing analyses and generating reports.

The ASAP 2020 System software monitors and controls the analyzer. It enables you to perform automatic analyses with just a few key strokes, and collects and reports analysis data. You can choose from a variety of reports, which can be printed automatically after an analysis or stored and printed later.

Report System

The ASAP 2020 software includes a report system which allows you to manipulate and customize reports. You can zoom in on portions of the graphs or shift the axes to examine fine details. Scalable graphs can be copied to the clipboard and pasted into other applications. Reports can be customized with your choice of fonts and a company logo added to the report header for an impressive presentation. Refer to REPORTS MENU for the options available for reports.
Specifications

The ASAP 2020 system has been designed and tested to meet these specifications.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PRESSURE MEASUREMENT</strong></td>
<td></td>
</tr>
<tr>
<td>Range:</td>
<td>0 to 950 mmHg</td>
</tr>
<tr>
<td>Resolution:</td>
<td></td>
</tr>
</tbody>
</table>
| 1000-mmHg Transducer | 0.001 mmHg (Analysis system)  
1 mmHg (Degas system) |
| 10-mmHg Transducer* | 0.00001 mmHg |
| 1-mmHg Transducer** (optional for high stability) | 0.000001 mmHg |
| 0.1-mmHg Transducer (optional for high stability) | 0.0000001 mmHg |
| Accuracy (Analysis system only): | |
| Includes nonlinearity, hysteresis, and nonrepeatability. Transducer manufacturer’s specifications. | |
| 1000-mmHg Range | Within 0.15% of reading |
| 10-mmHg Range* | Within 0.15% of reading |
| 1-mmHg Range** | Within 0.12% of reading |
| 0.1-mmHg Range*** | Within 0.15% of reading |
| **VACUUM SYSTEM** | |
| Vacuum Pump: | Mechanical, two-stage, for analysis; optional for degas. Ultimate vacuum 5 x 10^{-3} mmHg. Dry pumps available for systems equipped with optional High Vacuum pump. |
| High Vacuum Pump (if installed): | Less than 3.8 x 10^{-9} mmHg |

* High Vacuum systems  
**Micropore systems  
***Micropore systems with 0.1 mmHg transducer  
Ultimate vacuum measured by pump manufacturer according to Pneuprop Standard 5608.
<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Specification</th>
</tr>
</thead>
</table>
| MANIFOLD TEMPERATURE TRANSDUCER | Type: Platinum resistance device (RTD)  
Accuracy: ± 0.02 °C (by keyboard entry) |
| DEGAS SYSTEM (Optional) | Temperature Range: Ambient to 450 °C  
Selection: 1 °C increments  
Accuracy: Deviation less than ±10 °C of set point at thermocouple  
Backfill Gas: User-selectable, typically helium or nitrogen  
Pressure Range: 0 to 950 mmHg  
Accuracy: 1% best fit straight line |
| SYSTEM CAPACITY | Sample Preparation: 2 degas ports (optional)  
Analysis: 1 sample port and 1 saturation pressure tube  
Total Operating Capacity: Up to two complete analysis units can be controlled independently by one computer |
| CRYOGEN SYSTEM | Special Features: Isothermal Jackets effectively maintain cryogen level constant on sample tube and Po tube during analysis while evaporation of cryogen occurs  
Capacity: 3-Liter Dewar, which typically provides greater than 91 hours of unattended analysis |
<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Time:</td>
<td>Unlimited. Cryogen Dewars may be refilled without affecting the accuracy of results.</td>
</tr>
</tbody>
</table>

### SAMPLE SIZE
Sample tubes are available for various size pellets, cores and powders. Sample tube stems are normally 1.27-cm (1/2-in.) OD with 9-cc bulbs. Also available are 0.635-(1/4-) or 0.953-cm (3/8-in.) OD with 9-cc bulbs. A 22-mm (0.87-in.) ID, 25-mm (1.0-in) OD sample tube kit is also available. Special tubes can be designed to accommodate unusual samples.

### ELECTRICAL
| Voltage: | 100, 115, 230 VAC ±10% |
| Frequency: | 50/60 Hz |
| Power: | 700 VA, operating |

### ENVIRONMENT
| Temperature: | 10 to 30 °C, operating |
| | -10 to 55 °C, storing or shipping |
| Humidity | 20 to 80% relative, noncondensing |

### GASES
| Normal: | Argon, carbon dioxide, nitrogen, krypton (Multigas system), and other suitable gases |

### PHYSICAL
<p>| Height | 99 cm (39 in.) |
| Width: | 85 cm (33.5 in.) |
| Depth: | 61 cm (24 in.) |
| Weight: | 115 kg (250 lbs) |</p>
<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>COMPUTER</strong></td>
<td></td>
</tr>
<tr>
<td>Minimum requirements:</td>
<td>CD-ROM drive</td>
</tr>
<tr>
<td></td>
<td>512 megabytes of main memory</td>
</tr>
<tr>
<td></td>
<td>20-gigabyte hard drive</td>
</tr>
<tr>
<td></td>
<td>SVGA monitor (1024 x 768 min. resolution)</td>
</tr>
<tr>
<td></td>
<td>Windows Vista, Windows XP, or Windows 7 Professional.</td>
</tr>
</tbody>
</table>
2. INSTALLATION

This chapter contains instructions for the following:

- Unpacking and Inspection
- Setting Up the Analyzer
- Installing the Analysis Program

Initially, your ASAP 2020 analyzer will be installed and verified for operation by an authorized Micromeritics service representative or a representative of a Micromeritics distributor. If your analyzer is moved to a different location in your laboratory, use the instructions provided in this chapter for reinstallation.

Unpacking and Inspection

When you receive the shipping cartons, carefully compare the packing list with the equipment actually received while checking for equipment damaged during shipment. Be sure to sift through all packing materials before declaring equipment missing.

Save the shipping cartons if equipment or parts have been damaged or lost. The inspector or claim investigator must examine the cartons prior to completion of the inspection report.

Lifting the Analyzer

The ASAP 2020 analyzer weighs 115 kg (250 lbs) and requires the use of two people to lift it from its shipping carton. One person should not attempt to lift the analyzer. With one person on each side of the analyzer, lift it upright from its shipping carton. Place the analyzer on a table top of sufficient space.

Use proper lifting techniques to prevent back injury.

Equipment Damage or Loss During Shipment

When equipment is damaged or lost in transit, you are required to make note of the damage or loss on the freight bill. The carrier, not the shipper, is responsible for all damage or loss. In the event of equipment damage or loss during shipment, contact the carrier of the equipment immediately.
Equipment Return

Micromeritics strives to ensure that all items arrive safely and in working order. Occasionally, due to circumstances beyond our control, equipment is received which is not in working condition. When it is necessary to return equipment (damaged either during shipment or while in use) to Micromeritics for repair or replacement, use the following procedure:

1. Pack the instrument in its original shipping carton if possible. If the original carton is unavailable, for a nominal fee, Micromeritics can provide another carton for your use.

   **Failure to package your instrument properly may result in shipping damage.**

2. Tag or identify the defective equipment, noting the defect and circumstances, if any, under which the defect is observed.

3. Make reference to the sales order or purchase order for the equipment, and provide the date the equipment was received.

4. Notify the Micromeritics Service Department of the defect and request shipping instructions. The service department will assign a Returned Materials Authorization (RMA) number. Write the RMA number on the outside of the shipping carton.
Setting up the Analyzer

The ASAP 2020 System should be installed correctly and tested to ensure that it is operating properly before actual analyses are attempted.

Installing the Vacuum Pumps

Two vacuum pumps are required for operating the ASAP 2020 analyzer when equipped with a degas system: one for degas operations and one for analysis. A recessed cavity is provided on the rear side of the analyzer for placement of the vacuum pumps. The analysis pump (facing the rear of the analyzer) is on the left side and the degas pump on the right side.

Two types of vacuum pumps are available, the oil-based vacuum pump and the dry vacuum pump. Typically the dry vacuum pump is used when a mass spectrometer is attached to the analyzer and for chemisorption analyses.

Oil-Based Systems

1. Remove the vacuum pump from its shipping carton.

2. Prepare the alumina and oil vapor trap (refer to Replacing the Alumina in the Oil Vapor Trap on page 9-11), then install the trap onto the intake port of the vacuum pump.

   Oil vapor traps reduce the amount of oil vapor that collects in the hoses leading to the instrument.

3. Add fluid to the vacuum pump (refer to Inspecting and Changing Vacuum Pump Fluid on page 9-9).

4. Install the vacuum pump exhaust filter (refer to Replacing the Vacuum Pump Exhaust Filter on page 9-7).

5. Place the vacuum pump onto its drip tray and slide the tray into the right side of the vacuum pump cavity. Be sure the power cord is facing outward; do not connect the power cord to a power source at this time.
6. Connect the flexible tubing from the analyzer to the connector on the topside of the pump. The following illustration shows orientation of a typical vacuum pump and its components attached to the flexible tubing of the analyzer.

---

**Dry Systems**

1. Remove the vacuum pump from its shipping carton.

2. Slide the vacuum pump into the left side of the vacuum pump cavity. Be sure the power cord is facing outward; do not connect the cord to a power source at this time.

3. Set the voltage selector switch on the vacuum pump to suit the voltage of your local power source.

4. Connect the flexible tubing from the analyzer to the connector on the topside of the pump.
Verifying Line Voltage Selection

Do not connect the ASAP 2020 to the power source until the proper voltage selection is made. Doing so could result in electrical shock and/or damage to the assembly.

Verify the line voltage as follows:

1. Slide the safety gate to the right. Slide the voltage selection switch to the voltage position to suit the available power supply.

2. Slide the safety gate to the left.

Installing the Cold Trap Tubes

The glass cold trap tubes are supplied with the accessories. Install them as follows:

1. Loosen the nut and O-ring.

2. Slide the glass tube up around the metal tube and secure it with the O-ring and nut.
3. Repeat for the second cold trap port.

Installing Saturation Pressure (Psat) Tube

The saturation pressure tube is packaged separately. This tube must be mounted onto the Po port located just behind the sample analysis port.

1. Remove the plastic protective cover from the saturation pressure port by turning it counterclockwise, then pull downward.
2. Ensure that the O-ring is in place on the end of the saturation pressure tube. Rotate the tube so that the isothermal jacket is closest to the analysis port. Secure the tube in place by turning the connector nut clockwise. Tighten by hand.

Selecting the Computer Power Input

The power input selection on the computer must be set to match the input power source. The computer operates with either 100-120 VAC or 200-240 VAC at 50 or 60 Hz. Refer to the instruction manual supplied with your computer for instructions on selecting power input.

Do not connect the computer power cord to a power source until the proper voltage selection is made. Doing so could result in electrical shock and/or damage to the computer.
Connecting the Gas Supply

Delivery tubes for connecting the gases used with the ASAP 2020 system are supplied with the instrument. A regulator is required for each gas bottle connected to the analyzer. Appropriate regulators are available from Micromeritics. Refer to Ordering Information on page 10-1 for part numbers.

Connecting the gas supply involves three procedures; you must:

- connect a regulator to each gas bottle that is being attached to the analyzer
- connect the gas bottle(s) to the analyzer’s gas inlet(s)
- specify (using the software) which gas is attached to the inlet(s)

The first two procedures are found below; refer to Specifying Gas Ports on page 2-25 to perform the third procedure, which cannot be performed until after software installation.

Connecting a Regulator to the Gas Bottle

1. Leave the gas bottle shut-off valve closed until instructed otherwise.

2. If the regulator has a 1/8-in. outlet, proceed to the next step. If the regulator has a 1/4-in. outlet, attach the reducer fitting to the outlet of the regulator shut-off valve.

3. Close the regulator shut-off valve.

Do not overtighten the fittings. Doing so could collapse the tubing and cause a leak.

4. Attach the copper delivery tubing to the regulator or reducer fitting. Do not connect the other end of the tubing.
5. Purge the regulator as follows:
   a. Close the regulator shut-off valve by turning it fully clockwise.
   b. Turn the pressure regulator control knob fully counterclockwise.
   c. Open the gas bottle valve by turning it counterclockwise, then close the gas bottle valve.
   d. Observe the high pressure gauge. If the pressure decreases, tighten the nut connecting the regulator to the gas bottle. If the pressure is stable, proceed to Step e.
   e. Turn each pressure regulator control knob clockwise until the outlet pressure gauge indicates 10 psig (0.7 bar). Open each regulator shut-off valve by turning it counterclockwise briefly. Then close each valve.
   f. Make sure the gas bottle valve is completely closed.

6. Repeat steps 2 through 5 for each gas bottle to be attached to the analyzer.

7. Proceed to the next section to attach the other end of the copper delivery tubing to the analyzer.

**Connecting the Gas Delivery Tubing to the Analyzer**

The ASAP 2020 analyzer allows for connection of up to six physisorption gases, a gas for degassing, a helium port for the free-space gas, and a Vapor port for water vapor analyses. The helium gas bottle is connected to the analyzer for use in free-space measurements. Other gases can also be used as the analysis gas. Nitrogen or helium (or other suitable gas) can be used as the degas backfill gas.

Gas inlet connections, located on the right side panel of the analyzer, are labeled 1 through 6 for the physisorption gases, Degas for the backfill gas, and helium for the free-space measurement. A vapor gas inlet is also provided for water vapor analyses.
A typical hook-up for gases is as follows:

1. Nitrogen
2. Argon
3. Carbon dioxide
4. Krypton
5. As desired
6. As desired
Degas Backfill: Nitrogen
Freespace Helium: Helium

Attach the other end of the copper tubing (from the regulator) to the appropriate gas port on the side of the analyzer.

Be sure to specify which gas is attached to the ports you are using. Refer to Specifying Gas Ports on page 2-25.

Connecting Cables and Power Cords

All cables must be connected securely to their respective connectors for proper operation of the analyzer and its peripheral equipment.

1. Connect the keyboard cable, the monitor cable, the printer cable, and the mouse cable into their respective connectors on the rear panel of the computer. Refer to the manual provided with your computer if you are unsure of connector locations.

2. Plug one end of the instrument communications cable into the connector labeled RS232 on the right side of the analyzer. Plug the other end into the communications port on the computer.

3. Insert one end of the analyzer power cord into the input power connector on the right side of the analyzer and the other end into an appropriate power source.

4. Plug all other power cords, including the vacuum pumps, into an appropriate power source.

5. Turn on the power to the vacuum pumps, but do not turn on the instrument power at this time.

Some monitors and printers shipped from the United States must be connected to a 100-120 VAC power source. Connecting this equipment to a 200-240 VAC power source could result in electrical shock and/or damage to the equipment.
Turning On the System

1. Place the ON/OFF switches for the computer and all peripheral devices in the ON position.

2. Place the analyzer ON/OFF switch in the ON position; verify that the green power indicator on the front panel is illuminated.

Turning Off the System

Always exit the ASAP 2020 program and/or Windows before turning off the computer. Failure to do so could result in loss of data.

1. Select Close from the System Menu or Exit from the File menu.

2. If you exit the ASAP 2020 program with analyses in progress, you will be warned of the operation. If desired, you can continue with exiting the application and the analyses will proceed and continue to collect data. Reports that are queued under the Print Manager will print. If, however, a power failure occurs and an uninterruptible power supply (UPS) is not attached to the computer, the data collected after exiting the ASAP 2020 System program are lost.

3. Place the computer, monitor, printer, and plotter (if used) ON/OFF switches in the OFF position.

4. Place the analyzer Main Power switch in the OFF position.
Installing the Analysis Program

Your system must meet or exceed the following requirements before you can install the software:

- CD-ROM drive
- 128 megabytes of main memory
- 1-gigabyte hard drive
- SVGA monitor (800 x 600 minimum resolution)
- Windows Vista, Windows XP, or Windows 7 Professional

The ASAP 2020 program is also available as a standalone option so that you can install it on a computer other than the one controlling the analyzer. This allows you to create or edit sample and parameter files, as well as generate reports on completed sample files. Review the Micromeritics PROGRAM License Agreement for restrictions on the use of additional copies.

Power Management features should be disabled so that the Micromeritics application can communicate properly with the instrument during operation. These features can be disabled in the computer Setup configuration through Windows NT or through a utility supplied by the computer manufacturer.

Initial Installation

The ASAP 2020 System program is supplied on a CD. Perform the following steps to install the program:

1. Turn on the analyzer.
2. Insert the program CD into your CD-ROM drive.
3. Select Start from the Status bar, then Run from the Start menu.
4. Enter the name of the drive designator, followed by setup. For example:

   \texttt{e:setup}
5. Click **OK**; the New Installation dialog is displayed.

The **Destination Folder** group box displays the amount of current disk space, the amount of disk space required for the analysis program, and the directory into which the application will be installed. If you wish to install the application into a different directory, click **Browse** to choose the directory.

6. If you want to run the application from the desktop, select the check box just below the Destination Folder group box to add an icon.

7. The ASAP 2020 icon is added to the Micromeritics folder by default. If you prefer a different folder, enter or select one from the drop-down list.

8. The **Install this application for All Users** check box enables you to allow or prohibit users other than the installer to access the application.
   - Select the check box to allow access for all users logged onto Windows.
   - Deselect the check box to allow access for only the user installing the application.

9. Click **Next**; the Analyzer Configuration dialog is displayed.

You may cancel the installation at any time by selecting **Exit**. If you do so, you must start the installation program from the beginning to install the analysis program.
In the Step 1 group box, click the radio button for the number of analyzers to be attached to this computer. If you are attaching two analyzers, make sure your computer has two serial ports.

Choose 0 (zero) if you are installing this program for data reduction on a computer other than the one controlling the analyzer.

10. In the Step 2 group box, for each analyzer: enter the analyzer serial number and the communications port to which it will be attached.

11. Click Next; the Calibration File Installation dialog is displayed. Read the information in the dialog and proceed accordingly.

If you selected zero (0) as the number of instruments to install, the Calibration dialog is not displayed.

12. After the calibration files are installed, the Installation Complete dialog box containing the Readme file is displayed.

13. Use the scroll bar if you want to read the contents of the file, then click Finish to close the dialog.
14. Remove the Setup CD and store in a safe place. The original Setup CD contains the calibration files specific to your instrument. Upgrade CDs do not contain calibration files. Therefore, it is important that you maintain your original Setup CD in a secure location in the event calibration files need to be reinstalled.

**Using the Setup Program for Other Functions**

After initial installation of the ASAP 2020 analysis program, the application setup program can be used to:

- Upgrade software
- Add an analyzer
- Move an analyzer from one computer to another computer
- Remove an analyzer from the computer
- Change the analyzer setup
- Reinstall calibration files
- Uninstall the analysis program

To start the application setup program:

1. Ensure that the analysis program is not operating.
2. Insert the CD into your CD-ROM drive.
3. Select **Start** from the Status bar.
4. Select **Run** from the start menu.
5. Enter the drive designator of the CD-ROM drive, followed by `setup`. For example: `e:setup`.

Alternatively, you can click **Browse**, navigate to your CD-ROM drive, and select `setup.exe`. 
6. Click **OK**; the setup Welcome screen showing the options available is displayed.

![Welcome Screen](image)

### Installing Subsequent Software Versions

When you install a software upgrade, the system installs all of the application files and any status files that do not already exist on the computer. Existing analyzer status files are not affected and default and data files are not overwritten. There are three types of subsequent installation; the software version controlled by the setup program is:

- a later version than the version installed on the computer
- the same version as the version installed on the computer
- an earlier version than the version installed on the computer

The setup program automatically detects which type of installation applies and customizes the selection in the Setup dialog accordingly.

1. Start the Setup program. Choose the software option; remember, only the applicable option will display; it will be one of the following:

   - Upgrade software to version (number) from version (number)
   - Reinstall software version (number)
   - Downgrade software to version (number) from version (number)

2. Click **Start File Installation**; the application installs the software and redispays the setup Welcome dialog. If no other operations are desired using this dialog, click **Exit** to close the dialog.
Adding an Analyzer

Add an analyzer to the existing application as follows:

1. Start the Setup program. Select **Add an analyzer**, then click **Next**; the Setup analyzer dialog is displayed.

2. Enter the serial number of the analyzer being added, then the communications port to which it is to be connected.

3. Click **Next**; the Calibration Installation dialog is displayed.

4. Select the location of the calibration source files. If the calibration files are located in a directory other than the one displayed, click **Browse** to select the directory. Click **Finish**; a media change dialog is displayed.

5. Click **OK** to install the calibration files. A dialog containing the Readme file is displayed after the calibration files are installed.

6. Click **Exit** to close the dialog.
Moving an Analyzer from one PC to another PC

You can move an analyzer, along with its status and calibration files, from one computer (Source PC) to another computer (Destination PC).

This operation does not move sample or parameter files. To move these files, use a file management program such as Explorer or a backup/restore utility.

1. Install the application program on the destination computer. Refer to Installing the Analysis Program on page 2-12.

   If the analysis program is already installed on the destination computer, proceed to Step 2.

2. Start the application setup program on the source computer. Refer to Using the Setup Program for Other Functions on page 2-15.

3. In the Setup dialog, select Move an analyzer from one PC to another PC, then click Next; the Move analyzer operation dialog is displayed.

   The Move analyzer operation is done following these steps:

   1. Install the analyzer software on the Destination PC if it is not already installed there. If the Destination PC already has the maximum number of analyzers a move cannot be done.

   2. Proceed with the Move operation on the Source PC - this will gather the necessary information and files to be moved to the Destination PC.

   3. Run the setup program on the Destination PC and select the Move operation.

   4. If you want to copy or move sample or parameter files you will have to do that using a file management program like Explorer or a backup/restore utility.

   Is this the Source PC or the Destination PC?

   - Source PC
   - Destination PC

   < Back  Next >  Cancel
4. Select **Source PC**, then click **Next**; the following dialog is displayed.

5. In the Step 1 group box, select the analyzer that is to be moved.

6. In the Step 2 group box, choose a location in which the moved files will be stored.

7. Click **Next**; the files are moved and the setup Welcome screen is displayed.

8. Start the application setup program on the destination computer.

9. In the Setup dialog, select **Move an analyzer from one PC to another PC**; the Move analyzer operation dialog is displayed (shown on previous page).
10. Select **Destination PC**, then click **Next**; the following dialog is displayed.

![Move analyzer information to this PC dialog]

11. In the Step 1 group box, enter the serial number of the analyzer being moved and the communications port to which it will be attached.

12. In the Step 2 group box, click **Browse** and choose the location of the moved files.

13. Click **Finish**; the files are moved and the setup Welcome dialog is displayed.
Removing an Analyzer

You can remove an analyzer from the computer as follows. When you remove an analyzer, the status files are removed as well.

1. Start the Setup program. Refer to Using the Setup Program for Other Functions on page 2-15.

2. From the Setup dialog, select Remove an analyzer, then click Next; the Remove an analyzer dialog is displayed.

3. From the drop-down list, choose the serial number of the analyzer you want to remove.

4. Click Remove; the analyzer is removed and the Welcome screen is again displayed.

5. Click Exit to close the dialog.
Changing an Analyzer Setup

Change the analyzer setup as follows:

1. Start the Setup program. Refer to Using the Setup Program for Other Functions on page 2-15.

2. From the Setup dialog, select Change analyzer setup, then click Next; the Change analyzer setup dialog is displayed.

3. From the drop-down list, choose the analyzer you want to change.

4. Enter the new port number in the space provided.

5. Click Finish; the change is completed and the Welcome dialog is again displayed.

6. Click Exit to close the dialog.
Reinstalling the Calibration Files

You can reinstall the files containing an analyzer’s factory calibration data as follows:

1. Start the Setup program.

2. From the Setup dialog, select **Re-install calibration files for an analyzer**, then click **Next**; the Re-install calibration files dialog is displayed.

<table>
<thead>
<tr>
<th>If ....</th>
<th>Then ....</th>
</tr>
</thead>
<tbody>
<tr>
<td>you have only one analyzer installed</td>
<td>the calibration files are installed and the Welcome screen is displayed.</td>
</tr>
<tr>
<td>you have multiple analyzers installed, a dialog enabling you to choose the desired analyzer is displayed.</td>
<td>select the appropriate analyzer, then click <strong>Next</strong>; the calibration files are installed and the Welcome screen is displayed.</td>
</tr>
</tbody>
</table>
Uninstalling the Analysis Program

When you uninstall the ASAP 2020 analysis program, the application removes the analysis program, status files, analyzer setup files, and resulting empty directories. It does not remove data files. Perform the following steps to uninstall the program:

1. Start the Setup program. From the Setup dialog, select **Uninstall**, then click **Next**; the Uninstall dialog is displayed.

2. Click **Uninstall**; the Select Uninstall Method dialog is displayed.
3. Choose one of the following:

**Automatic**: click **Next**; the system uninstalls the analysis program automatically and the setup Welcome dialog redispays.

**Custom**: click **Next**; a series of dialogs is displayed, allowing you to choose the files you wish to uninstall. After all files are selected and uninstalled, the setup Welcome dialog redisplays.

4. Click **Exit** to close the Welcome dialog.

### Specifying Gas Ports

After all desired gases have been attached to the analyzer, perform the following steps to specify gas ports:

1. Select **Unit > Unit Configuration**; the Unit Configuration dialog is displayed.

2. Click **Gas**; the Gas Configuration dialog box is displayed.

3. Click on the down-arrow at each field for the ports to which gases are attached and choose the appropriate gas.
Gases may be added to the drop-down list using the Adsorptive Properties dialog. Refer to Adsorptive Properties on page 4-13.

4. Click **OK** to close the dialog box, and then again to close the Unit Configuration dialog.
3. USER INTERFACE

This chapter contains information to familiarize you with the hardware and software of the ASAP 2020 system. It is recommended that you read this chapter before attempting to operate the ASAP 2020 system.

Controls, Indicators, and Connectors

This section contains a description of the controls, indicators, and connectors located on the front, side, and rear panels of the ASAP 2020 system.

Front Panel

Green indicator light   Illuminated when power is applied to the analyzer.
Vacuum pump panel

Allows access to the vacuum pumps. Remove this panel when you need to service the pumps.

It is not necessary to remove the panel to inspect the condition of the oil or the oil level (oil-sealed forepump). To accomplish either of these tasks, remove (or fold over to the right) the protective rubber mat from the work surface and lift off the metal cover; this exposes the vacuum pump sight window.

Vacuum pump sight window

The vacuum pump sight windows enable you to inspect the oil levels in the degas and analysis pumps.

Vacuum pump drain

Provides a convenient method of draining fluid from the pump when service is required.

High vacuum pump

A high vacuum pump is used on all but the basic nitrogen instrument. A second high vacuum pump is installed as an option on the degas system.

Connections, as well as an on/off (breaker) switch, are located on the front right side of the analyzer beneath the work surface. Remove (or fold over to the left) the rubber mat from the work surface and lift off the metal cover.

Indicator lights (located on the underside of the upper extension of the front panel) illuminate when the high vacuum pump is operating. Left light = degas; right light = analysis.

Elevator

Allows placement of the Dewar around the sample tube.
The components listed here are located on the underside of the upper extension of the front panel.

**Degas ports**
Allow you to degas up to two samples. Each degassing port has connections for a heating mantle.

**Heating mantle thermocouple**
Allows connection of a heating mantle thermocouple (one for each degas port).

**Heating mantle power connector**
Allows connection of the heating mantle power cord (one for each heating mantle).

**Heating mantle breaker**
Protects the circuitry for the heating mantle in the event of a failure (one for each heating mantle). If the circuit breaker trips (pops out), call your Micromeritics service representative.

**Cold Traps**
Two cold traps are provided; one for degassing and one for analysis.
**High vacuum pump indicators**

Illuminate when the high vacuum pumps are operating at normal speed. The left indicator is for degas operations and the right one for analysis.

**Sample port**

For installing the sample tube containing the material you wish to analyze.

**Po port**

For installing a Po (saturation pressure) tube when performing physisorption analyses.

**Side Panel**

**Upper**

- **Chemisorption Ports**
  (available if upgraded to Chemisorption capability)
- **Gas Inlet Ports**
- **Vapor Gas Port**
- **Degas Backfill Port**
- **Freespace Helium Port**

**Gas inlet ports**

Used to connect gas supplies to the analyzer.

**Vapor gas port**

For attaching the water vapor option, or connecting a vapor gas. Refer to “ORDERING INFORMATION” on page 10-1 for the part number of the water vapor option.

**Degas Backfill port**

Allows connection of a gas to use for degassing the sample.

**Freespace Helium port**

Allows connection of helium to use for measuring the free space.
Lower

On/Off switch: For turning the analyzer on and off. This switch also serves as the main breaker for the analyzer; it switches off automatically in the event of an electrical fault.

Power connector: For connecting the analyzer to the electrical supply.

RS232 port: For connecting the analyzer to a computer.

Valve circuit breaker: Protects the circuitry for the valves in the event of a failure. If the circuit breaker trips (pops out), call your Micromeritics service representative.

Voltage selector switch: For setting the analyzer to the correct incoming AC line voltage.
Rear Panel

Vacuum pump recess

Provides for placement of the vacuum pumps. Vacuum pumps can be serviced from the front of the instrument by removing the vacuum pump panel located on the lower left side of the front panel (see Front Panel described previously).
Using the Software

The analysis program operates in the Windows environment and requires familiarity with standard Windows operations such as using the mouse, menus, and dialog boxes. While this manual provides brief instructions for such standard operations, you may have to refer to your Windows documentation or to its online help system to clarify functions which are specific to Windows.

Shortcut Menus

Shortcut menus (sometimes referred to as context-sensitive menus or pop-up menus) are available for certain components on the instrument schematic when in manual mode, and for onscreen graphs and tabular reports. These menus are accessed by selecting the item for which you wish to display its menu and clicking the right mouse button. For example, right-click in a column of an onscreen report and the following menu is displayed.

Shortcut Keys

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations (if assigned) are listed to the right of the menu item. Instead of opening the menu and choosing the command, simply press the key combination. For example, to open a sample information file, press F2; the Open Sample Information dialog is displayed.

You can also use shortcut keys to access a menu or any function that contains an underlined letter by pressing Alt plus the underlined letter in the command. For example, to access the File menu, press Alt, then F.

Table 3-1 provides a list of the keys available in the ASAP 2020 analysis program.
### Table 3-1. Shortcut Keys

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Access online operator’s manual</td>
</tr>
<tr>
<td>F2</td>
<td>Open a sample information file</td>
</tr>
<tr>
<td></td>
<td>Clear the field of existing date (Select Dates dialog)</td>
</tr>
<tr>
<td>F3</td>
<td>Open an analysis conditions file</td>
</tr>
<tr>
<td></td>
<td>Insert the current date (Select Dates dialog)</td>
</tr>
<tr>
<td>F4</td>
<td>Open an adsorptive properties file</td>
</tr>
<tr>
<td></td>
<td>Display a calendar from which to choose a date (Select Dates dialog)</td>
</tr>
<tr>
<td>F5</td>
<td>Open a report options file</td>
</tr>
<tr>
<td>F6</td>
<td>Tile open windows</td>
</tr>
<tr>
<td>F7</td>
<td>Cascade open windows</td>
</tr>
<tr>
<td>F8</td>
<td>Start report</td>
</tr>
<tr>
<td>F9</td>
<td>Close all open reports</td>
</tr>
<tr>
<td>Alt + F4</td>
<td>Exit the ASAP 2020 program</td>
</tr>
<tr>
<td>Shift + F2</td>
<td>List sample information files</td>
</tr>
<tr>
<td>Shift + F3</td>
<td>List analysis conditions files</td>
</tr>
<tr>
<td>Shift + F4</td>
<td>List adsorptive properties files</td>
</tr>
<tr>
<td>Shift + F5</td>
<td>List report options files</td>
</tr>
<tr>
<td>Shift + F9</td>
<td>Access shortcut menu of (1) selected component on instrument schematic, or (2) onscreen reports</td>
</tr>
</tbody>
</table>
Dialog Boxes

Dialog boxes are displayed when a menu item followed by an ellipsis (…) is selected. Subdialog boxes are displayed when certain push buttons are selected. Both types of boxes may contain one or more of the items listed below.

The following describes elements that are often included in dialog boxes. If an element is shown in gray instead of black, the element is currently unavailable.

**Data Entry Fields**
A Data Entry field is used to enter text; either numeric (numbers only) or alphanumeric (numbers, letters, or printable characters).

If an invalid entry is made, an error message is displayed; for example, if you attempt to enter text in a numeric field or a number outside of the range shown in the information bar.

**Information Bar**
Some dialog boxes contain information pertinent to the selected field in an information bar across the bottom of the dialog. For example, a range is shown for fields in which numeric entries are required.

**Radio buttons**
Radio buttons are provided in groups of two or more and are used to make a choice; only one radio button can be selected. Simply click the desired option with your mouse pointer. A black dot indicates the item is selected.

**Check boxes**
Check boxes allow you to choose multiple options from a group of options. Click the desired options with your mouse pointer. An X in the box indicates the item is selected; remove the X in the same manner.
<table>
<thead>
<tr>
<th><strong>Push Buttons</strong></th>
<th>A push button is used to display a subdialog box in which to enter additional information about the subject matter, or to invoke an action. For example, if you click <strong>Date Range</strong> on the Open Sample Information dialog box, the Select Dates subdialog box is displayed. If you click <strong>Cancel</strong> on the Open Sample Information dialog box, you invoke the action of canceling and closing the dialog box.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Close</strong></td>
<td>Closes the active dialog. If the dialog box contains unsaved changes, you will be prompted to save them before the dialog box closes. Any information entered in subdialog boxes (refer to the next section of this chapter), is discarded also.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Saves the information entered in the current session; the dialog box remains open.</td>
</tr>
<tr>
<td><strong>Replace</strong></td>
<td>Allows you to replace the contents of the current file with those from an existing file. For example, if you are creating an analysis conditions file, you can save time by clicking and choosing the file containing the values you wish to use. These values are copied into the current file automatically. And since the values are actually just copied into the file, you can edit them in any way you wish. The file from which they were copied remains intact and ready for the next use.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Discards everything you entered in the dialog box and any subdialog boxes, and closes the dialog box. A warning message is displayed before closing.</td>
</tr>
<tr>
<td><strong>Drop-down list</strong></td>
<td>A drop-down list contains a list of options and is indicated by a down arrow to the right of the field. If there are more items than can fit in the box, a scroll bar is provided for navigating through the list.</td>
</tr>
</tbody>
</table>
Selecting Files

Sample information is stored in files and saved under file names. Certain dialog boxes contain a **Files** list box which displays a list of files available for that particular operation. For example, the Open Sample Information File dialog.

A default string appears in the **File name** field. To select a file, simply move the mouse pointer to the desired file in the list and double-click.

You can limit the list of files displayed by choosing one or more of the following options:

- Use wildcard characters in the path name entered in the **File name** field. Standard and wildcard characters (such as * and ?) can be used to filter file names. For example, you could limit the list of files shown in the dialog above to those beginning with 13x by entering 13x*.SMP in the file name field.

- Enter a range of dates. Click **Date Range**; the Select Dates dialog is displayed.

Select **Show Date Range** to enable the **From** and **To** fields, then enter a beginning and ending date. Or you can double-click in each field to display a calendar to select a date. The range of dates remains the default until you change the dates or select **Show All Dates**.
For convenience, the following shortcut keys are available when the Select Dates dialog is displayed:

- **F2** Clears the date
- **F3** Inserts the current date
- **F4** Displays a calendar from which you may select a date

- Select a file status from the **Status** drop-down list. For example, choose **Complete** from the drop-down list and only files that have been used in an analysis are displayed. The table shown below describes each file status.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>All sample information files in the specified directory and within the specified range of dates</td>
</tr>
<tr>
<td>Analyzing</td>
<td>Sample information files that are currently being used with an analysis</td>
</tr>
<tr>
<td>Complete</td>
<td>Sample information files that have been used with an analysis</td>
</tr>
<tr>
<td>Entered</td>
<td>Sample information files that contain manually entered data</td>
</tr>
<tr>
<td>No analysis</td>
<td>Sample information files that have not been used in a degassing operation or an analysis</td>
</tr>
<tr>
<td>Prepared</td>
<td>Sample information files that have been used in an automatic degassing operation and are ready for analysis</td>
</tr>
<tr>
<td>Preparing</td>
<td>Sample information files that are currently being used in an automatic degassing operation</td>
</tr>
</tbody>
</table>

The **Status** drop-down list does not appear on the File, Open dialogs for parameter files.

- Navigate to a different directory. The current directory is displayed just above the **Directories** list box. You can change directories by double-clicking a directory in the **Directories** list box, double-clicking `[..]` to move up one level, or by entering the desired directory in the **File Name** field. For example, enter `C:\2020files\sample\*.smp` to display sample files in the `2020files\sample` directory on your local drive.
File Name Conventions

For sample information and parameter files, a wildcard character (*) and a default extension display.

The following table shows the file name extensions for the ASAP 2020 program.

Table 3-3. Default File Name Extensions

<table>
<thead>
<tr>
<th>File Type</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Information</td>
<td>SMP</td>
</tr>
<tr>
<td>Sample Tube</td>
<td>STB</td>
</tr>
<tr>
<td>Degas Conditions</td>
<td>DEG</td>
</tr>
<tr>
<td>Analysis Conditions</td>
<td>ANC</td>
</tr>
<tr>
<td>Report Options</td>
<td>RPO</td>
</tr>
<tr>
<td>Adsorptive Properties</td>
<td>ADP</td>
</tr>
<tr>
<td>Export to disk (ASCII)</td>
<td>ISO</td>
</tr>
<tr>
<td>Sample information files from the ASAP 2000 analyzers; may be converted to an ASAP 2020-compatible format</td>
<td>DAT</td>
</tr>
<tr>
<td>Report to disk</td>
<td>RPT</td>
</tr>
<tr>
<td>List to disk</td>
<td>LST</td>
</tr>
<tr>
<td>Thickness curve</td>
<td>THK</td>
</tr>
<tr>
<td>Alpha-s curve</td>
<td>ALS</td>
</tr>
<tr>
<td>The following types are available for reports saved from the Report window</td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td>REP</td>
</tr>
<tr>
<td>Spreadsheet</td>
<td>XLS</td>
</tr>
<tr>
<td>ASCII</td>
<td>TXT</td>
</tr>
</tbody>
</table>
Menu Structure

All functions for the ASAP 2020 are located on menus which are accessed from the Menu bar. Each menu contains commands, and in some cases a submenu. A submenu is indicated when the command is followed by an arrow.

Brief descriptions of each menu are provided below; refer to the chapter given in parentheses for a detailed description of the commands contained on that menu.

**File**
Enables you to maintain system files. (Chapter 5, **FILE MENU**)

**Unit [n]**
Enables you to perform analyses and other instrument operations. (Chapter 6, **UNIT MENU**)

**Reports**
Enables you to generate, customize, and close reports. Also provides examples of reports. (Chapter 7, **REPORTS MENU**)

**Options**
Enables you select data presentation formats, and enter system default values. (Chapter 8, **OPTIONS MENU**)

**Windows**
Enables you to arrange the windows and icons on your screen. It also displays the names of all open files. (this chapter, page **3-15**)

**Help**
Displays Help information. (this chapter, page **3-15**
**Windows Menu**

<table>
<thead>
<tr>
<th>Windows</th>
<th>F8</th>
<th>F7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tile</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cascade</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arrange Icons</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. C:DEMO020\DATA\3X_AR_SMP
2. C:DEMO020\PARAMS\13VARLARLANC

**Tile**
Resizes all open windows and arranges them side by side so that the contents of all open windows are visible.

**Cascade**
Resizes all open windows and arranges them in a stacked fashion. The active window is positioned on top of the stack. Each window’s title remains visible, making it easy to select other windows.

**Arrange Icons**
Arranges the symbols for all minimized windows in an orderly manner.

**Open Files**
Displays all open files; the active window is preceded with a check mark.

**Help Menu**

<table>
<thead>
<tr>
<th>Help</th>
<th>F1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator’s Manual...</td>
<td></td>
</tr>
<tr>
<td>Micromeritics on the Web...</td>
<td></td>
</tr>
<tr>
<td>About ASAP 2020...</td>
<td></td>
</tr>
</tbody>
</table>

**Operator’s Manual**
Displays the operator’s manual in PDF format.

**Micromeritics on the Web**
Accesses the Micromeritics Web site.

**About ASAP 2020**
Displays information about the ASAP 2020 analysis program.
4. OPERATIONAL PROCEDURES

This chapter contains brief step-by-step instructions on how to:

- specify sample file defaults, this page
- create sample information files, page 4-6
- define parameter files, page 4-9
- prepare the sample, page 4-16
- perform an analysis, page 4-29
- generate a list of information on a sample or parameter file, page 4-32
- print contents of a sample or parameter file, page 4-31
- export data in a sample information file to an ASCII file, page 4-33
- overlay graphs, page 4-34

This chapter does not contain detailed descriptions of the dialogs used to perform these procedures. Refer to Chapters 5 through 8 for dialog descriptions. Use the index to assist you in locating the appropriate dialog.

Specifying Sample File Defaults

You can specify sample defaults in the Basic or Advanced format. The defaults you specify are the ones you see when you create a new sample file in the respective format. Therefore, it is best to specify (or enter) parameters that you plan to use most frequently. For example; specify defaults for your most commonly analyzed sample material. You can always edit parameters in the sample file when it is created. The ASAP 2020 system automatically generates sample information file names and uses the values you specify as the defaults.
Basic Format

Perform the following steps to define defaults for a sample information file in the Basic format.

Select Option Presentation on the Options menu and ensure that Basic is selected as the format.

1. Select Options > Sample Defaults; the default Basic Sample Information dialog is displayed.

2. In the Sequence field, specify a default string. This is the number that is incrementally sequenced and displays in the File name field when you select File, Open, Sample information. You can use up to eight characters.

3. In the field on the right of the Sample line, enter a format for the sample identification. Be sure to include the $ symbol if you want the sample file number included as part of the identification. You can use up to 42 alphanumeric characters.

You also can edit the word Sample. For example, you may prefer to use Material or Test. You can enter up to 15 characters in this field.
4. You can enter a sample mass or have it calculated automatically; choose the desired method.
   
   • **Enter**: enter a default value in the Mass field.
   
   • **Calculate**: enter default values in the Empty tube and Sample+tube fields

Regardless of which method you choose, the choice can be changed when you create a sample file.

5. The sample density is used when free space is calculated; enter a default for your sample’s density if you typically use a calculated free space. Otherwise, this value is ignored.

6. Select the down arrow to the right of the parameter fields to choose default parameter files:

   • Sample tube
   • Degas conditions
   • Analysis conditions
   • Adsorptive properties
   • Report options

7. Click **Save**, then **Close**.
Advanced Format

The Advanced Sample Defaults dialog resembles a set of index cards. You can move from one set of parameters to another by clicking the parameter tab or by using Next and Prev. The values you specify in the parameter portions of the sample file (Analysis Conditions, Degas Conditions, Adsorptive Properties, and Report Options) are saved as the defaults for newly created parameter files.

For example, after specifying defaults for a sample file in the Advanced format:

- Select File > Open > Sample Information, Yes to create the file, and the defaults you specify display for all parameters.

- Select File > Open > Analysis Conditions, enter a name, then Yes to create the file, and the defaults you specify in the Analysis Conditions portion of the Advanced Sample Defaults dialog display in the fields.

Select Option Presentation on the Options menu and ensure that Advanced is selected as the format.

1. Select Options > Sample Defaults, the default Advanced Sample Defaults dialog is displayed.
2. In the **Sequence** field, specify a default string for the sample file number; you can use up to eight characters. This is the number that appears in the File name field when you select **File > Open > Sample information**.

3. In the right-side field of the **Sample** line, enter a format for the sample’s identification. You can enter up to 42 characters. Be sure to include the $ symbol if you want the sample file number (**Sequence**) included as part of the identification.

4. Edit the **Operator** and **Submitter** lines as desired. Or have them omitted entirely by selecting **Omit**.

5. If bar code information is not applicable, select **Omit** to omit this field from the sample information dialog. Or, if you prefer to use this line for some other type of information, edit the label.

6. You can enter a sample mass or have it calculated automatically; choose the desired method.
   - **Enter**: enter a default value in the **Mass** field.
   - **Calculate**: enter default values in the **Empty tube** and **Sample+tube** fields

   Regardless of which method you choose, the choice can be changed when you create a sample file.

7. If you plan to use a calculated free space, enter the sample’s density in the **Density** field.

8. Choose whether you wish to have data collected automatically or if you plan to enter the data. This option can be changed (if desired) before the analysis.

9. If you plan to report statistical process control (SPC) information, enter appropriate information. These are user-definable parameters that can be entered and tracked along with other statistical process control data; refer to **Sample Defaults**, page 8-4 for additional information on these parameters.

10. Click the **Sample Tube** tab. Enter criteria for the sample tube you most commonly use, then click **Save**.

    **You can click Save on each dialog as you specify parameters, or you can click Save on any dialog after all parameters have been specified. All dialog defaults will be saved.**

11. Click the **Analysis Conditions** tab. Choose the analysis conditions appropriate for your most commonly analyzed material, then click **Save**.

12. Click the **Degas Conditions** tab. Specify degassing criteria, then click **Save**.

13. Click the **Adsorptive Properties** tab. Specify gas characteristics, then click **Save**.
14. Click the **Report Options** tab. Choose desired reports, using **Edit** to specify details; then click **Save**.

15. Click **Close** to close the dialog.

**Creating Sample Information Files**

A sample information file must be assigned to every sample that is analyzed. When you create a sample file, you can accept the default values specified using Sample Defaults, or you can edit them as desired. You can create a sample information file using the Advanced, Basic, or Restricted format.

**Advanced Format**

The Advanced format allows you to customize the parameters of a sample information file. Chapter 5 provides a description of the fields associated with creating sample information files.

1. Select **File > Open > Sample information**; the Open Sample Information File dialog is displayed.

2. Accept the next sequenced file number or enter a new name in the **File name** field.

3. Click **OK**, then **Yes** to create the file; the Sample Information dialog is displayed.

![Sample Information Dialog](image)

The defaults that appear in the fields are the ones specified in **Sample Defaults**.
4. Accept the default identification in the Sample field or change it to an appropriate one. The dialog box above shows the sample file number because the dollar ($) symbol was used when specifying sample defaults.

If a sample information file already exists containing the values you want to use in this file, you can click Replace all to copy those values into this one. You can still edit the values after they are loaded.

5. Edit the Operator, Submitter and/or Bar Code fields as needed. If these fields are not displayed, they were selected to be omitted in Sample Defaults.

6. Select Enter to enter a value for the sample’s mass (if different from the default value), or Calculate to have the mass calculated automatically. If you select Calculate, you must enter weights for the Empty tube and the Tube + sample.

7. Enter a value in the Density field (or accept the default). This value is applicable only when using a calculated free space.

8. Choose whether you want data automatically collected by the system or whether you wish to enter the data.

9. Unless you are gathering statistical process control information, it is unnecessary to enter parameter values. These are user-definable parameters that can be entered and tracked along with other statistical process control data; refer to Sample Defaults, page 8–4 for information on user parameters.

Use the Comments window to record specifics of the analysis or its conditions. Anything you enter in this window is displayed in the report header.

10. Click Save to save the information you entered.

11. The steps for completing the remaining parameters of the sample information file are explained in subsequent sections:

   • Specifying Sample Tube Criteria
   • Defining Degas Conditions
   • Defining Analysis Conditions
   • Defining Adsorptive Properties
   • Defining Report Options

   Simply click on the tabs to open the associated dialog.
Basic and Restricted Formats

Sample information files are created in the Basic and Restricted formats using predefined parameter files. Chapter 5 provides a description of the fields associated with creating sample information files.

1. Select **File > Open > Sample information**; the Open Sample Information File dialog is displayed.

   ![Sample Information Dialog]

   Use this push button to copy parameters from an existing file into the current file.

   Not displayed on the Restricted dialog.

2. Accept the next sequenced file number or enter a new name in the **File name** field.

3. Click **OK**, then **Yes** to create the file; the Sample Information dialog is displayed. The defaults that appear in the fields are the ones specified in **Sample Defaults**.

4. Accept the default identification or change it to an appropriate one.

5. Select **Enter** to enter a value for the sample’s mass (if different from the default value), or **Calculate** to have the mass calculated automatically. If you select **Calculate**, you must enter weights for the **Empty tube** and the **Tube + sample**.

6. Enter a value in the Density field (or accept the default). This value is applicable only when using a calculated free space.
7. Using the down arrows to the right of each parameter field, select an appropriate file (or accept the defaults). You can review or edit the contents of these files by switching to the Advanced format if desired.

If you are using the Restricted format, you cannot switch to the Advanced format.

8. Click **Save**, then **Close**.

### Defining Parameter Files

The following file types can exist as part of the sample information file or as an individual parameter file:

- Sample tube
- Degas conditions
- Analysis conditions
- Adsorptive properties
- Report options

Having these files exist independently allows you to use them over and over again. Several predefined parameter files (located in the params directory) are included with the ASAP 2020 analysis program. Although these files may come close to the needs of your laboratory, you may wish to define additional ones. Or you can use a predefined file as a starting point. This is easily accomplished by creating a new file and then selecting **Replace**. A dialog is displayed so that you can select the existing file containing the values you wish to use. After the values are copied into the current file, you can edit the values as desired; the original file remains intact and ready for the next use.

If you wish to have parameter files display in the drop-down list on the Basic Sample Information dialog, be sure to save them to the directory specified as the Parameter Files Directory. (Refer to **Parameter Files Directory** on page 8-13 for additional information.)

### Sample Tube

1. Select **File > Open > Sample Tube**; the Sample tube dialog is displayed.

2. Enter a name in the **File name** field, then click **OK**.

Be sure the directory specified is the Parameter files directory if you wish to have it display in the drop-down list in the Basic Sample Information dialog. (Refer to **Parameter Files Directory** on page 8-13 for additional information.)
3. Click **Yes** to create the file; the Sample Tube dialog is displayed.

![Sample Tube dialog](image)

4. Enter a description in the **Sample Tube** field. Be sure to use an intuitive description so that you can recognize it easily.

5. Click **Load from Sample File**; the Open Sample Information File dialog is displayed.

6. Select the file you used in the blank run with this sample tube, then click **Open** to copy the warm and cold free space values into the Sample Tube dialog.

7. If a vacuum seal of some type was used, select the appropriate option or leave the default of **None** selected.

8. Click **Save**, then **Close**.

**Degas Conditions**

Degas Conditions files contain degassing information for preparing samples. These files are appropriate only if your ASAP 2020 analyzer is equipped with the SmartVac degassing system.

Perform the following steps to define a degas conditions file:

1. Select **File > Open > Degas Conditions**; the Degas Conditions dialog is displayed.

2. Enter a name in the **File name** field, then click **OK**.

Be sure the directory specified is the Parameter files directory if you wish to have it display in the drop-down list in the Basic Sample Information dialog. (Refer to Parameter Files Directory on page 8-13 for additional information.)
3. Click **Yes** to create the file; the Degas Conditions dialog is displayed.

![Degas Conditions Dialog]

4. Enter a description in the **Description** field. Be sure to use an intuitive description so that you can recognize it easily.

5. Specify values for the evacuation and heating phases for degassing the sample.

6. Click **Save**, then **Close**.

### Analysis Conditions

Analysis conditions specify the data used to guide an analysis. An analysis conditions file may be assigned a unique name, and you can direct any sample to be analyzed according to the conditions in any existing analysis conditions file. Chapter 5 provides a detailed description of the fields on this dialog.

1. Select **File > Open > Analysis Conditions**; the Open Analysis Conditions File dialog is displayed.

2. Enter a name (up to eight characters) in the **File name** field, then click **OK**.

---

Be sure the directory specified is the Parameter files directory if you wish to have it display in the drop-down list in the Basic Sample Information dialog. (Refer to Parameter Files Directory on page 8-13 for additional information.)
3. Click **Yes** to create the file; the Analysis Conditions dialog is displayed.

4. Enter a description (up to 42 characters) in the **Description** field. Use an intuitive description, one that will help you identify the type of sample you plan to analyze using these analysis conditions.

5. Specify points for your pressure table. Use the push buttons adjacent to the table to assist you in creating your table.

6. Click **Preparation** to specify evacuation and leak test values.

7. Click **Free Space** to specify how the free space is to be measured.

8. Click **Po and T** to specify how the saturation pressure (Po) is to be measured, and the analysis bath temperature. If you select **Absolute pressure dosing**, options 1 through 5 are disabled. The Po will be calculated using the analysis bath temperature; enter the appropriate temperature in the field provided.

9. Click **Dosing** to specify dosing options.

10. Click **Equilibration** to specify the equilibration interval and its delay time.

11. Click **Backfill** to specify backfill options.

12. If you wish to use absolute dosing, click the **Absolute pressure dosing** option.

13. Click **Save**, then **Close**.
Adsorptive Properties

Adsorptive properties specify the characteristics of the gases used in the ASAP 2020 System. Chapter 5 provides a detailed description of the fields on this dialog.

1. Select File > Open > Adsorptive properties; the Open Adsorptive Properties File dialog box is displayed.

2. Enter a name (up to eight characters) in the File name field, then click OK.

Be sure the directory specified is the Parameter files directory if you wish to have it display in the drop-down list in the Basic Sample Information dialog. (Refer to Parameter Files Directory on page 8-13 for additional information.)

3. Click Yes to create the file; the Adsorptive Properties dialog is displayed.

4. Enter the name of the adsorptive gas in the Adsorptive field, then enter its mnemonic.

5. Click Psat vs T to edit the Psat vs Temperature table. Edit any other field(s) on this dialog as required, then click OK.

6. Select Non-condensing Adsorptive if the gas is non-condensing.

7. Enter the appropriate information (or accept the defaults) in the following fields.

   Maximum manifold pressure
   Density conversion factor
   Therm. tran. hard-sphere diameter
   Molecular cross-sectional area

8. Choose your preferred dosing method; choose Normal for gases under pressure.
9. Click one of the following:

- **Real gas equation of state**, then use **Open** to select a table.

  Adsorbed molecules occupy volume in the sample tube reducing the cold free space. Select the **Adsorbed-phase free-space correction** box to adjust the reported quantity adsorbed to correct for this effect. This option is appropriate for all sample analyses that use the real gas equation of state. It should be deselected for blank tube analyses.

- **Ideal gas law with non-ideality correction**, then enter a Non-ideality factor.

---

**Report Options**

Report options specify the types of reports to be generated from an analysis or manually entered data. They also help you customize details of reports such as axis scale, axis range, column headings, and components of thickness curve equations.

You can tailor report options files to accommodate the requirements of your analyses. For example, you can generate a simple report that lets you determine the basic characteristics of the sample. Then use that report to make choices about the variables you want to include in lengthier, more sophisticated reports. You can specify for reports to be generated automatically after each analysis, or you can generate reports at any time during or after an analysis. However, a report generated during an analysis only includes data collected up to the time of the report. Chapter 5 provides a detailed description of the fields on this dialog.

Define report options as follows:

1. Select **File > Open > Report Options**; the Open Report Options File dialog is displayed.

2. Enter a name (up to eight characters) in the **File name** field, then click **OK**.

Be sure the directory specified is the Parameter files directory if you wish to have it display in the drop-down list in the Basic Sample Information dialog. (Refer to Parameter Files Directory on page 8-13 for additional information.)
3. Click **Yes** to create the file; the Report Options dialog is displayed.

![Report Options dialog](image.png)

4. Enter a description (up to 42 characters) in the **Description** field. Enter an identifier that gives a more intuitive description of the file’s contents. For example, **BJH Adsorption Report Options**.

5. Select **Show report title** and enter the title you wish to appear at the top of the report. Or deselect this option if you prefer not to have a report title.

   **If your company logo exists as a bitmap (bmp) or enhanced metafile (emf), you can have it display in the report header by selecting **Show graphic**. Click **Browse** to select the file; use the **Height** and **Width** fields to specify the size.**

6. If you wish to compare the same type of graph from multiple files, click **Overlays** and choose the files. Then be sure you edit the graph from the Selected Reports window and choose **Samples** from the Overlay drop-down list.

7. Select **Thermal transpiration correction** if you want correction made for thermal transpiration in the sample tube, then enter the inside diameter of the sample tube.

8. The reports that may be generated are listed in the Selected Reports list. Select reports by double-clicking on the desired report. Reports are deselected in the same manner. A report is selected when it is preceded by a check mark.

9. You can edit some reports by highlighting the desired report and clicking **Edit**.

10. Click **Save**, then **Close** to save the information and close the dialog.
Preparing Samples

Care should be taken in choosing, conditioning, and filling sample tubes. The following guidelines help ensure accurate, reproducible results.

Choosing Sample Tubes

A sample tube set consists of the following parts:

- Sample tube
- Stopper or seal frit
- Filler rod

Standard sample tubes for the ASAP 2020 degas and analysis stations have a 1.27-cm (1/2-in.) outside diameter (OD). Two other sizes are available: 0.64 cm and 0.95 cm (1/4 in. and 3/8 in.) OD. Stepped ferrules, smaller O-rings, isothermal jackets, and filler rods are available for adapting the smaller stems to the degas or analysis ports (refer to Ordering Information on page 10-1 for part numbers). The stem diameter selected for use is a matter of accuracy and precision requirements, as well as personal preference and convenience in loading the sample.

A rubber stopper may be used with all size sample tubes; however, seal frits are recommended for 1.27-cm (1/2-in.) OD sample tubes (refer to Ordering Information on page 10-1 for part numbers).

Filler rods help to ensure accuracy in samples with lower total surface areas by reducing the free-space volume. It is generally a good practice to use filler rods for samples having less than 100 square meters of total surface area. Filler rods are unnecessary for samples with total surface areas greater than 100 square meters.

**Filler rods can interfere with thermal transpiration correction and, therefore, should not be used when performing micropore analyses.**

The weight of the empty sample tube should be determined after it has been cleaned (refer to Cleaning and Labeling Sample Tubes, page 4-17), degassed, and filled with backfill gas. The sample tube should be allowed to cool to room temperature before backfilling. After the sample tube has cooled, remove it from the degas port and weigh it.

**If a seal frit is not used, insert a stopper immediately after removing the sample from the degas port.**

The weight of the isothermal jacket may vary slightly and cannot be considered as constant; therefore, do not weigh it with the sample tube set.
Cleaning and Labeling Sample Tubes

Sample tubes and filler rods must be clean and dry before samples are added and weighed. The following procedures are recommended. Refer to the following table for a list of materials needed to clean and weigh samples properly.

**Table 4-1: Materials Required to Clean and Weigh Sample Tubes**

<table>
<thead>
<tr>
<th>Supplied by Micromeritics</th>
<th>Supplied by User</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample tube</td>
<td>Drying oven</td>
</tr>
<tr>
<td>Quartz wool</td>
<td>Ultrasonic cleaning unit</td>
</tr>
<tr>
<td>Sample tube brush</td>
<td>Alconox Rubber gloves or lint-free cloth</td>
</tr>
<tr>
<td>Stoppers for sample tube</td>
<td>Acetone or isopropyl alcohol</td>
</tr>
<tr>
<td>Sample tube rack</td>
<td>Cryogen for the cold trap Dewar</td>
</tr>
<tr>
<td>Sample weighing support</td>
<td>Safety glasses</td>
</tr>
<tr>
<td>Cloth gloves</td>
<td>Forceps</td>
</tr>
<tr>
<td>Reference material</td>
<td>Insulating gloves</td>
</tr>
<tr>
<td>Funnel</td>
<td>Waste container</td>
</tr>
<tr>
<td>Sample data worksheet</td>
<td>Balance</td>
</tr>
<tr>
<td>(copied from Appendix A of this manual)</td>
<td>Pipe cleaners</td>
</tr>
</tbody>
</table>

1. Turn on the drying oven used for heating the sample tubes and filler rods and set the temperature to 110 °C.

2. Check the reservoir of the ultrasonic cleaning unit to make sure it is clean.

3. Using 5 grams of Alconox (or other suitable detergent) per 500 mL of warm water, fill the reservoir of the ultrasonic unit with enough water to cover the sample tubes and filler rods. Make sure the detergent is dissolved before placing the sample tubes and filler rods into the water. If too much detergent is used, it may be difficult to rinse from the sample tubes.

4. Fill the sample tubes with warm water and place them in the reservoir of the ultrasonic cleaning unit. Place the filler rods in the bowl also. Turn on the ultrasonic cleaning unit for approximately fifteen minutes.
5. Using rubber gloves, remove the sample tubes and filler rods from the reservoir.

6. Clean the interior of the sample tubes with the brush supplied with the ASAP 2020 System.

7. Rinse the sample tubes and filler rods thoroughly with hot water. Then rinse them with isopropyl alcohol or acetone using a waste container to collect used solvent.

If isopropyl alcohol or acetone is not available, deionized water may be used to rinse the sample tubes.

8. Using nitrogen, dry the interior of the sample tubes and filler rods under a vent hood. Use a tubing extension long enough and small enough in diameter to fit inside the tubes.
9. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in the rack. Bake for two hours.

10. Remove the sample tubes from the oven and allow them to cool.

11. Using either rubber gloves or a lint-free cloth (but not bare hands), place a filler rod (if used) in each sample tube by holding the sample tube horizontally and sliding the filler rod into the sample tube slowly.

12. Wipe a rubber stopper (or seal frit, if used with 1.27-cm (1/2-in.) tubes) with a lint-free cloth.

| If helium is used as the degas backfill gas, seal frits are recommended. Refer to Ordering Information on page 10-1 or seal frit part numbers. |

13. Label the sample tube and stopper or seal frit for identification.

14. Fill the tube with the selected backfill gas; then insert the stopper or seal frit quickly to avoid releasing the gas.

| To obtain the accurate mass of a degassed sample, the gas in both the empty sample tube and in the tube with the sample must be the same. |
Determining Amount of Sample to Use

Clean, dry sample tubes are essential for accurate results. How much sample to use can be determined best by experiment. In general, a sample providing 40 to 120 square meters of total surface area is recommended for nitrogen analysis. Less than this may cause variability of results; considerably more than this extends unnecessarily the time required for analysis.

Smaller quantities are required for samples having high surface areas. These samples require careful weighing after degassing because a small error may represent a considerable percent of total weight. Proper weighing techniques are most important in this case. Use no less than 100 mg to reduce the effect of weighing errors.

Care should be taken when loading powders; the accessory funnel is useful for this purpose. Large granules or chunks may be loaded with forceps.

Avoid touching the sample with your fingers because oils may be transferred to the sample and can alter results or create degassing problems.

Determining the Mass of the Sample

Analysis results are expressed in units of surface area per gram of sample; therefore, the true mass of the sample must be known. Carefully weigh each sample tube set and sample as described below.

1. Write the Sample Tube number on the Sample Data Worksheet. (A Sample Data Worksheet, which you may copy, is included in Appendix A.)

2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize at zero (0).

3. Place the sample tube set (sample tube, stopper or seal frit, and filler rod, if used) on the sample support. Record the stabilized weight on the Sample Data Worksheet as Mass of empty sample tube. Remove the sample support and sample tube set from the balance.

4. Place a sample container onto the balance. Tare the balance and allow it to stabilize at zero (0).

Do not touch the sample or filler rod with bare hands while performing the next six steps. Doing so could affect the accuracy of results.

5. Slowly add the sample to the sample container.

6. Remove the rubber stopper or seal frit and filler rod from the sample tube.
7. Using a funnel, pour sample from the container into the sample tube.

If some sample clings to the inside of the sample tube above the last 3 in. (7.5 cm) of the tube, use a pipe cleaner or lint-free wipe to remove it.

8. Replace the filler rod and insert the rubber stopper or seal frit.

9. Weigh the sample tube set containing the sample and record the weight on the Sample Data Worksheet as Mass of sample tube plus sample (Before Degas).

10. Subtract the Mass of empty sample tube from the Mass of sample tube plus sample; record this value as the Mass of sample.
Degassing the Sample

Most solid materials absorb moisture and other contaminants when exposed to the atmosphere. The sample must be clean when an analysis is performed. The sample is heated and placed under vacuum to remove moisture and other contaminants. This process is referred to as degassing the sample. Degassing the sample is easy and virtually automatic if your ASAP 2020 analyzer is equipped with the SmartVac degassing system. The procedure is as follows:

1. While holding the degas port plug, remove the connector nut and plug from the degas port by turning the connector nut counterclockwise.

2. Place the degas port connector nut, ferrule, and O-ring onto the sample tube set as shown in the following figure.

*When using 1/4- or 3/8-in. sample tubes, the seal frit opener must be removed from the sample connector.*
3. Remove the rubber stopper from the sample tube and attach the sample tube set to the degas port. Be sure to push the sample tube in to a full stop. Secure the sample tube in place by sliding the connector nut, ferrule, and O-ring up to the degas port and turning the connector nut clockwise. Tighten the nut securely by hand.

4. Place a heating mantle over the bulb of the sample tube and secure the mantle in place with a mantle clip.

5. Insert the heating mantle thermocouple plug into the appropriate connector on the analyzer. Then insert the heating mantle power plug into the appropriate connector on the analyzer. Make sure both plugs are inserted completely.

6. Select **Start Degas** from the Unit menu; the Start Degas dialog is displayed.

![Automatic Degas (Unit 1 - 5/2010)](image)

7. Click **Browse** to the right of the **Sample field** to choose your degas file.

   Repeat this step if you are degassing two samples.

8. Click **Start** to begin the degassing operation.

   **Observe the status bar of the degassing operation to determine when degassing is complete.**

9. After degassing has completed, transfer the sample tube to the analysis port to start the analysis (next section).
Transferring the Degassed Sample to the Analysis Port

The sample tube must be removed from the degas port, weighed and then installed onto the analysis port for analysis.

If the sample tube is not mounted to the analysis port immediately, either leave it on the degas port or remove it and insert the rubber stopper (unless you are using a seal frit) into the sample tube opening.

1. Allow the sample tube to cool.

Do not touch the sample tube or the heating mantle until they have reached room temperature. Touching the sample tube, heating mantle, or heating mantle clip could result in burns.

2. Carefully remove the heating mantle clip and the heating mantle from the sample tube and allow the sample tube to cool to room temperature (approximately fifteen minutes).

3. While holding the sample tube, loosen the port connector nut and remove the sample tube from the degas port. If you are not using a seal frit, insert a stopper immediately. Remove the connector nut, ferrule, and O-ring from sample tube stem.

4. Weigh the sample tube set. Enter the weight on the Sample Data Worksheet as Mass of sample tube plus sample (After Degas).

5. Subtract the Mass of empty sample tube (Before Degas) from the Mass of sample tube plus sample (After Degas) to determine the mass of the sample. Record this value as the Mass of sample (After Degas).

6. Slide an isothermal jacket down over the sample tube stem until it touches the sample tube bulb.

7. Place the connector nut, ferrule, and O-ring onto the sample tube stem.

8. Remove the stopper and immediately attach the sample tube to the analysis port, pushing it fully up into the port. Secure it in place by screwing the connector nut onto the analysis port connector; hand-tighten the connector nut.

You do not have to remove the seal frit (if used).

9. Place the sample tube Dewar cover over the sample tube stem just above the isothermal jacket as shown in the following illustration.
Installing Dewars

Precautions

Always handle Dewars with care. Any product with a glass vacuum flask is a potential safety hazard and should be treated with caution.

We recommend the following be observed when handling Dewars containing liquefied gases:

- Protect yourself by wearing 1) goggles (or a face shield), 2) an insulated or rubber apron, and 3) insulated gloves.

- When pouring liquefied gases from one container to another: 1) cool the receiving container gradually to minimize thermal shock, 2) pour the liquefied gas slowly to prevent splashing, and 3) vent the receiving container to the atmosphere.

- Use a plastic stirring rod when stirring substances in a Dewar containing liquefied gases (or other materials of extremely low temperature). Do not use a glass or metal stirring rod unless it is coated with some form of protective coating.

- Do not handle heavy objects above the Dewar. If unavoidable, place a protective cover over the Dewar’s opening. If an object of sufficient weight is accidentally dropped into the Dewar, shattering may occur.

- Always install the Dewar cover before performing an analysis. The cover reduces the accumulation of ice. Accumulated ice could cause the Dewar to bond to the sample tube.

Cold Trap Dewar

**Cryogens can cause frostbite injury. Wear safety glasses and insulating gloves when handling cryogens.**

1. Fill the cold trap Dewar with a cryogen such as liquid nitrogen to about 5 cm (2 in.) from the top.
2. Hang the cold trap Dewar around the cold trap port as shown below.

3. Place the insulator/stopper over the Dewar opening as shown below.
Analysis Dewar

1. Fill the analysis Dewar with the analysis bath fluid to about 5 cm (2 inches) from the top.

**Incorrect fluid levels can lead to measurement errors. Do not overfill the Dewar.**

2. Check the analysis bath fluid level with the dipstick as shown below.

3. Insert the analysis Dewar onto the elevator as shown in the following illustration.

4. Place a Dewar insulator over the open Dewar until you are ready to start your analysis; this helps to minimize ice accumulation.

5. When you are ready to start the analysis, remove the insulator and install a Dewar cover.
Performing an Analysis

After the sample has been degassed and transferred to an analysis port, you may begin an analysis.

You cannot perform an analysis while calibration is in progress.

Before beginning an analysis, make sure the tank pressure for the gas regulator is at least 200 psig. Pressures less than 200 psig may cause the sample to be inadequately saturated, resulting in inaccurate data or termination of analysis.

Ensure that the analysis gas and the Psat gas specified in the sample file match the system configuration gases; if they do not, correct the sample information file or correct the unit configuration gas.

Perform the following steps to begin an analysis:

1. Select Unit > Start Analysis; the Analysis dialog is displayed with the Start Analysis dialog positioned on top.

2. Choose a file for your analysis and click OK; the Analysis dialog containing the parameters of the selected file is displayed.

3. Verify parameters and make any changes you feel necessary.

4. To generate a report automatically after the analysis, click Report after Analysis and choose report output options. You can generate reports to the screen or directly to a printer.
5. Click **Export after Analysis** to have isotherm data generated automatically after the analysis if finished.

![Warning]

**Before clicking Start, make sure the elevator is all the way down. If it is not all the way down, hazardous conditions can result.**

6. Click **Start** to begin the analysis; as data are collected, the graph will be drawn in the window.

![Graph]

7. Click **Next** to perform another analysis; the first view of the Analysis dialog is displayed.

![Warning]

**After the elevator rises, do not place any items under the elevator platform. Objects under the platform will prevent the elevator from fully lowering, and could cause damage to the elevator mechanism.**
Printing File Contents

You can print the contents of one or more sample or parameter files.

1. Select **File > Print**; a drop-down list containing file types is displayed.

2. Choose the file type; a dialog similar to this one is displayed.

3. From the **Files** list box, select the desired file. If you plan to print multiple files, hold down **Ctrl** while clicking on the desired files.

   You can use the **Status** drop-down list and/or the **Date Range** push button to limit the files displayed in the **Files** list.

4. Choose whether you wish to print the contents to the screen (Preview) or to a printer (Print). If you choose Print, the **Copies** field is enabled allowing you to print up to four copies.

5. Click **OK**; the file is printed to the specified destination.
Listing File Statistics

You can generate a list of the following information on a sample file or parameter file.

- File name
- Date the file was created (or last edited)
- Time the file was created (or last edited)
- File identification
- File status

Perform the following steps to list file statistics:

1. Select **File > List**.

2. From the List drop-down menu, select the type of file on which you wish information. A dialog similar to the one shown below is displayed:

   ![List Sample Information File](image)

   Displays the type of file on which you requested information; in this example, a sample information file.

   - From the **Files** list box, choose the desired file(s). If you wish to include all files, leave all files deselected.

   - Choose whether you wish to print statistics to the screen (Preview) or to a printer (Print). If you choose Print, the **Copies** field is enabled allowing you to print up to four copies.

3. Click **OK**, a list for the requested file(s) is sent to the specified destination.
Exporting Isotherm Data

The Export option on the File menu allows you to copy the isotherm data in the sample information file and reformat it in ASCII text. If saved to a file, the data can be imported into applications, such as spreadsheets. The output file consists of five columns containing the elapsed time, absolute pressure, relative pressure, and specific volume adsorbed (refer to Format of Data Output, page 5-101 for an example of exported data).

Perform the following steps to export a sample information file or ASCII data:

1. Select File > Export; the Export Sample Information dialog is displayed.

2. From the Files list box, choose the file(s) you wish to export. You can select multiple files by holding down Ctrl while clicking on the desired files.

Use the Status drop-down list and/or the Date Range push button to limit the files displayed in the Files list.

3. In the Settings group box, choose a Destination for your exported file.
   a. If you choose File as the destination, select the file type. Then enter a name in the File name field or accept the default. If you have selected multiple files, individual files are exported as their file name. You can also change the destination path if desired.
   b. If you choose Printer, the Copies field is enabled; you can print up to four copies.
4. Click OK; the file(s) is exported to the specified destination.
Generating Graph Overlays

Use graph overlays when you wish to compare graphically results for multiple samples or multiple graphs for one sample. Graphical lines are differentiated by the use of varying symbols and reported in a legend on the report. If color output capability is available, different colors are used instead of symbols.

Graph overlays can be implemented in two ways:

- **Multiple Sample Overlays**
  Overlay results for up to eight samples on top of a previously selected sample.

- **Multiple Graph Overlays**
  Overlay two different types of graphs from one sample. The multiple graph overlay capability exists for:

  - BJH Adsorption/Desorption
  - DFT Pore Size/Surface Energy
  - Dollimore-Heal Adsorption/Desorption
  - Horvath-Kawazoe
  - MP-Method

You cannot overlay graphs if your sample file presentation is in the Basic format. You must switch to the Advanced format before proceeding.

**Multiple Samples Overlay**

1. Select **File > Open > Sample Information** to display the Open Sample Information File dialog box.

2. Select a sample on which to overlay graphs of other samples, then click **OK**; the Sample Information dialog is displayed.

3. Click the Report Options tab to display the Report Options dialog.
4. Make your report selections (or deselect any you do not wish to generate).

5. Choose the type of report for which you wish to generate overlays, click **Edit**, and perform the steps listed for that report:

<table>
<thead>
<tr>
<th>If you are overlaying this type of report....</th>
<th>Then ....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Isotherm</td>
<td>Select the desired plot(s) from the <strong>Select Reports</strong> group box.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Options</strong> (becomes enabled when the plot is selected) adjacent to the selected plot</td>
</tr>
<tr>
<td></td>
<td>Select the <strong>Overlay samples</strong> check box, then click <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>OK</strong> again to return to the Report Options dialog.</td>
</tr>
<tr>
<td>BET Surface Area</td>
<td>Select the <strong>Overlay Samples</strong> check box.</td>
</tr>
<tr>
<td>Langmuir Surface Area</td>
<td>Click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Freundlich</td>
<td></td>
</tr>
<tr>
<td>Temkin</td>
<td></td>
</tr>
<tr>
<td>t-Plot</td>
<td></td>
</tr>
<tr>
<td>Alpha-S</td>
<td></td>
</tr>
<tr>
<td>f-Ratio</td>
<td></td>
</tr>
</tbody>
</table>
If you are overlaying this type of report.... | Then ....
--- | ---
BJH Adsorption | Choose the report variable from the Selected Reports window, then click **Edit**.
BJH Desorption | Click on the down arrow at the **Overlay** field and choose **Samples**; then click **OK**.
Dollimore-Heal Adsorption | Click **OK** again to close the report variable’s dialog and return to the Report Options dialog.
Dollimore-Heal Desorption | DFT Pore Size | DFT Surface Energy | MP-Method

6. Click **Overlays**; the Graph Overlay Samples dialog is displayed.

7. Click **Browse** to the right of the **Sample 1** field; the Plot Overlay Sample Selection dialog is displayed.

8. Choose a sample file, then click **OK**. You may choose up to eight files in this manner.

9. After selecting the desired number of sample files, click **OK** to return to the Report Options dialog.

10. Click **Save** if you wish to save your Selected Reports list. Even if you don’t save, all of the options regarding overlays and anything else are available as your reports are generated.

11. Select **Reports** > **Start Report**; the Start Report screen is displayed with the name of your primary file highlighted.

12. Click **OK**; the Select Reports dialog is displayed.

13. Ensure that the desired graph is selected (preceded with a check mark), then click **OK**.
Multiple Graphs Overlay

Remember that multiple graph overlays can be done only for:

- BJH Adsorption
- BJH Desorption
- DFT Pore Size
- DFT Surface Energy
- Dollimore-Heal Adsorption
- Dollimore-Heal Desorption
- Horvath-Kawazoe
- MP-Method

1. Select **File > Open > Sample Information** to display the Open Sample Information File dialog.

2. Select a sample for which you want to overlay two graphs; then select **Edit**; the Sample Information dialog box is displayed.

3. Click the **Report Options** tab to display the Report Options dialog.

4. Make your report selections (or deselect any you do not wish to generate).
5. From the **Selected Reports** list, select the report for which you want multiple graph overlays, then select **Edit**; a Report Options dialog for that report (or graph) is displayed (this example shows BJH Adsorption).

![Image of BJH Adsorption Report Options dialog]

6. Select a report type, then click **Edit**; an options dialog for that specific item is displayed (this example shows Cumulative Pore Volume).

![Image of BJH Adsorption Cumulative Pore Volume Options dialog]

7. Click the down arrow at the **Overlay** field and select a graph type from the list. This selection will be overlaid on the graph selected in the **Variable** field.

8. Select **OK** to return to the BJH Adsorption Report Options dialog; do any editing you wish.

9. Click **OK** to return to the main Report Options dialog.
10. Click **Save** to save your Selected Reports list. Even if you don’t save, all of the options regarding overlays and anything else are available as your reports are run.

11. Select **Reports > Start Report**; the Start Report screen is displayed with the name of your primary file highlighted.

12. Click **OK**; the Select Reports dialog is displayed.

13. Ensure that the desired graph is selected (preceded with a check mark), then click **OK**.
5. FILE MENU

The File menu contains commands which allow you to manage sample and parameter files.

Description

Listed below are brief descriptions of the File menu commands. Detailed descriptions follow this section.

Open
Opens an existing sample information or parameter file. Page 5-3.

Save
Saves the file in the active window. Page 5-94.

Save As
Saves the file in the active window as a different name. You also can use this option to save a subset of the sample file as a parameter file. Page 5-95.

Save All
Saves all open files. Page 5-96.

Close
Closes the file in the active window. Page 5-96.

Close All
Closes all open files. Page 5-97.
<table>
<thead>
<tr>
<th><strong>Print</strong></th>
<th>Prints the contents of a sample or parameter file. Page 5-98.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>List</strong></td>
<td>Generates a list of certain information for sample or parameter files. Page 5-99.</td>
</tr>
<tr>
<td><strong>Export</strong></td>
<td>Copies the isotherm data in a sample information file and exports it in ASCII format. Page 5-100.</td>
</tr>
<tr>
<td><strong>Convert</strong></td>
<td>Allows you to convert a sample file in the MICMOS 2000 or 2000 micropore format to a format compatible with the ASAP 2020 program. Page 5-102.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Exits the analysis program. Page 5-104.</td>
</tr>
</tbody>
</table>
Open

**Open** allows you to create a new file or edit an existing one. The following file types are available:

- Sample information
- Sample tube criteria
- Degas conditions
- Analysis conditions
- Adsorptive properties
- Report options

Regardless of which file type you select, a dialog similar to the one shown here is displayed:

![Open Sample Information File](image)

**File name**

For *sample information* files, this field contains the next sequenced file name (as specified in sample defaults) generated by the system. If this is a new file, you can use the name displayed or enter a different one.

For *parameter* files, the file name displayed includes the wild card (*) and a default extension as follows:

*.DEG for degas conditions
*.STB for sample tube
*.ANC for analysis conditions
*.ADP for adsorptive properties
*.RPO for report options
If you are creating a new file, enter a name in the **File name** field. You can use up to 8 characters.

If you are opening an existing file, select the name from the **Files** window, then click **OK**.

**Date Range**

Click this push button to display files created within a specified range of dates; the Select Dates dialog box is displayed.

Refer to **Selecting Files**, page 3-11 for an explanation of the functions on this dialog.

**Status**

Displays for sample information files only. This drop-down list allows you to choose the types of sample files to display in the **Files** window. All files of the type you choose, within the range of dates, and in the current directory are displayed. Refer to **Table 3-2. File Status and Description**, page 3-12 for a description of the status types.

**Directories**

Displays the current directory. You can navigate to a different directory by clicking in the **Directories** list box or by entering the desired directory in the **File name** field.
Sample Information

Sample information files contain information used to control the analysis. Therefore, an analysis cannot proceed until it has been assigned a sample information file. A sample information file consists of the following:

- sample identification
- sample tube criteria
- analysis conditions
- adsorptive properties
- report options
- collected (after an analysis has been completed) or entered data

Portions of the sample information file can also exist as standalone parameter files. Having these files exist independently allows you to use them as many times as you wish. For example, if you typically use the same analysis conditions for many of your analyses, you can create an analysis conditions file containing the desired conditions. Then when you create your sample file, select that file for your analysis conditions; the values will be copied into the current sample file. After it becomes part of the new sample file, you can edit it as desired. The file from which the values were copied remains intact and ready for the next use.

Sample information files reside in a folder, more commonly referred to as a directory. The more files in a directory, the longer it may take to access a file. Therefore, it is a good practice to limit the number of files in a directory to approximately 200. You may create additional directories as needed.

Sample information files can be created and presented in the Advanced, Basic, or Restricted format.

- **Advanced**
  Presents all parts of the sample information file in a tabbed dialog. Each tab opens its associated dialog, allowing you to edit conditions. You can also switch to the Basic format if desired.

- **Basic**
  Presents all parts of the sample information file as a single dialog. This format allows you to quickly create a sample information file using predefined parameter files. You can also switch to the Advanced format if desired.

- **Restricted**
  Identical to the Basic format except that you cannot switch to the Advanced format for editing; certain functions are also disabled.
Advanced Format

The Advanced format displays all parts of the sample file in a tabbed dialog. This format allows you to customize your sample file, moving easily among the parameters simply by clicking on the tabs; alternatively, you can use Prev and Next. Refer to Advanced Format, page 4-6 for step-by-step instructions for creating a sample information file using the Advanced format.

These fields can be edited to display a different label if desired.

Sample

Contains the description of the current sample file. If this is a new file, this field contains the file description specified in Sample Defaults. The above dialog shows the sample file number because the dollar ($) symbol was included when sample defaults were specified.

You can enter a new description or edit the existing one if desired.

Maximum number of characters: 50
**Operator**

Displays the operator and submitter names of the current sample file.

If this is a new file, these fields contain the names specified in Sample Defaults.

You can enter a different name or edit the current one if desired. You can use up to 40 characters.

Either (or both) of these fields can be prevented from displaying on this dialog by selecting **Omit** in Sample Defaults (Chapter 8). The labels also can be edited in **Sample Defaults**.

**Submitter**

Displays the operator and submitter names of the current sample file.

**Bar Code**

This field enables you to enter bar code information. If bar code information is not used, you can use this field to enter additional information about the sample; for example, you may wish to enter the lot number of your sample. This field can also be omitted in Sample Defaults if it is not needed.

This field will also accept data from a bar code reader.

Range: 40 characters

**Mass**

You can enter a sample mass or have the mass calculated automatically.

**Enter**

Enables the **Sample Mass** field allowing you to enter a value.

**Calculate**

Enables the **Empty tube** and **Sample + tube** fields, allowing you to enter appropriate values. These values are used to calculate the mass of the sample,

\[ Mass_{sample} = Mass_{sample + tube} - Mass_{tube} \]

You should always use the same gas (typically nitrogen) for degassing and analysis. If different gases are used, the sample mass after degas and after analysis will not be equal. For example; if you use helium to backfill after degassing and nitrogen after analysis, you can get as much as a 0.02-gram difference.
### Density
If you plan to use a calculated free space, enter the sample’s density in this field. A value in this field is ignored for measured or entered free spaces.

### Type of Data
Displays the type of data for the current sample file.

If this is a new file, choose whether you wish to have data collected automatically or if you plan to enter data collected from another source.

### User Parameters
These fields are used primarily for SPC (Statistical Process Control) reporting. However, they can be used for other data as well. You may wish to enter specific analysis conditions or sample criteria. These parameters print on the Options report. Select Options > Sample Defaults to specify the parameters you wish to report. The parameters you specify replace the User Parameter labels.

If desired, you can have these fields omitted from the sample information file (refer to Sample Defaults, page 8-4).

### Comments
Allows you to enter pertinent information about the sample or analysis. The information you enter in this window is displayed in the report header. You may enter up to 500 characters in this window.

### Replace All
Use this push button to replace all parameters of the current file with those from an existing one. You can edit the parameters after they have been copied into the current file; editing the current file does not affect the file from which they were copied.

### Save
Saves all parameters of the current file; the dialog remains open.

### Close
Closes the dialog. If the file contains unsaved changes, you are prompted to save before the dialog closes.

### Basic
Switches the sample editor to the Basic format.
Basic Format

The Basic format displays all parts (parameters) of the file on a single dialog. With this format, you can quickly create a sample information file using predefined parameter files. You can also switch to the Advanced format if a specific parameter requires editing. Refer to Basic and Restricted Formats on page 4-8 for step-by-step instructions for creating a sample information file using the Basic format.

### Sample Information

<table>
<thead>
<tr>
<th>Mass</th>
<th>Calculate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Mass: 1.0000 g</td>
<td>Empty tube: 1.0000 g</td>
</tr>
<tr>
<td>Density: 1.000 g/cm³</td>
<td>Sample + tube: 2.0000 g</td>
</tr>
<tr>
<td>1.0000 g</td>
<td></td>
</tr>
</tbody>
</table>

- Sample tube: [Sample Tube]
- Analysis conditions: [Run Conditions]
- Adsorptive properties: [Nitrogen]
- Report options: [Report Options]
- Degas conditions: [Degas Conditions]

- Replace All...  Add Log Entry...

If you are creating a new file, this dialog displays the defaults you specified in Sample Defaults. Chapter 8 explains how to establish sample defaults.

### Sample

Contains the description of the current sample file.

If this is a new file, this field contains the next sequenced file description based on the format specified in Sample Defaults (see Chapter 8). The above dialog box shows the sample file number because the dollar ($) symbol was included when sample defaults were specified.

You can enter a new description or edit the existing one if desired.

Maximum number of characters: 50
<table>
<thead>
<tr>
<th><strong>Mass</strong></th>
<th>You can enter a sample mass or have the mass calculated automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enter</strong></td>
<td>Enables the <strong>Sample Mass</strong> field allowing you to enter a value.</td>
</tr>
</tbody>
</table>
| **Calculate** | Enables the **Empty tube** and **Sample + tube** fields, allowing you to enter appropriate values. These values are used to calculate the mass of the sample,  
\[
Mass_{sample} = Mass_{sample + tube} - Mass_{tube}
\] |
| **Density** | If you plan to use a calculated free space, enter the sample’s density in this field. A value in this field is ignored for measured or entered free spaces. |
| **Sample Tube** | Each parameter field contains the description of the current parameter file. |
| **Degas Conditions** | If this is a new sample file, these fields contain the descriptions of the files chosen as the defaults. |
| **Analysis Conditions** | Click on the down arrow to the right of each field to choose a different file. File parameters can be viewed or edited by switching to the Advanced format. |
| **Adsorptive Properties** |  |
| **Report Options** |  |
| **Replace All** | Use this push button to replace all parameters of the current file with those copied from an existing one. A dialog box is displayed allowing you to choose the desired file. |
| **Save** | Saves all parameters of the current file; the dialog remains open. |
| **Close** | Closes the dialog. |
| **Advanced** | Switches the sample editor to the Advanced format, allowing you to view or edit parameters of the current file. |
Restricted Format

The Restricted format is used when analysis parameters must remain constant. For example, in the pharmaceutical industry where consistency and accuracy are crucial. A password is required to enter and exit this format. Refer to Restricted, page 8-3 for additional information on the Restricted format.

When you open an existing sample information file or create a new one using the Restricted format, all parts of the sample file are displayed in the same manner as the Basic format. Some menu functions, however, are disabled and you cannot switch to the Advanced format to edit file parameters.
Sample Tube

The fields on this dialog are used for storing sample tube information. Before creating a sample tube file, you should perform a blank analysis (no sample) using the sample tube.

Sample Tube

Contains the description of the current file.

If this is a new file, this field contains the name (description) you specified as the default. You can enter a new description or add to the existing one if desired.

*Maximum number of characters:* 40

Replace

Use this push button to replace the values of the current file with those from an existing Sample Tube file. The Open Sample Tube dialog is displayed, allowing you to choose a file. After the values are copied into the current file, you can edit them as desired.

Warm free space

Displays the warm free space used for the blank analysis.

Cold free space

Displays the cold free space used for the blank analysis.

Use isothermal jacket

Select this option if an isothermal jacket is to be used in the analysis.

Use filler rod

Select this option if a filler rod is to be used in the sample tube.
<table>
<thead>
<tr>
<th>Vacuum seal type</th>
<th>If the sample is to be transferred under vacuum to the analysis port, select the seal type to be used. If not, leave None selected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load From Sample File</td>
<td>Click this push button to choose the sample file that was used in the blank analysis. The values for the Warm and Cold free spaces, and the non-ideality factor will be copied into the sample tube file.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves all parameters of the current dialog.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the dialog box. If the file contains unsaved changes, you are prompted to save before the dialog box closes.</td>
</tr>
</tbody>
</table>
Degas Conditions

The fields on this dialog are used for specifying degas conditions when your ASAP 2020 is equipped with the SmartVac degas option. If you do not have the SmartVac, the values you enter are meaningless.

### Description
Contains the description of the current Degas Conditions file.

If this is a new file, this field contains the name (description) you specified as the default. You can enter a new description or add to the existing one if desired.

*Maximum number of characters: 40*

### Replace
Use this push button to replace the parameters of the current file with those from an existing Degas Conditions file. The Open Degas Conditions File dialog is displayed, allowing you to choose a file. After the values are copied into the current file, you can edit them as desired.

### Evacuation Phase group box
The options in this group box allow you to specify conditions for the evacuation phase of the degassing operation.

### Temperature ramp rate
Allows you to specify the rate at which the temperature is to change while advancing to the target temperature during evacuation.
**Target temperature**
Allows you to specify a temperature at which the sample will be held for the remainder of the evacuation.

**Evacuation rate**
Enables you to specify an evacuation rate for initial evacuation.

**Unrestricted evac. from**
Enables you to specify a pressure at which unrestricted sample evacuation will begin.

**Vacuum setpoint**
Enables you to specify the vacuum level to be achieved before evacuation begins.

**Evacuation time**
Enables you to specify how long the sample is to be evacuated prior to the second stage of heating.

**Heating Phase group box**
The options in this group box allow you to specify conditions for the heating phase of the degassing operation.

**Ramp rate**
Enables you to specify the rate at which the temperature will change after evacuation while advancing to the hold temperature.

**Hold temp**
Enables you to specify a temperature at which the sample is to be held during degassing.

**Hold time**
Enables you to specify how long the sample is to be held at the specified temperature before beginning to cool down.

**Hold Pressure**
If during the temperature ramp the pressure exceeds the value you enter in this field, the ramp will be suspended until the pressure returns to a safe level.

**Backfill Sample Tube**
Select this option to have the sample tube backfilled. You should deselect this option if you are using the TranSeal; this allows the sample to remain under vacuum while transferring to the analysis port.
Save
Saves all parameters of the current dialog.

Close
Closes the dialog box. If the file contains unsaved changes, you are prompted to save before the dialog box closes.

Analysis Conditions

The Analysis Conditions dialog allows you to specify the data used to guide the analysis. You can create an Analysis Conditions file as an independent parameter file or include it as part of the sample information file.

Refer to Analysis Conditions, page 4-11 for step-by-step instructions on creating an analysis conditions file.

Description
Contains the description of the current Analysis Conditions file.

If this is a new file, this field contains the name you specified as the default. You can enter a new description or add to the existing one if desired.

Maximum number of characters: 40
Replace

Use this push button to replace the parameters in the current file with those from an existing Analysis Conditions file. After you choose the file and the values are copied into the current file, you can edit them in any way desired. Editing in the current file will not change anything in the file from which they were copied.

Collect ROA Data

Allows you to collect Rate of Adsorption (ROA) data. When this option is selected, its related fields become enabled. An ROA column is also added to the Pressure table, allowing you to select pressures at which to collect ROA data. See the ROA operator’s manual for additional information.

This group box is displayed only if the ROA option is installed.

Interval

Enter a value which represents the length of time from one reading to the next.

Dose amount

Enter the amount of gas to be applied.

Max. readings

Enter a value which represents the maximum number of readings to record.

Pressures selected

Displays the number of pressure points selected for ROA data.

Pressure Table

A pressure table is a list of pressure points (with calculation assignments) at which data are to be collected. The pressures may span the entire range from the lowest relative value of 0.00000001 to the maximum value of 0.995 P/Po. (The maximum recommended value for krypton is 0.5 P/Po.) In addition, one saturation point may be entered with relative pressure of 1.0.
The minimum absolute pressure for desorption is 0.050 mmHg. For example, if Po = 760 mmHg, a relative pressure less than \( \frac{0.050}{760.0} = 0.0000658 \) will result in an error. The analysis will terminate.

Several analysis conditions files containing complete pressure tables are included with the ASAP 2020 software and can be found in the PARAMS subdirectory.

The pressure table for automatically collected data includes the pressure points for data collection and identifies calculations through which the data are processed.

Edit existing values by highlighting the field and entering the desired values. Use Insert to add rows for additional values. To append to the beginning or to the end of the table, use Ctrl + Up Arrow and Ctrl + Down Arrow.

The pressure table must contain one sequence of strictly ascending relative pressures, optionally followed by one sequence of strictly descending relative pressures. You can enter a maximum of one thousand pressure points.

To specify the calculations performed at a given relative pressure, click in the field of the desired calculation type; an X in the field indicates the calculation is selected.

Insert Range

Displays the Insert Pressure Range dialog box.

This dialog allows you to specify the starting pressure, the ending pressure, the number of points to insert within the specified range, and whether you wish to have linear or geometric progression.

Linear

Inserts evenly spaced points into your table.
**Geometric from low pressure**  
Inserts geometrically spaced points from the low pressure range. For example, to insert 5 points with a 0.01 starting pressure and a 0.16 ending pressure, the following points are inserted into the table:

- 0.01
- 0.02
- 0.04
- 0.08
- 0.16

**Geometric towards saturation**  
Inserts geometrically spaced points from the saturation pressure. For example, to insert 5 points with a 0.99 starting pressure and a 0.84 ending pressure, the following points are inserted into the table:

- 0.99
- 0.98
- 0.96
- 0.92
- 0.84

**Insert predefined**  
Displays the Insert Predefined Pressures dialog.

Choose predefined pressure points for surface area, t-Plot micropore, and/or BJH adsorption/desorption.

Click on the down arrow for each field to choose the desired set of points. You can also specify Adsorption/Desorption total pore volume and Saturation.
**Insert**

Inserts a row into the table above the selected line.

**Delete**

Deletes the selected row.

**Clear**

Removes all but one required entry from the table. The rows do not have to be selected. A warning message appears requesting confirmation before the table is cleared.

**Absolute pressure dosing**

Select this option to specify pressure targets in mmHg, mbar, or kPa instead of relative pressure. This option is typically selected when using adsorptives at analysis conditions above the critical point of the gas; for example, H₂ adsorption on carbon at liquid nitrogen temperature.

**Use calculation assignments**

Select this option to assign the points to be collected for each type of report.

If this option is not selected, each report (with the exception of Langmuir and BET) uses a range of pressures as selected in the report options. The Langmuir and BET reports interpolate to entered relative pressures on the report options.

The outlier points can be selected so that they will not be reported.

**Preparation**

Displays the Analysis Preparation dialog box.
<table>
<thead>
<tr>
<th><strong>Fast evacuation</strong></th>
<th>Select this option for samples (such as pellets) that do not fluidize or shed particles during evacuation.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unrestricted evac. from</strong></td>
<td>Enabled when Fast evacuation is not desired. This field allows you to enter the pressure at which unrestricted sample evacuation is to begin.</td>
</tr>
<tr>
<td><strong>Vacuum setpoint</strong></td>
<td>Allows you to specify the vacuum level to be achieved before timed evacuation begins.</td>
</tr>
<tr>
<td><strong>Evacuation time</strong></td>
<td>Enables you to enter the length of time for preliminary evacuation, which takes place prior to the free-space measurement.</td>
</tr>
<tr>
<td><strong>Leak test</strong></td>
<td>Enables the system to check for leaks or sample outgassing before the analysis. The leak test allows sample pressure to rise during the test. If the pressure rises more than 0.15 mmHg, the analysis does not proceed and you are notified. While leak testing slightly increases analysis time, it prevents the continuation of analysis and collection of erroneous data if a leak exists.</td>
</tr>
<tr>
<td><strong>Leak test duration</strong></td>
<td>Enables you to specify how long the pressure is to be monitored.</td>
</tr>
<tr>
<td><strong>Use TranSeal</strong></td>
<td>Select this option if you are using the TranSeal to transfer the sample from the preparation port to the analysis port under vacuum.</td>
</tr>
</tbody>
</table>
**Free Space**

Allows you to specify free-space measurement conditions; the Free Space dialog is displayed.

![Image of Free Space dialog]

**Measure**

Select this option to have free space measured automatically by the system.

Typically, it is best to measure the free space when analyzing macro- and mesoporous samples, and for routine surface area measurements.

Select **Lower dewar for evacuation** to lower the dewar following free-space measurements.

Evacuation time enables you to specify how long evacuation is to take place following the measured free space.

Select Outgas test to check for system leaks or sample outgassing. After free space is measured, the Dewar is lowered and the sample evacuated for 30 minutes. The leak test is performed after evacuation. If a leak is found, the leak test repeats nine times, with 30 minutes evacuation between tests. If the 10th leak check fails, the analysis stops and you are notified. While leak testing slightly increases analysis time, it prevents the continuation of analysis and collection of erroneous data if a leak occurs.

**Outgas test duration** indicates the number of seconds the leak test is performed.
Enter
Select this option to enter values for the warm and cold free spaces. You may need to use this option if the sample retains helium and measurement of very low micron range pressures are required.

If you change the entered free-space value after the preliminary analysis stage is 50% complete, the change does not affect the analysis.

Warm free space is the sample tube gas capacity measured at room temperature.

Cold free space is the sample tube gas capacity measured with the Dewar raised.

Calculate
Select this option to have the free-space calculated using the mass, density, and sample tube parameters entered in the Sample Information and Sample Tube files. Calculated free space measurement takes less time than measured free space, so if you know the mass and density of the sample and the sample tube parameters, you may wish to use this choice of free space methods. If you do not know the parameters, you may wish to use measured free space.

Po and T
Displays the Po and Temperature Options dialog box, allowing you to choose saturation pressure and analysis bath temperature. It also provides a field for entering the ambient temperature.
This dialog provides six options for obtaining the saturation pressure (Po) and analysis bath temperature. Clicking on each option prompts you for the entry of related parameters in the lower portion of the dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Prompts for...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>a measurement interval (how often during analysis the Po is to be measured)</td>
</tr>
<tr>
<td>2</td>
<td>a measurement interval and the analysis bath temperature</td>
</tr>
<tr>
<td>3</td>
<td>a Po; the analysis bath temperature is calculated at the time of analysis</td>
</tr>
<tr>
<td>4</td>
<td>a Po and analysis bath temperature an analysis bath temperature only (when Absolute pressure dosing is selected on the Analysis conditions dialog)</td>
</tr>
</tbody>
</table>
5  a psat gas other than the adsorptive; the temperature and pressure ranges for the chosen gas are displayed. Click Psat vs. T to edit the values if desired. Editing the values in the current table do not affect the ones of the original table

6  an analysis bath temperature

**Ambient Temperature**

Enables you to enter the ambient temperature of the laboratory to be used in calculations.

**Dosing**

Displays the Dosing Options dialog.
| **First Pressure Fixed Dose** | The most frequent use of this option is when you are performing a standard nitrogen analysis of mesoporous materials such as catalysts. If the first pressure table point is low and you expect the gas uptake of the sample to be high, this option can shorten the time required to reach the first point on the pressure table.  

The sample is dosed repeatedly at low pressures with a specified amount of gas until the first pressure point is reached. This initial dosing quickly meets the adsorptive demand of the sample.  

The first point on the pressure table is the threshold value, triggering the transition from the **Fixed Dose Mode** to Pressure Table Mode. When the first pressure table value is reached, Fixed Dose Mode is disabled, and points are equilibrated and recorded in accordance with the specified pressure table.  

In the field adjacent to this option, enter the amount of gas that is to be added to the sample for each dose cycle.  

This option is disabled if Low pressure incremental dose mode is selected. |
| **Maximum volume increment** | Select this option to determine when additional data points are collected between target pressures in regions of adsorption. When the maximum increment has been adsorbed since the last collected data point, another point is equilibrated and collected.  

During desorption, this field is treated as a maximum volume “decrement” value. |
Absolute and Relative pressure tolerance

The values entered in these fields are used to determine how close the actual pressure must be to each target pressure from the pressure table. At lower pressures the relative tolerance value is smaller, and at higher pressures the absolute tolerance value is smaller. The lesser (or more stringent) of these two criteria are used to determine the tolerance.

For example, with relative tolerance = 5% and absolute tolerance = 5 mmHg, the relative tolerance at 40 mmHg target pressure is 5% of 40 mmHg, or 2 mmHg; 2 mmHg is smaller than the absolute tolerance of 5 mmHg, so 2 mmHg is used. At 200 mmHg target pressure, the relative tolerance is 5% of 200 mmHg, or 10 mmHg; in this case, the absolute tolerance of 5 mmHg is smaller and is used.

In the above example, a minimum pressure of 40 - 2 = 38 mmHg must be attained to collect data for a target pressure of 40 mmHg. For a target of 200 mmHg, 200 - 5 = 195 mmHg must be attained.

Normally, surface area measurement points are widely spaced, and the resulting measurement is not very sensitive to the precise location of points so wider tolerances may be used. Unnecessarily tight tolerances lengthen the analysis.

Low pressure incremental dose mode

Enabled only if the MicroPore option is installed. Choose this option when you are performing an analysis of microporous materials. At low pressures on Type 1 isotherms, the pressure points are very closely spaced, making a useful pressure table difficult to define. Choosing this mode enables you to measure equilibrium points at approximately equal intervals on the quantity adsorbed axis. Each dose is fully equilibrated and recorded as a data point.
| **Low pressure incremental dose mode (continued)** | In this mode, the sample is successively dosed with a specified amount of gas until the first pressure point is reached. The first point is the threshold value, triggering the transition from Incremental Dose Mode to Pressure Table Mode. When the first pressure table value is reached, Incremental Dose Mode is disabled, and points are recorded in accordance with the specified pressure table. Because the data points recorded during Incremental Dose Mode may define most of the analysis, one point on the pressure table can be sufficient and serve as the end point for the analysis.

This field is disabled if **First Pressure Fixed Dose Mode** is selected. |
| **Dose amount** | Enter the amount of gas to be added to the sample for each data point until the first point on the pressure table is reached. |
| **Enabled when Low pressure incremental dose mode is selected.** | **Equilibration delay** |
| | Enabled when Low pressure incremental dose mode is selected. |
| | Minimum: Prevents premature equilibration caused by reduced percentage sensitivity to pressure changes at the lowest pressures. |
| | Maximum: Prevents the effects of long term temperature or pressure drift, which may cause the instrument to wait an excessive length of time for equilibration. |
Equilibration

Displays the Equilibration dialog.

**Equilibration interval**

The number of seconds between successive pressure readings during equilibration. Long equilibration intervals tend to lengthen analyses, however, they do improve data integrity. Short equilibration intervals produce a faster analysis but may reduce the accuracy of data.

**Minimum equilibration delay at \( P/P_o > 0.995 \)**

The value entered in this field determines the minimum number of seconds required before equilibration can occur for a relative pressure greater than or equal to 0.995.

This field does not display if you select **Absolute pressure dosing** on the analysis conditions dialog.
Backfill

Displays the Sample Backfill Options dialog, allowing you to select options for backfilling the sample tube at the start and end of an analysis.

The options on this dialog are not available if the file status displayed in the Open Sample Information File dialog is Entered, Complete, or Analyzing.

Backfill sample at start of analysis

Backfills the sample tube at the beginning of the analysis with the specified backfill gas.

For micropore analyses, it may be best not to select this option. Generally, it is best to manually evacuate the sample and start the analysis under vacuum. This minimizes any stray gas contamination.

Backfill sample at end of analysis

Backfills the sample tube at the end of the analysis with the specified backfill gas. If the sample mass is determined after the analysis, it is best to use nitrogen as the backfill gas.

It is recommended that you backfill the sample tube at the start and at the end of the analysis unless you are using the TranSeal to transfer the sample tube under vacuum. If you deselect either backfill option, proceed with caution as damage to the analyzer or sample tube may occur.

Backfill Gas

Lists the available backfill gases. The gases in this list are the ones for which Adsorptive Properties files have been created; helium is also included.
**Adsorptive Properties**

This dialog allows you to specify the characteristics of the gases used in the ASAP 2020 system. An Adsorptive Properties file can be created as an independent parameter file or included as part of the sample information file.

Refer to **Adsorptive Properties**, page 4-13 for step-by-step instructions on creating adsorptive properties files.

**Adsorptive**

If this is a new file, this field contains either the name of the default adsorptive gas or is blank. Enter the name of the desired adsorptive gas.

- **Maximum number of characters**: 40 alphanumeric

**Replace**

Click this push button to choose an Adsorptive Properties file containing parameters you wish to copy and use in the current file. After the values have been copied into the file, you can edit them as desired. It does not affect the values of the file from which they were copied.

**Mnemonic**

The mnemonic for the adsorptive gas.

- **Maximum number of characters**: 5 alphanumeric
Non-condensing Adsorptive

Select this option if this file is for a non-condensing gas (adsorptive). When you select this option, the Density conversion factor field and the Psat vs. T push button become disabled.

Maximum manifold pressure

The maximum gas pressure allowed in the manifold.

Density conversion factor

This value is used to convert the gas volume at STP to liquid volume for the adsorptive. It is the ratio of gas density at STP to liquid density.

Therm. tran. hard-sphere diameter

The thermal transpiration hard-sphere diameter.

Molecular cross-sectional area

The molecular cross-sectional area.

Dosing Method

Select the manner in which the sample tube is dosed. Select Normal for gases under pressure.

Select From Psat tube for krypton analyses.

Select Vapor source for vapors. Vapor source is disabled if the maximum manifold pressure is greater than 800.00 mmHg.

Real gas equation of state

This radio button and the one below it let you choose how to account for non-ideal behavior of the adsorptive.

The real gas equation of state (EoS) calculations correct for non-ideal behavior at all pressures and temperatures. There are some adsorptives (like butane) that are significantly non-ideal even at the pressures used in the 2020. The real EoS calculations are necessary for analyses with these gases. But even for nitrogen, these calculations provide some improvement. Tables containing compressibility factors for several gases are installed with the ASAP 2020 software. Click Open to choose a table.
| **Real gas equation of state**  
* (continued) | The real EoS should be used whenever a table for the adsorptive is present. The gases included in the tables are: argon, carbon dioxide, carbon monoxide, ethane, ethylene, helium, hexane, hydrogen, isobutane, krypton, methane, nitrous oxide, n-butane, neon, ammonia, nitrogen, oxygen, pentane, propane, propene, sulfur hexafluoride, and xenon. You can use the **Save** button to save the table under a different name. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adsorbed-phase free-space correction</strong></td>
<td>This option is appropriate for all sample analyses that use the real gas equation of state. Adsorbed molecules occupy volume in the sample tube reducing the cold free space. If you select this option, the reported quantity adsorbed will be adjusted to correct for this effect. This check box should be deselected for blank tube analyses.</td>
</tr>
<tr>
<td><strong>Ideal gas law with non-ideality correction</strong></td>
<td>The non-ideality correction can be used if there is no compressibility table for the gas you are using or if you want to match existing data. This factor adjusts the ideal gas law for calculating the quantity of gas in the cold free space. Most gases are nearly ideal near room temperature and at pressures not much above atmospheric pressure, so the cold free space is where the correction is most important. If you choose this option, enter the <strong>Non-ideality factor</strong>.</td>
</tr>
</tbody>
</table>
**Psat vs. T**

Click to view or edit the Psat vs. Temperature table for the adsorptive gas; this example shows Nitrogen.

![Psat vs Temperature Table for Nitrogen @ 77.35 K](image)

This table contains saturation pressures and their corresponding temperatures. As many as 10 entries may be included; at least two entries are required.

You can edit the table by clicking on the desired saturation pressure or temperature and entering a different value.

Use **Insert** to insert a new row above the selected line; the cursor moves to the new line. Use **Delete** to delete the selected row.
Report Options

This dialog allows you to specify report options. A report options file can be created as an independent parameter file or included as part of the sample information file.

Refer to Report Options on page 4-14 for instructions on creating report options files.

Description
Displays a description of the current Report Options file.

If this is a new file, this field contains the description you specified as the default. You can enter a new description or add to the existing one if desired.

*Maximum number of characters: 40*

Replace
Click this push button to choose an existing Report Options file containing parameters you wish to copy and use in the current file. After the values have been copied into the file, you can edit them as desired. It does not affect the values of the file from which they were copied.

Show report title
This option allows you to enter a title for your report.

If this is a new file, the title you specified as the default is displayed. Accept the default title or enter a different one.

Deselect this option to omit the report title.

*Range: 40 characters*
**Show graphic**

Select this option to have a graphic display above the report title.

The graphic can be in a bitmap (bmp) or an enhanced metafile (emf) format. For example, you may wish to display your company logo.

Click **Browse** to choose the graphic, then use the height and width fields to specify the size. The image can also be edited from the report window.

**Overlays**

Displays the Graph Overlay Samples dialog so that you can choose the sample files containing the data you wish to overlay onto a selected plot.

Click **Browse** to the right of the sample number field to choose the desired file. Use **Clear** to clear a field of its entry. You can select up to eight files.

After choosing the desired files, select the **Overlay samples** option for each report type you plan to overlay.

**Edit**

Allows you to edit parameters of the selected report. This push button is disabled for the Options report.
Thermal transpiration correction

Select this option to correct for the temperature-induced pressure difference between the manifold and the chilled sample tube. This option is most significant for pressures less than approximately 1.0 mmHg. Never use filler rods in the sample tube when applying correction for thermal transpiration.

You should always use thermal transpiration when performing micropore analyses.

Inside diameter of sample tube

Enabled when you select Thermal transpiration correction, so that you may enter the inside diameter of the sample tube.

Selected Reports

Contains a list of available reports. Choose reports by double-clicking on the desired reports. Alternatively, you can highlight the desired report and press the Spacebar. A report is selected when it is preceded with a check mark. You may deselect reports in the same manner.

The following reports are available:

Summary
Isotherm
BET Surface Area
Langmuir Surface Area
Freundlich
Temkin
t-Plot
Alpha-S Method
f-Ratio Method
BJH Adsorption
BJH Desorption
Dollimore-Heal Adsorption
Dollimore-Heal Desorption
Horvath-Kawazoe
DFT Pore Size
DFT Surface Energy
Dubinin
MP-Method
Options
Sample Log
Validation

You can find printed examples of some reports in Chapter 7, beginning on page 7-27.
Summary Report

The Summary report provides a condensed listing of analysis statistics and data results. The Summary Report Options dialog allows you to choose the type of information to include in the report.

The choices on this dialog allow you to choose the types of data to include in the Summary report.

If you choose Adsorption or Desorption total for Pore Volume data, the P/Po field is enabled so that you can enter the relative pressure at which to calculate the total pore volume. If Use calculation assignments (Collected Data screen) is not selected, the isotherm is interpolated to this value and that point used for the Total pore volume calculation. Otherwise, the point selected with calculation assignment is used.

This dialog also enables you to specify Pass/Fail criteria for up to four parameters.

Select All  Selects all choices on the dialog.

Deselect All  Deselects all choices on the dialog.

Pass/Fail Selection  Displays the parameter you selected on the Pass/Fail Options dialog.
Pass/Fail Displays the Pass/Fail Options dialog so that you can choose a parameter on which to specify pass/fail criteria.

Upper/Lower Select these options to specify upper and lower limits for the selected parameter; a valid range for the selected field is displayed in the information bar.

You can leave the range open by deselecting one of the limits. For example; if you wish to leave the upper limit open, deselect the Upper check box and specify a value only for the Lower limit.

Each of these fields has a message line in which you can enter advice to the operator if a failure occurs. You may enter up to 120 characters in each field.
Isotherm Report Options

The isotherm report indicates adsorption (up to saturation pressure) and desorption (down from saturation pressure) of a gas by a solid held at constant temperature.

Select Reports

Lists the types of reports offered.

*Choices:* Tabular Report, Linear plot, Logarithmic plot, Linear Absolute plot, Logarithmic Absolute plot, Pressure Composition plot

When you select Pressure Composition plot, the *Adsorbate Molecular Weight* field is enabled so that you can enter a value for the adsorbate. This plot is useful for plotting pressure as a function of Weight % adsorbed; for example, H₂ adsorbed on carbon.

Options

Displays the related Plot Options dialog; this example shows the dialog for the Linear plot.

All plot dialogs contain the same options.
Options
(continued)

You can plot the graphs as a curve, points, or both.

Select **Overlay samples** to overlay data from the current plot with data from other samples. The other sample files are selected by clicking **Overlays** on the Report Options dialog.

**Autoscale** options enable you to have the X- and/or Y-axes automatically scaled.

Linear X-axes begin at zero, and logarithmic X-axes begin at an appropriate value. Y-axes begin at zero. The system uses the highest values collected during analysis as the ending points for axes ranges.

If you choose not to autoscale data, the **From** and **To** fields are enabled, allowing you to specify a range. Data collected outside these ranges are not included in the plot.

The value entered in the **To** field must be greater than the value entered in the **From** field.

The X-axis fields show the relative pressure. The Y-axis fields show the quantity of gas adsorbed.

Tabular Options

Enables you to have **Run Time** and/or **Time Between Points** reported. Run time reports the time elapsed from the beginning of the analysis to the finish. Time between points reports the time elapsed between each point.

Also enables you to report **Weight %** when plotting pressure composition.

Plot Options

Enables you to choose the type of isotherm you wish to plot. You can plot the adsorption and/or the desorption isotherm.

Volume Adsorbed

Enables you to choose the manner in which the volume adsorbed is reported. These data are reported by default as **Per Gram** (cm$^3$/g). However, you can choose to report data **Per BET Surface Area** (cm$^3$/m$^2$) or **Per Other Surface Area** (m$^2$/g). If the latter field is selected, a field is enabled allowing you to enter a value.
Weight

The **Adsorbate Molecular Weight** field is enabled when you choose *Pressure Composition plot*, allowing you to enter the molecular weight of the adsorbate.

**BET/Langmuir Surface Area Report Options**

- The BET calculation obtains the sample surface area value by determining the monolayer volume of adsorbed gas from the isotherm data.

- The Langmuir calculation determines the surface area of a sample by relating the surface area to the volume of gas adsorbed as a monolayer.

---

**Displays as Langmuir Surface Area Report Options if the Langmuir report is being edited.**

The Langmuir and BET Surface Area dialogs include the same fields; the operating instructions for both are the same.

**Tabular report**

Select this option to have a tabular report of the plotted data.

**BET transform plot**

Generates a traditional BET (Langmuir) surface area plot that is used to determine monolayer volume and BET C constant.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BET Isotherm plot</strong></td>
<td>Uses the BET (Langmuir) monolayer volume and constant to produce an isotherm.</td>
</tr>
<tr>
<td><strong>Overlay samples</strong></td>
<td>Allows you to overlay data of the selected type from the current plot with data from other samples. The other samples are selected by clicking Overlays on the main Report Options screen.</td>
</tr>
<tr>
<td><strong>Autoscale x-axis</strong></td>
<td>Select these options to have the X- and/or Y-axes scaled automatically.</td>
</tr>
<tr>
<td><strong>Autoscale y-axis</strong></td>
<td>Both X- and Y-axes begin at zero; the system uses the highest values collected during analysis as the ending points. If you choose not to autoscale data, the From and To fields are enabled, allowing you to enter the ranges.</td>
</tr>
<tr>
<td><strong>From/To fields</strong></td>
<td>Enabled when you choose not to autoscale data (deselect the Autoscale option), allowing you to specify the beginning and ending ranges of the X- and/or Y-axis. Data collected outside these ranges are not included in the plot. The values entered in the To field must be greater than the value entered in the From field.</td>
</tr>
<tr>
<td></td>
<td>The X-Axis Range fields show the relative pressure. The Y-Axis Range fields show the quantity of gas adsorbed.</td>
</tr>
</tbody>
</table>
Pressures

Displays the Report Pressure Table dialog so that you may edit or enter relative pressure points

If Use calculation assignments is not selected on the Collected/Entered dialog, the isotherm is interpolated to these pressure points, and those interpolated values are used in the BET calculations.

If Use calculation assignments is selected, the collected data are used.

Insert predefined

Displays the Surface Area Report Pressure Selection dialog, allowing you to select predefined points.

Choices: 1 Point, 3 Point, 5 Point, 5 Point Low Pressure

Insert

Inserts a row into the table above the selected line.

Delete

Deletes the selected row.

Clear

Removes all but one entry from the table; one entry is required. The rows do not have to be selected. A warning message requesting confirmation is displayed before the table is cleared.
Freundlich Isotherm

The Freundlich isotherm is an empirical isotherm that is used to model low-pressure adsorption data. It can also be applied to model some micropore isotherms.

**Specify monolayer capacity**
In this field, enter the monolayer capacity of the sample.

**Absolute pressure range**
Allows you to enter a pressure range when calculation assignments are not requested.

**Tabular report**
Select this option to have a tabular report of the pressure points generated.

**Transform plot**
Plots the log(p) vs log(Q) in a straight line.

**Isotherm plot**
Plots the absolute pressure vs quantity adsorbed. Shows best fit line.
**Overlay samples**

Choose this option to overlay Freundlich isotherm data from the current file with the same type of data from other samples (files). The desired files are chosen by clicking Overlays on the Report Options dialog.

**Autoscale x-axis**

**Autoscale y-axis**

Select these options to have the X- and/or Y-axis scaled automatically.

Both X- and Y-axes begin at zero; the system uses the highest values collected during analysis as the ending points.

If you choose not to autoscale data, the *From* and *To* fields are enabled, allowing you to enter the ranges.

The X-axis shows the log of absolute pressure and the Y-axis shows the quantity of gas adsorbed.

**From/To fields**

Enabled when you choose not to autoscale data (deselect the Autoscale option), allowing you to specify the beginning and ending ranges of the X- and/or Y-axis. Data collected outside these ranges are not included in the plot.
The Temkin isotherm is used to model adsorption data where the heat of adsorption drops linearly with increasing coverage.

**Specify monolayer capacity**

In this field, enter the monolayer capacity of the sample.

**Specify differential heat of adsorption at zero surface coverage**

Enter the differential heat of adsorption at zero surface coverage. This allows inclusion of all of Temkin constants.

**Absolute pressure range**

Allows you to enter a pressure range when calculation assignments are not requested.

**Tabular report**

Select this option to have a tabular report of the pressure points generated

**Transform plot**

Plots a linear form of the Temkin isotherm.
**Temkin Isotherm plot**
Overlays the Temkin isotherm with the analysis data.

**Overlay samples**
Choose this option to overlay Temkin isotherm data from the current file with the same type of data from other samples (files). The desired files are chosen by selecting **Overlays** on the Report Options dialog.

**Autoscale x-axis**
**Autoscale y-axis**
Select these options to have the X- and/or Y-axis scaled automatically.

Both X- and Y-axes begin at zero; the system uses the highest values collected during analysis as the ending points.

The X-axis shows the natural log of absolute pressure and the Y-axis shows the quantity of gas adsorbed.

If you choose not to autoscale data, the **From** and **To** fields are enabled, allowing you to enter the ranges.

**From/To fields**
Enabled when you choose not to autoscale data (deselect the Autoscale option), allowing you to specify the beginning and ending ranges of the X- and/or Y-axis. Data collected outside these ranges are not included in the plot.
t-Plot Report Options

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to micropores. Matrix area, the area external to micropores, is directly determined and often proves to be a valuable way of characterizing complex mixed materials.

![T-Plot Report Options](image)

**Thickness Curve**

Presents the type of thickness curves available.

- Reference
- Kruk-Jaroniec-Sayari
- Halsey
- Harkins and Jura
- Broekhoff-de Boer
- Carbon Black STSA

You can also apply the Frenkel-Halsey-Hill thickness curve using the Halsey option, and entering the appropriate values in the equation. Use **Edit** to edit the values in the equation.

**Edit**

Displays the equation for the type of thickness curve selected so that you may view or edit the values.
Reference

Displays the Entered t-Curve dialog allowing you to define a t-curve by entering the relative pressure and thickness values.

This table can also be created in another application if desired and imported into this dialog using Open. When creating the table in another application, the file must be saved as ASCII text with a .THK extension. Use a two-column format with the relative pressures in the first column and the thickness values in the second column. Columns must be separated by a space (or a tab).

Insert

Inserts a row above the selected row. A row cannot be inserted if the value in the selected row is at its lowest value; values must be strictly increasing. For example, in the table shown above the default value is 0.000000001. Therefore, you must use Ctrl + Down Arrow to insert rows.

Enables you to save the current table of values under a different name.
Delete
Deletes the selected row.

Clear
Clears the table of all but one entry; one entry is required.

Open
Enables you to import the values from an existing t-curve.

Save As

Kruk-Jaroniec-Sayari
Displays the Kruk-Jaroniec-Sayari Thickness Equation dialog.

You can edit the values for the numerator, the first element of the denominator, and the exponent. The range for a selected field is shown in the information bar at the bottom of the dialog.

Refer to Appendix C, Calculations, for more information.

Halsey
Displays the Halsey Thickness Equation dialog.

You can edit the values for the multiplier, numerator, and exponent. The range for a selected field is shown in the information bar at the bottom of the dialog.

Refer to Appendix C for more information.
**Harkins and Jura**

Displays the Harkins and Jura Thickness Equation dialog.

You can edit the values for the numerator, first element of the denominator, and exponent. The range for a selected field is shown in the information bar at the bottom of the dialog.

Refer to Appendix C for more information.

**Broekhoff-de Boer**

Displays the Broekhoff-de Boer Thickness Equation dialog.

You can edit the values for the multiplier, numerator, and exponent. The range for a selected field is shown in the information bar at the bottom of the dialog.

Refer to Appendix C for more information.
Carbon Black STSA

Displays the STSA Thickness Equation dialog.

![Carbon Black STSA Thickness Equation dialog](image)

All coefficients can be edited. The range for a selected field is shown in the information bar at the bottom of the dialog.

Refer to Appendix C for more information.

Surface Area group box

Allows you to choose the surface area value used for thickness calculations. You can use BET (most commonly used), Langmuir, or enter one of preference.

Pressure Range

Displays the Report Relative Pressure Range dialog so that you may specify minimum and maximum relative pressures to use with this report.

- If **Use calculation assignments is not selected** on the Collected/Entered dialog, all of the nonoutlier points of the collected data within the specified range are used for calculating the data for this report.

- If **Use calculation assignments is selected**, collected data points which are assigned to this report type are used.
<table>
<thead>
<tr>
<th><strong>Surface area correction factor</strong></th>
<th>This value corrects for surface areas that are not smooth and brings the values for BET surface area and micropore surface area into accordance. For most samples, the default value of 1.000 is adequate.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fitted Thickness Range</strong></td>
<td>Provides two fields, allowing you to enter the minimum and maximum thicknesses you wish to include in the thickness curve.</td>
</tr>
<tr>
<td><strong>Tabular report</strong></td>
<td>Select this option to generate a table of collected data.</td>
</tr>
<tr>
<td><strong>t-Plot</strong></td>
<td>Select this option to generate a graphical representation of the collected data.</td>
</tr>
<tr>
<td><strong>Overlay samples</strong></td>
<td>Allows you to overlay data from the current sample file with data from other sample files. The other sample files are chosen by clicking Overlays on the main Report Options screen.</td>
</tr>
<tr>
<td><strong>Autoscale x-axis</strong></td>
<td>Select these options to have the X- and/or Y-axes scaled automatically.</td>
</tr>
<tr>
<td><strong>Autoscale y-axis</strong></td>
<td>Both X- and Y-axes begin at zero; the system uses the highest values collected during analysis as the ending points.</td>
</tr>
<tr>
<td><strong>From/To fields</strong></td>
<td>Enabled when you choose not to autoscale data (deselect the Autoscale option), allowing you to specify the beginning and ending ranges of the X- and/or Y-axis. Data collected outside these ranges are not included in the plot.</td>
</tr>
<tr>
<td></td>
<td>The X-Axis Range fields show the relative pressure.</td>
</tr>
<tr>
<td></td>
<td>The Y-Axis Range fields show the quantity of gas adsorbed</td>
</tr>
</tbody>
</table>
Alpha-S Plot

The Alpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm using the quantity adsorbed at a relative pressure of 0.4.

Table

Provides two columns for entering the relative pressure (first column) and the alpha-s values (second column).

This table can also be created in another application if desired and imported into this dialog using Open. When creating the table in another application, the file must be saved as ASCII text with an ALS extension. Use a two-column format with the relative pressures in the first column and the alpha-s values in the second column. Columns must be separated by a space (or a tab).

Insert

Inserts a row above the selected row. A row cannot be inserted if the value in the selected row is at its lowest value; values must be strictly increasing. For example, in the table shown above, the default value is 0.000000001. Therefore you must use Ctrl + Down Arrow to insert rows.
Delete

Deletes the selected row.

Clear

Clears the table of all but one entry; one entry is required.

Open

Allows you to import the values from an existing alpha-s curve (ALS) into the table. One predefined curve is shipped with the analysis program. After the values are copied into the table, you may edit them if desired. Editing these values will not affect the file from which they were copied.

Save As

Enables you to save the current table of values under a file name.

Fitted Alpha-S range

Provides two fields for entering the minimum and maximum relative pressures from which the fit will be determined.

Ref. surface area

Enables you to enter the surface area from the reference curve. This value is used to calculate the sample surface area.

Relative pressure range

Provides two fields for entering a pressure range when calculation assignments are not used.

Tabular report

Select this option to generate collected data in a tabular manner.

Alpha-S plot

Select this option to generate collected data graphically.

Overlay samples

Allows you to overlay data from the current sample file with data from other sample file(s). The other sample file(s) are chosen by clicking Overlays on the main Report Options screen.
Autoscale x-axis
Autoscale y-axis

Select these options to have the X- and/or Y-axes scaled automatically.

Both X- and Y-axes begin at zero; the system uses the highest values collected during analysis as the ending points.

If you choose not to autoscale data, the From and To fields are enabled, allowing you to enter the ranges.

From/To fields

Enabled when you choose not to autoscale data (deselect the Autoscale option), allowing you to specify the beginning and ending ranges of the X- and/or Y-axis.

Data collected outside these ranges are not included in the plot.

The X-Axis Range fields show the relative pressure.

The Y-Axis Range fields show the quantity of gas adsorbed.
f-Ratio Plot

The f-Ratio report allows you to take the measured isotherm and normalize it using a reference isotherm.

Reference Isotherm
Displays the sample file you choose as a reference. You should always choose a file containing an isotherm measured from a non-porous sample of the same material as the current sample.

Browse
Click to choose the sample file you wish to use as a reference for the isotherm.

Relative pressure range
Allows you to enter a pressure range when calculations assignments are not used.

Tabular report
Choose this option to have a tabular report generated. The tabular report contains four columns: relative pressure, quantity adsorbed for the isotherm of interest, quantity adsorbed for the reference isotherm, and the ratio of the quantities adsorbed.

f-Plot
Choose this option to have the data plotted as a graph.
**Overlay samples**

Allows you to overlay data from the current sample file with data from other sample file(s). The other sample file(s) are chosen by clicking Overlays on the main Report Options screen.

**Autoscale x-axis**

**Autoscale y-axis**

Select these options to have the X- and/or Y-axes scaled automatically.

Both X- and Y-axes begin at zero; the system uses the highest values collected during analysis as the ending points.

If you choose not to autoscale data, the **From** and **To** fields are enabled, allowing you to enter the ranges.

**From/To fields**

Enabled when you choose not to autoscale data (deselect the Autoscale option), allowing you to specify the beginning and ending ranges of the X- and/or Y-axis. Data collected outside these ranges are not included in the plot.
BJH Adsorption/Desorption Report Options

The BJH Adsorption and Desorption dialogs include the same fields; the operating instructions for both are the same.

The BJH calculation determines the mesopore volume/area distribution which accounts for both the change in adsorbate layer thickness and the liquid condensed in pore cores. You can generate BJH reports from adsorption and desorption data.

**Thickness Curve Type**

Presents the type of thickness curves available.

- Reference
- Kruk-Jaroniec-Sayari
- Halsey
- Harkins-Jura
- Broekhoff-de Boer
- Carbon Black STSA (ASTM D-6556-01A)

You can also apply the Frenkel-Halsey-Hill thickness curve using the Halsey option, and entering the appropriate values in the equation. Use **Edit** to edit the values in the equation. Halsey is the default thickness curve and typically is used for BJH calculations.
If you select a thickness curve which is not a good match for the sample being analyzed, an incomplete pore distribution may be generated.

**Edit**

Displays the equation for the type of thickness curve selected.

Refer to t-Plot Report Options, page 5-49 for information on the equations for thickness curves.

**Minimum/Maximum BJH**

Provides fields for entering the minimum and maximum size pore to be included in BJH reports.

The size can be reported in width (default), radius, or diameter. Select Options > Units to specify the desired unit.

**Fraction of pores open at both ends**

During calculations, the software assumes that all pores are closed at one end. Sometimes a percentage of pores may be open at both ends, causing disagreement in the adsorption and desorption data or in the values for total volume and total BJH pore volume. Enter a value in this field to compensate for this error.

This field does not display on the BJH Desorption Report Options dialog.

Due to normal hysteresis, data may disagree even after applying this corrective factor.
**Adsorptive**

Displays the BJH Adsorptive Options dialog, allowing you to specify up to ten adsorptive/adsorbate property factor combinations.

The recommended adsorptives and their values are shown. You may specify up to six additional adsorptive/adsorbate property factor combinations.

The adsorbate property factor is the combination of constants in the numerator of the BJH equation which is specific to the type of gas used. Adsorbate property factors may be specified in angstroms or nanometers. Select **Options > Data Presentation > Units** to specify desired units.

**Smooth differentials**

Smoothes all of the differential calculations, eliminating variations in the differential computation caused by noise in the input data.

**Cumulative Reports**

Select **Larger** to report the total volume found in pores larger than the current pore size. This is the traditional way in which BJH data are displayed.

Select **Smaller** to report the total volume found in pores smaller than the current pore size.
Pressure Range Displays the Report Relative Pressure Range dialog so that you may specify minimum and maximum relative pressures to use with this report.

If Use calculation assignments is not selected on the Collected/Entered dialog, all of the nonoutlier points of the collected data within the specified range are used for calculating the data for this report.

If Use calculation assignments is selected, collected data points which are assigned to this report type are used.

BJH Correction Enables you to choose the type of correction to apply to calculations. The type you choose will be displayed in the report header.

Standard Uses original BJH models.

Kruk-Jaroniec-Sayari Good for reference thickness curves.

Faas Good for statistical thickness curves.

Selected Reports Lists the available BJH reports.

Tabular Report Cumulative Pore Volume 
\( dV/d\times Pore Volume \) 
\( dV/d\log(\times) Pore Volume \) 
Cumulative Pore Area 
\( dA/d\times Pore Area \) 
\( dA/d\log(\times) Pore Area \) 
\* = width, radius, or diameter

Choose a report by double-clicking on the report name or click the report name and press Spacebar. A report is selected when it is preceded with a check mark.

Edit Displays an associated dialog for the selected report. Editing options for available reports are shown in subsequent sections.
You can measure port width (W), pore radius (R), or pore diameter (D) for BJH reports. Select Options > Units to specify desired measurement.

Tabular Report

The BJH Adsorption/Desorption tabular report allows you to specify the method of data reduction.

You can measure pore width, diameter, or radius; pore size can be expressed in angstroms or nanometers. Select Options > Units to specify desired units.

Fixed pore size table  Select this option to specify exact pore sizes for which volume or area data are reported. Only the pore sizes within the specified range appear on the report. Click Table to enter (or edit) a fixed pore size table.

Collected points  Select this option to include in the report calculations the values collected by the system.
**Columns**

Displays the BJH Adsorption (or Desorption) Tabular Report column Options dialog, allowing you to select up to six columns of data for the tabular report.

The default column title appears next to the column number. Each column includes a pull-down list of the data types to include in the report; the pore width, radius, or diameter can be measured (select **Options > Units** to choose the desired unit).
Table

Enabled when Fixed pore size table is selected for tabular data. Displays the BJH Adsorption (or Desorption) Fixed Pore Size Table dialog, allowing you to enter or edit a fixed pore size table.

The table must contain a minimum of two points and may include as many as one thousand. Points must be strictly decreasing.

Insert

Inserts a row into the pressure table. The row is inserted above the selected row and the cursor moves to the new row.

Delete

Deletes the selected row from the pressure table.

Clear

Removes all entries (except the two required ones) from the table. A warning message requests confirmation before the table is cleared.
Plot Options

Selecting a BJH plot option from the BJH Adsorption or Desorption Report Options dialog enables you to specify the plotting method used for your report and to customize the plot.

You can measure pore width, diameter, or radius; pore size can be expressed in angstroms or nanometers. Select Options > Units to specify desired units.

When you edit a BJH Adsorption or Desorption plot, a dialog similar to the following is displayed.

**Plot Options**

Allows you to have data plotted as a curve, points, or both.

**X-Axis**

Lists the scale options for the x-axis

**Linear/Logarithmic**

Choose whether you wish to have the X-axis on a logarithmic or linear scale. Unless you are performing micropore analyses, use the logarithmic option.
**Autoscale**
Choose this option to have the x-axis scaled automatically. Linear X-axes begin at zero, and logarithmic X-axes begin at an appropriate value. The system uses the highest values collected during analysis as the ending points.

If you deselect this option, the corresponding fields are enabled so that you may enter a beginning and ending value. Data collected outside the specified ranges are not included in the plot.

X-axis range fields show pore radius or diameter in angstroms or nanometers.

Data ranges are displayed in the information bar across the bottom of the dialog when the cursor is in a numerical data entry field.

**Y-axis**
Lists the options for the Y-axis.

**Variable**
Click on the down-arrow to choose a variable for the Y-axis.

**Overlay**
Displays a list of overlay choices. You can choose a different type of plot to overlay with the current plot. Or, you can choose **Samples** to overlay the current type of plot with the same type from other sample files. If you choose Samples, you select the other files using **Overlays** on the Report Options dialog box.

**Autoscale**
Choose this option to have the y-axis scaled automatically. Y-axes begin at zero. The system uses the highest values collected during analysis as the ending points.

If you deselect this option, the corresponding fields are enabled so that you may enter a beginning and ending value. Data collected outside the specified ranges are not included in the plot.

Y-axis range fields show the quantity of gas adsorbed.

Data ranges are displayed in the information bar across the bottom of the dialog when the cursor is in a numerical data entry field.
Dollimore-Heal Adsorption/Desorption Report Options

You can generate DH reports from both adsorption and desorption data.

The options for Dollimore-Heal reports are the same as those for the BJH reports with the exception of BJH Correction and Adsorptive properties; this item is not applicable to DH reports. Refer to BJH Adsorption/Desorption Report Options, page 5-60 for a description of the fields on this dialog.
Horvath-Kawazoe Report Options

Pore Geometry
Select the option in this group box which best represents the physical geometry of the micropores in the sample material. Refer to Appendix C for additional information on calculations used for these parameters.

Apply Cheng/Yang correction
Allows you to apply the Cheng/Yang correction to the pore size analysis. This correction substitutes the Langmuir equation of state for Henry’s Law in the Horvath-Kawazoe derivation (see Appendix C).

Smooth differentials
Smoothes the differential calculations, eliminating variations in the differential computation caused by noise in the input data.
Pressure Range
Displays the Report Relative Pressure Range dialog so that you may specify minimum and maximum relative pressures to use with this report.

- If Use calculation assignments is not selected on the Collected/Entered dialog, all of the nonoutlier points of the collected data within the specified range are used for calculating the data for this report.

- If Use calculation assignments is selected, collected data points which are assigned to this report type are used.

Interaction Parameter
Select one of the options in this group box to determine which interaction parameter is used during report generation.

Computed
The interaction parameter is calculated using the parameters on the Horvath-Kawazoe Physical Properties dialog. You can click Properties to view or edit these parameters. Each time you change one of the parameters, the interaction parameter is recalculated. The formula for computing the interaction parameter is given in Appendix C.

Entered
The value you enter in the adjacent field will be used.
Properties

Use this push button to view or edit the constants (used during report generation) describing the physical properties of the adsorbent and adsorptive; the Horvath-Kawazoe Physical Properties dialog box is displayed.

Adsorbent Group Box

Contains the parameters for the sample. If you select Computed for the interaction parameter, all fields are enabled and can be edited if desired. If you select Entered, only the values in the Diameter and Diameter at zero energy fields may be edited.

Description

The name of the adsorbent used in the analysis.

Click on the down arrow to make a new selection. Each time you change the selection, the values for that adsorbent are displayed in the appropriate fields.

Diameter

The diameter of the sample atom.

Diameter at zero energy

The diameter of an atom at zero interaction energy, \((2/5)^{1/6} \times \text{diameter}\).
Adsorbent Group Box  

(continued)

Polarizability  
The polarizability of the adsorbent.

Magnetic susceptibility  
The magnetic susceptibility of the adsorbent.

Density  
The density per unit area of the adsorbent.

Adsorptive Group Box  

Contains the parameters for the adsorptives (provided with the software and/or user-defined). If you select Computed for the interaction parameter, all fields are enabled and can be edited if desired. If you select Entered, only the values in the Diameter and Diameter at zero energy fields may be edited.

Mnemonic  
The mnemonic name of the adsorptive gas in use.

Click on the down arrow to make a new selection. Each time you change the selection, the values for that adsorptive display in the appropriate fields. If no parameters have been defined, the default values are displayed.

Diameter  
The diameter of the adsorptive atom.

Diameter at zero energy  
The diameter of an atom at zero interaction energy, $(2/5)^{1/6} \times \text{diameter}$.

Polarizability  
The polarizability of the adsorptive.

Magnetic susceptibility  
The magnetic susceptibility of the adsorptive.

Density  
The density per unit area of the adsorptive.
**Selected Reports**

Lists the available Horvath-Kawazoe reports. Choose a report by double-clicking on the report name or highlight the report name and press the **Spacebar**. A report is selected when it is preceded with a check mark.

The following reports are available:

- Tabular Report
- Cumulative Pore Volume
- dV/dw Pore Volume

**Edit**

Allows you to edit the selected report.

**Tabular Report Options**

Displays the Horvath-Kawazoe Tabular Report Column Options dialog so that you can select the type of data to display in each column.

The default column title displays next to the column number. Each column includes a drop-down list of the types of data to include in the report.
Plot Options

Selecting a Horvath-Kawazoe plot option from the Horvath-Kawazoe Report Options dialog enables you to specify the plotting method used for your report and to customize the plot. Plots for Cumulative Pore Volume and dV/dw Pore Volume are available.

When you select either of these plots from the Horvath-Kawazoe Report Options dialog, a dialog like the following is displayed.

![Horvath-Kawazoe Cumulative Pore Volume Options](image)

**Plot Options**

Lists the data presentation styles available; you must choose to plot a curve, points, or both.

**X-axis options**

Choose *Autoscale* to have the x-axis scaled automatically. The X-axis begins at zero and the system uses the highest value collected during analysis as the ending point.

If you deselect *Autoscale*, the adjacent fields are enabled so that you may enter a beginning and ending value. Data collected outside these ranges are not included in the plot.

X-axis range fields show pore radius or diameter in angstroms or nanometers.

Data ranges are displayed in the information bar across the bottom of the dialog when the cursor is in a numerical data entry field.
**Y-axis options**

Click on the down-arrow at the Variable field to choose a variable for the Y-axis.

Click on the down-arrow at the Overlay field to overlay the plot with data from other samples.

Choose **Autoscale** to have the y-axis scaled automatically. Y-axes begin at zero. The system uses the highest value collected during analysis as the ending point.

If you deselect **Autoscale**, the corresponding fields are enabled so that you may enter a beginning and ending value. Data collected outside these ranges are not included in the plot.

Y-axis range fields show the quantity of gas adsorbed Data ranges are displayed in the information bar across the bottom of the dialog when the cursor is in a numerical data entry field.
DFT Pore Size

**Type**
Drop-down list containing the types of models available; DFT or Classical.

DFT models are based on the density functional theory. Classical models are based on the Kelvin equation and thickness for determining the pore size distribution. Refer to Appendix G for a discussion on models.

**Geometry**
Drop-down list containing pore shapes available; Slit or Cylinder.

**Models**
Lists the models that meet the criteria specified and which match the adsorbate and temperature of the sample data.

The models display in alphabetical order with the first one automatically selected; you may select any one desired.

If the list is empty, there were no models that meet the selected criteria.

**Link to Micromeritics Web Site**
Provides access to the Micromeritics Web page containing the DFT models.
Pressure Range
Displays the Report Relative Pressure Range dialog so that you may specify minimum and maximum relative pressures to use with this report.

- If Use calculation assignments is not selected on the Collected/Entered dialog, all of the nonoutlier points of the collected data within the specified range are used for calculating the data for this report.

- If Use calculation assignments is selected, collected data points which are assigned to this report type are used.

Regularization
These choices enable you to choose the extent of smoothing you wish to have applied to your data, or you can choose None.

If you choose Entered, its field is enabled allowing you to enter a number giving a relative weight for the smoothing during deconvolution. Larger values produce more smoothing.

Reports to Generate
Displays the types of reports available.

- Pore Size table
- Isotherm table
- Cumulative area graph
- Incremental area graph
- Differential area graph
- Log goodness of fit graph
- Goodness of fit graph

Graph details can be edited by selecting the Edit push button.
Edit

Use this push button to edit details of a selected graph; a dialog like the following is displayed.

**Plot Type**

Enables you to choose the manner in which you wish to display plotted data.

**Autoscale Options**

Select these options to have the axes scaled automatically.

If you deselect one or both of these options, you must enter a range in the related **Axis Range** fields which become enabled automatically.

**Overlay**

This drop-down list contains the type of overlays available for the current graph.

Choose **Samples** to overlay the same type of graph as the current one from other data reductions. Then select **Overlays** on the Report Options dialog to choose your files (explained on page 5-35).

**Axis Range**

The fields in this group box become enabled when you deselect Autoscale, allowing you to specify beginning and ending values for the X- and/or Y-axis. Data collected outside these ranges are not included in the plot.

Valid ranges for a selected field are displayed in the information bar across the lower portion of the dialog. The X-axis displays the energy and the Y-axis displays the area.
Surface Energy

The fields on the Surface Energy dialog are identical to those on the DFT Pore Size dialog with the following exceptions:

**Geometry drop-down list**  
Is not applicable to the Surface Energy report and, therefore, does not display on its dialog.

**Reports to Generate**  
Displays the types of reports available.

- Surface energy table
- Isotherm table
- Cumulative area graph
- Incremental area graph
- Differential area graph
- Log goodness of fit graph
- Goodness of fit graph

Graph details can be edited by selecting the **Edit** push button.

Refer to the previous section for the DFT Pore Size report beginning on page 5-77 for information on the fields contained on this dialog.
Dubinin Report Options

Report Type

Allows you to specify the type of report you want. At least one type of report must be selected.

Select Radushkevich to generate the Radushkevich report.

Select Astakhov to generate the Astakhov report. With this choice, you may select Optimize Astakhov exponent. If you do not select this option, the Exponent value field is enabled so that you can enter a value.

Refer to Appendix C for more information.

Fitted relative pressure range

Allows you to specify minimum and maximum limits on relative pressures included in the line fit. Data collected outside these limits are not included.
Adsorptive

Displays the Dubinin Adsorptive Options dialog allowing you to specify up to 8 Adsorptive/Affinity Coefficient (beta) combinations.

Pressure Range

Displays the Report Relative Pressure Range dialog so that you may specify minimum and maximum relative pressures to use with this report.

- If Use calculation assignments is not selected on the Collected/Entered dialog, all of the nonoutlier points of the collected data within the specified range are used for calculating the data for this report.

- If Use calculation assignments is selected, collected data points which are assigned to this report type are used.

Selected Reports

Lists the available Dubinin reports. Choose a report by double-clicking on the report name or highlight the report name and press the Spacebar. A report is selected when it is preceded with a check mark.

The following reports are available:

Tabular Report
Transformed Isotherm
dV/dw Pore Volume (Astakhov only)
**Tabular Report**

The Tabular report enables you to customize your report with one to six columns of data for Astakhov reports and one to five columns of data for Radushkevich reports. The Dubinin Tabular Report Column Options dialog is displayed.

The default column title appears next to the column number. Each column includes a drop-down list of the data types to include in the report.

**Transformed Isotherm**

The Transformed Isotherm report allows you to restrict the line fit to a portion of the isotherm. The Dubinin Transformed Isotherm Plot Options dialog box is displayed.

**Overlay Samples**

Select this option to overlay the current plot with data from other samples. Then click Overlays on the Report Options dialog to choose the sample files.

**Autoscale x-axis**

**Autoscale y-axis**

Select these options to have the X- and/or Y-axes automatically scaled. Both X- and Y-axes begin at zero, and the system uses the highest values collected during analysis as the ending points for axes ranges.
Pore Volume

When you select the dV/dw Pore Volume plot from the Dubinin Report Options dialog, the Dubinin dV/dw Pore Volume Options dialog is displayed.

The Pore Volume report is unavailable if you choose Radushkevich as the type of report.

Plot options

You can plot data with a curve, points, or both.

Overlay Samples

Select this option to overlay data from other samples. Then click **Overlays** on the Report Options dialog to choose the files.
Autoscale x-axis
Autoscale y-axis

Select these options to have the X- and/or Y-axes automatically scaled. Both X- and Y-axes begin at zero, and the system uses the highest values collected during analysis as the ending points for axes ranges.

If you choose not to autoscale data for either (or both) axis, the adjacent fields are enabled so that you may enter a beginning and ending value. Data collected outside these ranges are not included in the plot.

The X-axis Range fields show pore width, radius, or diameter in angstroms or nanometers.

The Y-axis Range fields show the quantity of gas adsorbed.

Data ranges are displayed in the information bar across the bottom of the dialog when the cursor is in a numerical data entry field.
MP-Method Report Options

**Thickness Curve group box**  Select the type of thickness curve from this group box. You must choose either the Halsey equation or the Harkins and Jura equation. Use **Equation** to edit the values in the equation.

**Equation**  Displays the equation for the type of thickness curve selected

**Harkins and Jura**  Displays the Harkins and Jura Thickness Equation dialog.

You can edit the values for the numerator, first element of the denominator, and exponent. The range for a selected field is shown in the information bar at the bottom of the dialog.

Refer to Appendix C for more information.
Halsey Displays the Halsey Thickness Equation dialog.

You can edit the values for the multiplier, numerator, and exponent. The range for a selected field is shown in the information bar at the bottom of the dialog.

Refer to Appendix C for more information.

Pressure Range Displays the Report Relative Pressure Range dialog so that you may specify minimum and maximum relative pressures to use with this report.

- If Use calculation assignments is not selected on the Collected/Entered dialog, all of the nonoutlier points of the collected data within the specified range are used for calculating the data for this report.

- If Use calculation assignments is selected, collected data points which are assigned to this report type are used.

Selected Reports Lists the available MP-Method reports. Choose a report by double-clicking on the report name or highlight the report name and press the Spacebar. A report is selected when it is preceded with a check mark.

The following reports are available:

- Tabular Report
- Cumulative Pore Volume
- dV/dw Pore Volume
- Cumulative Pore Area
- dA/dw Pore Area
**Tabular Report**

The Tabular report enables you to customize your report with one to six columns of data. (The data types in the first and second columns cannot be changed.) The MP-Method Tabular Report Column Options dialog is displayed.

The default column title appears next to the column number for columns three through six. Each of these columns includes a drop-down list of the data types to include in the report. Columns 1 and 2 are fixed and cannot be edited.

> The MP-Method reports hydraulic radius only. If you select Pore size in diameter from the Units dialog, the MP-Method still reports pore size in radius.

---

**Pore Volume/Pore Area Plot**

MP-Method plot options enable you to specify the plotting method used for your report and to customize the plot. A dialog box like the following is displayed. The fields on all dialogs are the same.
### Plot options
You can plot data with a curve, points, or both.

### X-axis options
Choose **Autoscale** to have the x-axis scaled automatically. The X-axis begins at zero and the system uses the highest value collected during analysis as the ending point.

If you deselect Autoscale, the adjacent fields are enabled so that you may enter a beginning and ending value. Data collected outside these ranges are not included in the plot.

X-axis range fields show pore radius or diameter in angstroms or nanometers.

Data ranges are displayed in the information bar across the bottom of the dialog when the cursor is in a numerical data entry field.

### Y-axis options
Allows you to choose Y-axis options.

### Variable
Click on the down-arrow to choose a variable for the Y-axis.

### Overlay
You can use the choices in this drop-down list to overlay plots. You can choose a different type of plot for the current sample to overlay with the listed **Variable**, or you can choose **Samples** to overlay the **Variable** plot with the same type of plot from other samples.

### Autoscale
Choose this option to have the y-axis scaled automatically. Y-axes begin at zero. The system uses the highest value collected during analysis as the ending point.

If you deselect **Autoscale**, the adjacent fields are enabled so that you may enter a beginning and ending value. Data collected outside these ranges are not included in the plot.

Y-axis range fields show the quantity of gas adsorbed.

Data ranges are displayed in the information bar across the bottom of the dialog when the cursor is in a numerical data entry field.
Options Report

The Options report provides pertinent information for the following:

- Degas conditions
- Adsorptive properties
- Analysis conditions
- Sample tube criteria
- Free space
- Po and temperature
- Equilibration
- Isotherm collection

The Options report cannot be edited.

Sample Log Report

The Sample Log report displays the following:

- Manual control operations performed during analysis
- Information entered using Add Log Entry on the sample file editor
- Warnings and/or errors which occurred during analysis

The Sample Log report is a new feature with the ASAP 2020 program. Therefore, if you request a Sample Log report on a file that was used with the ASAP 2010 program, no information will be available.

The Sample Log report cannot be edited.
Validation Report

Use this report to have your data examined by the software to determine if the results are within typical ranges.

If the data for any report you selected for validation are determined to be out of range, a warning is displayed and suggestions are given for corrective action. This information is also detailed in the report and plotted on the graph as a unique plot symbol.
**Collected/Entered Data**

If you choose **Manually entered** as the type of data in the Sample Information dialog, an **Entered** tab is added allowing you to enter the data.

If you choose **Automatically collected** as the type of data in the Sample Information dialog, a **Collected Data** tab is added when analysis is complete. The Collected Data dialog will contain the data points collected during analysis and the specified calculation assignments.

This example shows the Collected Data dialog from a completed sample information file; the Entered dialog is identical except the data is entered and the tab displays as Entered Data.

---

**Pressure table**

For collected data, columns for the following are displayed:

- absolute pressure
- relative pressure
- quantity adsorbed
- outliers (if **Use calculation assignments** is not selected)
- calculation assignments for each requested report option (if **Use calculation assignments** is selected)
<table>
<thead>
<tr>
<th><strong>Pressure table (continued)</strong></th>
<th>For <strong>entered data</strong>, columns for the following are displayed:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• absolute or relative pressure (depending on the selection in the <strong>Pressures</strong> group box)</td>
</tr>
<tr>
<td></td>
<td>• quantity adsorbed</td>
</tr>
</tbody>
</table>

| **Insert** | Enabled for entered data; inserts a row into the pressure table. |
| **Delete** | Enabled for entered data; deletes the selected row. |
| **Clear**  | Enabled for entered data; clears the entire table of all entries except one (one is required). |

| **Use calculation assignments** | If selected, allows you to assign the points to be collected for each report type. |
|                                | If deselected, each report (with the exception of Langmuir and BET) uses a range of pressures as selected in Report Options. The Langmuir and BET reports interpolate to entered relative pressures on Report Options. |
|                                | The outlier points can be selected so that they will not be reported. |

| **Po and T** | Displays the Po and T dialog, allowing you to edit the saturation pressure and temperature. Only the applicable options are enabled. |
**Free Space**

Displays the Free Space dialog, allowing you to edit the cold and warm free spaces.

Also allows you to choose how to account for non-ideal behavior of the adsorptive (refer to "Real gas equation of state" on page 5-33).

This dialog also includes the plotted isotherm. The isotherm is redrawn each time you edit the values in either field.

Also available for the isotherm is a shortcut menu containing options allowing you to edit the curve and axes. You also can zoom in for finer detail. Refer to **Onscreen Reports**, page 7-18 for the options available.

---

**Save**

Save enables you to save any changes you have made to the file in the active window. The file is saved under its current name.
Save As

Save As enables you to:

- save a sample or parameter file in the active window under a different name. This option is useful for making a duplicate copy of a file that you can modify as desired without changing the original one. The original file remains open when you use this function, so be sure to open the new file before making any changes.

- save a subset (parameter) of the sample file in the active window as a standalone parameter file. For example, select Analysis Conditions from the Save As menu to create a standalone parameter file of the analysis conditions portion of the active sample file.

- save as an ASCII file the relative pressures and corresponding thicknesses (t-Curve) from the collected data. These data are derived by dividing the condensed volume of adsorptive by the selected surface area. The density conversion factor in the adsorptive properties file is used to convert quantity adsorbed to volume of condensed adsorptive.

- save as an ASCII file the relative pressures and resulting quantities adsorbed (Alpha-S) from the collected data. These data are derived by taking the isotherm and dividing it by the quantity adsorbed at 0.4 relative pressure.

Sample and Parameter Files

A dialog similar to the one shown below is displayed when you select Sample Information, Sample Tube, Degas Conditions, Analysis Conditions, Adsorptive Properties, or Report Options.

![Save As Sample Information File dialog](image)

Enter a file name (up to eight characters) in the File name field; the appropriate extension is appended automatically when you click OK. The new file is saved as specified, but does not remain in the active window. Be sure to open the new file before making any changes to the file.
t-Curve and Alpha-S Files

The same type of dialog box shown above is also displayed when you select t-Curve or Alpha-S. However, before you receive this dialog for t-Curve, the Save As t-Curve dialog is displayed. This dialog allows you to choose the surface area for the sample.

Save All

Save All enables you to save all open files under their current names. This option provides a faster way to save all open files at one time and avoids having to perform a Save operation on each individual file.

Close

Close enables you to close the file in the active window. If the file contains changes that have not been saved, the following message is displayed:

(file name) has been changed. Save changes before closing?

Yes  No  Cancel

Click Yes to close the file and save the changes.
Click No to close the file without saving the changes.
Click Cancel to return to the active file.
Close All

Close All enables you to close all open files under their current names. The following message displays for every file containing changes that have not been saved:

(file name) has been changed. Save changes before closing?

Yes  No  Cancel

Click Yes to close the file and save the changes.
Click No to close the file without saving the changes.
Click Cancel to return to the active file.
Print

Print enables you to print the contents of one or more files to the screen, a printer, or a file. For example, if you choose Analysis Conditions, you will receive the parameters used for all analysis conditions associated with the file(s). The print dialog is common to all file types.

Select the desired file type from the drop-down menu; a dialog similar to the following is displayed:

- **File name**: The name of the file you choose to print is copied to this field. If you choose multiple files, the name of the last one selected is displayed.

- **Copies**: Enabled when Printer is selected as the print destination. You may print up to four copies.

- **Destination**: Select the destination. You may print to a printer, the screen, or to a file.

- **File name**: Enabled when you select File as the destination. A default file name (the same name as the sample file) appears if you choose only one file; you can use the default name or enter another one.
Refer to Selecting Files on page 3-11 for a description of the other fields on this dialog and the Date Range push button.

List

List enables you to generate a listing of the following information on a selected sample or parameter file.

- File name
- Date the file was created or last edited
- Time the file was created or last edited
- File identification
- File status

Regardless of the type of file you choose, the dialogs are similar; the options presented in the header vary slightly. The types of dialogs displayed are identical to the ones displayed for the Print function; you simply obtain different types of information. This example shows a dialog for sample files.

![List Sample Information File](image)

Indicates the type of file on which you have requested a list of statistics

Refer to Print, page 5-98 for an explanation of the fields on this dialog.

You may request a list of multiple files by holding down Ctrl while selecting files. If no files are selected, a list is generated for all files.
Export

Export copies the isotherm data in the sample information file and reformats it in a text format acceptable to other programs, such as spreadsheets. The output file consists of five columns containing the elapsed time, absolute pressure, relative pressure, and specific quantity absorbed, and quantity dosed (see example on next page).

File Name

The name of the file you choose to export is copied to this field. If you choose multiple files, the name of the last one selected is displayed.

Destination

You can export data to a printer, to the screen, or to a File.

If you select Printer, the Copies field is enabled allowing you to print up to four copies.

If you select File, the File Type and File name fields are enabled.

File Type

You can export data in a spreadsheet format (XLS) or as a text file (TXT).
### File Name

Allows you to specify a name for your exported file, or you may accept the default. The default name is the name of the sample file appended with the appropriate extension.

### Format of Data Output

This example shows the format of the output file for exported data.

<table>
<thead>
<tr>
<th>Description</th>
<th>13X Reference (Ar) (example)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
<td>Sample File</td>
</tr>
<tr>
<td>Submitter</td>
<td>TK</td>
</tr>
<tr>
<td>Sample mass</td>
<td>0.1918</td>
</tr>
<tr>
<td>Type of Data*</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Elapsed time</th>
<th>Absolute pressure</th>
<th>Relative pressure</th>
<th>Specific quantity adsorbed</th>
<th>Quantity dosed</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.13</td>
<td>0.0062572</td>
<td>0.000000355</td>
<td>3.05747</td>
<td>0.58726</td>
</tr>
<tr>
<td>3.21</td>
<td>0.0124568</td>
<td>0.000016554</td>
<td>6.11118</td>
<td>1.17384</td>
</tr>
<tr>
<td>4.30</td>
<td>0.0195110</td>
<td>0.000026974</td>
<td>9.16535</td>
<td>1.75016</td>
</tr>
<tr>
<td>5.36</td>
<td>0.0274382</td>
<td>0.000030682</td>
<td>12.21964</td>
<td>2.34677</td>
</tr>
<tr>
<td>6.37</td>
<td>0.0350114</td>
<td>0.000048234</td>
<td>15.27365</td>
<td>2.93340</td>
</tr>
<tr>
<td>7.27</td>
<td>0.0453694</td>
<td>0.000060932</td>
<td>18.32729</td>
<td>3.52001</td>
</tr>
<tr>
<td>8.12</td>
<td>0.0549884</td>
<td>0.000073578</td>
<td>21.38107</td>
<td>4.10669</td>
</tr>
<tr>
<td>8.56</td>
<td>0.0647505</td>
<td>0.000086652</td>
<td>24.42503</td>
<td>4.83934</td>
</tr>
<tr>
<td>8.50</td>
<td>0.0744669</td>
<td>0.000099395</td>
<td>27.46892</td>
<td>5.55012</td>
</tr>
<tr>
<td>10.36</td>
<td>0.0843877</td>
<td>0.000113007</td>
<td>30.54317</td>
<td>6.28693</td>
</tr>
<tr>
<td>11.23</td>
<td>0.0940951</td>
<td>0.000126040</td>
<td>33.59755</td>
<td>6.45374</td>
</tr>
<tr>
<td>12.10</td>
<td>0.1037792</td>
<td>0.000139049</td>
<td>36.65230</td>
<td>7.04061</td>
</tr>
<tr>
<td>12.57</td>
<td>0.1133715</td>
<td>0.000151941</td>
<td>39.70670</td>
<td>7.82741</td>
</tr>
<tr>
<td>13.39</td>
<td>0.1241400</td>
<td>0.000166412</td>
<td>42.76178</td>
<td>8.21345</td>
</tr>
<tr>
<td>14.21</td>
<td>0.1350450</td>
<td>0.000179195</td>
<td>45.81652</td>
<td>8.60122</td>
</tr>
<tr>
<td>15.09</td>
<td>0.1459705</td>
<td>0.000191654</td>
<td>48.87221</td>
<td>9.38824</td>
</tr>
<tr>
<td>16.50</td>
<td>0.1524950</td>
<td>0.000204574</td>
<td>51.93727</td>
<td>9.97510</td>
</tr>
<tr>
<td>16.32</td>
<td>0.1603960</td>
<td>0.000217483</td>
<td>54.98290</td>
<td>10.56223</td>
</tr>
<tr>
<td>17.07</td>
<td>0.1721800</td>
<td>0.000231081</td>
<td>58.03778</td>
<td>11.14918</td>
</tr>
<tr>
<td>17.47</td>
<td>0.1822500</td>
<td>0.000244517</td>
<td>61.09369</td>
<td>11.73633</td>
</tr>
<tr>
<td>18.25</td>
<td>0.1927750</td>
<td>0.000258385</td>
<td>64.14918</td>
<td>12.32344</td>
</tr>
<tr>
<td>19.01</td>
<td>0.2038500</td>
<td>0.000273751</td>
<td>67.20437</td>
<td>12.91056</td>
</tr>
<tr>
<td>19.36</td>
<td>0.2153900</td>
<td>0.000289315</td>
<td>70.25985</td>
<td>13.49777</td>
</tr>
</tbody>
</table>

*0 = automatically collected  
1 = entered (relative pressures)  
2 = entered (absolute pressures)
Convert

Convert allows you to convert sample information files used with the ASAP 2000 to files compatible with the ASAP 2020 analysis program. You do not have to use the Convert function for ASAP 2010 files. You can open ASAP 2010 files using the Open command on the File menu. After an ASAP 2010 file is saved in the ASAP 2020 program, it is no longer compatible with the ASAP 2010 program. You will be warned of this and given the opportunity to save under a different name if desired.

The only files displayed are standard MICMOS 2000 files (SI*.DAT) and 2000 Micropore files (SM*.DAT).

**Destination File name**

This field enables you to specify different names for the converted files. You may choose one of the following options:

- Accept the default for the converted file name. If you accept this option, the converted files will retain their original names; only the extension will change. For example, if you choose si0140.dat from the Files list box, it is converted as si0140.smp.

- Type the name for the converted file. For example, if you wish to convert the following file on the C drive:

  From: C:\DATA1\SI0010.DAT
  To: C:\DATA2\SAMP90.SMP
  Then type: C:\DATA2\SAMP90.SMP
Refer to Selecting Files on page 3-11 for a description of the other fields on this dialog and the Date Range push button.

The following message is displayed when the first file containing a fixed pore size table is encountered:

**Fixed pore size tables will not be converted. If a sample file to be converted uses a fixed pore size table, the fixed pore size table can be entered after conversion is complete.**

This message informs you that fixed pore size tables are not converted to the new format. You must enter a fixed pore size table after conversion if you desire to use one with the sample information file. Click OK to clear the message.
Exit

Exit enables you to exit (close) the ASAP 2020 program.

- If an analysis is in progress, the following message is displayed:

  **CAUTION:** Sample analysis is in progress. If you exit
  the program analysis will continue to completion, but
  the data are not saved to disk until the program is
  restarted. Do you want to exit the program?
  
  Yes  No

  Click **Yes** to close the ASAP 2020 program. The analysis continues and data are collected. Click **No** to allow the program to remain active.

  Although data are stored in the analyzer when you exit the program during analysis, they are not saved in the file until the program is restarted. At that time the data are saved automatically. If a power failure occurs in the interim and you do not have an Uninterruptible Power Supply (UPS) attached, loss of data will result.

- If a report is in progress, you are cautioned that reports are being generated, and given the opportunity to either cancel the print job or allow the reports to print before exiting.

  Observe the Status area of the instrument schematic; it indicates when an analysis is complete.
6. UNIT MENU

The Unit menu contains the options for the operations that can be performed with the ASAP 2020 analyzer. The main menu will contain a Unit menu for each attached analyzer. For example, if you have two attached analyzers, the main menu contains two Unit menus. The appropriate unit number and serial number display in the title bar of the operational windows. The status windows also display in different colors. This feature is especially useful when you have more than one analyzer attached to the same computer.

The Unit menu does not display on the menu bar if the analysis program is being used for offline data manipulation on a computer other than the one controlling the analyzer.

Description

Listed below are brief descriptions of the Unit menu options. Detailed descriptions are found in subsequent sections.

Sample Analysis

Starts an analysis. This option is disabled if analyses are in progress. Page 6-3.

Start Degas

Allows you to start the degassing operation on one or two samples. Page 6-8.

Enable Manual Control

Allows you to control the system manually. Page 6-9.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show Instrument Schematic</strong></td>
<td>Displays a schematic of the analyzer components. Page 6-12.</td>
</tr>
<tr>
<td><strong>Show Status</strong></td>
<td>Shows the status window of the operation in progress. Page 6-13.</td>
</tr>
<tr>
<td><strong>Show Instrument Log</strong></td>
<td>Displays a log of recent analyses, calibrations, and error messages. Page 6-14.</td>
</tr>
<tr>
<td><strong>Unit Configuration</strong></td>
<td>Displays the configuration of the analyzer. Page 6-16.</td>
</tr>
<tr>
<td><strong>Diagnostics</strong></td>
<td>Enables you to perform certain diagnostic tests. Page 6-18</td>
</tr>
<tr>
<td><strong>Calibration</strong></td>
<td>Enables you to calibrate certain components of the analyzer. Page 6-20</td>
</tr>
<tr>
<td><strong>Degas</strong></td>
<td>Allows you to perform sample degassing operations. Enabled only if the SmartVac is installed. Page 6-26.</td>
</tr>
<tr>
<td><strong>Service Test</strong></td>
<td>Enables you to perform certain troubleshooting procedures. This option is enabled only with the direction of a Micromeritics service representative. Page 6-31.</td>
</tr>
</tbody>
</table>
Sample Analysis

When you select this option from the Unit menu, the Sample Analysis dialog is displayed with all fields disabled (grayed) and the Start Analysis dialog positioned on top. This allows you to select a sample file for your analysis or to create a new one.

After a sample file has been designated, the Analysis dialog is displayed. The fields now contain the values for the selected file or, if creating a new file, the specified defaults.

View

Allows you to view one of the following in the current window:

- the current operation
- the instrument schematic
- the instrument log

Refer to Show Instrument Schematic on page 6-12 and Show Instrument Log on page 6-14.

Browse

Displays the Start Analysis dialog allowing you to choose a different sample file for the current analysis.

Sample

Displays an identification of the sample file.

Mass

Enables you to enter the sample’s mass.
**Sample Tube**

Displays the name of the Sample Tube file for the current sample file.

If this is a new file, this field contains the file you specified as the default.

The drop-down list contains a list of predefined parameter files that were saved to the Parameter Files Directory (refer to Parameter Files Directory on page 8-13), as well as those included with the analysis program. You may choose a different file from this list if desired.

**Analysis Conditions**

Displays the name of the Analysis Conditions file for the current sample file.

If this is a new file, this field contains the file you specified as the default.

The drop-down list contains a list of predefined parameter files that were saved to the Parameter Files Directory (refer to Parameter Files Directory on page 8-13), as well as those included with the analysis program. You may choose a different file from this list if desired.

**Adsorptive Properties**

Displays the name of the Adsorptive Properties file for the current sample file.

If this is a new file, this field contains the file you specified as the default.

The drop-down list contains a list of predefined parameter files that were saved to the Parameter Files Directory (refer to Parameter Files Directory on page 8-13), as well as those shipped with the analysis program. You may choose a different file from this list if desired.
**Report Options**
Displays the name of the Report Options file for the current sample file.

If this is a new file, this field contains the file you specified as the default.

The drop-down list contains a list of predefined parameter files that were saved to the Parameter Files Directory (refer to [Parameter Files Directory](#) on page 8-13), as well as those shipped with the analysis program. You may choose a different file from this list if desired.

**Po**
Enabled if you have chosen to enter the Po measurement. Enter (or confirm) the saturation pressure of the adsorptive, or edit the current one if desired.

**Bath temperature**
Enabled if you have chosen to enter the bath temperature (Po and T option on the Analysis Conditions dialog). Enter (or confirm) the temperature for the analysis bath.

**Ambient Temperature**
Enter the temperature of the air outside of the instrument.

**Warm and Cold Free space**
Enabled if you have chosen to enter the free space values (Free Space option on the Analysis Conditions dialog). Enter (or confirm) the appropriate values.

**Report After Analysis**
Displays the Report Settings dialog so that you may specify report output options. If you choose Screen, reports have many options for being customized and manipulated. (Refer to [Onscreen Reports](#) on page 7-18 for details about onscreen reports.)
Export After Analysis

Allows you to have isotherm generated automatically after the analysis; displays the Export Settings dialog so that you may specify output options.

Start

Begins the analysis; after data start to collect, an analyzing view of the Analysis dialog is displayed.

Suspend

Suspended the analysis.

Skip

Skips the current step of the analysis.

Use the Skip function with caution; the ASAP performs multiple steps for a given task. Skipping certain steps may reduce the quality of the data, or cause instrument damage or personal injury.
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resume</td>
<td>Resumes a suspended analysis.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels the analysis.</td>
</tr>
<tr>
<td>Start</td>
<td>On this view of the analysis dialog, this push button changes to <strong>Next</strong> when the analysis is finished.</td>
</tr>
<tr>
<td>Next</td>
<td>Enabled at the completion of the analysis. Returns you to the first view of the Analysis dialog so that you may schedule another analysis.</td>
</tr>
<tr>
<td>Close</td>
<td>Enabled at the completion of analysis. Closes the dialog.</td>
</tr>
</tbody>
</table>
Start Degas

This option allows you to choose the file and start degas operations on one or two samples; the Automatic Degas dialog is displayed.

Sample

Click **Browse** to the right of this field to select a sample file that will be used with the current sample.

Degas Conditions

Displays the Degas Conditions file designated as the default. After you choose a sample file, this field displays the file associated with the sample file.

You can choose a different Degas Conditions file from the drop-down list if desired. If you choose a different file, the values in the current file will be overwritten with the values of the new one.

Clear

Clears the sample file from the port assignment. Click **Browse** to choose a different file.

Start

Starts the degassing operation

Cancel

Closes the dialog, cancelling the degassing operation.
Select this option to control certain components of your system manually. If the instrument schematic is not displayed, select **Instrument Schematic** from the **View** drop-down list.

When manual control is enabled, the valve symbols change color on the monitor screen to indicate their status.

Green = open
Yellow = closed

Use the mouse pointer to select a component. A component is selected when it is surrounded by a thin line. Each component has a shortcut menu displaying the operations available for that particular component. These menus may be accessed by right-clicking on the desired component, or by using the shortcut keys **Shift + F9**.

You can open and close valves, and raise or lower the elevator by using one of the following methods:

- right-click on the valve or elevator symbol to access the shortcut menu and select the appropriate action
- double-click on the valve or elevator symbol
- select the valve or elevator symbol and press the **Spacebar**
System valves and their functions are listed in Table 6-1.

**Actions:** Open, Close, Pulse

*Pulse* briefly opens and closes (or vice versa) the valve.

### Table 6-1. System Valves

<table>
<thead>
<tr>
<th>Valve</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Unrestricted vacuum</td>
</tr>
<tr>
<td>2</td>
<td>Restricted vacuum</td>
</tr>
<tr>
<td>3</td>
<td>Free-space measurement gas (helium)</td>
</tr>
<tr>
<td>4</td>
<td>Restricted analysis gas</td>
</tr>
<tr>
<td>5</td>
<td>Unrestricted analysis gas</td>
</tr>
<tr>
<td>7</td>
<td>Lower manifold isolation</td>
</tr>
<tr>
<td>8</td>
<td>Vapor</td>
</tr>
<tr>
<td>9</td>
<td>Sample port</td>
</tr>
<tr>
<td>10</td>
<td>Restricted Psat tube port</td>
</tr>
<tr>
<td>11</td>
<td>Unrestricted Psat tube port</td>
</tr>
<tr>
<td>P1 through P6</td>
<td>Gas inlet port valves</td>
</tr>
<tr>
<td>PS</td>
<td>Supply valve for physisorption gases</td>
</tr>
<tr>
<td>PV</td>
<td>Vacuum valve for physisorption gases</td>
</tr>
</tbody>
</table>

**Dewar positions**

The Dewar can be raised, lowered, or stopped.

- Indicates the Dewar is being raised; note the position of the arrow in the center of the Dewar symbol.

- Indicates the Dewar is being lowered; note the position of the arrow in the center of the Dewar symbol.

- Indicates the Dewar is stopped in the raised position.
Indicates the Dewar is stopped in the lowered position.

The remainder of the components are displayed for informational purposes only; they cannot be controlled manually.

Represents the sample tube.

Represents the Psat tube.

This group of rectangles on the left side of the schematic displays the temperature, the vacuum gauge pressure, and the transducer(s) currently installed. This representation shows all three transducers installed.
Show Instrument Schematic

Select this option to display a schematic of the ASAP 2020 analyzer. The schematic is a graphical representation of the plumbing system including system valves, the analysis station, and the Dewar position. The valves and Dewar can be controlled from the schematic when Manual control is enabled. Refer to Enable Manual control on page 6-9 for an explanation of the components displayed on the instrument schematic.

The state of the valves can be determined quickly by color representation even when manual control is not enabled:

- Green = open
- White = closed

If you wish to change the state of a valve, you must enable manual control.
Show Status

A status window is shown across the bottom of all operational dialogs as well as the instrument schematic. The Show Status option enables you to show only the status window. This frees up your computer screen allowing you to perform other tasks (such as creating or editing sample files), while still monitoring the progress of your analysis.

If you have multiple instruments attached to your computer, the status bar for each instrument is displayed in a different color.

![Status Window](image)

### Analysis status bar

Shows the progression of the analysis. This bar contains three stages:

- **Preliminary**: warm and cold free spaces are determined; displays green during progression
- **Analysis**: data are collected; displays blue during progression
- **Termination**: the dewar lowers, and the sample tube is warmed and backfilled; displays gray during progression

All stages are displayed in red if the analysis has been suspended.

### Analysis details

The following analysis details are displayed:

- **Sample**: Sample file number
- **Stage**: Stage of the analysis (as in status bar)
- **Last Point**: Last point and number of points requested
- **P**: Absolute pressure of last point
- **P/Po**: Relative pressure of last point
- **Q**: Quantity adsorbed
- **Po**: Absolute pressure of last measured or calculated saturation pressure (Po)
- **Run Time**: Elapsed time since the start of analysis

### Step details

Provides details of the current step of the analysis.
Show Instrument Log

Displays a log of recent analyses, calibrations, and errors or messages.

By default, this information is logged for a 60-day period for analyses and messages, and a 90-day period for calibrations. You may change the time for which this information is retained in the Unit section of the WIN2020.INI file. Simply replace the default value with the desired number.

**Analysis**

These options allow you to choose which entries are displayed in the window. For example, select the **Calibration** check box to display only calibration information.

**Add Log Entry**

Enables you to make an entry in the instrument log that cannot be recorded automatically through the application software. For example, you may change the port filter. The field adjacent to the push button allows you to enter the operation; the push button is enabled when you make an entry in the field, allowing you to add the entry.
Report

Displays the Log Report Settings dialog allowing you to generate the log contents to a specified destination.

![Log Report Settings dialog]

Use the **Start Date** field to specify the date at which to start the printout. This date does not limit the entries that display in the window, it is only pertinent to the entries that will be printed on the report.

You can specify a date using one of the following methods:

- Highlight the field (or press **F2** to clear the field) and type in the desired date.
- Double-click in the field (or press **F4**) to display a calendar to choose a date.
- Press **F2** to clear the field, then **F3** to insert the current date.

Enter the number of copies desired in the **Copies** field; you may print up to 4. This field is disabled if you are printing to a File or to the Screen.

Choose the report destination from the drop-down list in the **Destination** field. If you choose File, the **File name** field is enabled, allowing you to enter a name for the printed file (or you may accept the default).
Unit Configuration

Select this option to view the current calibration settings, the date on which calibration was performed, and the software and hardware configuration of your system.

**Volume Calibration**
Displays the system, lower, and reference volumes from the most recent calibration. It also displays the date and time the calibration was completed.

**A/D Calibration**
Displays the following:
- The date and time the manifold temperature was last calibrated.
- The date and time the transducer offsets were last calibrated.
- The percent of nominal transducer scale in use, and the date and time the transducer scale was last calibrated.
- The date and time the vacuum gauge was calibrated.
**Configuration**

Displays the following:

- The hardware code specifying the hardware components (for example transducers) present in your analyzer. This code is provided so the Service Department may quickly identify your hardware configuration and provide prompt assistance. Hardware codes translate as follows:
  
  \[ \begin{align*}
  E &= 1000\text{-mmHg transducer} \\
  G &= 10\text{- and } 1000\text{-mmHg transducers} \\
  H &= 1\text{-}, 10\text{-}, \text{ and } 1000\text{-mmHg transducers}
  \end{align*} \]

- The identification number of the port being used to control the analyzer.

- The serial number of the attached analyzer (active unit).

**Software Versions**

The software versions of the MIC BIOS, Controller, and ASAP 2020 System software.

**SmartVac Software Versions**

The software versions of the MIC BIOS and SmartVac software. This group box is not displayed if the SmartVac is not installed.

**Features**

The options currently enabled on your system (for example, MicroPore or MultiGas).

**Gas**

Displays the Gas Configuration dialog.

This dialog allows you to choose the gases attached to each port of the analyzer.
Board ID

Displays the Board ID dialog so that you can view the statistics of the board contained in the requested slot of the card cage in the instrument.

Diagnostics

This option enables you to clean and verify gas lines when connecting or changing a gas. This option also allows you to perform diagnostic tests which your service representative may request. The data generated from these tests may be insignificant to you as a user, but can be very helpful to your service representative. Your service representative can view the results and may be able to resolve the problem, eliminating downtime and repair costs.

Diagnostic tests generate files to the 2020\Service\userdiag directory. Your service representative will request that you E-mail the files to him so that he may examine them.

When you select Unit [n] > Diagnostics, the Service Test dialog is displayed:
**View**

Allows you to view the current operation, the instrument schematic, or the instrument log in the Service Test dialog. **Operation** is the appropriate choice for tests.

**Test**

Contains a list of diagnostic tests. These tests will always include the latest revision letter at the end of the test name.

**Sequence**

Displays the test file name. This name is assigned automatically and incrementally sequenced by the software each time a test is performed. This also serves as the name of the file that is generated to the `userdiag` directory, and will be appended with SVT.

**Report after test**

Select this option to have a report generated automatically after the test.

If you do not select this option, you can still have a report generated from the report window.

**Cancel**

Cancels the test.

**Next**

Begins the test; displays the next view of the Service test dialog. The second view of the Service test dialog may contain a single pane or two panes, depending on the test selected.
The following push buttons become enabled when the test is complete.

**Report (field)**
Contains a list of the reports that will be generated during this test.

**Item [n]**
Lists the data in the two panes. **Item 1** is the upper pane and **Item 2**, the lower pane.

**Report (push button)**
Enables you to generate a report.

**Cancel**
Cancels the test.

---

**Calibration**

This option allows you to calibrate the vacuum gauge, pressure gauge, pressure scale, manifold temperature, and system volume. You can also save the current calibrations to a file or load a different calibration file.

**Vacuum Gauge**

Displays the Calibration Vacuum Gauge dialog containing the current vacuum level.

![Calibrate Vacuum Gauge dialog](image)

This dialog also allows you to enter a new value (if necessary) after calibration using an external reference gauge.
Pressure Zero

Displays the Calibrate Pressure Offset dialog.

![Calibrate Pressure Offset dialog]

This dialog allows you to evacuate the manifold and zero all pressure transducers in the system.

Pressure Scale

A Pressure Scale option is available for each type of transducer you have installed. For example, if you have the 1000-mmHg, 10-mmHg, and 1-mmHg transducers installed, a Pressure Scale option is displayed for the adjustment of each one.

Use these options to adjust the scale of a transducer to match a reference standard; the Calibrate Pressure Scale dialog is displayed.

![Calibrate Pressure Scale dialog]

**Reset to nominal**

Restores factory calibration settings for all transducers.

**Match to entered pressure**

Select this option to enter a value obtained using a reference pressure gauge to determine the actual manifold pressure.
Temperature

Use this option to adjust the offset of the manifold temperature sensor to agree with a value obtained using a calibration device. The Calibrate Manifold Temperature dialog is displayed so that you may enter the measured value.

Volume

Use this option to enter a predetermined system volume in the event of data loss.

The system volume typically is calibrated after servicing valves, transducers, or any part of the analysis plumbing. The ASAP 2020 must be idle to calibrate system volume. Before system volume is calibrated, the manifold temperature sensor and the master pressure gauge must be calibrated.

Previous Retains the values currently in use.

Entered Allows you to enter values to use.

Measured This field is used by authorized service personnel when measuring the system and lower manifold volumes. A special Service Kit is required to perform these procedures.
**Done**  
Closes the dialog (displays for the Previous and Entered selections).

**Next**  
Appears only when **Measured** was selected; displays a dialog that enables service personnel to enter measured volumes.

**Reference Volume**  
Enter the volume in cubic centimeters for the reference volume you are using in this calibration.

**Reference Volume Temp.**  
Enter the temperature of the reference volume. Since the reference volume should be submerged in an ice bath, this value should remain at 0.0 °C for best accuracy.

**Perform measurement**  
Choose the number of measurements you wish to perform; you may choose up to 9.
Start

Start

Begins the calibration; a status view is displayed. After the calibration has finished, a confirmation view of the Calibrate System Volume dialog is displayed.

![Calibrate System Volume dialog](image)

This dialog allows you to choose the volume you wish to use.

Previous

The system volume and lower manifold volume in use before this measurement.

Entered

An entered measurement.

Measured

The last measured system and lower manifold volumes; for example if you choose 3 measurements, this value is that of the last (third) measurement.

Average

The average of the series of measurements; for example if you choose 3 measurements, this value is the average of the three measurements.

Click **Done** to close the dialog.
Save to File

Use this option to save the current calibration settings to a file; the Select Calibration File dialog is displayed.

File name

Defaults to the next sequence number for calibration files. The sequence number consists of: xxx-yyy.CAL, where xxx = serial number of unit and yyy = sequence number. For example, the number listed in the above dialog represents the first calibration file for unit serial number 202.

Load from File

Displays the Select Calibration File dialog (shown above) so that you can load a previously saved calibration file.
This option on the Unit menu is enabled if your ASAP 2020 is equipped with the SmartVac degassing option. The choices on this cascading menu allow you to select operations for the SmartVac degasser.

### Enable Manual Control

Select this option to control manually certain components of the degas operation. If the instrument schematic for the SmartVac is not displayed, select **Show Instrument Schematic** from the Degas menu.

### Valves D1, D2, D5, D6, D7

Degasser valves and their functions are listed in Table 6-2.

*Actions: Open, Close*
Table 6-2. Degasser Valves

<table>
<thead>
<tr>
<th>Valve</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1 and D2</td>
<td>Sample port valves</td>
</tr>
<tr>
<td>D5</td>
<td>Vacuum valve</td>
</tr>
<tr>
<td>D6</td>
<td>Servo isolation valve</td>
</tr>
<tr>
<td>D7</td>
<td>Gas inlet port valve</td>
</tr>
</tbody>
</table>

Servo Valve  
*Actions: Set, Close*

Set displays the Servo Valve Settings dialog so that you can enter a target pressure for sample evacuation. This feature enables you to use the software to bring down the sample pressure slowly and incrementally.

Close closes the servo valve.

Heaters  
*Actions: Set, Disable*

Set displays the Port [n] Heater Settings dialog so that you can specify a ramp rate and target temperature. After you click and close the dialog, the settings are displayed directly below the heater symbol.

Disable cancels the settings.

Status window  
Displays the status of the current degassing operation(s).

Show Instrument Schematic

Displays the schematic (shown in the previous section) for the SmartVac.
Show Status

This option allows you to monitor the degassing operation.

**Sample**
Displays the sample file being used with the degassing operation for each port.

**Status**
Displays the current stage of the degassing operation for each port.

**Check**
Allows you to check the outgassing rate of the sample on the related port; the following actions occur:

- current degassing step is suspended (on both ports).
  Degassing can be checked after the vacuum setpoint has been attained, or during a temperature ramp and hold. If you choose this option during any other step, a message indicating the SmartVac is not in a valid state is displayed.

- vacuum valves are closed and the vacuum level monitored.

- the Status window is displayed (if not already displayed).
  The Status window will indicate that the degassing operation is being checked and will display the outgassing rate as it becomes available.

During the degas check, this push button changes to Continue. When Continue is clicked, the valves open, the temperature ramp or hold continues, and the degassing operation resumes. If your outgassing rate indicated that contaminants have been removed from the sample (minimal pressure increase), you can click Skip to advance to the next state of the degassing operation. For example, if you check degassing after the setpoint is attained, Skip advances you to the ramping stage.

**Skip**
Skips the current stage of the degassing operation for the port associated with this push button.
**Cancel**

Cancels the degassing operation for the port associated with this push button.

---

**Calibrate Pressure Zero**

Use this option to evacuate the manifold and zero the transducer.

![Calibrate Pressure Zero Window](image)

**Start**

Begins the calibration.

Status messages are displayed during this procedure, then the dialog closes automatically.

---

**Calibrate Pressure Scale**

Use this option to adjust the scale of the pressure transducer.

![Calibrate Pressure Scale Window](image)

**Current Pressure**

Enter the current pressure of the degasser manifold.
**Calibrate Vacuum Gauge**

Displays the Calibration Vacuum Gauge dialog containing the current vacuum level.

![Calibrate Vacuum Gauge dialog](image)

This dialog also allows you to enter a new calibration value (if necessary) obtained using an external reference gauge.

**Calibrate Servo**

Use this option to calibrate the servo valve to the manifold pressure transducer. The servo valve should always be recalibrated after a pressure calibration has been performed. The Calibrate Servo Valve dialog is displayed.

![Calibrate Servo Valve dialog](image)

**Start**

Begins the calibration. The servo valve is used to evacuate and equilibrate the manifold. The pressure transducer readings are used to calibrate the servo set point. Status messages are displayed during this procedure, then the dialog closes automatically.
Service Test

Various service tests are included in the ASAP 2020 operating program. These tests can be enabled and performed only with the assistance of a trained Micromeritics service representative. These tests are designed to provide your service representative with instrument readouts, as well as to assist him in troubleshooting potential problems and, perhaps, eliminating unnecessary repair services. This service strategy allows you to conduct expert tests in less time than it would take to be trained in servicing the instrument properly.
7. REPORTS MENU

This chapter describes the commands on the Reports menu; it also contains examples of reports.

Reports can be generated for data:

- collected on a sample that has completed analysis
- collected on a sample that is currently being analyzed (includes only the information collected up to the time of the report)
- that is manually entered

Description

<table>
<thead>
<tr>
<th>Reports</th>
<th>F8</th>
<th>F9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Report...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Report...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SPC Report Options...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Regression Report...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control Chart...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Heat of Adsorption...</td>
<td>F10</td>
<td></td>
</tr>
<tr>
<td>Rate of Adsorption...</td>
<td>F11</td>
<td></td>
</tr>
</tbody>
</table>

Listed below are brief descriptions of the commands contained on the Reports menu. Detailed descriptions follow this section.

Start Report

Allows you to generate a report on a completed sample analysis or on the data collected thus far for an analysis in progress. Page 7-3.

Close Reports

Closes all open report windows. Page 7-5.

Open Report

Enables you to open a report that was saved from the report window. Page 7-5.

SPC Report Options

Allows you to specify the sample data to be included in SPC reports. Page 7-6.
<table>
<thead>
<tr>
<th>Report Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Chart</td>
<td>Allows you to generate a control chart report. Page 7-11.</td>
</tr>
<tr>
<td>Rate of Adsorption</td>
<td>Invokes the Rate of Adsorption program, allowing you to generate ROA reports. Page 7-17.</td>
</tr>
</tbody>
</table>
Start Report

Select this option to generate a report on a sample analysis. Select Start report from the Reports menu to display the Start Report dialog.

**File name**

The name you select from the Files list box is copied to this field. If you select multiple files, only the last one selected is displayed. If you have a sample file open when you select this option, its name is displayed.

**Status**

This drop-down list determines what type of sample files are displayed in the Files list window in the specified directory for all dates, or within the specified range of dates (using push button).

*Choices: All, Analyzing, Complete, Entered*

Refer to Table 3-2. File Status and Description, page 3-12 for a description of the status types.

**Date Range**

Displays the Select Dates dialog so that you may specify a range of dates. Refer to Selecting Files on page 3-11 for a description of this push button.

**Copies**

Enabled when the Printer or Printer/Plotter destination is chosen. This option allows you to print up to four copies of the selected report(s).
<table>
<thead>
<tr>
<th><strong>Destination</strong></th>
<th>Displays a drop-down list of output destinations.</th>
</tr>
</thead>
</table>

*Choices: File, Printer, Screen*

If you select **Printer**, requested reports are printed to the selected printer.

If you select **Screen**, many options are available for manipulating and customizing reports. Refer to Printed reports on page 7-18.

If you select **File**, the tabular reports of the requested file are converted to a text file which can be viewed with a text editor or other text file manipulation tool. Graphical data cannot be generated to a File.

<table>
<thead>
<tr>
<th><strong>File name</strong></th>
<th>Enabled when you select File as the destination. Allows you to enter a name, or you may accept the default.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Files list box</strong></th>
<th>Displays a list of the available sample files for the choice shown in the <strong>Status</strong> field and within the range of dates specified in the Dates dialog.</th>
</tr>
</thead>
</table>

| **Directories** | Displays a list of available drives and directories. The drive and directory last accessed is displayed immediately above the Directories list box.  
If you choose a single sample file, the Reports to Generate dialog is displayed. The reports selected are the ones you specified in the sample file. This dialog allows you to deselect reports or select additional ones. |
|-----------------|--------------------------------------------------|
Close Reports

This option enables you to close all open report windows at one time. This avoids having to select close on each report window.

Open Report

Enables you to open a report that you saved from the report window.

Double-click on the report(s) you wish to select (or deselect); alternatively, you can highlight the report and press Space-bar. A check mark is placed before each selected report. After you make your report selection and click OK, the requested reports are sent to the specified destination.

If you choose more than one file, this dialog is not displayed. The reports specified in each sample file will be generated.
SPC Report Options

When you select SPC Report Options, the SPC Report Options dialog is displayed.

The SPC Report Options dialog lists the variables that are most frequently used for SPC reporting. You can check as many as desired. All variables selected are computed for each sample file used in an SPC report.

Click More for additional SPC calculations for the detailed reports.
Regression Report

Select this option to generate a regression report. The regression report is used to determine the interdependency between two variables. Up to three dependent variables (Y-axis) may be plotted against a single independent variable (X-axis). The degree of correlation between the variables also is reported. The graphs for the regression report are scaled so that all three fit on a single page. If you choose less than three, the graphs are scaled to fill most of the page.

Show report title

Select this option to have a title display on your report. Accept the default or enter a new title. You can enter up to 40 alphanumeric characters.

Deselect this option to omit the report title.

Show graphic

Select this option to have a graphic display above your report title. For example, you may wish to display your company logo. The graphic must be a bitmap (bmp) or enhanced metafile (emf).

Click Browse to choose the file, then use the Height and Width fields to specify a size. This image can be edited in the report window (when printed to the screen), or removed if desired.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X- and Y-Axes Variable fields</strong></td>
<td>Allows you to designate the X- and Y-axes variables. Click on the down arrow to display a list of variables. The variables in this list are the ones you specified in the SPC report options. With this option, you can plot the regression of up to three Y-axis variables against the X-axis variable. The X-axis specifies the independent variable for the regression, while the Y-axes provide the dependent variables.</td>
</tr>
<tr>
<td><strong>Axis Range</strong></td>
<td>Enables you to specify the beginning and ending values for the X- and Y-axis ranges. Data collected outside these ranges are not included in the plot. These fields are disabled if you choose Autoscale.</td>
</tr>
<tr>
<td><strong>Autoscale</strong></td>
<td>Allows you to have the X- and/or Y-axes scaled automatically. When scaled automatically, both axes begin at zero. The analysis program uses the highest values collected during analysis as the ending points.</td>
</tr>
<tr>
<td><strong>Recalculate archived SPC results</strong></td>
<td>Select this option to have archived SPC values recalculated. This ensures that any changes made to the SPC Report Options are included in the new report; however, it does lengthen the time required to generate the report.</td>
</tr>
<tr>
<td><strong>Tabular report</strong></td>
<td>Enables you to generate tabular, as well as graphical, data of the included samples. A tabular report contains the numeric values contributed by each sample.</td>
</tr>
<tr>
<td><strong>Label data</strong></td>
<td>Allows you to label the points on the plot to correspond with the values in the sample files.</td>
</tr>
<tr>
<td><strong>Samples</strong></td>
<td>Displays the Regression Report Sample Selection dialog, allowing you to choose the sample files you wish to have reported.</td>
</tr>
</tbody>
</table>
**File name**

Use this field to limit the files displayed in the Available Files pane. For example; enter `g*.smp` to display only the files beginning with an `g`.

**Status**

This drop-down list determines the type of sample files that display in the Available Files pane in the selected directory for all dates, or within the specified range of dates (using Date Range push button). Refer to Table 3-2. File Status and Description, page 3-12 for an explanation of the Status types.

**Date Range**

Displays the Select Dates dialog so that you can specify a range of dates. Refer to Selecting Files, page 3-11 for an explanation of this dialog.

**Use all files in this directory**

Select this option to include all files from the selected directory in the report.

**Directories**

Lists the current directory. Use the directory window to navigate to a different directory.

**Add**

Moves the selected file in the Available Files pane to the Selected Files pane. Alternatively, you can simply double-click on the desired file(s). You can select multiple files by holding down `Ctrl` while making your selections. You can include up to 200 sample files.
<table>
<thead>
<tr>
<th>Remove</th>
<th>Removes the selected file from the <strong>Selected Files</strong> pane and places it back into the <strong>Available Files</strong> pane.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save As Default</td>
<td>Saves the current definition of the report as the default.</td>
</tr>
<tr>
<td>Report Settings</td>
<td>The options in this group box enable you to choose output criteria.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Copies</strong> field is enabled when you choose <strong>Printer</strong> as the destination, enabling you to print up to four copies of the report.</td>
</tr>
<tr>
<td>Report</td>
<td>Generates the report.</td>
</tr>
</tbody>
</table>
Control Chart

This option enables you to generate a control chart report which plots the changes in a statistic.

Show report title
Select this option to have a title display on your report. Accept the default or enter a new title. You can enter up to 40 alphanumeric characters.

Deselect this option to omit the report title.

Show graphic
Select this option to have a graphic display above your report title. For example, you may wish to display your company logo. The graphic must be a bitmap (bmp) or enhanced metafile (emf).

Click Browse to choose the file, then use the Height and Width fields to specify a size. This image can be edited in the report window (when printed to the screen), or removed if desired.

X-axis Order By
Enables you to choose the order in which X-axis statistics are placed. You can have them placed by Time, File name, Date, Minutes, or Days.
Graph [n] Displays the Control Chart Graph [n] Options dialog, allowing you to define the Y-axis of each graph.

Statistic This drop-down list displays the SPC variables selected on the SPC Report Options dialog. The variable you choose will be plotted against time.

Autoscale Allows you to have the Y-axis scaled automatically. If you wish to specify a range, deselect this option and enter a range in the From and To fields.

Center Line Displays placement options for the variable’s optional value. Choose Entered to specify placement of the line.

Limit Lines Displays the options available for limiting lines. You can have the lines placed at some multiple of the standard deviation or at specified positions (Entered).

When you select Entered, the High limit and Low limit fields are enabled, allowing you to enter appropriate values.

Tabular report Allows you to generate tabular, as well as graphical, data of the included samples. A tabular report contains the numeric values contributed by each sample.

Recalculate archived SPC results Select this option to have archived SPC values recalculated. This ensures that any changes made to the SPC Report Options are included in the new report. It also lengthens the time required to generate the report.
Samples Displays the Control Chart Sample Selection dialog, allowing you to choose the sample files on which you wish to report.

This dialog functions in the same manner as the Regression Report Sample Selection Dialog explained on page 7-8.

Save as Default Saves the current definition of the report as the default.

Report Settings The options in this group box enable you to choose output criteria.

The Copies field is enabled when you choose Printer as the destination, enabling you to print up to four copies of the report.

Report Generates the report.
Heat of Adsorption

The isosteric heat of adsorption is an important parameter for characterizing the surface heterogeneity, providing information about the adsorbent and the adsorption capacity. Multiple adsorption isotherms are obtained on the same sample using the same adsorptive but at different temperatures to obtain the heat of adsorption.

This option allows you to choose the sample files, define the quantities, and generate a Heat of Adsorption report; the Heat of Adsorption dialog is displayed.

Table  Contains the files you choose; also lists the quantity adsorbed.

Add Samples  Displays the Select Samples dialog so that you can choose desired files.

Remove Samples  Removes the selected sample from the list. If no samples are selected, the last one is removed.

Clear Samples  Removes all samples from the list.
Edit Quantities

Displays the Edit Quantities Adsorbed dialog so that you can specify the range of surface coverage to include in the heat of adsorption report.

Quantity Adsorbed table

Allows you to enter the points.

Insert Range

Displays the Insert Quantity Range dialog. This dialog allows you to specify the starting and ending quantities adsorbed, as well as the number of points to insert within the specified range.

Insert

Inserts a row above the selected row.

Delete

Deletes the selected row.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td>Clears the entire table of all entries except one; one is required.</td>
</tr>
<tr>
<td>Load Table</td>
<td>Allows you to import a previously saved table.</td>
</tr>
<tr>
<td>Save Table</td>
<td>Allows you to save the current table as a file (QNT extension).</td>
</tr>
</tbody>
</table>
| Apply            | Applies the quantities in the table to the current Heat of Adsorption report.
<p>| Report Settings  | The options in this group box allow you to choose report criteria.           |
| Show report title| Choose this option to have a title display in the header of your report, then use the adjacent field to enter the title. |
| Show graphic     | This option allows you to have a graphic appear in your title; for example, you may wish to show your company logo. You can use a bitmap or an enhanced metafile. Use the <strong>Height</strong> and <strong>Width</strong> fields to define a size. |
| Tabular report   | Select this option to have data generated in a tabular format.              |
| Isostere plot    | Select this option to generate a graph showing quantities of gas adsorbed vs. the temperature. |
| Heat of adsorption plot | Select this option to generate the Heat of Adsorption data in a graphical format. |
| Copies           | Enabled when you choose <strong>Printer</strong> as the destination, allowing you to print up to four copies of your report(s). |
| Destination      | Enables you to choose a destination for your report.                        |
| File name        | Enabled when you choose <strong>File</strong> as the destination, allowing you to enter a name (or you can accept the default). |
| Open             | Enables you to open a previously saved report.                              |</p>
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Saves the current report.</td>
</tr>
<tr>
<td>Report</td>
<td>Generates the report.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the dialog.</td>
</tr>
</tbody>
</table>

**Rate of Adsorption (ROA)**

Rate of Adsorption is enabled only if this option is installed.

Select **Rate of Adsorption** to start the ROA program. Refer to your Rate of Adsorption operator’s manual for operating instructions.
Printed Reports

Header

All printed reports (either to the screen or to a printer) contain a header displaying file statistics.

- Tabular and graphical reports contain sample and instrument statistics such as when the file was created and by whom, date and time of analysis, analysis conditions, and so forth.

  The headers for these reports also contain notes of any changes to the sample file that occur after analysis.

- Summary report headers contain the same type of information displayed in tabular and graphical reports with the exception of notes.

Onscreen Reports

The report window containing onscreen reports provides many options for customizing and manipulating reports:

- a tool bar
- shortcut menus
- zoom feature
- axis cross-hairs

When reports are printed to the screen, they are printed in a window like the one shown below. Each requested report is listed in the Reports window on the tool bar; they are also indicated by selectable tabs across the top of the report header. To view a specific report, select its tab or select the report in the Reports window and click Show.
Tabs display for each type of report you choose to generate.

Displays graphical (or tabular) data

Tool Bar

Reports
Contains a list of all requested reports.

Show
Shows the selected report in the report window. If the report has been hidden, it and its associated tab will become visible.
**Delete**

Deletes the selected report. A deletion confirmation dialog is displayed since this function cannot be undone. The deleted report(s) will have to be regenerated if deleted in error.

**Hide**

Hides (removes) the selected report from the report window. The report’s associated tab is also removed.

**Open**

Allows you to open a previously saved report file.

**Print**

Displays a print dialog so that you can choose an appropriate printer for report output. A list of available reports is displayed in the window on the right side of the dialog.

For convenience in selecting which reports to print, push buttons are provided beneath the report window. Or, you can make your selection by clicking on the desired reports.

**Current** selects the report displayed in the report window.

**Shown** selects only the shown reports; any non-highlighted reports indicate they are hidden. You can still select hidden reports from this window to print.

**All** selects all reports, including those that may have been hidden.

**Clear** clears all selections.
Save

Saves all reports of the currently open file in a report format using the same name as the sample file, only with an rep extension. If you wish to specify a name and/or specific reports to save, use the Save As push button.

Save As

Saves all or specified reports from the currently open file. The push buttons displayed on this dialog perform in the same manner as the print dialog (explained above).

Reports can be saved in three different formats:

- **Report system (*.rep):** Saved in a format which allows you to reopen the file using the push button on the Report window tool bar.

- **Spreadsheet (*.xls):** Saved in a format which can be imported into most spreadsheet programs.

- **Ascii Text (*.txt):** Saved in ASCII text which can be imported into programs accepting this type of file.

Default Style

Displays the Default Style dialog so that you can specify default parameters for report fonts and curve properties.

**Default Style**

- **Fonts**
  
  Contains a list of report elements for which the font can be edited. Simply highlight the desired element and click **Edit**, a font dialog is displayed so that you can specify the desired font and attributes.

- **Curve**
  
  The items in this group box enable you to specify a thickness for report curves and, when using histograms, the type of fill to apply.
<table>
<thead>
<tr>
<th><strong>Graph border line thickness</strong></th>
<th>Enables you to specify a thickness for the border of the graph.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Load</strong></td>
<td>Loads the last <em>saved</em> defaults.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Saves the changes as the defaults. If you do not click <strong>Save</strong>, the changes will apply to the current report set only. The next reports will revert to the defaults.</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Closes the dialog and applies the changes. If you clicked <strong>Save</strong>, the changes become the defaults. If you did not click <strong>Save</strong>, the changes apply to the current report only.</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Closes the report window.</td>
</tr>
</tbody>
</table>
Shortcut Menus

Shortcut menus are accessed when you right-click on the tabular or graphical portion of a report.

Tabular Reports

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resize column</td>
<td>Displays a dialog so that you can specify the width of the selected column (in inches).</td>
</tr>
<tr>
<td>Rename column</td>
<td>Displays a dialog so that you can edit the name of the selected column. Use Ctrl + Enter to insert line feeds.</td>
</tr>
<tr>
<td>Move column</td>
<td>Allows you to move the location of the selected column to the left or to the right.</td>
</tr>
<tr>
<td>Align column</td>
<td>Enables you to right-align, left-align, or center the data in the selected column.</td>
</tr>
<tr>
<td>Hide column</td>
<td>Displays a list of the columns that have not been hidden, enabling you to select the one you wish to hide.</td>
</tr>
<tr>
<td>Show column</td>
<td>Displays a list of all hidden columns, enabling you to select the one you wish to have shown again.</td>
</tr>
<tr>
<td>Column font</td>
<td>Displays a Font dialog, allowing you to change font attributes for the tabular data in the current report.</td>
</tr>
</tbody>
</table>
**Header font**
Displays a Font dialog, allowing you to change font attributes for column headers in the current report.

**Edit title**
Allows you to edit the table title and font.

**Copy table as text**
Enables you to copy the entire table (column headers and data) and then insert it into another program. Columns are tab-delimited, allowing easy alignment.

**Graphs**

<table>
<thead>
<tr>
<th>Autoscale</th>
<th>Autoscales all axes of the graph. This function is useful for returning to a full view after having zoomed in.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redraw</td>
<td>Sets axis boundaries to its original view. You can also use this function to remove cross-hairs.</td>
</tr>
<tr>
<td>Show curve</td>
<td>Shows any curve(s) that has been hidden. This option is disabled (grayed) if no curves have been hidden.</td>
</tr>
<tr>
<td>Hide curve</td>
<td>Hides (removes from view) any unwanted curve(s).</td>
</tr>
</tbody>
</table>
**Edit curve**
Displays the Curve Properties dialog, allowing you to edit curve properties.

![Curve Properties dialog](image)

**Title**
Displays the title of the curve you are editing. You can edit the title if desired.

**Style**
This drop-down list contains the styles in which collected data can be displayed.

*Choices: Curve, Histogram, Points, Curve and Points*

**Curve group box**
Contains options for curves and points. You can edit the curve interpolation, the style of curve and/or points, as well as the pen color. The options in this group box are disabled if Histogram is chosen in the Style drop-down list.

**Histogram group box**
The options in this group box are enabled when you choose Histogram as the style for collected data. The choices in the drop-down list allow you to choose the type of fill for the Histogram, then you can click Color to select the fill color.
**Edit axis**
Displays the Axis Properties dialog, allowing you to edit axis properties.

**Edit legend**
Displays the Legend Properties dialog, allowing you to edit the placement of the legend. You can also edit the font if desired.

**Edit title**
Displays the Title Properties dialog, allowing you to edit the current graph’s title and font.

**Copy as metafile**
Copies the graph and places it on the clipboard, allowing you to paste it into other applications accepting Windows metafiles.
**Zoom Feature**

A zoom feature is included with the report system so that you can zoom in to examine fine details. To use this feature, simply hold down the left mouse button and drag the mouse cursor (drawing a box) across the area you wish to view; then release the button. The enlarged area immediately fills the graph area. Right-click in the graph area and choose **Autoscale** from the shortcut menu to return to the normal view.

**Axis Cross Hair**

A cross-hair function is available so that you can view axis coordinates. To use this feature, simply left-click in the desired area of the graph.

Right-click in the graph area and choose **Autoscale** or **Redraw** from the shortcut menu to remove cross-hair lines and return to the normal view. Alternatively, you can click outside of the graph area.

**Report Examples**

The remainder of this chapter contains samples of reports produced by analyses of two different materials:

- Silican Alumina reference material analyzed with N\textsubscript{2} at 77 K
- Y Zeolite reference material analyzed with N\textsubscript{2} at 77.35 K
Summary Report - Silica Alumina

Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Sample Mass: 0.2614 g Warm Free Space: 16.5571 cm³ Entered
Cold Free Space: 47.8248 cm³ Equilibration Interval: 10 s
Ambient Temperature: 295.15 K Low Pressure Dose: None
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Summary Report

Surface Area
Single point surface area at p/p° = 0.225437928: 213.4148 m²/g
BET Surface Area: 220.2100 m²/g
t-Plot Micropore Area: 13.0309 m²/g
t-Plot External Surface Area: 207.1791 m²/g

BJH Adsorption cumulative surface area of pores between 17.000 Å and 3000.000 Å width: 270.516 m²/g
BJH Desorption cumulative surface area of pores between 17.000 Å and 3000.000 Å width: 323.9513 m²/g

Pore Volume
Single point adsorption total pore volume of pores less than 872.017 Å width at p/p° = 0.977284499: 0.612585 cm³/g
t-Plot micropore volume: 0.004058 cm³/g
BJH Adsorption cumulative volume of pores between 17.000 Å and 3000.000 Å width: 0.624602 cm³/g
BJH Desorption cumulative volume of pores between 17.000 Å and 3000.000 Å width: 0.623106 cm³/g

Pore Size
Adsorption average pore width (4V/A by BET): 111.2728 Å
BJH Adsorption average pore width (4V/A): 92.357 Å
BJH Desorption average pore width (4V/A): 76.938 Å

Pass/Fail
S A: Multi-point BET Passed
S A: Single-point BET Passed
P V: Adsorption Total - 0.99500000 Relative Pressure Passed
P S: Avg. pore diameter Passed
Isotherm Report - Silica Alumina

Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

<table>
<thead>
<tr>
<th>Relative Pressure (p/p°)</th>
<th>Absolute Pressure (mmHg)</th>
<th>Quantity Adsorbed (cm³/g STP)</th>
<th>Elapsed Time (h:min)</th>
<th>Saturation Pressure (mmHg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.009531209</td>
<td>7.080653</td>
<td>36.0245</td>
<td>00:41</td>
<td>743.126831</td>
</tr>
<tr>
<td>0.033702750</td>
<td>25.035069</td>
<td>43.1510</td>
<td>01:04</td>
<td></td>
</tr>
<tr>
<td>0.069312916</td>
<td>51.482746</td>
<td>48.5056</td>
<td>01:11</td>
<td></td>
</tr>
<tr>
<td>0.081949977</td>
<td>60.865673</td>
<td>49.9859</td>
<td>01:21</td>
<td></td>
</tr>
<tr>
<td>0.118880333</td>
<td>88.288406</td>
<td>53.7985</td>
<td>01:26</td>
<td></td>
</tr>
<tr>
<td>0.140710115</td>
<td>104.493446</td>
<td>55.8419</td>
<td>01:31</td>
<td></td>
</tr>
<tr>
<td>0.186214229</td>
<td>138.275955</td>
<td>59.8815</td>
<td>01:36</td>
<td></td>
</tr>
<tr>
<td>0.225437928</td>
<td>167.390518</td>
<td>63.2936</td>
<td>01:41</td>
<td></td>
</tr>
<tr>
<td>0.277756514</td>
<td>206.220673</td>
<td>67.8903</td>
<td>01:47</td>
<td></td>
</tr>
<tr>
<td>0.326989938</td>
<td>242.753265</td>
<td>72.4267</td>
<td>01:53</td>
<td></td>
</tr>
<tr>
<td>0.37692638</td>
<td>279.555420</td>
<td>77.2896</td>
<td>01:59</td>
<td></td>
</tr>
<tr>
<td>0.425275617</td>
<td>315.668060</td>
<td>82.4824</td>
<td>02:05</td>
<td></td>
</tr>
<tr>
<td>0.474365209</td>
<td>352.071655</td>
<td>88.3683</td>
<td>02:12</td>
<td></td>
</tr>
<tr>
<td>0.522901435</td>
<td>387.983337</td>
<td>95.0969</td>
<td>02:19</td>
<td></td>
</tr>
<tr>
<td>0.570348466</td>
<td>423.222412</td>
<td>102.9292</td>
<td>02:27</td>
<td></td>
</tr>
<tr>
<td>0.599440995</td>
<td>444.767334</td>
<td>108.6925</td>
<td>02:34</td>
<td></td>
</tr>
<tr>
<td>0.646909553</td>
<td>479.914734</td>
<td>120.3034</td>
<td>02:45</td>
<td></td>
</tr>
<tr>
<td>0.695583996</td>
<td>515.918579</td>
<td>137.1353</td>
<td>02:47</td>
<td></td>
</tr>
<tr>
<td>0.754458542</td>
<td>559.387817</td>
<td>172.1878</td>
<td>02:59</td>
<td></td>
</tr>
<tr>
<td>0.803352647</td>
<td>595.383398</td>
<td>230.9460</td>
<td>03:23</td>
<td></td>
</tr>
<tr>
<td>0.818916439</td>
<td>606.666016</td>
<td>259.0634</td>
<td>03:55</td>
<td></td>
</tr>
<tr>
<td>0.855473657</td>
<td>633.506958</td>
<td>329.6220</td>
<td>04:12</td>
<td></td>
</tr>
<tr>
<td>0.879826475</td>
<td>651.377197</td>
<td>356.5463</td>
<td>04:46</td>
<td></td>
</tr>
<tr>
<td>0.907384285</td>
<td>671.489868</td>
<td>371.8145</td>
<td>05:03</td>
<td></td>
</tr>
<tr>
<td>0.932766033</td>
<td>690.099731</td>
<td>382.2773</td>
<td>05:05</td>
<td></td>
</tr>
<tr>
<td>0.947137652</td>
<td>700.609253</td>
<td>387.4319</td>
<td>05:31</td>
<td></td>
</tr>
<tr>
<td>0.977284499</td>
<td>722.745789</td>
<td>396.0335</td>
<td>05:38</td>
<td></td>
</tr>
<tr>
<td>0.998767570</td>
<td>738.447876</td>
<td>400.5519</td>
<td>05:47</td>
<td></td>
</tr>
<tr>
<td>0.965056688</td>
<td>713.857544</td>
<td>398.5429</td>
<td>05:57</td>
<td></td>
</tr>
<tr>
<td>0.924130039</td>
<td>683.109375</td>
<td>396.8252</td>
<td>06:01</td>
<td></td>
</tr>
<tr>
<td>0.876993917</td>
<td>648.145264</td>
<td>390.7455</td>
<td>06:06</td>
<td></td>
</tr>
<tr>
<td>0.857717903</td>
<td>633.810852</td>
<td>387.4625</td>
<td>06:13</td>
<td></td>
</tr>
<tr>
<td>0.852194791</td>
<td>629.666199</td>
<td>398.3166</td>
<td>06:19</td>
<td></td>
</tr>
<tr>
<td>0.829198788</td>
<td>612.567139</td>
<td>381.0485</td>
<td>06:23</td>
<td></td>
</tr>
</tbody>
</table>
Silica Alumina iso N2@77 K, 004/16821/00

ASAP 2020 V4.00
Unit 1
Serial #: 1410
Page 4

Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

<table>
<thead>
<tr>
<th>Relative Pressure (p/p°)</th>
<th>Absolute Pressure (mmHg)</th>
<th>Quantity Adsorbed (cm³/g STP)</th>
<th>Elapsed Time (h:min)</th>
<th>Saturation Pressure (mmHg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.805018739</td>
<td>594.554626</td>
<td>373.4363</td>
<td>06:40</td>
<td>737.983887</td>
</tr>
<tr>
<td>0.756437482</td>
<td>558.074768</td>
<td>265.0066</td>
<td>07:30</td>
<td>737.983887</td>
</tr>
<tr>
<td>0.699072862</td>
<td>515.473999</td>
<td>157.2673</td>
<td>08:05</td>
<td>737.983887</td>
</tr>
<tr>
<td>0.635931970</td>
<td>468.792633</td>
<td>121.2898</td>
<td>08:22</td>
<td>737.983887</td>
</tr>
<tr>
<td>0.592357948</td>
<td>436.596680</td>
<td>108.6831</td>
<td>08:33</td>
<td>737.983887</td>
</tr>
<tr>
<td>0.534731256</td>
<td>394.068115</td>
<td>97.4256</td>
<td>08:42</td>
<td>737.983887</td>
</tr>
<tr>
<td>0.479370390</td>
<td>353.231873</td>
<td>89.1965</td>
<td>08:49</td>
<td>737.983887</td>
</tr>
<tr>
<td>0.426910874</td>
<td>314.542145</td>
<td>82.6950</td>
<td>08:56</td>
<td>736.569763</td>
</tr>
<tr>
<td>0.375251524</td>
<td>276.454559</td>
<td>77.0545</td>
<td>09:02</td>
<td>736.569763</td>
</tr>
<tr>
<td>0.324221734</td>
<td>238.985138</td>
<td>72.0226</td>
<td>09:08</td>
<td>736.569763</td>
</tr>
<tr>
<td>0.273687848</td>
<td>201.596436</td>
<td>67.3259</td>
<td>09:13</td>
<td>736.569763</td>
</tr>
<tr>
<td>0.223387277</td>
<td>164.540314</td>
<td>62.8633</td>
<td>09:15</td>
<td>736.569763</td>
</tr>
<tr>
<td>0.172815469</td>
<td>127.290649</td>
<td>58.4314</td>
<td>09:20</td>
<td>736.569763</td>
</tr>
<tr>
<td>0.112054097</td>
<td>82.535660</td>
<td>52.8082</td>
<td>09:31</td>
<td>736.569763</td>
</tr>
</tbody>
</table>
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Isotherm Linear Plot

- Silica-Alumina Reference analyzed with N2 at 77 K - Adsorption
- Silica-Alumina Reference analyzed with N2 at 77 K - Desorption
BET Surface Area Report - Silica Alumina

Silica Alumina iso N2@77 K, 004/16821/00

ASAP 2020 V4.00  Unit 1  Serial #: 1410  Page 6

Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Sample Mass: 0.2614 g  Warm Free Space: 16.5571 cm³ Entered
Cold Free Space: 47.8248 cm³  Equilibration Interval: 10 s
Ambient Temperature: 295.15 K  Low Pressure Dose: None
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

BET Surface Area Report
BET Surface Area: 220.2100 ± 0.2949 m²/g
Slope: 0.019590 ± 0.000026 g/cm³ STP
Y-Intercept: 0.000178 ± 0.000004 g/cm³ STP
C: 111.058215
Qm: 50.5858 cm³/g STP
Correlation Coefficient: 0.9999964
Molecular Cross-Sectional Area: 0.1620 nm²

<table>
<thead>
<tr>
<th>Relative Pressure (p/p°)</th>
<th>Quantity Adsorbed (cm³/g STP)</th>
<th>1/(Q(p°/p - 1)]</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.069312916</td>
<td>48.5056</td>
<td>0.001535</td>
</tr>
<tr>
<td>0.081949977</td>
<td>49.9859</td>
<td>0.001786</td>
</tr>
<tr>
<td>0.118880333</td>
<td>53.7985</td>
<td>0.002508</td>
</tr>
<tr>
<td>0.140710115</td>
<td>55.8419</td>
<td>0.002932</td>
</tr>
<tr>
<td>0.186214229</td>
<td>59.8815</td>
<td>0.003821</td>
</tr>
<tr>
<td>0.225437928</td>
<td>63.2936</td>
<td>0.004598</td>
</tr>
</tbody>
</table>
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Started: 2011-02-24 7:22:09PM
Completed: 2011-02-24 17:21:07PM
Analysis Adsorptive: N2
Analysis Bath Temp.: 77.125 K
Sample Mass: 0.2614 g
Warm Free Space: 16.5571 cm³ Entered
Cold Free Space: 47.8248 cm³
Ambient Temperature: 295.15 K
Automatic Degas: No
Equilibration Interval: 10 s
Low Pressure Dose: None

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

BET Surface Area Plot
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Started: 2011-02-24 7:22:09PM
Completed: 2011-02-24 17:21:07PM
Sample Mass: 0.2614 g
Cold Free Space: 47.8248 cm³
Ambient Temperature: 295.15 K

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

<table>
<thead>
<tr>
<th>Relative Pressure (p/p°)</th>
<th>Statistical Thickness (Å)</th>
<th>Quantity Adsorbed (cm³/g STP)</th>
<th>Fitted</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.009531209</td>
<td>2.6093</td>
<td>36.0245</td>
<td></td>
</tr>
<tr>
<td>0.033702750</td>
<td>3.0475</td>
<td>43.1510</td>
<td></td>
</tr>
<tr>
<td>0.069312916</td>
<td>3.4242</td>
<td>48.5056</td>
<td></td>
</tr>
<tr>
<td>0.081949977</td>
<td>3.5336</td>
<td>49.9859</td>
<td></td>
</tr>
<tr>
<td>0.118880333</td>
<td>3.8197</td>
<td>53.7985</td>
<td></td>
</tr>
<tr>
<td>0.140710115</td>
<td>3.9744</td>
<td>55.8419</td>
<td></td>
</tr>
<tr>
<td>0.186214229</td>
<td>4.2792</td>
<td>59.8815</td>
<td></td>
</tr>
<tr>
<td>0.225437928</td>
<td>4.5326</td>
<td>63.2936</td>
<td></td>
</tr>
<tr>
<td>0.277756514</td>
<td>4.8681</td>
<td>67.8903</td>
<td></td>
</tr>
<tr>
<td>0.326988938</td>
<td>5.1896</td>
<td>72.4267</td>
<td></td>
</tr>
<tr>
<td>0.376592638</td>
<td>5.5261</td>
<td>77.2896</td>
<td></td>
</tr>
<tr>
<td>0.425275617</td>
<td>5.8750</td>
<td>82.4824</td>
<td></td>
</tr>
<tr>
<td>0.474365209</td>
<td>6.2522</td>
<td>88.3683</td>
<td></td>
</tr>
<tr>
<td>0.522801435</td>
<td>6.6573</td>
<td>95.0697</td>
<td></td>
</tr>
<tr>
<td>0.570348466</td>
<td>7.0957</td>
<td>102.9292</td>
<td></td>
</tr>
<tr>
<td>0.599440995</td>
<td>7.3888</td>
<td>108.6925</td>
<td></td>
</tr>
<tr>
<td>0.648909633</td>
<td>7.9178</td>
<td>120.3034</td>
<td></td>
</tr>
<tr>
<td>0.689593996</td>
<td>8.5439</td>
<td>137.1353</td>
<td></td>
</tr>
</tbody>
</table>
Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:
## BJH Adsorption Report - Silica Alumina

### Silica Alumina iso N2@77 K, 004/16821/00

**ASAP 2020 V4.00**  
Unit 1  
Serial #: 1410  
Page 10

- **Sample:** Silica-Alumina Reference analyzed with N2 at 77 K
- **Operator:** DJS
- **Submitter:** Micromeritics
- **File:** C:\2020\DATA\PERF-TST\N2-SIAL.SMP

**Started:** 2011-02-24 7:22:09PM  
**Completed:** 2011-02-24 17:21:07PM  
**Analysis Adsorptive:** N2  
**Analysis Bath Temp.:** 77.125 K  
**Thermal Correction:** No  
**Cold Free Space:** 47.8248 cm³  
**Warm Free Space:** 16.5571 cm³  
**Equilibration Interval:** 10 s  
**Ambient Temperature:** 295.15 K  
**Low Pressure Dose:** None  
**Automatic Degas:** No

**Comments:** Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

**Notes:**

### BJH Adsorption Pore Distribution Report

**Faas Correction**

\[ t = 3.54 \left( \frac{-5}{\ln(p/p^0)} \right)^{0.333} \]

**Width Range:** 17,000 Å to 3000,000 Å  
**Adsorbate Property Factor:** 9.53000 Å  
**Density Conversion Factor:** 0.0015468  
**Fraction of Pores Open at Both Ends:** 0.00

<table>
<thead>
<tr>
<th>Pore Width Range (Å)</th>
<th>Average Width (Å)</th>
<th>Incremental Por Volume (cm³/g)</th>
<th>Cumulative Por Volume (cm³/g)</th>
<th>Incremental Por Area (m²/g)</th>
<th>Cumulative Por Area (m²/g)</th>
</tr>
</thead>
<tbody>
<tr>
<td>15565.9 - 869.5</td>
<td>912.2</td>
<td>0.007644</td>
<td>0.007644</td>
<td>0.335</td>
<td>0.335</td>
</tr>
<tr>
<td>869.5 - 380.3</td>
<td>455.0</td>
<td>0.015010</td>
<td>0.022654</td>
<td>1.319</td>
<td>1.655</td>
</tr>
<tr>
<td>380.3 - 300.7</td>
<td>330.9</td>
<td>0.009209</td>
<td>0.031864</td>
<td>1.113</td>
<td>2.768</td>
</tr>
<tr>
<td>300.7 - 219.9</td>
<td>247.3</td>
<td>0.019314</td>
<td>0.051177</td>
<td>3.123</td>
<td>5.891</td>
</tr>
<tr>
<td>219.9 - 170.3</td>
<td>188.5</td>
<td>0.029272</td>
<td>0.080449</td>
<td>6.212</td>
<td>12.103</td>
</tr>
<tr>
<td>170.3 - 142.0</td>
<td>153.4</td>
<td>0.053885</td>
<td>0.134334</td>
<td>14.048</td>
<td>26.152</td>
</tr>
<tr>
<td>142.0 - 113.5</td>
<td>124.3</td>
<td>0.146772</td>
<td>0.281106</td>
<td>47.218</td>
<td>73.370</td>
</tr>
<tr>
<td>113.5 - 104.6</td>
<td>108.6</td>
<td>0.059021</td>
<td>0.340127</td>
<td>21.732</td>
<td>95.102</td>
</tr>
<tr>
<td>104.6 - 83.6</td>
<td>91.5</td>
<td>0.123344</td>
<td>0.463471</td>
<td>53.919</td>
<td>149.021</td>
</tr>
<tr>
<td>83.6 - 66.9</td>
<td>73.2</td>
<td>0.069129</td>
<td>0.532600</td>
<td>37.772</td>
<td>186.793</td>
</tr>
<tr>
<td>66.9 - 57.2</td>
<td>61.2</td>
<td>0.029505</td>
<td>0.562105</td>
<td>19.288</td>
<td>206.081</td>
</tr>
<tr>
<td>57.2 - 49.8</td>
<td>52.9</td>
<td>0.018117</td>
<td>0.580223</td>
<td>13.692</td>
<td>219.773</td>
</tr>
<tr>
<td>49.8 - 46.1</td>
<td>47.8</td>
<td>0.008156</td>
<td>0.598379</td>
<td>6.828</td>
<td>226.601</td>
</tr>
<tr>
<td>46.1 - 40.8</td>
<td>43.1</td>
<td>0.010013</td>
<td>0.598392</td>
<td>9.297</td>
<td>235.899</td>
</tr>
<tr>
<td>40.8 - 36.4</td>
<td>38.3</td>
<td>0.007467</td>
<td>0.605859</td>
<td>7.801</td>
<td>243.700</td>
</tr>
<tr>
<td>36.4 - 32.5</td>
<td>34.2</td>
<td>0.005683</td>
<td>0.611542</td>
<td>6.652</td>
<td>250.351</td>
</tr>
<tr>
<td>32.5 - 29.2</td>
<td>30.6</td>
<td>0.004241</td>
<td>0.615783</td>
<td>5.539</td>
<td>255.891</td>
</tr>
<tr>
<td>29.2 - 26.2</td>
<td>27.5</td>
<td>0.003361</td>
<td>0.619144</td>
<td>4.892</td>
<td>260.783</td>
</tr>
<tr>
<td>26.2 - 23.5</td>
<td>24.6</td>
<td>0.002546</td>
<td>0.621690</td>
<td>4.132</td>
<td>264.915</td>
</tr>
<tr>
<td>23.5 - 20.9</td>
<td>22.0</td>
<td>0.001780</td>
<td>0.623470</td>
<td>3.240</td>
<td>268.155</td>
</tr>
<tr>
<td>20.9 - 19.0</td>
<td>19.8</td>
<td>0.000816</td>
<td>0.624286</td>
<td>1.648</td>
<td>269.803</td>
</tr>
<tr>
<td>19.0 - 16.8</td>
<td>17.8</td>
<td>0.000317</td>
<td>0.624602</td>
<td>0.713</td>
<td>270.516</td>
</tr>
</tbody>
</table>
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Sample Mass: 0.2614 g  Warm Free Space: 16.5571 cm³ Entered
Cold Free Space: 47.8248 cm³  Equilibration Interval: 10 s
Ambient Temperature: 295.15 K  Low Pressure Dose: None
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

BJH Adsorption Cumulative Pore Volume (Larger)

Halsey : Faas Correction

Silica-Alumina Reference analyzed with N2 at 77 K
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Started: 2011-02-24 7:22:09PM
Completed: 2011-02-24 17:21:07PM
Analysis Adsorptive: N2
Analysis Bath Temp.: 77.125 K
Thermal Correction: No
Warm Free Space: 16.5571 cm³ Entered
Equilibration Interval: 10 s
Low Pressure Dose: None
Sample Mass: 0.2614 g
Cold Free Space: 47.8248 cm³
Ambient Temperature: 295.15 K
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

BJH Adsorption $dV/d\log(w)$ Pore Volume

Silica-Alumina Reference analyzed with N2 at 77 K
BJH Desorption Report - Silica Alumina

Silica Alumina iso N2@77 K, 004/16821/00

ASAP 2020 V4.00  Unit 1  Serial #: 1410  Page 13

Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Sample Mass: 0.2614 g  Warm Free Space: 16.5571 cm³ Entered
Cold Free Space: 47.8248 cm³  Equilibration Interval: 10 s
Ambient Temperature: 295.15 K  Low Pressure Dose: None
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

BJH Desorption Pore Distribution Report

<table>
<thead>
<tr>
<th>Pore Width Range (Å)</th>
<th>Average Width (Å)</th>
<th>Incremental Pore Volume (cm³/g)</th>
<th>Cumulative Pore Volume (cm³/g)</th>
<th>Incremental Pore Area (m²/g)</th>
<th>Cumulative Pore Area (m²/g)</th>
</tr>
</thead>
<tbody>
<tr>
<td>15564.3 - 577.4</td>
<td>596.3</td>
<td>0.003480</td>
<td>0.003480</td>
<td>0.233</td>
<td>0.233</td>
</tr>
<tr>
<td>577.4 - 265.6</td>
<td>317.2</td>
<td>0.004807</td>
<td>0.008287</td>
<td>0.606</td>
<td>0.840</td>
</tr>
<tr>
<td>265.6 - 164.8</td>
<td>191.7</td>
<td>0.009538</td>
<td>0.017825</td>
<td>1.990</td>
<td>2.829</td>
</tr>
<tr>
<td>164.8 - 142.6</td>
<td>152.0</td>
<td>0.006374</td>
<td>0.024199</td>
<td>1.677</td>
<td>4.506</td>
</tr>
<tr>
<td>142.6 - 137.3</td>
<td>139.8</td>
<td>0.002257</td>
<td>0.026455</td>
<td>0.645</td>
<td>5.152</td>
</tr>
<tr>
<td>137.3 - 118.7</td>
<td>126.6</td>
<td>0.010515</td>
<td>0.036971</td>
<td>3.323</td>
<td>8.475</td>
</tr>
<tr>
<td>118.7 - 103.9</td>
<td>110.2</td>
<td>0.015982</td>
<td>0.052553</td>
<td>5.655</td>
<td>14.129</td>
</tr>
<tr>
<td>103.9 - 82.6</td>
<td>90.7</td>
<td>0.235321</td>
<td>0.287874</td>
<td>103.830</td>
<td>117.959</td>
</tr>
<tr>
<td>82.6 - 66.1</td>
<td>72.4</td>
<td>0.235614</td>
<td>0.523488</td>
<td>130.183</td>
<td>248.142</td>
</tr>
<tr>
<td>66.1 - 53.7</td>
<td>58.5</td>
<td>0.065587</td>
<td>0.589075</td>
<td>44.839</td>
<td>292.981</td>
</tr>
<tr>
<td>53.7 - 47.3</td>
<td>50.0</td>
<td>0.016589</td>
<td>0.605664</td>
<td>13.265</td>
<td>306.246</td>
</tr>
<tr>
<td>47.3 - 40.4</td>
<td>43.3</td>
<td>0.010129</td>
<td>0.615793</td>
<td>9.367</td>
<td>315.613</td>
</tr>
<tr>
<td>40.4 - 35.2</td>
<td>37.4</td>
<td>0.004607</td>
<td>0.620401</td>
<td>4.928</td>
<td>320.541</td>
</tr>
<tr>
<td>35.2 - 31.0</td>
<td>32.8</td>
<td>0.002019</td>
<td>0.622420</td>
<td>2.462</td>
<td>323.004</td>
</tr>
<tr>
<td>31.0 - 27.5</td>
<td>29.0</td>
<td>0.000687</td>
<td>0.623106</td>
<td>0.948</td>
<td>323.951</td>
</tr>
</tbody>
</table>

Mar 2011  7-39
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Started: 2011-02-24 17:21:07PM
Completed: 2011-02-24 17:21:07PM
Sample Mass: 0.2614 g
Cold Free Space: 47.8248 cm³
Equilibration Interval: 10 s
Automatic Degas: No

Analysis Adsorptive: N2
Analysis Bath Temp.: 77.125 K
Thermal Correction: No
Warm Free Space: 16.5571 cm³ Entered
Low Pressure Dose: None

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

BJH Desorption Cumulative Pore Volume (Larger)
Halsey : Faas Correction

Pore Volume (cm³/g)

Pore Width (Å)
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:
Sample: Silica-Alumina Reference analyzed with N2 at 77 K  
Operator: DJS  
Submitter: Micromeritics  
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Porosity Distribution by Density Functional Theory  
Model: N2 @ 77K, Cylindrical Pores in an Oxide Surface  
Method: Non-negative Regularization; No Smoothing  
Standard Deviation of Fit: 2.26318, cm³/g STP

<table>
<thead>
<tr>
<th>Pore Width (Å)</th>
<th>Cumulative Volume (cm³/g)</th>
<th>Incremental Volume (cm³/g)</th>
<th>Cumulative Area (m²/g)</th>
<th>Incremental Area (m²/g)</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.37</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>17.73</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>18.09</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>18.44</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>18.80</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>19.16</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>19.52</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>19.87</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>20.23</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>20.59</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>20.95</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>21.30</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>21.66</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>22.38</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>23.09</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>23.81</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>24.52</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>25.24</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>25.95</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>26.67</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>27.38</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>28.10</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>28.81</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>29.53</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>30.24</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>30.96</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>31.67</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>32.39</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
</tbody>
</table>
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Sample Mass: 0.2614 g Warm Free Space: 16.5571 cm³ Entered
Cold Free Space: 47.8248 cm³ Equilibration Interval: 10 s
Ambient Temperature: 295.15 K Low Pressure Dose: None
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Porosity Distribution by Density Functional Theory
Model: N2 @ 77K, Cylindrical Pores in an Oxide Surface
Method: Non-negative Regularization; No Smoothing
Standard Deviation of Fit: 2.26318, cm³/g STP

<table>
<thead>
<tr>
<th>Pore Width (Å)</th>
<th>Cumulative Volume (cm³/g)</th>
<th>Incremental Volume (cm³/g)</th>
<th>Cumulative Area (m²/g)</th>
<th>Incremental Area (m²/g)</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.37</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>17.73</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>18.09</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>18.44</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>18.80</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>19.16</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>19.52</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>19.87</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>20.23</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>20.59</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>20.95</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>21.30</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>21.66</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>22.38</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>23.09</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>23.81</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>24.52</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>25.24</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>25.95</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>26.67</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>27.38</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>28.10</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>28.81</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>29.53</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>30.24</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>30.96</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>31.67</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>32.39</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
</tbody>
</table>
Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

<table>
<thead>
<tr>
<th>Pore Width (Å)</th>
<th>Cumulative Volume (cm³/g)</th>
<th>Incremental Volume (cm³/g)</th>
<th>Cumulative Area (m²/g)</th>
<th>Incremental Area (m²/g)</th>
</tr>
</thead>
<tbody>
<tr>
<td>33.10</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>33.82</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>34.53</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>35.25</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>35.96</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>36.68</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>37.39</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>38.11</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>38.82</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>39.54</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>40.25</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>40.96</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>41.68</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>42.39</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>43.11</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>43.82</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>44.54</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>45.25</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>45.97</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>46.68</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>47.40</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>48.11</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>48.83</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>49.54</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>50.26</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>52.05</td>
<td>0.00382</td>
<td>0.00382</td>
<td>2.940</td>
<td>2.940</td>
</tr>
<tr>
<td>54.91</td>
<td>0.00600</td>
<td>0.00217</td>
<td>4.524</td>
<td>1.584</td>
</tr>
<tr>
<td>57.77</td>
<td>0.00922</td>
<td>0.00322</td>
<td>6.752</td>
<td>2.228</td>
</tr>
<tr>
<td>60.98</td>
<td>0.01610</td>
<td>0.00688</td>
<td>11.267</td>
<td>4.515</td>
</tr>
<tr>
<td>64.20</td>
<td>0.02103</td>
<td>0.00493</td>
<td>14.340</td>
<td>3.073</td>
</tr>
<tr>
<td>67.42</td>
<td>0.02939</td>
<td>0.00836</td>
<td>19.301</td>
<td>4.961</td>
</tr>
<tr>
<td>70.99</td>
<td>0.03727</td>
<td>0.00788</td>
<td>23.739</td>
<td>4.438</td>
</tr>
<tr>
<td>74.57</td>
<td>0.04326</td>
<td>0.00599</td>
<td>26.952</td>
<td>3.213</td>
</tr>
<tr>
<td>78.50</td>
<td>0.05491</td>
<td>0.01165</td>
<td>32.886</td>
<td>5.934</td>
</tr>
<tr>
<td>82.79</td>
<td>0.06762</td>
<td>0.01272</td>
<td>39.032</td>
<td>6.145</td>
</tr>
<tr>
<td>87.08</td>
<td>0.07661</td>
<td>0.00899</td>
<td>43.161</td>
<td>4.129</td>
</tr>
<tr>
<td>91.37</td>
<td>0.08693</td>
<td>0.01032</td>
<td>47.678</td>
<td>4.517</td>
</tr>
</tbody>
</table>
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Started: 2011-02-24 7:22:09PM
Completed: 2011-02-24 17:21:07PM
Sample Mass: 0.2614 g
Cold Free Space: 47.8246 cm³
Warm Free Space: 16.5571 cm³ Entered
Analysis Adsorptive: N2
Analysis Bath Temp.: 77.125 K
Thermal Correction: No
Low Pressure Dose: None
Auto Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

<table>
<thead>
<tr>
<th>Pore Size Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pore Width (Å)</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>96.37</td>
</tr>
<tr>
<td>101.38</td>
</tr>
<tr>
<td>106.38</td>
</tr>
<tr>
<td>112.10</td>
</tr>
<tr>
<td>117.82</td>
</tr>
<tr>
<td>123.90</td>
</tr>
<tr>
<td>130.33</td>
</tr>
<tr>
<td>136.76</td>
</tr>
<tr>
<td>143.91</td>
</tr>
<tr>
<td>151.06</td>
</tr>
<tr>
<td>158.93</td>
</tr>
<tr>
<td>167.15</td>
</tr>
<tr>
<td>175.73</td>
</tr>
<tr>
<td>184.66</td>
</tr>
<tr>
<td>193.96</td>
</tr>
<tr>
<td>203.97</td>
</tr>
<tr>
<td>214.33</td>
</tr>
<tr>
<td>225.05</td>
</tr>
<tr>
<td>236.50</td>
</tr>
<tr>
<td>248.29</td>
</tr>
<tr>
<td>261.16</td>
</tr>
<tr>
<td>274.39</td>
</tr>
<tr>
<td>287.97</td>
</tr>
<tr>
<td>302.63</td>
</tr>
<tr>
<td>318.00</td>
</tr>
<tr>
<td>334.08</td>
</tr>
<tr>
<td>350.88</td>
</tr>
<tr>
<td>368.76</td>
</tr>
<tr>
<td>387.34</td>
</tr>
</tbody>
</table>
Silica Alumina iso N2@77 K, 004/16821/00

ASAP 2020 V4.00  Unit 1  Serial #: 1410  Page 19

Sample: Silica-Alumina Reference analyzed with N2 at 77 K  
Operator: DJS  
Submitter: Micromeritics  
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Started: 2011-02-24 7:22:09PM  
Completed: 2011-02-24 17:21:07PM  
Thermal Correction: No  
Sample Mass: 0.2614 g  
Cold Free Space: 47.8248 cm³  
Ambient Temperature: 295.15 K  
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Porosity Distribution by Density Functional Theory
Model: N2 @ 77K, Cylindrical Pores in an Oxide Surface 
Method: Non-negative Regularization; No Smoothing

Standard Deviation of Fit: 2.26318, cm³/g STP

<table>
<thead>
<tr>
<th>Relative Pressure</th>
<th>Experimental Quantity Adsorbed (cm³/g STP)</th>
<th>Fitted Quantity Adsorbed (cm³/g STP)</th>
<th>Absolute Residual (cm³/g STP)</th>
<th>Relative Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.010000000</td>
<td>36.1963</td>
<td>33.9344</td>
<td>2.2619</td>
<td>0.062490</td>
</tr>
<tr>
<td>0.012359640</td>
<td>37.0506</td>
<td>35.2667</td>
<td>1.7839</td>
<td>0.048146</td>
</tr>
<tr>
<td>0.015186320</td>
<td>38.0505</td>
<td>36.6101</td>
<td>1.4404</td>
<td>0.037865</td>
</tr>
<tr>
<td>0.018485530</td>
<td>39.1661</td>
<td>37.9287</td>
<td>1.2374</td>
<td>0.031594</td>
</tr>
<tr>
<td>0.022294740</td>
<td>40.3665</td>
<td>39.2356</td>
<td>1.1309</td>
<td>0.028016</td>
</tr>
<tr>
<td>0.026634240</td>
<td>41.5932</td>
<td>40.5226</td>
<td>1.0706</td>
<td>0.025740</td>
</tr>
<tr>
<td>0.031598160</td>
<td>42.7486</td>
<td>41.8327</td>
<td>0.9159</td>
<td>0.021425</td>
</tr>
<tr>
<td>0.037162240</td>
<td>43.7566</td>
<td>43.1397</td>
<td>0.6168</td>
<td>0.014097</td>
</tr>
<tr>
<td>0.043374470</td>
<td>44.8019</td>
<td>44.6038</td>
<td>0.3412</td>
<td>0.007615</td>
</tr>
<tr>
<td>0.050259210</td>
<td>45.8935</td>
<td>45.7872</td>
<td>0.1063</td>
<td>0.002315</td>
</tr>
<tr>
<td>0.057835260</td>
<td>47.0073</td>
<td>47.0913</td>
<td>-0.0840</td>
<td>-0.001787</td>
</tr>
<tr>
<td>0.066115920</td>
<td>48.123</td>
<td>48.3730</td>
<td>-0.2607</td>
<td>-0.005419</td>
</tr>
<tr>
<td>0.075109080</td>
<td>49.2051</td>
<td>49.6257</td>
<td>-0.4206</td>
<td>-0.008548</td>
</tr>
<tr>
<td>0.084815920</td>
<td>50.2909</td>
<td>50.8434</td>
<td>-0.5525</td>
<td>-0.010985</td>
</tr>
<tr>
<td>0.095232370</td>
<td>51.3960</td>
<td>52.0278</td>
<td>-0.6318</td>
<td>-0.012293</td>
</tr>
<tr>
<td>0.106348200</td>
<td>52.5526</td>
<td>53.2136</td>
<td>-0.6610</td>
<td>-0.012578</td>
</tr>
<tr>
<td>0.118147500</td>
<td>53.7279</td>
<td>54.4444</td>
<td>-0.7165</td>
<td>-0.013336</td>
</tr>
<tr>
<td>0.130609100</td>
<td>54.9145</td>
<td>55.7869</td>
<td>-0.8545</td>
<td>-0.015650</td>
</tr>
<tr>
<td>0.143709600</td>
<td>56.1022</td>
<td>57.1914</td>
<td>-1.0813</td>
<td>-0.019271</td>
</tr>
<tr>
<td>0.157410500</td>
<td>57.3354</td>
<td>58.6579</td>
<td>-1.3225</td>
<td>-0.023066</td>
</tr>
<tr>
<td>0.171685500</td>
<td>58.6043</td>
<td>60.1325</td>
<td>-1.5282</td>
<td>-0.026076</td>
</tr>
<tr>
<td>0.186492100</td>
<td>59.9058</td>
<td>61.6095</td>
<td>-1.7037</td>
<td>-0.028440</td>
</tr>
<tr>
<td>0.201792100</td>
<td>61.2372</td>
<td>63.0953</td>
<td>-1.8581</td>
<td>-0.030342</td>
</tr>
<tr>
<td>0.217539600</td>
<td>62.6056</td>
<td>64.5869</td>
<td>-1.9814</td>
<td>-0.031648</td>
</tr>
<tr>
<td>0.233689500</td>
<td>64.0144</td>
<td>66.0851</td>
<td>-2.0707</td>
<td>-0.032347</td>
</tr>
<tr>
<td>0.250196100</td>
<td>65.4612</td>
<td>67.5898</td>
<td>-2.1266</td>
<td>-0.032517</td>
</tr>
<tr>
<td>0.267011800</td>
<td>66.9415</td>
<td>69.0972</td>
<td>-2.1557</td>
<td>-0.032203</td>
</tr>
<tr>
<td>0.284089500</td>
<td>68.4545</td>
<td>70.6092</td>
<td>-2.1546</td>
<td>-0.031475</td>
</tr>
<tr>
<td>0.301380300</td>
<td>70.0317</td>
<td>72.1252</td>
<td>-2.0935</td>
<td>-0.029893</td>
</tr>
<tr>
<td>0.318838200</td>
<td>71.6604</td>
<td>73.6451</td>
<td>-1.9847</td>
<td>-0.027969</td>
</tr>
<tr>
<td>0.336417100</td>
<td>73.3228</td>
<td>75.1697</td>
<td>-1.8469</td>
<td>-0.025189</td>
</tr>
</tbody>
</table>
Sample: Silica-Alumina Reference analyzed with N2 at 77 K  
Operator: DJS  
Submitter: Micromeritics  
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Started: 2011-02-24 7:22:09PM  
Completed: 2011-02-24 17:21:07PM  
Analysis Adsorptive: N2  
Analysis Bath Temp.: 77.125 K  
Sample Mass: 0.2614 g  
Warm Free Space: 16.5571 cm³ Entered  
Cold Free Space: 47.8248 cm³  
Equilibration Interval: 10 s  
Low Pressure Dose: None  
Automatic Degas: No  
Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

<table>
<thead>
<tr>
<th>Relative Pressure</th>
<th>Experimental Quantity Adsorbed (cm³/g STP)</th>
<th>Fitted Quantity Adsorbed (cm³/g STP)</th>
<th>Absolute Residual (cm³/g STP)</th>
<th>Relative Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.354071100</td>
<td>75.0419</td>
<td>76.7004</td>
<td>-1.6585</td>
<td>-0.022101</td>
</tr>
<tr>
<td>0.371757900</td>
<td>76.8035</td>
<td>79.7889</td>
<td>-1.1815</td>
<td>-0.015030</td>
</tr>
<tr>
<td>0.398435500</td>
<td>80.4845</td>
<td>81.3548</td>
<td>-0.8704</td>
<td>-0.010814</td>
</tr>
<tr>
<td>0.424610500</td>
<td>82.4086</td>
<td>82.9392</td>
<td>-0.5306</td>
<td>-0.006438</td>
</tr>
<tr>
<td>0.442034200</td>
<td>84.4033</td>
<td>86.1726</td>
<td>0.3171</td>
<td>0.003966</td>
</tr>
<tr>
<td>0.476393400</td>
<td>88.6250</td>
<td>87.8292</td>
<td>0.7959</td>
<td>0.008960</td>
</tr>
<tr>
<td>0.493271100</td>
<td>90.8534</td>
<td>90.5062</td>
<td>0.3472</td>
<td>0.003822</td>
</tr>
<tr>
<td>0.509911800</td>
<td>93.1878</td>
<td>92.2003</td>
<td>0.9875</td>
<td>0.010597</td>
</tr>
<tr>
<td>0.526293400</td>
<td>95.9294</td>
<td>94.5030</td>
<td>1.0830</td>
<td>0.011330</td>
</tr>
<tr>
<td>0.542394700</td>
<td>98.1346</td>
<td>97.1456</td>
<td>0.9889</td>
<td>0.010077</td>
</tr>
<tr>
<td>0.558200000</td>
<td>100.8002</td>
<td>100.8967</td>
<td>-0.0965</td>
<td>-0.000957</td>
</tr>
<tr>
<td>0.573690800</td>
<td>103.5331</td>
<td>102.6166</td>
<td>0.9165</td>
<td>0.008852</td>
</tr>
<tr>
<td>0.589853900</td>
<td>106.4955</td>
<td>105.8180</td>
<td>0.6776</td>
<td>0.006362</td>
</tr>
<tr>
<td>0.603677600</td>
<td>109.5999</td>
<td>110.1203</td>
<td>-0.5203</td>
<td>-0.004748</td>
</tr>
<tr>
<td>0.618153900</td>
<td>112.9576</td>
<td>111.7963</td>
<td>1.1612</td>
<td>0.010280</td>
</tr>
<tr>
<td>0.632272400</td>
<td>116.5022</td>
<td>115.9740</td>
<td>0.5282</td>
<td>0.004534</td>
</tr>
<tr>
<td>0.646028900</td>
<td>120.0740</td>
<td>119.5869</td>
<td>0.4871</td>
<td>0.004057</td>
</tr>
<tr>
<td>0.659417100</td>
<td>123.9543</td>
<td>125.1541</td>
<td>-1.1998</td>
<td>-0.009680</td>
</tr>
<tr>
<td>0.672435500</td>
<td>128.4107</td>
<td>126.7495</td>
<td>1.6612</td>
<td>0.012937</td>
</tr>
<tr>
<td>0.685081600</td>
<td>133.1213</td>
<td>132.7459</td>
<td>0.3754</td>
<td>0.002820</td>
</tr>
<tr>
<td>0.697355300</td>
<td>137.8245</td>
<td>137.5052</td>
<td>0.3192</td>
<td>0.002316</td>
</tr>
<tr>
<td>0.709258800</td>
<td>143.1260</td>
<td>142.8095</td>
<td>0.3164</td>
<td>0.002211</td>
</tr>
<tr>
<td>0.720789500</td>
<td>149.3008</td>
<td>151.8437</td>
<td>-2.5430</td>
<td>-0.017033</td>
</tr>
<tr>
<td>0.731953900</td>
<td>156.1519</td>
<td>153.3167</td>
<td>2.8353</td>
<td>0.018157</td>
</tr>
<tr>
<td>0.742756600</td>
<td>163.5096</td>
<td>163.2793</td>
<td>0.2303</td>
<td>0.001409</td>
</tr>
<tr>
<td>0.753200000</td>
<td>171.2223</td>
<td>170.9685</td>
<td>0.2258</td>
<td>0.001319</td>
</tr>
<tr>
<td>0.763289500</td>
<td>179.5559</td>
<td>179.3622</td>
<td>0.1937</td>
<td>0.001079</td>
</tr>
<tr>
<td>0.773030300</td>
<td>189.1292</td>
<td>193.8378</td>
<td>-4.7086</td>
<td>-0.024896</td>
</tr>
<tr>
<td>0.782430300</td>
<td>199.0012</td>
<td>195.0806</td>
<td>4.9206</td>
<td>0.024603</td>
</tr>
<tr>
<td>0.791496100</td>
<td>212.1898</td>
<td>212.0294</td>
<td>0.1605</td>
<td>0.007566</td>
</tr>
<tr>
<td>0.800232900</td>
<td>225.6826</td>
<td>225.5435</td>
<td>0.1391</td>
<td>0.006016</td>
</tr>
<tr>
<td>0.808648700</td>
<td>240.3101</td>
<td>240.1757</td>
<td>0.1344</td>
<td>0.005599</td>
</tr>
<tr>
<td>0.816752600</td>
<td>255.2179</td>
<td>255.1008</td>
<td>0.1171</td>
<td>0.004599</td>
</tr>
<tr>
<td>0.824652600</td>
<td>269.9568</td>
<td>269.8444</td>
<td>0.1124</td>
<td>0.004160</td>
</tr>
</tbody>
</table>
Silica Alumina iso N2@77 K, 004/16821/00

Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Started: 2011-02-24 7:22:09PM
Completed: 2011-02-24 17:21:07PM
Analysis Adsorptive: N2
Analysis Bath Temp.: 77.125 K
Sample Mass: 0.2614 g
Warm Free Space: 16.5571 cm³ Entered
Cold Free Space: 47.8248 cm³ Entered
Ambient Temperature: 295.15 K
Low Pressure Dose: None
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

<table>
<thead>
<tr>
<th>Relative Pressure</th>
<th>Experimental Quantity Adsorbed (cm³/g STP)</th>
<th>Fitted Quantity Adsorbed (cm³/g STP)</th>
<th>Absolute Residual (cm³/g STP)</th>
<th>Relative Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.832053900</td>
<td>284.6197</td>
<td>291.3352</td>
<td>-6.7155</td>
<td>-0.023594</td>
</tr>
<tr>
<td>0.839267100</td>
<td>298.8533</td>
<td>300.0003</td>
<td>6.8530</td>
<td>0.022931</td>
</tr>
<tr>
<td>0.846200000</td>
<td>312.3517</td>
<td>312.2606</td>
<td>0.0911</td>
<td>0.000292</td>
</tr>
<tr>
<td>0.852460500</td>
<td>324.8806</td>
<td>324.7974</td>
<td>0.0832</td>
<td>0.000256</td>
</tr>
<tr>
<td>0.859257900</td>
<td>335.8928</td>
<td>335.8168</td>
<td>0.0760</td>
<td>0.000252</td>
</tr>
<tr>
<td>0.865398700</td>
<td>344.1136</td>
<td>344.0416</td>
<td>0.0719</td>
<td>0.000220</td>
</tr>
<tr>
<td>0.871292100</td>
<td>350.1375</td>
<td>350.0720</td>
<td>0.0655</td>
<td>0.000187</td>
</tr>
<tr>
<td>0.876947400</td>
<td>354.6217</td>
<td>354.5619</td>
<td>0.0598</td>
<td>0.000169</td>
</tr>
<tr>
<td>0.882369700</td>
<td>358.1534</td>
<td>358.0971</td>
<td>0.0564</td>
<td>0.000157</td>
</tr>
<tr>
<td>0.887589700</td>
<td>361.3644</td>
<td>361.3130</td>
<td>0.0514</td>
<td>0.000142</td>
</tr>
<tr>
<td>0.892573000</td>
<td>364.3068</td>
<td>365.4654</td>
<td>-1.1587</td>
<td>-0.03180</td>
</tr>
<tr>
<td>0.897328900</td>
<td>366.9574</td>
<td>365.7445</td>
<td>1.2129</td>
<td>0.003305</td>
</tr>
<tr>
<td>0.901905300</td>
<td>389.3046</td>
<td>389.2597</td>
<td>0.0449</td>
<td>0.000122</td>
</tr>
<tr>
<td>0.906286800</td>
<td>371.3407</td>
<td>371.2998</td>
<td>0.0409</td>
<td>0.000110</td>
</tr>
<tr>
<td>0.910484200</td>
<td>373.1341</td>
<td>373.0949</td>
<td>0.0392</td>
<td>0.000105</td>
</tr>
<tr>
<td>0.914501300</td>
<td>374.8452</td>
<td>374.8087</td>
<td>0.0365</td>
<td>0.000097</td>
</tr>
<tr>
<td>0.918347400</td>
<td>376.4730</td>
<td>376.4391</td>
<td>0.0339</td>
<td>0.000090</td>
</tr>
<tr>
<td>0.922026300</td>
<td>378.0092</td>
<td>377.9777</td>
<td>0.0315</td>
<td>0.000083</td>
</tr>
<tr>
<td>0.925547400</td>
<td>379.4506</td>
<td>379.4207</td>
<td>0.0298</td>
<td>0.000079</td>
</tr>
<tr>
<td>0.928915800</td>
<td>380.7942</td>
<td>380.7666</td>
<td>0.0276</td>
<td>0.000073</td>
</tr>
<tr>
<td>0.932138800</td>
<td>382.0392</td>
<td>380.2888</td>
<td>-8.2496</td>
<td>-0.021594</td>
</tr>
<tr>
<td>0.935218400</td>
<td>383.1983</td>
<td>390.4504</td>
<td>-7.2521</td>
<td>-0.019925</td>
</tr>
<tr>
<td>0.938163200</td>
<td>384.2902</td>
<td>390.6042</td>
<td>-6.3140</td>
<td>-0.016430</td>
</tr>
<tr>
<td>0.940978800</td>
<td>385.3120</td>
<td>390.7572</td>
<td>-5.4452</td>
<td>-0.014132</td>
</tr>
<tr>
<td>0.943669700</td>
<td>386.2607</td>
<td>390.9145</td>
<td>-4.6538</td>
<td>-0.012648</td>
</tr>
<tr>
<td>0.946242100</td>
<td>387.1357</td>
<td>391.0645</td>
<td>-3.9287</td>
<td>-0.010148</td>
</tr>
<tr>
<td>0.948700000</td>
<td>387.9436</td>
<td>391.2074</td>
<td>-3.2639</td>
<td>-0.008413</td>
</tr>
<tr>
<td>0.951048700</td>
<td>388.7777</td>
<td>391.3527</td>
<td>-2.6450</td>
<td>-0.006805</td>
</tr>
<tr>
<td>0.953292100</td>
<td>389.4297</td>
<td>391.5019</td>
<td>-2.0722</td>
<td>-0.005321</td>
</tr>
<tr>
<td>0.955435500</td>
<td>390.1102</td>
<td>391.6442</td>
<td>-1.5340</td>
<td>-0.003932</td>
</tr>
<tr>
<td>0.957482900</td>
<td>390.7495</td>
<td>391.7798</td>
<td>-1.0303</td>
<td>-0.002637</td>
</tr>
<tr>
<td>0.959438200</td>
<td>391.3488</td>
<td>391.9092</td>
<td>-0.5603</td>
<td>-0.001432</td>
</tr>
<tr>
<td>0.961305300</td>
<td>391.9093</td>
<td>392.0503</td>
<td>-0.1410</td>
<td>-0.000360</td>
</tr>
<tr>
<td>0.963082000</td>
<td>392.4324</td>
<td>392.1921</td>
<td>0.2403</td>
<td>0.000612</td>
</tr>
<tr>
<td>0.967489500</td>
<td>392.9195</td>
<td>392.3274</td>
<td>0.5921</td>
<td>0.001507</td>
</tr>
<tr>
<td>0.966414500</td>
<td>393.3726</td>
<td>392.4563</td>
<td>0.9163</td>
<td>0.002329</td>
</tr>
</tbody>
</table>
Silica Alumina iso N2@77 K, 004/16821/00

ASAP 2020 V4.00  Unit 1  Serial #: 1410  Page 22

Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Isotherm Table

<table>
<thead>
<tr>
<th>Relative Pressure</th>
<th>Experimental Quantity Adsorbed (cm³/g STP)</th>
<th>Fitted Quantity Adsorbed (cm³/g STP)</th>
<th>Absolute Residual (cm³/g STP)</th>
<th>Relative Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.967965800</td>
<td>393.7934</td>
<td>392.5794</td>
<td>1.2140</td>
<td>0.003083</td>
</tr>
<tr>
<td>0.969447400</td>
<td>394.1838</td>
<td>392.6968</td>
<td>1.4870</td>
<td>0.003772</td>
</tr>
<tr>
<td>0.972092000</td>
<td>394.5450</td>
<td>392.8387</td>
<td>1.7063</td>
<td>0.004325</td>
</tr>
<tr>
<td>0.973496100</td>
<td>394.8791</td>
<td>392.9925</td>
<td>1.8866</td>
<td>0.004778</td>
</tr>
<tr>
<td>0.974725000</td>
<td>395.1876</td>
<td>393.1391</td>
<td>2.0485</td>
<td>0.005184</td>
</tr>
<tr>
<td>0.975897400</td>
<td>395.7350</td>
<td>393.4126</td>
<td>2.2225</td>
<td>0.005869</td>
</tr>
<tr>
<td>0.977015800</td>
<td>395.9768</td>
<td>393.5398</td>
<td>2.3439</td>
<td>0.006154</td>
</tr>
<tr>
<td>0.978082900</td>
<td>396.2014</td>
<td>393.6612</td>
<td>2.5403</td>
<td>0.006412</td>
</tr>
<tr>
<td>0.979101300</td>
<td>396.4156</td>
<td>393.7770</td>
<td>2.6386</td>
<td>0.006656</td>
</tr>
<tr>
<td>0.980072400</td>
<td>396.6199</td>
<td>393.8722</td>
<td>2.7327</td>
<td>0.006930</td>
</tr>
<tr>
<td>0.980998700</td>
<td>396.8147</td>
<td>393.9901</td>
<td>2.8246</td>
<td>0.007118</td>
</tr>
<tr>
<td>0.981882900</td>
<td>397.0007</td>
<td>394.0884</td>
<td>2.9123</td>
<td>0.007336</td>
</tr>
<tr>
<td>0.982726300</td>
<td>397.1791</td>
<td>394.1821</td>
<td>2.9960</td>
<td>0.007543</td>
</tr>
<tr>
<td>0.983503000</td>
<td>397.3472</td>
<td>394.2714</td>
<td>3.0758</td>
<td>0.007741</td>
</tr>
<tr>
<td>0.984297400</td>
<td>397.5085</td>
<td>394.3565</td>
<td>3.1520</td>
<td>0.007929</td>
</tr>
<tr>
<td>0.985028900</td>
<td>397.6623</td>
<td>394.6254</td>
<td>3.0369</td>
<td>0.007637</td>
</tr>
<tr>
<td>0.985727600</td>
<td>397.8093</td>
<td>394.8822</td>
<td>2.9271</td>
<td>0.007358</td>
</tr>
<tr>
<td>0.986392100</td>
<td>397.9491</td>
<td>395.1294</td>
<td>2.8227</td>
<td>0.007093</td>
</tr>
<tr>
<td>0.987027600</td>
<td>398.0827</td>
<td>395.3599</td>
<td>2.7228</td>
<td>0.006840</td>
</tr>
<tr>
<td>0.987632900</td>
<td>398.2100</td>
<td>395.5823</td>
<td>2.6277</td>
<td>0.006599</td>
</tr>
<tr>
<td>0.988209200</td>
<td>398.3312</td>
<td>395.9965</td>
<td>2.3348</td>
<td>0.005861</td>
</tr>
<tr>
<td>0.988760500</td>
<td>398.4472</td>
<td>396.7324</td>
<td>1.7148</td>
<td>0.004304</td>
</tr>
<tr>
<td>0.989285500</td>
<td>398.5276</td>
<td>397.4332</td>
<td>1.1244</td>
<td>0.002821</td>
</tr>
<tr>
<td>0.989785500</td>
<td>398.6628</td>
<td>398.1006</td>
<td>0.5622</td>
<td>0.001410</td>
</tr>
<tr>
<td>0.990263200</td>
<td>398.7632</td>
<td>399.0940</td>
<td>-0.3308</td>
<td>-0.000830</td>
</tr>
<tr>
<td>0.990718400</td>
<td>398.8590</td>
<td>400.3168</td>
<td>-1.4578</td>
<td>-0.003685</td>
</tr>
<tr>
<td>0.991151300</td>
<td>398.9500</td>
<td>401.4798</td>
<td>-2.5927</td>
<td>-0.008341</td>
</tr>
<tr>
<td>0.991568800</td>
<td>399.0372</td>
<td>402.5932</td>
<td>-3.5560</td>
<td>-0.008911</td>
</tr>
<tr>
<td>0.991959200</td>
<td>399.1199</td>
<td>403.6500</td>
<td>-4.5300</td>
<td>-0.011350</td>
</tr>
</tbody>
</table>
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Sample Mass: 0.2614 g Warm Free Space: 16.5571 cm³ Entered
Cold Free Space: 47.8248 cm³ Equilibration Interval: 10 s
Ambient Temperature: 295.15 K Low Pressure Dose: None
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Cumulative Pore Volume vs. Pore Width
Silica Alumina iso N2@77 K, 004/16821/00

Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Started: 2011-02-24 7:22:09PM
Completed: 2011-02-24 17:21:07PM
Analysis Adsorptive: N2
Analysis Bath Temp.: 77.125 K
Thermal Correction: No
Sample Mass: 0.2614 g
Warm Free Space: 16.5571 cm³
Cold Free Space: 47.8248 cm³
Ambient Temperature: 295.15 K
Low Pressure Dose: None
Equilibration Interval: 10 s
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Differential Pore Volume vs. Pore Width

Differential Pore Volume (cm³/g)
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Sample Mass: 0.2614 g Warm Free Space: 16.5571 cm³ Entered
Cold Free Space: 47.8248 cm³ Equilibration Interval: 10 s
Ambient Temperature: 295.15 K Low Pressure Dose: None
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Standard Deviation of Fit: 2.26318, cm³/gSTP
DFT Surface Energy Report - Silica Alumina

Silica Alumina iso N2@77 K, 004/16821/00

Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Started: 2011-02-24 7:22:09PM
Completed: 2011-02-24 17:21:07PM
Analysis Adsorptive: N2
Analysis Bath Temp.: 77.125 K
Thermal Correction: No
Warm Free Space: 16.5571 cm³ Entered
Equilibration Interval: 10 s
Low Pressure Dose: None
Sample Mass: 0.2614 g
Cold Free Space: 47.8248 cm³
Ambient Temperature: 295.15 K
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Surface Energy Distribution by Modified Density Functional Theory
Model: N2 @ 77K, Surface Energy Distribution
Method: Non-negative Regularization; No Smoothing
Standard Deviation of Fit: 0.08682, cm³/g STP

Total Area : 349.553 m²/g

Surface Energy Table

<table>
<thead>
<tr>
<th>Energy (e/k)</th>
<th>Cumulative Area (m²/g)</th>
<th>Incremental Area (m²/g)</th>
</tr>
</thead>
<tbody>
<tr>
<td>20.00</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>22.00</td>
<td>129.052</td>
<td>129.052</td>
</tr>
<tr>
<td>24.00</td>
<td>129.052</td>
<td>0.000</td>
</tr>
<tr>
<td>26.00</td>
<td>129.052</td>
<td>0.000</td>
</tr>
<tr>
<td>28.00</td>
<td>129.052</td>
<td>0.000</td>
</tr>
<tr>
<td>30.00</td>
<td>129.052</td>
<td>0.000</td>
</tr>
<tr>
<td>32.00</td>
<td>129.052</td>
<td>0.000</td>
</tr>
<tr>
<td>34.00</td>
<td>129.052</td>
<td>0.000</td>
</tr>
<tr>
<td>36.00</td>
<td>145.197</td>
<td>16.145</td>
</tr>
<tr>
<td>38.00</td>
<td>145.197</td>
<td>0.000</td>
</tr>
<tr>
<td>40.00</td>
<td>145.197</td>
<td>0.000</td>
</tr>
<tr>
<td>42.00</td>
<td>145.197</td>
<td>0.000</td>
</tr>
<tr>
<td>44.00</td>
<td>262.309</td>
<td>117.112</td>
</tr>
<tr>
<td>46.00</td>
<td>262.309</td>
<td>0.000</td>
</tr>
<tr>
<td>48.00</td>
<td>262.335</td>
<td>0.027</td>
</tr>
<tr>
<td>50.00</td>
<td>262.335</td>
<td>0.000</td>
</tr>
<tr>
<td>52.00</td>
<td>262.335</td>
<td>0.000</td>
</tr>
<tr>
<td>54.00</td>
<td>262.335</td>
<td>0.000</td>
</tr>
<tr>
<td>56.00</td>
<td>287.694</td>
<td>25.358</td>
</tr>
<tr>
<td>58.00</td>
<td>287.694</td>
<td>0.000</td>
</tr>
<tr>
<td>60.00</td>
<td>287.694</td>
<td>0.000</td>
</tr>
<tr>
<td>62.00</td>
<td>287.694</td>
<td>0.000</td>
</tr>
<tr>
<td>64.00</td>
<td>308.720</td>
<td>21.026</td>
</tr>
<tr>
<td>66.00</td>
<td>308.720</td>
<td>0.000</td>
</tr>
<tr>
<td>68.00</td>
<td>308.720</td>
<td>0.000</td>
</tr>
<tr>
<td>70.00</td>
<td>308.720</td>
<td>0.000</td>
</tr>
<tr>
<td>72.00</td>
<td>319.473</td>
<td>10.753</td>
</tr>
<tr>
<td>74.00</td>
<td>319.473</td>
<td>0.000</td>
</tr>
<tr>
<td>76.00</td>
<td>319.473</td>
<td>0.000</td>
</tr>
<tr>
<td>78.00</td>
<td>328.859</td>
<td>9.386</td>
</tr>
<tr>
<td>80.00</td>
<td>328.859</td>
<td>0.000</td>
</tr>
</tbody>
</table>
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

<table>
<thead>
<tr>
<th>Energy (e/k)</th>
<th>Cumulative Area (m²/g)</th>
<th>Incremental Area (m²/g)</th>
</tr>
</thead>
<tbody>
<tr>
<td>82.00</td>
<td>328.859</td>
<td>0.000</td>
</tr>
<tr>
<td>84.00</td>
<td>328.859</td>
<td>0.000</td>
</tr>
<tr>
<td>86.00</td>
<td>336.830</td>
<td>7.971</td>
</tr>
<tr>
<td>88.00</td>
<td>336.830</td>
<td>0.000</td>
</tr>
<tr>
<td>90.00</td>
<td>336.830</td>
<td>0.000</td>
</tr>
<tr>
<td>92.00</td>
<td>341.670</td>
<td>4.840</td>
</tr>
<tr>
<td>94.00</td>
<td>341.670</td>
<td>0.000</td>
</tr>
<tr>
<td>96.00</td>
<td>341.670</td>
<td>0.000</td>
</tr>
<tr>
<td>98.00</td>
<td>341.670</td>
<td>0.000</td>
</tr>
<tr>
<td>100.00</td>
<td>349.553</td>
<td>7.884</td>
</tr>
</tbody>
</table>

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Surface Energy Distribution by Modified Density Functional Theory
Model: N2 @ 77K, Surface Energy Distribution
Method: Non-negative Regularization; No Smoothing

Standard Deviation of Fit: 0.08682, cm³/g STP

<table>
<thead>
<tr>
<th>Relative Pressure</th>
<th>Experimental Quantity Adsorbed (cm³/g STP)</th>
<th>Fitted Quantity Adsorbed (cm³/g STP)</th>
<th>Absolute Residual (cm³/g STP)</th>
<th>Relative Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.010000000</td>
<td>36.196</td>
<td>35.852</td>
<td>0.3434</td>
<td>0.009487</td>
</tr>
<tr>
<td>0.010592537</td>
<td>36.412</td>
<td>36.184</td>
<td>0.2286</td>
<td>0.006279</td>
</tr>
<tr>
<td>0.011220185</td>
<td>36.640</td>
<td>36.510</td>
<td>0.1305</td>
<td>0.003562</td>
</tr>
<tr>
<td>0.011850222</td>
<td>36.881</td>
<td>36.833</td>
<td>0.0483</td>
<td>0.001310</td>
</tr>
<tr>
<td>0.012589254</td>
<td>37.134</td>
<td>37.153</td>
<td>-0.0187</td>
<td>-0.000504</td>
</tr>
<tr>
<td>0.013335214</td>
<td>37.400</td>
<td>37.471</td>
<td>-0.0714</td>
<td>-0.001908</td>
</tr>
<tr>
<td>0.014125375</td>
<td>37.679</td>
<td>37.790</td>
<td>-0.1105</td>
<td>-0.002933</td>
</tr>
<tr>
<td>0.014962357</td>
<td>37.972</td>
<td>38.109</td>
<td>-0.1371</td>
<td>-0.003611</td>
</tr>
<tr>
<td>0.015848932</td>
<td>38.279</td>
<td>38.431</td>
<td>-0.1521</td>
<td>-0.003975</td>
</tr>
<tr>
<td>0.016788040</td>
<td>38.599</td>
<td>38.759</td>
<td>-0.1567</td>
<td>-0.004059</td>
</tr>
<tr>
<td>0.017782794</td>
<td>38.933</td>
<td>39.085</td>
<td>-0.1517</td>
<td>-0.003897</td>
</tr>
<tr>
<td>0.018836491</td>
<td>39.281</td>
<td>39.419</td>
<td>-0.1382</td>
<td>-0.003518</td>
</tr>
<tr>
<td>0.019952623</td>
<td>39.640</td>
<td>39.757</td>
<td>-0.1168</td>
<td>-0.002947</td>
</tr>
<tr>
<td>0.021134890</td>
<td>40.012</td>
<td>40.100</td>
<td>-0.0883</td>
<td>-0.002206</td>
</tr>
<tr>
<td>0.022387211</td>
<td>40.394</td>
<td>40.447</td>
<td>-0.0532</td>
<td>-0.001316</td>
</tr>
<tr>
<td>0.023713737</td>
<td>40.784</td>
<td>40.797</td>
<td>-0.0126</td>
<td>-0.000309</td>
</tr>
<tr>
<td>0.025118864</td>
<td>41.181</td>
<td>41.150</td>
<td>0.0313</td>
<td>0.000760</td>
</tr>
<tr>
<td>0.026607251</td>
<td>41.581</td>
<td>41.560</td>
<td>0.0752</td>
<td>0.001908</td>
</tr>
<tr>
<td>0.028183829</td>
<td>41.980</td>
<td>41.866</td>
<td>0.1136</td>
<td>0.002706</td>
</tr>
<tr>
<td>0.029853826</td>
<td>42.370</td>
<td>42.239</td>
<td>0.1391</td>
<td>0.003282</td>
</tr>
<tr>
<td>0.031622777</td>
<td>42.756</td>
<td>42.619</td>
<td>0.1417</td>
<td>0.003314</td>
</tr>
<tr>
<td>0.033496544</td>
<td>43.114</td>
<td>43.004</td>
<td>0.1097</td>
<td>0.002545</td>
</tr>
<tr>
<td>0.035481339</td>
<td>43.464</td>
<td>43.418</td>
<td>0.0526</td>
<td>0.001209</td>
</tr>
<tr>
<td>0.037583740</td>
<td>43.829</td>
<td>43.827</td>
<td>0.0018</td>
<td>0.000041</td>
</tr>
<tr>
<td>0.039810717</td>
<td>44.200</td>
<td>44.242</td>
<td>-0.0332</td>
<td>-0.000750</td>
</tr>
<tr>
<td>0.042196950</td>
<td>44.636</td>
<td>44.653</td>
<td>-0.0498</td>
<td>-0.001116</td>
</tr>
<tr>
<td>0.044668359</td>
<td>45.016</td>
<td>45.069</td>
<td>-0.0513</td>
<td>-0.001140</td>
</tr>
<tr>
<td>0.047315126</td>
<td>45.435</td>
<td>45.479</td>
<td>-0.0434</td>
<td>-0.000955</td>
</tr>
<tr>
<td>0.050118723</td>
<td>45.871</td>
<td>45.903</td>
<td>-0.0314</td>
<td>-0.000685</td>
</tr>
<tr>
<td>0.053088444</td>
<td>46.320</td>
<td>46.338</td>
<td>-0.0183</td>
<td>-0.000396</td>
</tr>
<tr>
<td>0.056023413</td>
<td>46.776</td>
<td>46.783</td>
<td>-0.0038</td>
<td>-0.000081</td>
</tr>
</tbody>
</table>
Sample: Silica-Alumina Reference analyzed with N2 at 77 K  
Operator: DJS  
Submitter: Micromeritics  
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP  

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

<table>
<thead>
<tr>
<th>Relative Pressure</th>
<th>Experimental Quantity Adsorbed (cm³/g STP)</th>
<th>Fitted Quantity Adsorbed (cm³/g STP)</th>
<th>Absolute Residual (cm³/g STP)</th>
<th>Relative Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.059568214</td>
<td>47.2482</td>
<td>47.2370</td>
<td>0.0113</td>
<td>0.000239</td>
</tr>
<tr>
<td>0.063095734</td>
<td>47.7234</td>
<td>47.7018</td>
<td>0.0216</td>
<td>0.000453</td>
</tr>
<tr>
<td>0.066834392</td>
<td>48.2023</td>
<td>48.1820</td>
<td>0.0204</td>
<td>0.000423</td>
</tr>
<tr>
<td>0.070794578</td>
<td>48.6842</td>
<td>48.6777</td>
<td>0.0066</td>
<td>0.000135</td>
</tr>
<tr>
<td>0.074989421</td>
<td>49.1908</td>
<td>49.1840</td>
<td>0.0067</td>
<td>0.000137</td>
</tr>
<tr>
<td>0.079432823</td>
<td>49.7097</td>
<td>49.6971</td>
<td>0.0126</td>
<td>0.000253</td>
</tr>
<tr>
<td>0.084139514</td>
<td>50.2189</td>
<td>50.2187</td>
<td>0.0002</td>
<td>0.000004</td>
</tr>
<tr>
<td>0.089125094</td>
<td>50.7492</td>
<td>50.7547</td>
<td>-0.0054</td>
<td>-0.000107</td>
</tr>
<tr>
<td>0.094406088</td>
<td>51.3088</td>
<td>51.3119</td>
<td>-0.0030</td>
<td>-0.000059</td>
</tr>
<tr>
<td>0.100000000</td>
<td>51.9893</td>
<td>51.9894</td>
<td>0.0015</td>
<td>0.000028</td>
</tr>
<tr>
<td>0.105925373</td>
<td>52.6093</td>
<td>52.6094</td>
<td>0.0004</td>
<td>0.000013</td>
</tr>
<tr>
<td>0.11201845</td>
<td>53.1441</td>
<td>53.1319</td>
<td>0.0123</td>
<td>0.000231</td>
</tr>
<tr>
<td>0.118850223</td>
<td>53.7956</td>
<td>53.7815</td>
<td>0.0141</td>
<td>0.000263</td>
</tr>
<tr>
<td>0.125892541</td>
<td>54.4691</td>
<td>54.4560</td>
<td>0.0131</td>
<td>0.000240</td>
</tr>
<tr>
<td>0.133352143</td>
<td>55.1704</td>
<td>55.1602</td>
<td>0.0102</td>
<td>0.000185</td>
</tr>
<tr>
<td>0.141525754</td>
<td>55.8906</td>
<td>55.8936</td>
<td>-0.0031</td>
<td>-0.000055</td>
</tr>
<tr>
<td>0.149623566</td>
<td>56.6397</td>
<td>56.6534</td>
<td>-0.0138</td>
<td>-0.000243</td>
</tr>
<tr>
<td>0.158489319</td>
<td>57.4316</td>
<td>57.4407</td>
<td>-0.0091</td>
<td>-0.000158</td>
</tr>
<tr>
<td>0.167880402</td>
<td>58.2672</td>
<td>58.2632</td>
<td>0.0040</td>
<td>0.000068</td>
</tr>
<tr>
<td>0.177827941</td>
<td>59.1464</td>
<td>59.1327</td>
<td>0.0138</td>
<td>0.000233</td>
</tr>
<tr>
<td>0.188364909</td>
<td>60.0691</td>
<td>60.0602</td>
<td>0.0089</td>
<td>0.000148</td>
</tr>
<tr>
<td>0.199526231</td>
<td>61.0404</td>
<td>61.0500</td>
<td>-0.0096</td>
<td>-0.000158</td>
</tr>
<tr>
<td>0.211348904</td>
<td>62.0674</td>
<td>62.0958</td>
<td>-0.0284</td>
<td>-0.000457</td>
</tr>
<tr>
<td>0.223872114</td>
<td>63.1570</td>
<td>63.1900</td>
<td>-0.0329</td>
<td>-0.000522</td>
</tr>
<tr>
<td>0.237137371</td>
<td>64.3161</td>
<td>64.3351</td>
<td>-0.0190</td>
<td>-0.000296</td>
</tr>
<tr>
<td>0.251188643</td>
<td>65.5484</td>
<td>65.5451</td>
<td>0.0034</td>
<td>0.000051</td>
</tr>
<tr>
<td>0.266072506</td>
<td>66.8586</td>
<td>66.8407</td>
<td>0.0180</td>
<td>0.000289</td>
</tr>
<tr>
<td>0.281838203</td>
<td>68.2530</td>
<td>68.2424</td>
<td>0.0106</td>
<td>0.000156</td>
</tr>
<tr>
<td>0.298538262</td>
<td>69.7694</td>
<td>69.7632</td>
<td>0.0062</td>
<td>0.000089</td>
</tr>
<tr>
<td>0.316227766</td>
<td>71.4155</td>
<td>71.4077</td>
<td>0.0078</td>
<td>0.000109</td>
</tr>
<tr>
<td>0.334969349</td>
<td>73.1837</td>
<td>73.1847</td>
<td>-0.0004</td>
<td>-0.000005</td>
</tr>
<tr>
<td>0.354813389</td>
<td>75.1152</td>
<td>75.1089</td>
<td>0.0062</td>
<td>0.000083</td>
</tr>
<tr>
<td>0.375837404</td>
<td>77.2136</td>
<td>77.2050</td>
<td>0.0086</td>
<td>0.000111</td>
</tr>
<tr>
<td>0.398107171</td>
<td>79.5221</td>
<td>79.5093</td>
<td>0.0128</td>
<td>0.000161</td>
</tr>
<tr>
<td>0.421696503</td>
<td>82.0862</td>
<td>82.0747</td>
<td>0.0115</td>
<td>0.000140</td>
</tr>
<tr>
<td>0.448893502</td>
<td>84.9558</td>
<td>84.9683</td>
<td>-0.0125</td>
<td>-0.000147</td>
</tr>
</tbody>
</table>
Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:
Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Differential Surface Area vs. Energy
Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

Sample Mass: 0.2614 g Warm Free Space: 16.5571 cm³ Entered
Cold Free Space: 47.8248 cm³ Equilibration Interval: 10 s
Ambient Temperature: 295.15 K Low Pressure Dose: None
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Standard Deviation of Fit: 0.08682, cm³/gSTP
Options Report - Silica Alumina

---

**Silica Alumina iso N2@77 K, 004/16821/00**

ASAP 2020 V4.00  
Unit 1  
Serial #: 1410  
Page 36

Sample: Silica-Alumina Reference analyzed with N2 at 77 K  
Operator: DJS  
Submitter: Micromeritics  
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP

- **Started:** 2011-02-24 7:22:09PM  
- **Analysis Adsorptive:** N2  
- **Analysis Bath Temp.:** 77.125 K  
- **Thermal Correction:** No  
- **Equilibration Interval:** 10 s  
- **Low Pressure Dose:** None

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

---

**Options Report**

**Sample Tube**
- Warm free space: 1.0000 cm³
- Cold free space: 1.0000 cm³
- Non-ideality factor: 0.0000620
- Use Isothermal Jacket: Yes
- Use Filler Rod: Yes
- Vacuum seal type: Seal Frit

**Analysis Conditions**

**Preparation**
- Fast evacuation: Yes
- Vacuum setpoint: 10 µmHg
- Evacuation time: 0.50 h
- Leak test: No
- Use TranSeal: No

**Free Space**
- Free-space type: Entered
- Warm free space: 27.9452 cm³
- Cold free space: 89.2064 cm³

**p° and Temperature**
- p° and T type: Measure p° at intervals during analysis. Calculate the Analysis Bath Temperature from these values.
  - Measurement interval: 120 min
  - Ambient temperature: 295.15 K

**Dosing**
- Use first pressure fixed dose: No
- Use maximum volume increment: No
  - Target tolerance: 5.0% or 5.000 mmHg
- Low pressure dosing: No

**Equilibration**
- Equilibration time (p/p° = 1.000000000): 10 s
- Minimum equilibration delay at p/p° >= 0.995: 600 s

**Sample Backfill**
- Backfill at start of analysis: Yes
- Backfill at end of analysis: Yes
- Backfill gas: N2
Options Report (cont’d) - Silica Alumina

Silica Alumina iso N2@77 K, 004/16821/00

ASAP 2020 V4.00  Unit 1  Serial #: 1410  Page 37

Sample: Silica-Alumina Reference analyzed with N2 at 77 K
Operator: DJS
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-SIAL.SMP


Sample Mass: 0.2614 g  Warm Free Space: 16.5571 cm³ Entered
Cold Free Space: 47.8248 cm³  Equilibration Interval: 10 s
Ambient Temperature: 295.15 K  Low Pressure Dose: None
Automatic Degas: No

Comments: Use sample tube with isothermal jacket and filler rod. Follow the instructions on the Silica-Alumina sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Notes:

Adsorptive Properties
Adsorptive: Nitrogen @ 77.35 K
Maximum manifold pressure: 925.00 mmHg
Non-ideality factor: 0.0000660
Density conversion factor: 0.0015468
Therm. tran. hard-sphere diameter: 3.860 Å
Molecular cross-sectional area: 0.162 nm²
Inside diameter of sample tube: 9.53 mm
Summary Report - Y Zeolite

<table>
<thead>
<tr>
<th>Y Zeolite, N2 @ 77.35 K, 004/16844/00</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASAP 2020 V4.00 (V4.00 J)</td>
</tr>
<tr>
<td>Unit 1</td>
</tr>
<tr>
<td>Serial #: 1410</td>
</tr>
<tr>
<td>Page 1</td>
</tr>
</tbody>
</table>

Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K  
Operator: AWT/JCH  
Submitter: Micromeritics  
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

- Started: 2011-03-10 17:35:46PM  
- Completed: 2011-03-11 23:41:34PM  
- Analysis Adsorptive: N2  
- Analysis Bath Temp.: 77.150 K  
- Sample Mass: 0.1272 g  
- Warm Free Space: 28.5000 cm³ Entered  
- Cold Free Space: 90.1000 cm³  
- Equilibration Interval: 30 s  
- Ambient Temperature: 295.15 K  
- Low Pressure Dose: 3.000 cm³/g STP  
- Automatic Degas: Yes

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

---

Summary Report

Horvath-Kawazoe

Maximum pore volume at p/p° = 0.011168820: 0.228476 cm³/g

Median pore width: 7.350 Å

Pass/Fail  
H-K:Median pore width Passed
Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

Started: 2011-03-10 17:35:46PM
Completed: 2011-03-11 23:41:34PM
Thermal Correction: Yes
Sample Mass: 0.1272 g
Warm Free Space: 28.5000 cm³ Entered
Cold Free Space: 90.1000 cm³
Equilibration Interval: 30 s
Automatic Degas: Yes

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

### Isotherm Tabular Report

<table>
<thead>
<tr>
<th>Relative Pressure (p/p°)</th>
<th>Absolute Pressure (mmHg)</th>
<th>Quantity Adsorbed (cm³/g STP)</th>
<th>Elapsed Time (h:min)</th>
<th>Time Between Points (min)</th>
<th>Saturation Pressure (mmHg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0000000239</td>
<td>0.000177</td>
<td>3.0294</td>
<td>00:29</td>
<td>0052</td>
<td>740.679810</td>
</tr>
<tr>
<td>0.0000000621</td>
<td>0.000460</td>
<td>6.0590</td>
<td>02:09</td>
<td>0048</td>
<td></td>
</tr>
<tr>
<td>0.000001783</td>
<td>0.001321</td>
<td>9.0833</td>
<td>02:58</td>
<td>0049</td>
<td></td>
</tr>
<tr>
<td>0.000004095</td>
<td>0.003034</td>
<td>12.0998</td>
<td>03:46</td>
<td>0048</td>
<td></td>
</tr>
<tr>
<td>0.000007564</td>
<td>0.005604</td>
<td>15.1076</td>
<td>04:30</td>
<td>0044</td>
<td></td>
</tr>
<tr>
<td>0.000012090</td>
<td>0.008959</td>
<td>18.1064</td>
<td>05:18</td>
<td>0048</td>
<td></td>
</tr>
<tr>
<td>0.000017449</td>
<td>0.012931</td>
<td>21.0999</td>
<td>06:04</td>
<td>0046</td>
<td></td>
</tr>
<tr>
<td>0.000023408</td>
<td>0.017348</td>
<td>24.0910</td>
<td>06:52</td>
<td>0048</td>
<td></td>
</tr>
<tr>
<td>0.000029782</td>
<td>0.022073</td>
<td>27.0861</td>
<td>07:36</td>
<td>0044</td>
<td></td>
</tr>
<tr>
<td>0.000036472</td>
<td>0.027033</td>
<td>30.0855</td>
<td>08:21</td>
<td>0045</td>
<td></td>
</tr>
<tr>
<td>0.000043383</td>
<td>0.032157</td>
<td>33.0950</td>
<td>09:03</td>
<td>0042</td>
<td></td>
</tr>
<tr>
<td>0.000050499</td>
<td>0.037435</td>
<td>36.1166</td>
<td>09:42</td>
<td>0039</td>
<td></td>
</tr>
<tr>
<td>0.000057585</td>
<td>0.042690</td>
<td>39.1393</td>
<td>10:20</td>
<td>0038</td>
<td></td>
</tr>
<tr>
<td>0.000064632</td>
<td>0.047917</td>
<td>42.1602</td>
<td>10:59</td>
<td>0039</td>
<td></td>
</tr>
<tr>
<td>0.000071718</td>
<td>0.053173</td>
<td>45.1826</td>
<td>11:39</td>
<td>0040</td>
<td></td>
</tr>
<tr>
<td>0.000078830</td>
<td>0.058449</td>
<td>48.2051</td>
<td>12:17</td>
<td>0038</td>
<td></td>
</tr>
<tr>
<td>0.000085878</td>
<td>0.063679</td>
<td>51.2251</td>
<td>12:55</td>
<td>0038</td>
<td></td>
</tr>
<tr>
<td>0.000092883</td>
<td>0.068878</td>
<td>54.2460</td>
<td>13:36</td>
<td>0041</td>
<td></td>
</tr>
<tr>
<td>0.000100027</td>
<td>0.074179</td>
<td>57.2660</td>
<td>14:14</td>
<td>0038</td>
<td></td>
</tr>
<tr>
<td>0.000107099</td>
<td>0.079428</td>
<td>60.2858</td>
<td>14:53</td>
<td>0039</td>
<td></td>
</tr>
<tr>
<td>0.000114277</td>
<td>0.084757</td>
<td>63.3050</td>
<td>15:33</td>
<td>0040</td>
<td></td>
</tr>
<tr>
<td>0.000121620</td>
<td>0.090208</td>
<td>66.3241</td>
<td>16:13</td>
<td>0040</td>
<td></td>
</tr>
<tr>
<td>0.000129125</td>
<td>0.095781</td>
<td>69.3430</td>
<td>16:53</td>
<td>0040</td>
<td></td>
</tr>
<tr>
<td>0.000136672</td>
<td>0.101633</td>
<td>72.3591</td>
<td>17:34</td>
<td>0041</td>
<td></td>
</tr>
<tr>
<td>0.000146580</td>
<td>0.106741</td>
<td>75.3764</td>
<td>18:12</td>
<td>0038</td>
<td></td>
</tr>
<tr>
<td>0.000155519</td>
<td>0.115140</td>
<td>78.3930</td>
<td>18:55</td>
<td>0043</td>
<td></td>
</tr>
<tr>
<td>0.000164444</td>
<td>0.122157</td>
<td>81.4082</td>
<td>19:37</td>
<td>0042</td>
<td></td>
</tr>
<tr>
<td>0.000175318</td>
<td>0.130084</td>
<td>84.4229</td>
<td>20:16</td>
<td>0039</td>
<td></td>
</tr>
<tr>
<td>0.000187481</td>
<td>0.139118</td>
<td>87.4361</td>
<td>20:57</td>
<td>0041</td>
<td></td>
</tr>
<tr>
<td>0.000201991</td>
<td>0.149893</td>
<td>90.4464</td>
<td>21:35</td>
<td>0038</td>
<td></td>
</tr>
<tr>
<td>0.000219856</td>
<td>0.163159</td>
<td>93.4542</td>
<td>22:10</td>
<td>0035</td>
<td></td>
</tr>
<tr>
<td>0.000241799</td>
<td>0.179453</td>
<td>96.4589</td>
<td>22:46</td>
<td>0036</td>
<td></td>
</tr>
<tr>
<td>0.000269905</td>
<td>0.203222</td>
<td>99.4557</td>
<td>23:20</td>
<td>0034</td>
<td></td>
</tr>
<tr>
<td>0.000306012</td>
<td>0.227131</td>
<td>102.4440</td>
<td>23:51</td>
<td>0031</td>
<td></td>
</tr>
<tr>
<td>0.000352816</td>
<td>0.261881</td>
<td>105.4210</td>
<td>24:19</td>
<td>0028</td>
<td></td>
</tr>
<tr>
<td>0.000412723</td>
<td>0.306361</td>
<td>108.3662</td>
<td>24:47</td>
<td>0028</td>
<td></td>
</tr>
<tr>
<td>0.000491049</td>
<td>0.364515</td>
<td>111.4105</td>
<td>25:12</td>
<td>0025</td>
<td></td>
</tr>
</tbody>
</table>
Y Zeolite, N2 @ 77.35 K, 004/16844/00

Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

Started: 2011-03-10 17:35:46PM
Completed: 2011-03-11 23:41:34PM
Analysis Adsorptive: N2
Analysis Bath Temp.: 77.150 K
Thermal Correction: Yes
Equilibration Interval: 30 s
Low Pressure Dose: 3.000 cm³/g STP

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

<table>
<thead>
<tr>
<th>Relative Pressure (p/p°)</th>
<th>Absolute Pressure (mmHg)</th>
<th>Quantity Adsorbed (cm³/g STP)</th>
<th>Elapsed Time (h:min)</th>
<th>Time Between Points (min)</th>
<th>Saturation Pressure (mmHg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000590797</td>
<td>0.438577</td>
<td>114.4263</td>
<td>25:38</td>
<td>0026</td>
<td></td>
</tr>
<tr>
<td>0.000716280</td>
<td>0.531748</td>
<td>117.4310</td>
<td>26:02</td>
<td>0024</td>
<td></td>
</tr>
<tr>
<td>0.000873058</td>
<td>0.648157</td>
<td>120.4220</td>
<td>26:24</td>
<td>0022</td>
<td></td>
</tr>
<tr>
<td>0.001088032</td>
<td>0.792932</td>
<td>123.3953</td>
<td>26:47</td>
<td>0023</td>
<td></td>
</tr>
<tr>
<td>0.001312099</td>
<td>0.974165</td>
<td>126.3434</td>
<td>27:08</td>
<td>0021</td>
<td></td>
</tr>
<tr>
<td>0.001620134</td>
<td>1.202902</td>
<td>129.2561</td>
<td>27:29</td>
<td>0021</td>
<td></td>
</tr>
<tr>
<td>0.002015208</td>
<td>1.496277</td>
<td>132.1076</td>
<td>27:49</td>
<td>0020</td>
<td></td>
</tr>
<tr>
<td>0.002529451</td>
<td>1.878152</td>
<td>134.8674</td>
<td>28:08</td>
<td>0019</td>
<td></td>
</tr>
<tr>
<td>0.003206058</td>
<td>2.380602</td>
<td>137.4922</td>
<td>28:25</td>
<td>0017</td>
<td></td>
</tr>
<tr>
<td>0.004090737</td>
<td>3.037581</td>
<td>139.9300</td>
<td>28:42</td>
<td>0017</td>
<td></td>
</tr>
<tr>
<td>0.005288317</td>
<td>3.912094</td>
<td>142.2017</td>
<td>28:59</td>
<td>0017</td>
<td></td>
</tr>
<tr>
<td>0.006894097</td>
<td>5.119403</td>
<td>144.3670</td>
<td>29:06</td>
<td>0007</td>
<td>742.577698</td>
</tr>
<tr>
<td>0.008813154</td>
<td>6.544452</td>
<td>146.1397</td>
<td>29:18</td>
<td>0012</td>
<td></td>
</tr>
<tr>
<td>0.011168820</td>
<td>8.293716</td>
<td>147.7088</td>
<td>29:41</td>
<td>0011</td>
<td></td>
</tr>
</tbody>
</table>
Y Zeolite, N2 @ 77.35 K, 004/16844/00

ASAP 2020 V4.00 (V4.00 J)       Unit 1       Serial #: 1410       Page 4

Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

Started: 2011-03-10 17:35:46PM       Analysis Adsorptive: N2
Completed: 2011-03-11 23:41:34PM       Analysis Bath Temp.: 77.150 K
Sample Mass: 0.1272 g                 Warm Free Space: 28.5000 cm³ Entered
Cold Free Space: 90.1000 cm³           Equilibration Interval: 30 s
Ambient Temperature: 295.15 K         Low Pressure Dose: 3.000 cm³/g STP
Automatic Degas: Yes

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

 Isotherm Linear Plot

Y-Zeolite Reference Mat analyzed with N2 at 77 K - Adsorption

Relative Pressure (p/p°) vs. Quantity Adsorbed (cm³/g STP)
Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEO\SMP

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.
## Horvath-Kawazoe Report - Y Zeolite

Y Zeolite, N₂ @ 77.35 K, 004/16844/00

ASAP 2020 V4.00 (V4.00 J) Unit 1 Serial #: 1410 Page 6

- **Sample:** Y-Zeolite Reference Mat analyzed with N₂ at 77 K
- **Operator:** AWT/JCH
- **Submitter:** Micromeritics
- **File:** C:\2020\DATA\PERF-TST\N2-YZEOL.SMP
- **Started:** 2011-03-10 17:35:46PM
- **Completed:** 2011-03-11 23:41:34PM
- **Analysis Bath Temp.:** 77.150 K
- **Thermal Correction:** Yes
- **Sample Mass:** 0.1272 g
- **Cold Free Space:** 90.1000 cm³
- **Automatic Degas:** Yes

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

### Horvath-Kawazoe Report

Cylinder Pore Geometry (Saito-Foley)

- **Maximum Pore Volume:** 0.228476 cm³/g
- **Median Pore Width:** 7.350 Å
- **Relative Pressure Range:** 2.393e-07 to 1.117e-02
- **Diameter of Adsorptive Molecule:** 3.000 Å
- **Diameter of Sample Atom:** 2.760 Å
- **Interaction Parameter:** 1.68e-43 erg·cm^4
- **Density Conversion Factor:** 0.0015468

### Summary Data

<table>
<thead>
<tr>
<th>Absolute Pressure (mmHg)</th>
<th>Relative Pressure (p/p°)</th>
<th>Quantity Adsorbed (cm³/g STP)</th>
<th>Pore Width (Å)</th>
<th>Cumulative Pore Volume (cm³/g)</th>
<th>Smoothed Differential Pore Volume (cm³/g·Å)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00018</td>
<td>0.0000000239</td>
<td>3.02941</td>
<td>5.065</td>
<td>0.0047</td>
<td>0.0216</td>
</tr>
<tr>
<td>0.00046</td>
<td>0.0000000621</td>
<td>6.05896</td>
<td>5.299</td>
<td>0.0094</td>
<td>0.0180</td>
</tr>
<tr>
<td>0.00132</td>
<td>0.0000001783</td>
<td>9.08332</td>
<td>5.586</td>
<td>0.0141</td>
<td>0.0168</td>
</tr>
<tr>
<td>0.00303</td>
<td>0.0000004095</td>
<td>12.09979</td>
<td>5.840</td>
<td>0.0187</td>
<td>0.0203</td>
</tr>
<tr>
<td>0.00560</td>
<td>0.0000007564</td>
<td>15.10761</td>
<td>6.045</td>
<td>0.0234</td>
<td>0.0251</td>
</tr>
<tr>
<td>0.00896</td>
<td>0.0000012090</td>
<td>18.10640</td>
<td>6.215</td>
<td>0.0280</td>
<td>0.0301</td>
</tr>
<tr>
<td>0.01293</td>
<td>0.0000017449</td>
<td>21.09987</td>
<td>6.356</td>
<td>0.0326</td>
<td>0.0362</td>
</tr>
<tr>
<td>0.01735</td>
<td>0.0000023408</td>
<td>24.09103</td>
<td>6.474</td>
<td>0.0373</td>
<td>0.0426</td>
</tr>
<tr>
<td>0.02207</td>
<td>0.0000029782</td>
<td>27.08609</td>
<td>6.576</td>
<td>0.0419</td>
<td>0.0490</td>
</tr>
<tr>
<td>0.02703</td>
<td>0.0000036472</td>
<td>30.08552</td>
<td>6.666</td>
<td>0.0465</td>
<td>0.0560</td>
</tr>
<tr>
<td>0.03216</td>
<td>0.0000043383</td>
<td>33.09500</td>
<td>6.744</td>
<td>0.0512</td>
<td>0.0633</td>
</tr>
<tr>
<td>0.03743</td>
<td>0.0000050499</td>
<td>36.11664</td>
<td>6.814</td>
<td>0.0559</td>
<td>0.0711</td>
</tr>
<tr>
<td>0.04269</td>
<td>0.0000057585</td>
<td>39.13934</td>
<td>6.877</td>
<td>0.0605</td>
<td>0.0793</td>
</tr>
<tr>
<td>0.04792</td>
<td>0.0000064632</td>
<td>42.16202</td>
<td>6.933</td>
<td>0.0652</td>
<td>0.0869</td>
</tr>
<tr>
<td>0.05317</td>
<td>0.0000071718</td>
<td>45.18257</td>
<td>6.985</td>
<td>0.0699</td>
<td>0.0948</td>
</tr>
<tr>
<td>0.05845</td>
<td>0.0000078830</td>
<td>48.20512</td>
<td>7.033</td>
<td>0.0746</td>
<td>0.1025</td>
</tr>
<tr>
<td>0.06368</td>
<td>0.0000085878</td>
<td>51.22509</td>
<td>7.077</td>
<td>0.0792</td>
<td>0.1098</td>
</tr>
<tr>
<td>0.06888</td>
<td>0.0000092883</td>
<td>54.24596</td>
<td>7.118</td>
<td>0.0839</td>
<td>0.1166</td>
</tr>
<tr>
<td>0.07418</td>
<td>0.0000100027</td>
<td>57.26600</td>
<td>7.157</td>
<td>0.0886</td>
<td>0.1231</td>
</tr>
<tr>
<td>0.07943</td>
<td>0.0000107099</td>
<td>60.28585</td>
<td>7.194</td>
<td>0.0933</td>
<td>0.1283</td>
</tr>
<tr>
<td>0.08476</td>
<td>0.0000114277</td>
<td>63.30503</td>
<td>7.230</td>
<td>0.0979</td>
<td>0.1314</td>
</tr>
<tr>
<td>0.09021</td>
<td>0.0000121620</td>
<td>66.32415</td>
<td>7.264</td>
<td>0.1026</td>
<td>0.1331</td>
</tr>
<tr>
<td>0.09578</td>
<td>0.0000129125</td>
<td>69.34298</td>
<td>7.298</td>
<td>0.1073</td>
<td>0.1343</td>
</tr>
<tr>
<td>0.10153</td>
<td>0.0000136872</td>
<td>72.35906</td>
<td>7.330</td>
<td>0.1119</td>
<td>0.1341</td>
</tr>
<tr>
<td>0.10874</td>
<td>0.0000146580</td>
<td>75.37638</td>
<td>7.369</td>
<td>0.1166</td>
<td>0.1321</td>
</tr>
<tr>
<td>0.11514</td>
<td>0.0000155196</td>
<td>78.39297</td>
<td>7.403</td>
<td>0.1213</td>
<td>0.1290</td>
</tr>
</tbody>
</table>
Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

<table>
<thead>
<tr>
<th>Absolute Pressure (mmHg)</th>
<th>Relative Pressure (p/p°)</th>
<th>Quantity Adsorbed (cm³/g STP)</th>
<th>Pore Width (Å)</th>
<th>Cumulative Pore Volume (cm³/g)</th>
<th>Smoothed Differential Pore Volume (cm³/g-Å)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.12216</td>
<td>0.000164644</td>
<td>81.40818</td>
<td>7.437</td>
<td>0.1259</td>
<td>0.1240</td>
</tr>
<tr>
<td>0.13008</td>
<td>0.000175318</td>
<td>84.42292</td>
<td>7.475</td>
<td>0.1306</td>
<td>0.1174</td>
</tr>
<tr>
<td>0.13912</td>
<td>0.000187481</td>
<td>87.43611</td>
<td>7.515</td>
<td>0.1352</td>
<td>0.1085</td>
</tr>
<tr>
<td>0.14989</td>
<td>0.000201991</td>
<td>90.44636</td>
<td>7.561</td>
<td>0.1399</td>
<td>0.0967</td>
</tr>
<tr>
<td>0.16316</td>
<td>0.000219856</td>
<td>93.45420</td>
<td>7.614</td>
<td>0.1446</td>
<td>0.0843</td>
</tr>
<tr>
<td>0.17945</td>
<td>0.000241799</td>
<td>96.45890</td>
<td>7.674</td>
<td>0.1492</td>
<td>0.0723</td>
</tr>
<tr>
<td>0.20032</td>
<td>0.000269905</td>
<td>99.45574</td>
<td>7.745</td>
<td>0.1538</td>
<td>0.0613</td>
</tr>
<tr>
<td>0.22713</td>
<td>0.000306012</td>
<td>102.44401</td>
<td>7.829</td>
<td>0.1585</td>
<td>0.0517</td>
</tr>
<tr>
<td>0.26188</td>
<td>0.000352816</td>
<td>105.42100</td>
<td>7.926</td>
<td>0.1631</td>
<td>0.0445</td>
</tr>
<tr>
<td>0.30636</td>
<td>0.000412723</td>
<td>108.38621</td>
<td>8.037</td>
<td>0.1677</td>
<td>0.0391</td>
</tr>
<tr>
<td>0.36452</td>
<td>0.000491049</td>
<td>111.41055</td>
<td>8.165</td>
<td>0.1723</td>
<td>0.0348</td>
</tr>
<tr>
<td>0.43858</td>
<td>0.000590797</td>
<td>114.42627</td>
<td>8.307</td>
<td>0.1770</td>
<td>0.0314</td>
</tr>
<tr>
<td>0.53175</td>
<td>0.000716280</td>
<td>117.43103</td>
<td>8.462</td>
<td>0.1816</td>
<td>0.0287</td>
</tr>
<tr>
<td>0.64816</td>
<td>0.000873058</td>
<td>120.42204</td>
<td>8.630</td>
<td>0.1863</td>
<td>0.0265</td>
</tr>
<tr>
<td>0.79293</td>
<td>0.001068032</td>
<td>123.39527</td>
<td>8.810</td>
<td>0.1909</td>
<td>0.0245</td>
</tr>
<tr>
<td>0.97416</td>
<td>0.001312099</td>
<td>126.34338</td>
<td>9.005</td>
<td>0.1954</td>
<td>0.0224</td>
</tr>
<tr>
<td>1.20290</td>
<td>0.001620191</td>
<td>129.25610</td>
<td>9.215</td>
<td>0.1999</td>
<td>0.0203</td>
</tr>
<tr>
<td>1.49628</td>
<td>0.002015208</td>
<td>132.10764</td>
<td>9.446</td>
<td>0.2043</td>
<td>0.0178</td>
</tr>
<tr>
<td>1.87815</td>
<td>0.002529451</td>
<td>134.86744</td>
<td>9.705</td>
<td>0.2086</td>
<td>0.0153</td>
</tr>
<tr>
<td>2.38060</td>
<td>0.003206054</td>
<td>137.49222</td>
<td>9.994</td>
<td>0.2127</td>
<td>0.0129</td>
</tr>
<tr>
<td>3.03758</td>
<td>0.004090737</td>
<td>139.92998</td>
<td>10.317</td>
<td>0.2164</td>
<td>0.0107</td>
</tr>
<tr>
<td>3.91209</td>
<td>0.005268317</td>
<td>142.20172</td>
<td>10.680</td>
<td>0.2200</td>
<td>0.0087</td>
</tr>
<tr>
<td>5.11940</td>
<td>0.006894097</td>
<td>144.36896</td>
<td>11.106</td>
<td>0.2233</td>
<td>0.0071</td>
</tr>
<tr>
<td>6.54445</td>
<td>0.008813154</td>
<td>146.13971</td>
<td>11.534</td>
<td>0.2280</td>
<td>0.0067</td>
</tr>
<tr>
<td>8.29372</td>
<td>0.011688820</td>
<td>147.70882</td>
<td>11.988</td>
<td>0.2285</td>
<td>0.0052</td>
</tr>
</tbody>
</table>
Y Zeolite, N2 @ 77.35 K, 004/16844/00

ASAP 2020 V4.00 (V4.00 J)  Unit 1  Serial #: 1410  Page 8

Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

Started: 2011-03-10 17:35:46PM  Analysis Adsorptive: N2
Completed: 2011-03-11 23:41:34PM  Analysis Bath Temp.: 77.150 K
Sample Mass: 0.1272 g  Warm Free Space: 28.5000 cm³ Entered
Cold Free Space: 90.1000 cm³  Equilibration Interval: 30 s
Ambient Temperature: 295.15 K  Low Pressure Dose: 3.000 cm³/g STP
Automatic Degas: Yes

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.
Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.
Porosity Distribution by Non-Local Density Functional Theory

Model: Tarazona NLDFT, Cylindrical Pores, Esf = 30.0K
Method: Non-negative Regularization; No Smoothing
Standard Deviation of Fit: 0.80712, cm³/g STP

<table>
<thead>
<tr>
<th>Pore Width (Å)</th>
<th>Cumulative Volume (cm³/g)</th>
<th>Incremental Volume (cm³/g)</th>
<th>Cumulative Area (m²/g)</th>
<th>Incremental Area (m²/g)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.86</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>5.22</td>
<td>0.01855</td>
<td>0.01855</td>
<td>142.171</td>
<td>142.171</td>
</tr>
<tr>
<td>5.93</td>
<td>0.03767</td>
<td>0.01912</td>
<td>271.037</td>
<td>128.866</td>
</tr>
<tr>
<td>6.29</td>
<td>0.03767</td>
<td>0.00000</td>
<td>271.037</td>
<td>0.000</td>
</tr>
<tr>
<td>6.65</td>
<td>0.07376</td>
<td>0.03610</td>
<td>488.204</td>
<td>217.167</td>
</tr>
<tr>
<td>7.36</td>
<td>0.09830</td>
<td>0.02454</td>
<td>621.497</td>
<td>133.293</td>
</tr>
<tr>
<td>7.72</td>
<td>0.15755</td>
<td>0.05925</td>
<td>928.497</td>
<td>306.932</td>
</tr>
<tr>
<td>8.44</td>
<td>0.21667</td>
<td>0.05912</td>
<td>1208.753</td>
<td>280.324</td>
</tr>
<tr>
<td>8.79</td>
<td>0.24849</td>
<td>0.03182</td>
<td>1353.498</td>
<td>144.746</td>
</tr>
<tr>
<td>9.51</td>
<td>0.26132</td>
<td>0.01283</td>
<td>1407.483</td>
<td>53.985</td>
</tr>
<tr>
<td>10.22</td>
<td>0.26609</td>
<td>0.00477</td>
<td>1426.133</td>
<td>18.650</td>
</tr>
<tr>
<td>10.94</td>
<td>0.27209</td>
<td>0.00600</td>
<td>1448.061</td>
<td>21.928</td>
</tr>
<tr>
<td>11.65</td>
<td>0.27737</td>
<td>0.00528</td>
<td>1466.199</td>
<td>18.137</td>
</tr>
<tr>
<td>12.37</td>
<td>0.28059</td>
<td>0.00322</td>
<td>1476.602</td>
<td>10.403</td>
</tr>
<tr>
<td>13.08</td>
<td>0.28059</td>
<td>0.00000</td>
<td>1476.602</td>
<td>0.000</td>
</tr>
</tbody>
</table>
Porosity Distribution by Non-Local Density Functional Theory
Model: Tarazona NLDFT, Cylindrical Pores, Esf = 30.0K
Method: Non-negative Regularization; No Smoothing

Standard Deviation of Fit: 0.80712, cm³/g STP

<table>
<thead>
<tr>
<th>Relative Pressure</th>
<th>Experimental Quantity Adsorbed (cm³/g STP)</th>
<th>Fitted Quantity Adsorbed (cm³/g STP)</th>
<th>Absolute Residual (cm³/g STP)</th>
<th>Relative Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000000251</td>
<td>3.1549</td>
<td>3.8649</td>
<td>-0.7100</td>
<td>-0.225033</td>
</tr>
<tr>
<td>0.000000316</td>
<td>3.8242</td>
<td>4.4456</td>
<td>-0.6214</td>
<td>-0.162493</td>
</tr>
<tr>
<td>0.000000398</td>
<td>4.6006</td>
<td>4.9751</td>
<td>-0.3745</td>
<td>-0.081396</td>
</tr>
<tr>
<td>0.000000501</td>
<td>5.4199</td>
<td>5.4705</td>
<td>-0.0506</td>
<td>-0.009339</td>
</tr>
<tr>
<td>0.000000631</td>
<td>6.0659</td>
<td>6.6552</td>
<td>0.1407</td>
<td>0.023073</td>
</tr>
<tr>
<td>0.000000784</td>
<td>6.8679</td>
<td>6.6553</td>
<td>0.2127</td>
<td>0.031893</td>
</tr>
<tr>
<td>0.000001000</td>
<td>7.3251</td>
<td>7.0000</td>
<td>0.3252</td>
<td>0.044391</td>
</tr>
<tr>
<td>0.000001259</td>
<td>8.0441</td>
<td>7.6231</td>
<td>0.4210</td>
<td>0.052341</td>
</tr>
<tr>
<td>0.000001585</td>
<td>8.7602</td>
<td>8.3570</td>
<td>0.4032</td>
<td>0.046024</td>
</tr>
<tr>
<td>0.000001995</td>
<td>9.3838</td>
<td>9.2099</td>
<td>0.1748</td>
<td>0.018632</td>
</tr>
<tr>
<td>0.000002512</td>
<td>10.1268</td>
<td>10.1342</td>
<td>-0.0074</td>
<td>-0.000727</td>
</tr>
<tr>
<td>0.000003162</td>
<td>11.0298</td>
<td>11.0719</td>
<td>-0.0421</td>
<td>-0.003821</td>
</tr>
<tr>
<td>0.000003981</td>
<td>11.9901</td>
<td>12.0079</td>
<td>-0.0178</td>
<td>-0.001486</td>
</tr>
<tr>
<td>0.000005012</td>
<td>12.9536</td>
<td>12.9757</td>
<td>-0.0221</td>
<td>-0.001708</td>
</tr>
<tr>
<td>0.000006310</td>
<td>14.1219</td>
<td>14.0370</td>
<td>0.0849</td>
<td>0.006011</td>
</tr>
<tr>
<td>0.000007943</td>
<td>15.3741</td>
<td>15.2764</td>
<td>0.0977</td>
<td>0.006353</td>
</tr>
<tr>
<td>0.000010000</td>
<td>16.7915</td>
<td>16.7949</td>
<td>-0.0035</td>
<td>-0.000208</td>
</tr>
<tr>
<td>0.000012589</td>
<td>18.3963</td>
<td>18.6407</td>
<td>-0.2444</td>
<td>-0.013288</td>
</tr>
<tr>
<td>0.000015849</td>
<td>20.2476</td>
<td>20.6894</td>
<td>-0.4408</td>
<td>-0.021770</td>
</tr>
<tr>
<td>0.000019953</td>
<td>22.3819</td>
<td>22.7777</td>
<td>-0.3958</td>
<td>-0.017686</td>
</tr>
<tr>
<td>0.000025119</td>
<td>24.9082</td>
<td>24.9444</td>
<td>-0.0362</td>
<td>-0.001454</td>
</tr>
<tr>
<td>0.000031623</td>
<td>27.9207</td>
<td>27.4162</td>
<td>0.5045</td>
<td>0.018068</td>
</tr>
<tr>
<td>0.000039811</td>
<td>31.5512</td>
<td>30.6664</td>
<td>0.8848</td>
<td>0.028042</td>
</tr>
<tr>
<td>0.000050119</td>
<td>35.9545</td>
<td>35.1709</td>
<td>0.7836</td>
<td>0.021795</td>
</tr>
<tr>
<td>0.000063096</td>
<td>41.5024</td>
<td>42.4985</td>
<td>-0.9961</td>
<td>-0.024000</td>
</tr>
<tr>
<td>0.000079433</td>
<td>48.4623</td>
<td>51.3675</td>
<td>-2.9052</td>
<td>-0.059948</td>
</tr>
<tr>
<td>0.000100000</td>
<td>57.2546</td>
<td>57.1940</td>
<td>0.0606</td>
<td>0.001059</td>
</tr>
<tr>
<td>0.000125892</td>
<td>68.0482</td>
<td>64.7057</td>
<td>3.3425</td>
<td>0.049120</td>
</tr>
<tr>
<td>0.000158490</td>
<td>79.4780</td>
<td>80.0467</td>
<td>-0.5687</td>
<td>-0.007155</td>
</tr>
<tr>
<td>0.000199526</td>
<td>89.9798</td>
<td>91.9006</td>
<td>-1.9208</td>
<td>-0.021348</td>
</tr>
<tr>
<td>0.000251188</td>
<td>97.5451</td>
<td>97.2743</td>
<td>0.2708</td>
<td>0.002776</td>
</tr>
<tr>
<td>0.000316228</td>
<td>103.1539</td>
<td>101.7184</td>
<td>1.4355</td>
<td>0.013916</td>
</tr>
</tbody>
</table>
Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

<table>
<thead>
<tr>
<th>Relative Pressure</th>
<th>Experimental Quantity Adsorbed (cm³/g STP)</th>
<th>Fitted Quantity Adsorbed (cm³/g STP)</th>
<th>Absolute Residual (cm³/g STP)</th>
<th>Relative Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000398107</td>
<td>107.7336</td>
<td>107.9825</td>
<td>-0.2490</td>
<td>-0.002311</td>
</tr>
<tr>
<td>0.000501187</td>
<td>111.7458</td>
<td>111.6661</td>
<td>0.0797</td>
<td>0.000714</td>
</tr>
<tr>
<td>0.000630958</td>
<td>115.4573</td>
<td>115.6514</td>
<td>-0.1941</td>
<td>-0.001681</td>
</tr>
<tr>
<td>0.000794328</td>
<td>119.0015</td>
<td>118.8609</td>
<td>0.1406</td>
<td>0.001181</td>
</tr>
<tr>
<td>0.001000000</td>
<td>122.4354</td>
<td>122.5966</td>
<td>-0.1612</td>
<td>-0.001316</td>
</tr>
<tr>
<td>0.001258925</td>
<td>125.7628</td>
<td>125.6283</td>
<td>0.1344</td>
<td>0.001069</td>
</tr>
<tr>
<td>0.001584895</td>
<td>128.9630</td>
<td>129.0265</td>
<td>-0.0655</td>
<td>-0.000508</td>
</tr>
<tr>
<td>0.001995263</td>
<td>131.9846</td>
<td>132.0112</td>
<td>-0.0266</td>
<td>-0.000201</td>
</tr>
<tr>
<td>0.002511882</td>
<td>134.7887</td>
<td>134.6513</td>
<td>0.1375</td>
<td>0.001020</td>
</tr>
<tr>
<td>0.003162276</td>
<td>137.3515</td>
<td>137.3437</td>
<td>0.0078</td>
<td>0.000057</td>
</tr>
<tr>
<td>0.003981066</td>
<td>139.6780</td>
<td>139.6902</td>
<td>-0.0123</td>
<td>-0.000088</td>
</tr>
<tr>
<td>0.005011868</td>
<td>141.7823</td>
<td>141.8016</td>
<td>-0.0194</td>
<td>-0.000137</td>
</tr>
<tr>
<td>0.006309579</td>
<td>143.6834</td>
<td>143.6644</td>
<td>0.0190</td>
<td>0.000132</td>
</tr>
<tr>
<td>0.007943276</td>
<td>145.4297</td>
<td>145.3954</td>
<td>0.0342</td>
<td>0.000235</td>
</tr>
<tr>
<td>0.010000000</td>
<td>146.9303</td>
<td>147.0277</td>
<td>-0.0974</td>
<td>-0.000663</td>
</tr>
</tbody>
</table>
Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

Started: 2011-03-10 17:35:46PM Analysis Adsorptive: N2
Completed: 2011-03-11 23:41:34PM Analysis Bath Temp.: 77.150 K
Sample Mass: 0.1272 g Warm Free Space: 28.5000 cm³ Entered
Cold Free Space: 90.1000 cm³ Equilibration Interval: 30 s
Ambient Temperature: 295.15 K Low Pressure Dose: 3.000 cm³/g STP
Automatic Degas: Yes

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Cumulative Surface Area vs. Pore Width

Cumulative Surface Area vs. Pore Width (Angstroms)
Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

Started: 2011-03-10 17:35:46 PM
Completed: 2011-03-11 23:41:34 PM

Analysis Adsorptive: N2
Analysis Bath Temp.: 77.150 K
Thermal Correction: Yes

Sample Mass: 0.1272 g
Warm Free Space: 28.5000 cm³ Entered

Cold Free Space: 90.1000 cm³
Equilibration Interval: 30 s

Ambient Temperature: 295.15 K
Low Pressure Dose: 3.000 cm³/g STP

Automatic Degas: Yes

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Incremental Surface Area vs. Pore Width

Incremental Surface Area (m²/g)

Incremental Surface Area (m²/g) vs. Pore Width (Å)

Incremental Surface Area (m²/g) vs. Pore Width (Å)
Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Standard Deviation of Fit: 0.80712, cm^3/g STP
### Y Zeolite, N2 @ 77.35 K, 004/16844/00

Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K  
Operator: AWT/JCH  
Submitter: Micromeritics  
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

- Started: 2011-03-10 17:35:46PM  
- Completed: 2011-03-11 23:41:34PM  
- Analysis Adsorptive: N2  
- Analysis Bath Temp.: 77.150 K  
- Thermal Correction: Yes  
- Warm Free Space: 28.5000 cm³ Entered  
- Equilibration Interval: 30 s  
- Low Pressure Dose: 3.000 cm³/g STP

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

### Surface Energy Table

<table>
<thead>
<tr>
<th>Energy (e/k)</th>
<th>Cumulative Area (m²/g)</th>
<th>Incremental Area (m²/g)</th>
</tr>
</thead>
<tbody>
<tr>
<td>84.00</td>
<td>695.632</td>
<td>0.000</td>
</tr>
<tr>
<td>86.00</td>
<td>731.306</td>
<td>35.674</td>
</tr>
<tr>
<td>88.00</td>
<td>731.306</td>
<td>0.000</td>
</tr>
<tr>
<td>90.00</td>
<td>731.306</td>
<td>0.000</td>
</tr>
<tr>
<td>92.00</td>
<td>731.306</td>
<td>0.000</td>
</tr>
<tr>
<td>94.00</td>
<td>731.306</td>
<td>0.000</td>
</tr>
<tr>
<td>96.00</td>
<td>731.306</td>
<td>0.000</td>
</tr>
<tr>
<td>98.00</td>
<td>731.306</td>
<td>0.000</td>
</tr>
<tr>
<td>100.00</td>
<td>731.306</td>
<td>0.000</td>
</tr>
</tbody>
</table>
**Y Zeolite, N2 @ 77.35 K, 004/16844/00**

**ASAP 2020 V4.00 (V4.00 J)**

**Sample:** Y-Zeolite Reference Mat analyzed with N2 at 77 K  
**Operator:** AWT/JCH  
**Submitter:** Micromeritics  
**File:** C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

**Sample Mass:** 0.1272 g  
**Warm Free Space:** 28.5000 cm³ Entered  
**Cold Free Space:** 90.1000 cm³  
**Ambient Temperature:** 295.15 K  
**Low Pressure Dose:** 3.000 cm³/g STP  
**Automatic Degas:** Yes

**Comments:** Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

**Surface Energy Distribution by Modified Density Functional Theory**

**Model:** N2 @ 77K, Surface Energy Distribution  
**Method:** Non-negative Regularization; No Smoothing  
**Standard Deviation of Fit:** 0.45744, cm³/g STP

**Isotherm Table**

<table>
<thead>
<tr>
<th>Relative Pressure</th>
<th>Experimental Quantity Adsorbed (cm³/g STP)</th>
<th>Fitted Quantity Adsorbed (cm³/g STP)</th>
<th>Absolute Residual (cm³/g STP)</th>
<th>Relative Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000001000</td>
<td>7.3251</td>
<td>7.3867</td>
<td>-0.0616</td>
<td>-0.008407</td>
</tr>
<tr>
<td>0.000001059</td>
<td>7.5007</td>
<td>7.5380</td>
<td>-0.0373</td>
<td>-0.004977</td>
</tr>
<tr>
<td>0.000001122</td>
<td>7.6797</td>
<td>7.6957</td>
<td>-0.0160</td>
<td>-0.002085</td>
</tr>
<tr>
<td>0.000001189</td>
<td>7.8611</td>
<td>7.8587</td>
<td>0.0024</td>
<td>0.000310</td>
</tr>
<tr>
<td>0.000001259</td>
<td>8.0411</td>
<td>8.0260</td>
<td>0.0182</td>
<td>0.002258</td>
</tr>
<tr>
<td>0.000001334</td>
<td>8.2273</td>
<td>8.1961</td>
<td>0.0312</td>
<td>0.003789</td>
</tr>
<tr>
<td>0.000001413</td>
<td>8.4091</td>
<td>8.3680</td>
<td>0.0410</td>
<td>0.004881</td>
</tr>
<tr>
<td>0.000001496</td>
<td>8.5875</td>
<td>8.5408</td>
<td>0.0467</td>
<td>0.005344</td>
</tr>
<tr>
<td>0.000001585</td>
<td>8.7602</td>
<td>8.7141</td>
<td>0.0461</td>
<td>0.005260</td>
</tr>
<tr>
<td>0.000001679</td>
<td>8.9243</td>
<td>8.8878</td>
<td>0.0365</td>
<td>0.004084</td>
</tr>
<tr>
<td>0.000001778</td>
<td>9.0763</td>
<td>9.0623</td>
<td>0.0140</td>
<td>0.001548</td>
</tr>
<tr>
<td>0.000001884</td>
<td>9.2249</td>
<td>9.2381</td>
<td>-0.0132</td>
<td>-0.001429</td>
</tr>
<tr>
<td>0.000001995</td>
<td>9.3838</td>
<td>9.4160</td>
<td>-0.0322</td>
<td>-0.003429</td>
</tr>
<tr>
<td>0.000002113</td>
<td>9.5333</td>
<td>9.5967</td>
<td>-0.0434</td>
<td>-0.004545</td>
</tr>
<tr>
<td>0.000002239</td>
<td>9.7336</td>
<td>9.7812</td>
<td>-0.0476</td>
<td>-0.004888</td>
</tr>
<tr>
<td>0.000002371</td>
<td>9.9248</td>
<td>9.9703</td>
<td>-0.0545</td>
<td>-0.004582</td>
</tr>
<tr>
<td>0.000002512</td>
<td>10.1268</td>
<td>10.1649</td>
<td>-0.0381</td>
<td>-0.003762</td>
</tr>
<tr>
<td>0.000002681</td>
<td>10.3393</td>
<td>10.3658</td>
<td>-0.0265</td>
<td>-0.002566</td>
</tr>
<tr>
<td>0.000002818</td>
<td>10.5614</td>
<td>10.5734</td>
<td>-0.0120</td>
<td>-0.001136</td>
</tr>
<tr>
<td>0.000002985</td>
<td>10.7921</td>
<td>10.7879</td>
<td>0.0042</td>
<td>0.000388</td>
</tr>
<tr>
<td>0.000003162</td>
<td>11.0298</td>
<td>11.0093</td>
<td>0.0205</td>
<td>0.001856</td>
</tr>
<tr>
<td>0.000003350</td>
<td>11.2721</td>
<td>11.2371</td>
<td>0.0349</td>
<td>0.003099</td>
</tr>
<tr>
<td>0.000003548</td>
<td>11.5159</td>
<td>11.4709</td>
<td>0.0449</td>
<td>0.003903</td>
</tr>
<tr>
<td>0.000003758</td>
<td>11.7570</td>
<td>11.7102</td>
<td>0.0468</td>
<td>0.003978</td>
</tr>
<tr>
<td>0.000003981</td>
<td>11.9901</td>
<td>11.9549</td>
<td>0.0352</td>
<td>0.002937</td>
</tr>
<tr>
<td>0.000004217</td>
<td>12.2126</td>
<td>12.2048</td>
<td>0.0077</td>
<td>0.000633</td>
</tr>
<tr>
<td>0.000004467</td>
<td>12.4454</td>
<td>12.4604</td>
<td>-0.0150</td>
<td>-0.001206</td>
</tr>
<tr>
<td>0.000004732</td>
<td>12.6925</td>
<td>12.7219</td>
<td>-0.0294</td>
<td>-0.002318</td>
</tr>
<tr>
<td>0.000005012</td>
<td>12.9536</td>
<td>12.9896</td>
<td>-0.0360</td>
<td>-0.002779</td>
</tr>
<tr>
<td>0.000005309</td>
<td>13.2284</td>
<td>13.2638</td>
<td>-0.0355</td>
<td>-0.002683</td>
</tr>
<tr>
<td>0.000005623</td>
<td>13.5158</td>
<td>13.5448</td>
<td>-0.0290</td>
<td>-0.002148</td>
</tr>
<tr>
<td>0.000005957</td>
<td>13.8143</td>
<td>13.8326</td>
<td>-0.0183</td>
<td>-0.001326</td>
</tr>
</tbody>
</table>
Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

<table>
<thead>
<tr>
<th>Relative Pressure</th>
<th>Experimental Quantity Adsorbed (cm³/g STP)</th>
<th>Fitted Quantity Adsorbed (cm³/g STP)</th>
<th>Absolute Residual (cm³/g STP)</th>
<th>Relative Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000006310</td>
<td>14.1219</td>
<td>14.1277</td>
<td>-0.0059</td>
<td>-0.000415</td>
</tr>
<tr>
<td>0.000006683</td>
<td>14.4353</td>
<td>14.4305</td>
<td>0.0048</td>
<td>0.000335</td>
</tr>
<tr>
<td>0.000007079</td>
<td>14.7505</td>
<td>14.7415</td>
<td>0.0090</td>
<td>0.000613</td>
</tr>
<tr>
<td></td>
<td></td>
<td>15.0619</td>
<td>0.0007</td>
<td>0.000043</td>
</tr>
<tr>
<td>0.000007943</td>
<td>15.3741</td>
<td>15.3903</td>
<td>-0.0162</td>
<td>-0.001054</td>
</tr>
<tr>
<td>0.000008414</td>
<td>15.7036</td>
<td>15.7286</td>
<td>-0.0250</td>
<td>-0.001595</td>
</tr>
<tr>
<td>0.000008913</td>
<td>16.0504</td>
<td>16.0763</td>
<td>-0.0259</td>
<td>-0.001616</td>
</tr>
<tr>
<td>0.000009441</td>
<td>16.4135</td>
<td>16.4332</td>
<td>-0.0196</td>
<td>-0.001197</td>
</tr>
<tr>
<td>0.000010000</td>
<td>16.7915</td>
<td>16.7991</td>
<td>-0.0076</td>
<td>-0.000455</td>
</tr>
<tr>
<td>0.000010593</td>
<td>17.1819</td>
<td>17.1744</td>
<td>0.0075</td>
<td>0.000436</td>
</tr>
<tr>
<td>0.000011220</td>
<td>17.5816</td>
<td>17.5998</td>
<td>0.0218</td>
<td>0.001239</td>
</tr>
<tr>
<td>0.000011885</td>
<td>17.9861</td>
<td>17.9665</td>
<td>0.0296</td>
<td>0.001646</td>
</tr>
<tr>
<td>0.000012589</td>
<td>18.3963</td>
<td>18.3660</td>
<td>0.0302</td>
<td>0.001644</td>
</tr>
<tr>
<td>0.000013335</td>
<td>18.8280</td>
<td>18.7904</td>
<td>0.0376</td>
<td>0.001996</td>
</tr>
<tr>
<td>0.000014125</td>
<td>19.2816</td>
<td>19.2319</td>
<td>0.0497</td>
<td>0.002576</td>
</tr>
<tr>
<td>0.000014982</td>
<td>19.7556</td>
<td>19.6931</td>
<td>0.0625</td>
<td>0.003165</td>
</tr>
<tr>
<td>0.000015849</td>
<td>20.2476</td>
<td>20.1765</td>
<td>0.0711</td>
<td>0.003513</td>
</tr>
<tr>
<td>0.000016788</td>
<td>20.7541</td>
<td>20.6848</td>
<td>0.0693</td>
<td>-0.003341</td>
</tr>
<tr>
<td>0.000017783</td>
<td>21.2717</td>
<td>21.2206</td>
<td>0.0511</td>
<td>0.002402</td>
</tr>
<tr>
<td>0.000018386</td>
<td>21.8129</td>
<td>21.7860</td>
<td>0.0269</td>
<td>0.001231</td>
</tr>
<tr>
<td>0.000019663</td>
<td>22.3819</td>
<td>22.3824</td>
<td>-0.0006</td>
<td>-0.000025</td>
</tr>
<tr>
<td>0.000021135</td>
<td>22.9773</td>
<td>23.0101</td>
<td>-0.0329</td>
<td>-0.001431</td>
</tr>
<tr>
<td>0.000022387</td>
<td>23.5967</td>
<td>23.6681</td>
<td>-0.0714</td>
<td>-0.003025</td>
</tr>
<tr>
<td>0.000023714</td>
<td>24.2373</td>
<td>24.3541</td>
<td>-0.1168</td>
<td>-0.004820</td>
</tr>
<tr>
<td>0.000025119</td>
<td>24.9082</td>
<td>25.0651</td>
<td>-0.1569</td>
<td>-0.006300</td>
</tr>
<tr>
<td>0.000026607</td>
<td>25.6137</td>
<td>25.7982</td>
<td>-0.1845</td>
<td>-0.007202</td>
</tr>
<tr>
<td>0.000028184</td>
<td>26.3517</td>
<td>26.5512</td>
<td>-0.1995</td>
<td>-0.007571</td>
</tr>
<tr>
<td>0.000029654</td>
<td>27.1189</td>
<td>27.3236</td>
<td>-0.2047</td>
<td>-0.007547</td>
</tr>
<tr>
<td>0.000031623</td>
<td>27.9207</td>
<td>28.1600</td>
<td>-0.1954</td>
<td>-0.006997</td>
</tr>
<tr>
<td>0.000033497</td>
<td>28.7640</td>
<td>28.9309</td>
<td>-0.1669</td>
<td>-0.005803</td>
</tr>
<tr>
<td>0.000035481</td>
<td>29.6484</td>
<td>29.7717</td>
<td>-0.1234</td>
<td>-0.004161</td>
</tr>
<tr>
<td>0.000037584</td>
<td>30.5745</td>
<td>30.6430</td>
<td>-0.0684</td>
<td>-0.002238</td>
</tr>
<tr>
<td>0.000039981</td>
<td>31.5512</td>
<td>31.5499</td>
<td>0.0013</td>
<td>0.000042</td>
</tr>
<tr>
<td>0.000042170</td>
<td>32.5753</td>
<td>32.4987</td>
<td>0.0766</td>
<td>0.002351</td>
</tr>
<tr>
<td>0.000044668</td>
<td>33.6419</td>
<td>33.4962</td>
<td>0.1457</td>
<td>0.004330</td>
</tr>
<tr>
<td>0.000047315</td>
<td>34.7642</td>
<td>34.5501</td>
<td>0.2142</td>
<td>0.006161</td>
</tr>
<tr>
<td>0.000050119</td>
<td>35.9545</td>
<td>35.6688</td>
<td>0.2857</td>
<td>0.007947</td>
</tr>
</tbody>
</table>
Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

### Isotherm Table

<table>
<thead>
<tr>
<th>Relative Pressure</th>
<th>Experimental Quantity Adsorbed (cm³/g STP)</th>
<th>Fitted Quantity Adsorbed (cm³/g STP)</th>
<th>Absolute Residual (cm³/g STP)</th>
<th>Relative Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000053088</td>
<td>37.2203</td>
<td>36.8621</td>
<td>0.3582</td>
<td>0.009624</td>
</tr>
<tr>
<td>0.000056234</td>
<td>38.5622</td>
<td>38.1403</td>
<td>0.4218</td>
<td>0.010939</td>
</tr>
<tr>
<td>0.000059566</td>
<td>39.9880</td>
<td>39.5154</td>
<td>0.4726</td>
<td>0.011620</td>
</tr>
<tr>
<td>0.000066834</td>
<td>43.1006</td>
<td>42.6077</td>
<td>0.4929</td>
<td>0.011436</td>
</tr>
<tr>
<td>0.000070795</td>
<td>44.7890</td>
<td>44.3526</td>
<td>0.4364</td>
<td>0.009744</td>
</tr>
<tr>
<td>0.000074989</td>
<td>46.5727</td>
<td>46.2479</td>
<td>0.3248</td>
<td>0.006974</td>
</tr>
<tr>
<td>0.000079433</td>
<td>48.6223</td>
<td>48.3046</td>
<td>0.1577</td>
<td>0.003254</td>
</tr>
<tr>
<td>0.000084140</td>
<td>50.4787</td>
<td>50.2286</td>
<td>0.0499</td>
<td>0.000988</td>
</tr>
<tr>
<td>0.000089125</td>
<td>52.6262</td>
<td>52.9178</td>
<td>-0.2916</td>
<td>-0.005541</td>
</tr>
<tr>
<td>0.000094406</td>
<td>54.8939</td>
<td>55.4589</td>
<td>-0.5650</td>
<td>-0.010292</td>
</tr>
<tr>
<td>0.000100000</td>
<td>57.2546</td>
<td>58.1261</td>
<td>-0.8715</td>
<td>-0.015222</td>
</tr>
<tr>
<td>0.000105925</td>
<td>59.7962</td>
<td>60.8524</td>
<td>-1.0962</td>
<td>-0.018335</td>
</tr>
<tr>
<td>0.000112202</td>
<td>62.4381</td>
<td>63.6848</td>
<td>-1.2467</td>
<td>-0.019967</td>
</tr>
<tr>
<td>0.000118850</td>
<td>65.1929</td>
<td>66.4916</td>
<td>-1.2987</td>
<td>-0.019921</td>
</tr>
<tr>
<td>0.000125893</td>
<td>68.0483</td>
<td>69.2682</td>
<td>-1.2199</td>
<td>-0.017927</td>
</tr>
<tr>
<td>0.000133352</td>
<td>71.0192</td>
<td>71.9898</td>
<td>-0.9706</td>
<td>-0.013677</td>
</tr>
<tr>
<td>0.000141254</td>
<td>73.7685</td>
<td>74.8410</td>
<td>-0.8725</td>
<td>-0.011828</td>
</tr>
<tr>
<td>0.000149624</td>
<td>76.4391</td>
<td>77.2130</td>
<td>-0.7739</td>
<td>-0.010124</td>
</tr>
<tr>
<td>0.000158489</td>
<td>79.4779</td>
<td>79.7004</td>
<td>-0.2225</td>
<td>-0.002800</td>
</tr>
<tr>
<td>0.000167880</td>
<td>82.3461</td>
<td>82.0994</td>
<td>0.2647</td>
<td>0.003213</td>
</tr>
<tr>
<td>0.000177828</td>
<td>85.0813</td>
<td>84.4060</td>
<td>0.6752</td>
<td>0.007937</td>
</tr>
<tr>
<td>0.000183865</td>
<td>87.6373</td>
<td>86.6167</td>
<td>1.0206</td>
<td>0.011645</td>
</tr>
<tr>
<td>0.000196526</td>
<td>89.9798</td>
<td>88.7295</td>
<td>1.2503</td>
<td>0.013895</td>
</tr>
<tr>
<td>0.000213439</td>
<td>92.0996</td>
<td>90.7440</td>
<td>1.3556</td>
<td>0.014719</td>
</tr>
<tr>
<td>0.000238727</td>
<td>94.0512</td>
<td>92.6623</td>
<td>1.3889</td>
<td>0.014768</td>
</tr>
<tr>
<td>0.000237137</td>
<td>95.8811</td>
<td>94.4881</td>
<td>1.3930</td>
<td>0.014528</td>
</tr>
<tr>
<td>0.000251189</td>
<td>97.5451</td>
<td>96.2262</td>
<td>1.3189</td>
<td>0.013521</td>
</tr>
<tr>
<td>0.000260073</td>
<td>99.0948</td>
<td>97.8821</td>
<td>1.2127</td>
<td>0.012338</td>
</tr>
<tr>
<td>0.000281838</td>
<td>100.5246</td>
<td>99.4615</td>
<td>1.0631</td>
<td>0.010576</td>
</tr>
<tr>
<td>0.000298538</td>
<td>101.8934</td>
<td>100.9700</td>
<td>0.9234</td>
<td>0.009062</td>
</tr>
<tr>
<td>0.000316228</td>
<td>103.1539</td>
<td>102.4130</td>
<td>0.7409</td>
<td>0.007182</td>
</tr>
<tr>
<td>0.000334965</td>
<td>104.3770</td>
<td>103.7955</td>
<td>0.5815</td>
<td>0.005571</td>
</tr>
<tr>
<td>0.000354813</td>
<td>105.6296</td>
<td>105.1222</td>
<td>0.4076</td>
<td>0.003963</td>
</tr>
<tr>
<td>0.000375837</td>
<td>106.6423</td>
<td>106.3972</td>
<td>0.2451</td>
<td>0.002298</td>
</tr>
<tr>
<td>0.000398107</td>
<td>107.7336</td>
<td>107.6245</td>
<td>0.1091</td>
<td>0.001013</td>
</tr>
<tr>
<td>0.000421697</td>
<td>108.7661</td>
<td>108.8075</td>
<td>-0.0414</td>
<td>-0.000381</td>
</tr>
</tbody>
</table>
Y Zeolite, N2 @ 77.35 K, 004/16844/00

Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

Started: 2011-03-10 17:35:46PM
Completed: 2011-03-11 23:41:34PM
Analysis Adsorptive: N2
Analysis Bath Temp.: 77.150 K
Sample Mass: 0.1272 g
Cold Free Space: 90.1000 cm³
Ambient Temperature: 295.15 K
Automatic Degas: Yes

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Cumulative Surface Area vs. Energy

Energy (e/k)
Cumulative Surface Area (m²/g)
Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Incremental Surface Area vs. Energy
Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K
Operator: AWT/JCH
Submitter: Micromeritics
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

Started: 2011-03-10 17:35:46PM Analysis Adsorptive: N2
Completed: 2011-03-11 23:41:34PM Analysis Bath Temp.: 77.150 K
Sample Mass: 0.1272 g Warm Free Space: 28.5000 cm³ Entered
Cold Free Space: 90.1000 cm³ Equilibration Interval: 30 s
Ambient Temperature: 295.15 K Low Pressure Dose: 3.000 cm³/g STP
Automatic Degas: Yes

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Standard Deviation of Fit: 0.45744, cm³/gSTP

<table>
<thead>
<tr>
<th>Relative Pressure (p/p°)</th>
<th>10^{-6}</th>
<th>10^{-5}</th>
<th>10^{-4}</th>
<th>10^{-3}</th>
<th>10^{-2}</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity Adsorbed (cm³/g STP)</td>
<td>0</td>
<td>0</td>
<td>20</td>
<td>40</td>
<td>60</td>
</tr>
</tbody>
</table>
Options Report - Y Zeolite

Y Zeolite, N2 @ 77.35 K, 004/16844/00

Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K  
Operator: AWT/JCH  
Submitter: Micromeritics  
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

<table>
<thead>
<tr>
<th>Started</th>
<th>Completed</th>
<th>Analysis Adsorptive: N2</th>
<th>Analysis Bath Temp.: 77.150 K</th>
</tr>
</thead>
<tbody>
<tr>
<td>2011-03-10 17:35:46PM</td>
<td>2011-03-11 23:41:34PM</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Sample Mass: 0.1272 g  
Cold Free Space: 90.1000 cm³  
Ambient Temperature: 295.15 K  
Automatic Degas: Yes

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Options Report

Sample Tube
- Warm free space: 1.0000 cm³
- Cold free space: 1.0000 cm³
- Non-ideality factor: 0.0000620
- Use isothermal Jacket: Yes
- Use Filler Rod: No
- Vacuum seal type: Seal Frit

Analysis Conditions

Preparation
- Fast evacuation: Yes
- Vacuum setpoint: 10 µmHg
- Evacuation time: 0.00 h
- Leak test: No
- Use TranSeal: No

Free Space
- Free-space type: Entered
- Warm free space: 28.5000 cm³
- Cold free space: 90.1000 cm³

p° and Temperature
- p° and T type: Measure p° at intervals during analysis. Enter the Analysis Bath Temperature below.
  - Temperature: 77.150 K
  - Measurement interval: 120 min
  - Ambient temperature: 295.15 K

Dosing
- Use first pressure fixed dose: No
- Use maximum volume increment: No
- Target tolerance: 5.0% or 0.500 mmHg
- Low pressure dosing: Yes
- Dose amount: 3.0000 cm³/g STP
- Minimum equilibration delay: 0.00 h
- Maximum equilibration delay: 999.00 h

Equilibration
- Equilibration time (p/p° = 1.000000000): 30 s
- Minimum equilibration delay at p/p° >= 0.995: 600 s
Sample: Y-Zeolite Reference Mat analyzed with N2 at 77 K  
Operator: AWT/JCH  
Submitter: Micromeritics  
File: C:\2020\DATA\PERF-TST\N2-YZEOL.SMP

| Started: 2011-03-10 17:35:46PM | Analysis Adsorptive: N2 |
| Completed: 2011-03-11 23:41:34PM | Analysis Bath Temp.: 77.150 K |
| Sample Mass: 0.1272 g | Warm Free Space: 28.5000 cm³ Entered |
| Cold Free Space: 90.1000 cm³ | Equilibration Interval: 30 s |
| Ambient Temperature: 295.15 K | Low Pressure Dose: 3.000 cm³/g STP |
| Automatic Degas: Yes |

Comments: Use sample tube with isothermal jacket, but no filler rod. Follow the instructions on the Y-Zeolite sample data sheet for sample preparation and special instructions. Be sure to use specifications for the current lot.

Sample Backfill
- Backfill at start of analysis: No
- Backfill at end of analysis: Yes
- Backfill gas: N2

Adsorptive Properties
- Adsorptive: Nitrogen
- Maximum manifold pressure: 925.00 mmHg
- Non-ideality factor: 0.0000570
- Density conversion factor: 0.0015468
- Therm. tran. hard-sphere diameter: 3.860 Å
- Molecular cross-sectional area: 0.162 nm²
- Inside diameter of sample tube: 9.53 mm
8. OPTIONS MENU

The commands on the Options menu enable you to configure the system to your laboratory’s requirements and establish sample defaults.

**Description**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option Presentation</strong></td>
<td>Allows you to display the sample file dialog in Advanced, Basic, or Restricted mode. Page 8-2.</td>
</tr>
<tr>
<td><strong>Sample Defaults</strong></td>
<td>Enables you to specify default values for sample and parameter files. Page 8-4.</td>
</tr>
<tr>
<td><strong>Units</strong></td>
<td>Enables you to choose the way in which data are presented on the screen and in printed reports. Page 8-12.</td>
</tr>
<tr>
<td><strong>Graph Grid Lines</strong></td>
<td>Enables you to choose the type(s) of grid lines to show on your report. Page 8-12.</td>
</tr>
<tr>
<td><strong>Live Graph</strong></td>
<td>Enables you to choose the variable for the X-axis during data collection. Page 8-13.</td>
</tr>
<tr>
<td><strong>Parameter Files Directory</strong></td>
<td>Allows you to specify a location for the parameter files used in the Basic sample file editor. Page 8-13.</td>
</tr>
<tr>
<td><strong>Service Test Mode</strong></td>
<td>Enables you to perform certain troubleshooting procedures. This option is available only under the direction of a Micromeritics service representative. Page 8-14.</td>
</tr>
</tbody>
</table>
Option Presentation

The sample editing dialogs for the ASAP 2020 analysis program may be presented in three modes: Restricted, Basic, and Advanced. Each format displays sample information dialogs differently.

- **Advanced**: displays all parts of the sample information file in a tabbed dialog as in an index card file. You just click on the tab of the desired parameter. This format also allows you to switch to the Basic mode.

- **Basic**: displays all parts of the sample file as a single dialog, in which you select from pre-defined parameter files. This format also allows you to switch to the Advanced mode if editing of parameters is desired.

- **Restricted**: displays in the same manner as the Basic format. Certain menu options, however, become disabled and you cannot switch to the Advanced mode. You also must enter a password to access and exit this format.

### Advanced

The Advanced format presents all parts of the sample information file in a tabbed dialog. Each tab opens its associated dialog. For example, if you are using the Advanced format and you open or create a sample information file, the following dialog is displayed.

The Advanced format can be used to edit sample parameters and customize files.
Basic

The Basic format presents the sample information file and its parameter files as a single dialog. You also have access to all menu options. For example, if you are using the Basic format and open or create a sample information file, the dialog is displayed in this manner.

The Basic format is used to quickly create sample information files using previously defined parameter files. You also can switch easily to the Advanced format to view or edit details of parameter files.

Restricted

The Restricted format is identical to the Basic format, except that certain options are disabled. You also cannot switch to the Advanced format. This format is password-protected and typically is used in laboratories where analysis conditions must remain constant, for example, in the pharmaceutical industry.

When you select Restricted, a dialog requesting a password is displayed.

You can enter any password (up to 31 characters) to enable the Restricted mode. You must enter the same password to exit the Restricted mode. For example, if you enter “password” to enable the Restricted format, then you must enter “password” to exit. If you forget the
password, open the application INI file and navigate to the Private section. The current password is shown immediately following “OptionPresentationPassword.” Make a note of the password, exit the INI file, and enter the password where requested. Deleting the password from the INI file will not disable the Restricted mode; you must enter the password using the Password dialog to exit the Restricted format.

Sample Defaults

Sample defaults are the values you see in the sample information editors when you create a new sample file. This option allows you to specify the default values. This feature makes it easy for you to apply the same conditions to many samples.

For efficiency, it is best to specify defaults for materials you most commonly analyze. You can always edit the values in the sample file when it is created. Sample defaults can be specified using the Basic or Advanced format.

The analysis program contains one complete default sample information file. When you select Open, Sample information from the Main Menu, a new file with these default values is generated. Default files for degas conditions, analysis conditions, adsorptive properties, and report options also are included. Appendix F, Default Files and System Files lists details on system default files.

Sample defaults can be specified using the Advanced or Basic format. The Advanced or Basic format is chosen by selecting Options > Option presentation from the main menu.
Basic Format

When you select Sample Defaults using the Basic format, the Basic Sample Defaults dialog is displayed.

Sequence

Allows you to specify a default sequence for the sample file name. The number you specify is incrementally sequenced each time you create a sample file. It is the number that appears in the File name field when you select File > Open > Sample information.

Use numbers, letters, or other printable characters, such as dashes. At least three numbers must be included.

- Use up to eight characters.
- Do not use characters such as * or ?.

Sample

Allows you to enter an additional identification that provides more information than the sample file name itself.

The field on the left allows you to specify a name for the identification label. For example, you may prefer to use Test or Material.

The field on the right allows you to specify a format for the sample identification.
Sample
(continued)

Use numbers, letters, or other printable characters, such as dashes.

- Use up to 20 characters for the prompt.
- Use up to 43 characters (including the $ symbol).
- Include the automatically generated file name as part of the identification by using the $ symbol where you want the sequence number to appear.

For example, if the sequence number is 000-001, enter the identification as follows:

**Lab #25 - $**

The resulting sample identification for the first sample information file would be:

**Lab #25 - 000-001**

for the second file:

**Lab #25 - 000-002**, and so on.

Mass

You can choose to enter a sample mass or have the mass automatically calculated. Regardless of which option you choose for your default, you can change it in the sample file.

Enter

Enables the **Sample Mass** field allowing you to enter a default value.

Calculate

Enables the **Empty tube** and **Sample + tube** fields, allowing you to enter default values. These values are used to calculate the mass of the sample,

\[
Mass_{sample} = Mass_{sample + tube} - Mass_{tube}
\]

Density

The sample density is used when using a calculated free space. The default value is appropriate unless you typically use a calculated free space. This field can always be edited in the sample file.
When you select Sample Defaults while using the Advanced format, the Advanced Sample Defaults dialog is displayed.

**Advanced Format**

The defaults you specify for the parameters in the Advanced format display as the defaults for newly created standalone parameter files.
Sequence

Allows you to specify a default sequence for the sample file name. The number you specify is incrementally sequenced each time you create a sample file. It is the number that appears in the File name field when you select File > Open > Sample information.

- Use numbers, letters, or other printable characters, such as dashes. At least three numbers must be included.
- Use up to eight characters.
- Do not use characters such as * or ?.
**Sample**

Allows you to enter an additional identification that provides more information than the sample file name itself.

The field on the left allows you to specify a name for the identification label. For example, you may prefer to use *Test* or *Material*.

The field on the right allows you to specify a format for the sample identification.

- Use numbers, letters, or other printable characters, such as dashes.
- Use up to 20 characters for the prompt.
- Use up to 43 characters (including the $ symbol).
- Include the automatically generated file name as part of the identification by using the $ symbol where you want the sequence number to appear.

For example, if the sequence number is 000-001, enter the identification as follows:

```
Lab #25 - $
```

The resulting sample identification for the first sample information file would be:

```
Lab #25 - 000-001
```

for the second file:

```
Lab #25 - 000-002, and so on.
```
Operator
Submitter

These fields contain the name (or other identification) of the operator and submitter.

The fields on the left can be edited to display a different label if desired.

The fields on the right allow you to specify default names or titles.

- Include the automatically generated file number as part of the identification by using the symbol $ where you want the sequence number to appear. Refer to the example in the previous section.

- Use up to 20 characters for the prompt.

- Use up to 43 characters (including the $ symbol).

- Omit either (or both) item entirely from the sample information file by selecting **Omit**.

Bar Code

This field can be used to enter bar code information or to accept data from a bar code reader. If bar code information is not used, this field can be used to enter additional information about the sample. The field can also be omitted if it is not needed.

Use up to 40 characters.

Mass

You can choose to enter a sample mass or have the mass automatically calculated. Regardless of which option you choose for your default, you can change it in the sample file.

Enter

Enables the **Sample Mass** field allowing you to enter a default value.

Calculate

Enables the **Empty tube** and **Sample + tube** fields, allowing you to enter default values. These values are used to calculate the mass of the sample,

\[ Mass_{sample} = Mass_{sample\,+\,tube} - Mass_{tube} \]

Density

Enter a default density. If there is a material you analyze quite often, you may wish to use its default in this field. This value can be edited in the sample information file.
Type of Data

Choose whether you wish to enter data or have it collected automatically by the system.

User Parameters

The fields in this group box are used primarily for SPC (Statistical Process Control) reporting. They are used to specify characteristics of the sample or its manufacturing process.

Once specified, these parameters display on the sample editor and in the SPC Sample Options dialog (accessed through the SPC Report Options dialog).

These fields can also be used to record analysis conditions or sample information so that it can be printed on the Summary report.

Select **Omit** if you do not wish to use these fields; this will prevent them from displaying on the sample information dialog.

Comments

Use this window to enter sample characteristics, analysis conditions, etc. Anything you type in this window is printed in the report header.

Add Log Entry

Allows you to enter comments about the sample or its analysis conditions. Anything you enter using this option appears in the Instrument Log Report; it does not display in the report header.

Replace All

Use this push button to replace the current default values with those from an existing sample file.

Save

Saves the current definition as the defaults.

Close

Closes the dialog.

Basic

Switches the sample editor to the Basic format.
Units

This menu command displays the Units Selections dialog which allows you to choose the manner in which to display data on reports.

Graph Grid Lines

Graph Grid Lines enables you to choose the type(s) of grid lines to show on your reports; the Graph Grid Lines dialog is displayed.

X-Axis

Y-Axis

 Enables you to choose Major and/or Minor lines to display in printed reports for the Logarithmic and Linear scales.

 If you deselect these items (remove the check marks), your report will not display grid lines.

Grid Line Style

 Allows you to choose the type of grid line to display if grid lines are being shown.
### Live Graph

This option enables you to choose the variable for the x-axis during data collection. You can also choose to correct for thermal transpiration which should always be selected for micropore analyses (refer to page 5-37 for additional information on thermal transpiration).

### Parameter Files Directory

This option allows you to specify a location for the predefined Analysis conditions, Degas conditions, Adsorptive properties, and Report options files displayed in the drop-down lists on the Basic Sample Information dialog. The current directory is displayed above the drives/directory window.

The default directory is params and includes several parameter files supplied with the analysis program. If you specify a different directory, these files will not be included in the drop-down lists unless you copy (or move) them to the new directory.

If you wish to continue using the params directory for parameter files, be sure to save any files you create to this directory.
Various service tests are included in the ASAP 2020 operating program. These tests can be performed only with the assistance of a trained Micromeritics service representative. When you select Service Test Mode from the Options menu, a dialog box prompting you to enter a password is displayed. This password is coded to change on a regular basis and is known only by your service representative. You will not be able to perform these tests without his guidance.
9. TROUBLESHOOTING AND MAINTENANCE

The ASAP 2020 system has been designed to provide efficient and continuous service. However, to get the best results over the longest period of time, certain maintenance procedures must be followed. This chapter includes troubleshooting information, recommended preventive maintenance procedures, and routine maintenance procedures.

Troubleshooting

Most operational problems are caused by leaks (commonly around the sample tube O-ring at the analysis port), sample weighing errors, use of too much analysis bath fluid in the Dewar at the start of an analysis, or entry of incorrect system volume for analysis. Always check these first when expected analysis results are not obtained. Some common operational problems, which are not indicated on the video monitor screen, and their respective causes and solutions are provided in the following table.

<table>
<thead>
<tr>
<th>What Happened</th>
<th>Why</th>
<th>What To Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Dewar cannot be raised (or lowered).</td>
<td>Elevator that moves dewar stuck in up position, down position, or somewhere in between.</td>
<td>Check for possible obstruction to elevator movement.</td>
</tr>
<tr>
<td>Vacuum pump gurgles continuously.</td>
<td>Sample tube or cold trap tube O-ring or fitting loose.</td>
<td>Tighten fitting. Replace O-ring.</td>
</tr>
<tr>
<td></td>
<td>Sample tube cracked.</td>
<td>Replace with new sample tube.</td>
</tr>
<tr>
<td></td>
<td>No sample tube loaded on a selected port.</td>
<td>Install plug or empty sample tube.</td>
</tr>
<tr>
<td></td>
<td>Gas inlet valve open while vacuum valve open.</td>
<td>With manual control enabled, use the instrument schematic to close gas inlet valve.</td>
</tr>
<tr>
<td>Vacuum gauge shows reading above 20 μmHg, even after extended pumping through unrestricted valve with analysis or degas ports closed.</td>
<td>Vacuum pump oil is low, causing ineffective evacuation.</td>
<td>Add or change vacuum pump oil. Be sure to add oil to proper level according to indicator window on the pump.</td>
</tr>
<tr>
<td>What Happened</td>
<td>Why</td>
<td>What To Do</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vacuum gauge shows reading above 20 (\mu\text{mHg}), even after extended pumping through unrestricted valve with analysis or degas ports closed. (continued)</td>
<td>Cold trap obstructed by condensation.</td>
<td>Clean the cold trap tubes. Refer to <em>Cleaning the Cold Trap Tubes</em> on page 9-14.</td>
</tr>
<tr>
<td>Filter in port being used is dirty.</td>
<td>Replace filter in port. Refer to <em>Replacing the Port Filters</em> on page 9-6.</td>
<td></td>
</tr>
<tr>
<td>Leak in vacuum plumbing.</td>
<td>Check and tighten all connections in vacuum plumbing, including cold traps.</td>
<td></td>
</tr>
<tr>
<td>Vacuum pump turned off or unplugged.</td>
<td>Check pump power plug and power switch.</td>
<td></td>
</tr>
<tr>
<td>The alumina in the oil vapor trap is holding moisture.</td>
<td>Replace or dry the alumina. Refer to <em>Replacing the Alumina in the Oil Vapor Traps</em> on page 9-11.</td>
<td></td>
</tr>
<tr>
<td>Analysis valves cannot be operated.</td>
<td>Circuit opened by circuit breaker.</td>
<td>Reset breaker (depress breaker button) located on the right side of the instrument near (page 3-4 shows location). If it does not stay in or if it continues to trip, contact appropriate service personnel.</td>
</tr>
<tr>
<td>Cable from computer to the instrument is loose.</td>
<td>Make sure the cable is seated properly.</td>
<td></td>
</tr>
</tbody>
</table>
Preventive Maintenance

The table below lists the preventive maintenance procedures you should perform to keep your analyzer operating at peak performance. Instructions for each procedure follow the table. Micromeritics recommends that you perform these procedures as indicated, as well as by one of our service representatives every 12 months.

<table>
<thead>
<tr>
<th>Maintenance Required</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean the analyzer, page 9-22</td>
<td>As required or every 6 months</td>
</tr>
<tr>
<td>Lubricate elevator screw, page 9-4</td>
<td>As required or every 6 months</td>
</tr>
<tr>
<td>Check analysis port Dewar, page 9-4</td>
<td>Weekly</td>
</tr>
<tr>
<td>Replace sample tube O-ring, page 9-5</td>
<td>As required or every 3 months</td>
</tr>
<tr>
<td>Replace port filters, page 9-6</td>
<td>Every 30 days</td>
</tr>
<tr>
<td>Replace vacuum pump exhaust filter*, page 9-7</td>
<td>Annually (Heavy use may require more frequent maintenance.)</td>
</tr>
<tr>
<td>Inspect and change vacuum pump fluid*, page 9-9</td>
<td>As required or every 3 months</td>
</tr>
<tr>
<td>Replace alumina in oil vapor traps*, page 9-11 (if installed)</td>
<td>As required or every 3 months</td>
</tr>
<tr>
<td>Replace diaphragm in vacuum pump (oil-free pump only)**</td>
<td>Every 12 months</td>
</tr>
<tr>
<td>Clean cold trap tubes, page 9-14</td>
<td>As required or every 3 months</td>
</tr>
<tr>
<td>Calibrate manifold temperature sensor, page 9-15</td>
<td>Every 12 months</td>
</tr>
<tr>
<td>Calibrate system volume</td>
<td>Every 12 months</td>
</tr>
<tr>
<td>Check analyzer outgassing rate</td>
<td>Every 6 months</td>
</tr>
<tr>
<td>Test analyzer for leaks, page D-1</td>
<td>As required or every 12 months</td>
</tr>
</tbody>
</table>

*Oil-based vacuum pumps only.
**After about 12 to 18 months of operation, the diaphragm in the pump will wear out and become completely inoperable. To prevent any instrument downtime due to an inoperable pump, it is recommended that you have the diaphragm replaced by a Micromeritics Service Representative every 12 months.
Lubricating the Elevator Screw

Apply a light coat of lithium grease to the elevator screw, accessed from the rear of the instrument, as needed.

Checking the Analysis Port Dewar

Ice and suspended frost particles may accumulate in the bottom of the analysis port Dewar. Particles or deposits exceeding 1/4 in. (0.64 cm) in depth may jam between the bottom of the sample tube and the bottom of the Dewar, causing the Dewar not to raise fully. Accumulations of fine particles impede liquid nitrogen circulation around the bottom of the sample tube. This causes the sample temperature to be slightly higher which, in turn, can cause pore volume measurement errors in those samples exhibiting high isotherm slope above 0.97 relative pressure. Accumulated ice is likely to melt and form a pool of water in the Dewar if all liquid nitrogen evaporates. The water must be removed; otherwise it will solidify when liquid nitrogen is added and could press on the bottom of the sample tube causing breakage.

To ensure problems do not develop due to ice accumulation, check the Dewar after each use. Clean on a weekly basis as follows:

1. Lift out the entire analysis port Dewar.
2. Pour out liquid nitrogen into an appropriate cryogenic container.
3. Rinse the Dewar with warm water to melt any ice accumulation which may remain in the Dewar, then dry thoroughly.
4. Replace the Dewar.

When handling Dewars, be sure to observe the Dewar precautions outlined in "Installing Dewars in Chapter 3."
Replacing the Sample Tube O-ring

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-ring becomes worn or cracked, it does not provide a good seal and will need to be replaced. This procedure applies to both degas and analysis ports.

Before removing (or installing) a sample tube, ensure that the port valve is closed. Observe the instrument schematic or degas schematic to verify valve status.

To replace the O-ring:

1. Holding the sample tube firmly with one hand, loosen the sample tube connector nut by turning counterclockwise.

Be careful not to let the sample tube connector nut drop onto the bottom of the tube as it may break the tube.

2. Carefully pull the sample tube down until it is free from the port. You may have to grasp the sample tube with both hands.

3. Remove the O-ring from the top of the sample tube and replace it with a new one.

If the O-ring remains inside the sample port, you may use a pair of tweezers or needle-nose pliers to remove it.
4. After the new O-ring is in place, insert the sample tube back into the sample port until it is fully seated.

5. Slide the sample tube connector nut up the tube (the ferrule and O-ring will move along with the connector nut). Then, turning clockwise, **hand-tighten** the connector nut to the sample connector.

### Replacing the Port Filters

A porous metal filter is located in the analysis port and in each degas port of the analyzer. If a filter on a degas port is contaminated, the contaminant may adsorb atmospheric gases when the port is not plugged (with either a sample tube or plug), resulting in extended degassing time for samples on that port. Using a contaminated filter on the analysis port may extend the time required to achieve a vacuum at that port. More importantly, the contaminant may adsorb or desorb during analysis, affecting the analysis results. A contaminated filter on the analysis port may be detected by a leak test (if the contaminant outgasses) or by a free space reading much lower than normal.

Perform the following steps to replace the filters:

### Analysis Port

1. Make sure the Dewar and sample tube (or plug) are removed. Make sure the analysis port (sample valve) is closed.

2. Using a wrench, remove the sample tube fitting from the manifold connector and remove the filter and O-ring.
3. Replace the filter and the O-ring. Carefully reassemble the sample tube fitting, filter, O-ring and manifold connector, and tighten by hand. Then tighten with a wrench to prevent leaks when evacuated.

To avoid analysis problems, the new filter and O-ring must be clean. Do not touch them with bare hands.

Degas Port

1. Using a wrench, remove the degas port fitting and remove the filter and O-ring.

2. Replace the filter and the O-ring. Carefully reassemble the sample tube fitting, filter, O-ring and manifold connector, and tighten by hand. Then tighten with the wrenches to prevent leaks when evacuated.

To avoid degassing problems, the new filter and O-ring must be clean. Do not touch them with bare hands.

Replacing the Vacuum Pump Exhaust Filter

This procedure does not apply, and is not required, for dry vacuum pumps.

The gases used by the ASAP 2020 are exhausted by vacuum pumps. An exhaust filter is installed on the exhaust port of each vacuum pump. The filter minimizes the release of oil vapor and should be replaced when it becomes so saturated with oil that it is ineffective.

Exhaust filters are used on the vacuum pump to minimize the release of oil vapors. The gases used are diluted substantially upon being released from the vacuum pumps. However, it may be desirable in some locations to provide a fume hood for added protection from hazardous gases and vapors released into the work area.

1. Using a flat-head screwdriver, remove the screws from the vacuum pump panel on the front of the analyzer, then remove the panel to access the pump.
2. Loosen the wing nut of the vacuum clamp at the vacuum pump exhaust port. Swing the clamp fastening screw away from the exhaust port. Open the clamp to remove it from the port.

3. Make sure the dust cover has been removed. Lift the exhaust filter from the exhaust port and discard it. Install a new filter on the exhaust port and push the filter against the O-ring.

4. Open the clamp and place it around the flange of the exhaust port and the flange of the exhaust filter. Swing the clamp fastening screw toward the exhaust port until it fits into the slot in the other half of the clamp. Tighten the wing nut.

5. Reinstall the vacuum pump panel.
Inspecting and Changing Vacuum Pump Fluid

The fluid in the vacuum pump should be changed every three months or when the efficiency of the vacuum pump declines (requiring increased time to reach vacuum levels). The fluid can first be inspected to determine if a change is necessary.

Use oil supplied by Micromeritics, or refer to the manual for the vacuum pump for other acceptable oils.

**Inspecting Fluid**

Inspect the fluid as follows:

1. Remove the vacuum pump panel (located on the left front side of the analyzer).

2. View the vacuum pump fluid through the oil level indicator window. Fluid in good condition is clean, clear or light in color, and transparent. If the color of the fluid is darkened, the fluid should be changed.

**Changing Fluid**

Change the fluid as follows:

1. Place the analyzer ON/OFF switch in the OFF position.

2. Remove the vacuum pump panel (if not already removed).

3. Disconnect the vacuum pump power cord from its power source.

4. Disconnect the vacuum pump hose from the top of the vacuum pump.

5. Grasp the handle on top of the vacuum pump and lift it out of the analyzer; place the vacuum pump on a work table.
6. Drain the used oil:
   a. Place a waste container under the drain fitting.
   b. Remove the plug from the drain spout.
   c. Allow the oil to drain into the waste container.
   d. Replace the drain plug.

7. Remove the Oil-fill plug; add fresh fluid to the oil-fill port until the level is midway between the two indicator lines.

8. Check the washer or O-ring used at the oil-filling port; replace if necessary. Replace the oil-fill plug.

9. Place the vacuum pump back into the analyzer onto the drip tray and reconnect the vacuum pump hose.

10. Reconnect the vacuum pump power cord.

11. Replace the vacuum pump panel.

12. Place the analyzer ON/OFF switch in the ON position. The pump must run a few hours (or overnight) to eliminate air and moisture from the fresh fluid and to produce efficient vacuum operations.
Replacing the Alumina in the Oil Vapor Traps

The activated alumina in the oil vapor traps becomes saturated during use. The alumina should be replaced if any of the following conditions exist:

- The alumina has been used for a three-month period.
- Oil has accumulated in the cold trap.
- Most of the alumina pellets are no longer white.

When you replace the alumina, you may also need to change the vacuum pump oil if the interval between changes of alumina has been short.

Do not perform the following procedure on used alumina. The resultant oil vapors may cause a fire or an explosion.

Perform the following steps to replace the alumina:

1. Remove the vacuum pump panel.

2. Turn off power to the vacuum pump.

3. Prepare fresh alumina as follows:
   a. Heat an oven between 250 °C and 350 °C.
   b. Pour about 180 grams of alumina into a glass or metal container for each trap (approximately 250 mL if a graduated beaker is used). Place the container in the oven.
   c. Bake the alumina for two hours; turn off the oven.
   d. Allow the alumina to cool in the oven before pouring it into the traps.


5. Open the vacuum valve (P1 on analysis schematic and D5 on degas schematic) and an inlet valve (nitrogen or helium) until the pressure stabilizes around atmospheric pressure. Then, close all valves. This step fills the vacuum section before disconnecting.
6. Remove the traps by opening both vacuum clamps and separating the trap from the vacuum pump and hose connections.

7. Remove one end fitting from each trap body.

8. Remove the used alumina from the trap body and dispose of it in an appropriate manner.
9. If the trap body interior appears oily or dirty, wash it with isopropyl alcohol or ethyl alcohol and dry it thoroughly.

**Exposure of the trap body to oil vapor may cause small cracks on the inside surface of the trap body. Under normal circumstances, these cracks will not cause problems or leaks.**

Ensure adequate ventilation when using solvents for cleaning purposes.

10. Pour the new activated alumina pellets into each trap until they are level with the tops of the trap bodies.

11. Screw the end fittings back onto the trap bodies and tighten securely by hand.

12. Replace the traps on the vacuum pump.

13. Reconnect the hose.

14. Turn on power to the vacuum pump.

15. Replace the vacuum pump access panel.
Cleaning the Cold Trap Tubes

Oil vapor from the vacuum pumps accumulates in the cold trap. Clean the tubes as follows:

If the high vacuum pump is installed, wait for it to completely stop (approximately 10 minutes).

1. Remove the vacuum pump panel.
2. Disconnect the vacuum pump power cord from its power source.
4. Open analysis valves in the following order: P1, PS, 5, 7, and 1. Allow the pressure to stabilize until around atmospheric. Then, close the valves in the same order as they were opened. This step fills the analysis vacuum section before disconnecting.
6. Open degas valves in the following order: D5 and D7. Allow the pressure to stabilize until around atmospheric. Then, close valve D7 and D5. This step fills the degas vacuum section before disconnecting.
7. Remove the connector nut from the glass tube and inspect the O-ring. Replace the O-ring if it is cracked or worn.

8. Carefully slide the glass tube down over the metal tube and remove the glass tube.
9. Rinse the tube with acetone; then dry it.
10. Reinstall the cold trap tube. Make sure the O-rings are in place.

11. Repeat Steps 2 through 10 for the other cold trap.

12. Reconnect the vacuum pump power cord.

13. Replace the vacuum pump access panel.

**Calibrating the Manifold Temperature Sensor**

You should calibrate the manifold temperature on an annual basis. This allows you to correct for any changes in the manifold temperature sensor that occur with time.

You will need a small diameter probe, such as a 1/16-in. (1.5-mm) thermocouple to calibrate the manifold temperature sensor.

1. Insert the thermocouple probe into the opening located to the left of the sample port connector.

2. Move the thermocouple back and forth until you locate the small opening on the underside of the manifold. Push the thermocouple through the white insulation into the opening until the thermocouple stops.

   **You may have to scrape the insulation to locate the opening on the underside of the manifold.**

3. Allow the temperature gauge reading to stabilize.
4. Select **Unit > Calibration > Temperature**; the Calibrate Manifold Temperature dialog is displayed.

5. Enter the manifold temperature indicated on the reference temperature gauge. Click **OK** to store the new value.

6. Remove the thermocouple probe.

**Performing a Leak Test**

This procedure may be performed at the request of your service representative to determine if there is a leak in your system. This test generates a report that your service representative will request that you send to him for observation.

The following types of information are displayed during the test:

- Prompts on preparing the instrument for the test
- Approximate time period of the test
- Prompts in which an operator response is required

A manual procedure for checking leaks is also available. Refer to Appendix D, page **D-1**.
1. Select Unit [n] > Diagnostics; the Service Test dialog is displayed.

2. Click the down arrow to the right of the Test field and select System Leak Test Rev. [latest revision letter].

3. Ensure that Report after test is selected and that Screen is chosen as the destination.

4. Click Next; the second view of the Service Test dialog is displayed.
Data will be inserted into the pane as collected.

5. After the test is finished, a dialog stating the test is complete is displayed.

6. Click **OK** to close the dialog, then click **Close** on the test dialog to close the test.

7. When you close the test, a report is generated automatically to the screen.

8. Click **Save as**; the Save As dialog is displayed.

9. Accept the default name displayed in the **File name** field, then click **Save** to return to the report window.

10. Click **Close** to close the report window.

11. An additional report file named with the same file name and the extension ECD will be automatically created.

12. E-mail the report file and the ECD file to your service representative.
Cleaning and Verifying the Gas Line

You should always clean the gas lines and verify there are no leaks at the connections after you connect a gas bottle. This test examines the gas line from the instrument to the gas bottle. A report is generated at the completion of the test verifying that it has passed or failed. Causes and corrective action for a failure are provided.

Before beginning, confirm that the state for valves and the low-pressure gauge are as follows:

1. Select **Unit [n] > Diagnostics**; the Service Test dialog is displayed.

2. Click the down arrow to the right of the **Test** field and select **Clean and Verify Gas Line # Rev** [latest revision letter].

3. Ensure that **Report after test** is selected and that **Screen** is chosen as the destination.
4. Click **Next**; the second view of the Service Test dialog is displayed. On this dialog a series of messages is displayed. These messages are of the following types:

- **Informative**: for example, advising how long the test will take or how long before you will be required to open or close a valve. Read the message and click **OK** to proceed.

- **Operator response**: for example, you will be asked to open and close regulator and gas bottle valves (depicted below). Perform the task first, then click **OK**.

![Diagram showing regulator, gas bottle shut-off valve, and low-pressure gauge]

5. After the test is finished, a dialog stating the test is complete is displayed; click **OK** to close the dialog.

6. A report is generated automatically to the screen.

![Image of the Outgas/Leak Rate of the Gas Line report]

Observe the **Rate of Change** on the **Outgas/Leak Rate of the Gas Line** report; it should display **Passed**, indicating that the gas line from the instrument to the gas bottle is clean and leak-free.
If Failed is shown, a leak is indicated between this connection. Check the connections from the instrument to the gas bottle. Tighten as necessary, then try the test again.

7. Click the **Gas Pressure Test - 2** tab to display its report.

   ![Gas Pressure Test Image]

   **Passed** should display in the **Maximum** field, indicating that all valves are in the proper state for operation.

   If Failed is shown, one or more valves is not in the proper position; set the valves as shown below and ensure the appropriate pressure is displayed on the low-pressure gauge.

   ![Valve Positions Image]

   If you wish to run the test again, close the gas bottle valve before starting the test.

8. Click **Close** to close the test report.

9. Click **Close** on the test dialog to close the test.
Routine Maintenance

The procedures in this section are performed as needed.

Cleaning the Analyzer

The ASAP 2020 should be cleaned every six months, or sooner if required. Clean the outside casing of the analyzer (except for the shields) with a clean cloth dampened with isopropyl alcohol (IPA), a mild detergent in water, or a 3% hydrogen peroxide solution. It is not necessary to remove any switches or screws to clean the outside casing. Use only a mild detergent in water to clean the shields.

Use only a mild detergent in water to clean the shields. Do not use isopropyl alcohol. Isopropyl alcohol could damage the surface of the shield.

Calibrating the Pressure Offset

When operating the system in manual mode, Calibration > Pressure Zero enables you to evacuate the manifold and zero all the transducers. Your system may contain up to three transducers.

The system automatically zeros the transducers before an analysis begins. Therefore, you do not need to use this feature unless you are operating the system in manual mode.

Perform the following steps to calibrate the pressure gauge:

1. Select Unit > Calibration > Pressure Zero; the Calibrate Pressure Offset dialog is displayed.

2. Click Start to evacuate the manifold and zero the pressure gauge(s).

3. When the calibration is complete, click OK to close the dialog.

You may cancel a calibration at any time by selecting Cancel. If you cancel a calibration, no new calibration data are saved.
Calibrating the Pressure Scale

**Calibration > Pressure Scale** allows the software to adjust the gain of the selected transducer to match a reference standard.

1. Attach a reference pressure gauge to the sample port of the analyzer.
2. With manual control enabled:
   a. Dose the manifold with helium or nitrogen to 760 mmHg.
   b. Open the sample port to expose the reference pressure gauge to the same pressure as the analyzer’s transducer.
3. Select **Unit > Calibration > Pressure Scale**; the Calibrate Pressure Scale dialog is displayed.

```
[Image: Calibrate Pressure Scale dialog]
```

4. Select **Match to entered pressure**.
5. Enter the pressure reported by the reference pressure gauge, then click **OK**.
6. Close the sample port and evacuate the manifold.
7. Remove the reference pressure gauge.
10. ORDERING INFORMATION

The ASAP2020 system components and accessories can be ordered using one of the following methods:

- Call our Customer Service Department at (770) 662-3636
- Access our web site at www.micromeritics.com
- Contact your local sales representative

When ordering, please use the information provided in this chapter to place your order:

### Analysis System Components and Accessories

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Item and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Peripheral Accessories</strong></td>
<td></td>
</tr>
<tr>
<td>060-00030-00</td>
<td>FlowPrep 060, degasses up to six samples at up to 400 °C with flowing gas</td>
</tr>
<tr>
<td>061-00030-00</td>
<td>VacPrep 061, degasses up to six samples at up to 400 °C with either flowing gas or by evacuation (evacuation requires a vacuum pump)</td>
</tr>
<tr>
<td>021-00000-00</td>
<td>Model 021 LN₂ transfer system, for easy filling of sample Dewars; includes 47-L Dewar, mobile platform, and pump with 100-cm discharge line</td>
</tr>
<tr>
<td>202-33050-00</td>
<td>Water vapor option; allows water vapor adsorption studies</td>
</tr>
<tr>
<td><strong>System Components</strong></td>
<td></td>
</tr>
<tr>
<td>202-25849-00</td>
<td>Dewar, 3 liter, cold trap</td>
</tr>
<tr>
<td>202-25850-00</td>
<td>Dewar, 3 liter, analysis</td>
</tr>
<tr>
<td>200-25928-00</td>
<td>Dewar, 1 liter, analysis (wide mouth)</td>
</tr>
<tr>
<td>202-33053-00</td>
<td>Stainless Steel Dewar Kit, 4 liter, wide mouth, includes analysis Dewar, cold trap Dewar, and elevator adapter. Typically provides greater than 40 hours of unattended analysis.</td>
</tr>
<tr>
<td>240-25901-00</td>
<td>Dewar depth gauge</td>
</tr>
<tr>
<td>202-31708-00</td>
<td>Dewar cover, cold trap</td>
</tr>
<tr>
<td>202-31707-00</td>
<td>Dewar cover, analysis</td>
</tr>
<tr>
<td>200-25929-00</td>
<td>Dewar stopper, sample port, 1-liter Dewar</td>
</tr>
<tr>
<td>004-25103-00</td>
<td>Ferrule, front, Teflon 1/4 in.</td>
</tr>
<tr>
<td>004-25104-00</td>
<td>Ferrule, rear, Nylon 1/4 in.</td>
</tr>
<tr>
<td>Part Number</td>
<td>Item and Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>290-25846-00</td>
<td>Copper tube, for gas inlet, 1/8-in. diameter, 6 ft. long</td>
</tr>
<tr>
<td>290-25846-01</td>
<td>Same as 290-25846-00, but uses 16-ft. (5m) tubing</td>
</tr>
<tr>
<td>201-25818-00</td>
<td>Same as 290-25846-00, but uses stainless steel tubing</td>
</tr>
<tr>
<td>201-25818-01</td>
<td>Same as 290-25846-00, but uses stainless steel 16-ft. (5m) tubing</td>
</tr>
<tr>
<td>004-25549-00</td>
<td>Reducer, 1/8-in. tube x 1/4-in. tube, accepts 1/8-in. tube, connects to 1/4-in. swage fittings</td>
</tr>
<tr>
<td>004-62230-35</td>
<td>Gas pressure regulator, CGA 350 fitting (CO, H₂), 30 psig</td>
</tr>
<tr>
<td>004-62230-54</td>
<td>Gas pressure regulator, CGA 540 fitting (O₂), 30 psig</td>
</tr>
<tr>
<td>004-62230-32</td>
<td>Gas pressure regulator, CGA 320 fitting (CO₂), 30 psig</td>
</tr>
<tr>
<td>004-62230-326</td>
<td>Gas pressure regulator, CGA 326 fitting (N₂O), 30 psig</td>
</tr>
<tr>
<td>004-62230-705</td>
<td>Gas pressure regulator, CGA 705 fitting (NH₃), 30 psig</td>
</tr>
<tr>
<td>004-33601-00</td>
<td>Expansion Kit; adds an additional outlet to the gas regulator, includes fittings and instructions</td>
</tr>
<tr>
<td>004-33602-00</td>
<td>Pressure Relief Kit; prevents excessive gas pressure in the event of regulator failure (not to be used with noxious gases)</td>
</tr>
<tr>
<td>003-26043-00</td>
<td>Heating mantle with type K thermocouple, 450 °C maximum, 24 V</td>
</tr>
<tr>
<td>003-26045-00</td>
<td>Heating mantle with type K thermocouple, 450 °C maximum, 24 V, side-laced to accommodate monolithic &amp; nonstandard sample tubes</td>
</tr>
<tr>
<td>230-25808-00</td>
<td>Heating mantle clip</td>
</tr>
<tr>
<td>202-42801-00</td>
<td>Operator’s manual</td>
</tr>
<tr>
<td>004-25006-00</td>
<td>O-ring, size 006, Buna-N, for Po tube</td>
</tr>
<tr>
<td>004-16821-00</td>
<td>Reference material, high surface area</td>
</tr>
<tr>
<td>004-16816-00</td>
<td>Reference material, low surface area (krypton)</td>
</tr>
<tr>
<td>004-16843-00</td>
<td>Reference material, micropore, 13X</td>
</tr>
<tr>
<td>004-16844-00</td>
<td>Reference material, micropore, Y-zeolite</td>
</tr>
<tr>
<td>004-54609-00</td>
<td>Sample tube brush</td>
</tr>
<tr>
<td>240-25853-00</td>
<td>Sample tube funnel</td>
</tr>
<tr>
<td>240-14855-00</td>
<td>Sample tube rack</td>
</tr>
<tr>
<td>240-32805-00</td>
<td>Sample tube support, assists sample weighing</td>
</tr>
<tr>
<td>004-54618-00</td>
<td>Tool, for removing sample port O-ring</td>
</tr>
<tr>
<td>200-25840-00</td>
<td>Saturation pressure tube, includes isothermal jacket</td>
</tr>
<tr>
<td>Part Number</td>
<td>Item and Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>250-25608-00</td>
<td>Valve gasket, Kel-F, for analysis manifold</td>
</tr>
<tr>
<td>250-25627-00</td>
<td>Valve plunger, Buna-N seal, for analysis manifold</td>
</tr>
<tr>
<td>201-22600-00</td>
<td>Valve spring, for Buna-N plunger, for analysis manifold</td>
</tr>
<tr>
<td>004-25459-00</td>
<td>Valve plunger, Kalrez seal, for analysis manifold</td>
</tr>
<tr>
<td>250-25602-00</td>
<td>Valve spring, for Kalrez plunger, for analysis manifold</td>
</tr>
</tbody>
</table>

**Vacuum System Components**

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Item and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>062-00200-00</td>
<td>Vacuum forepump, dry, for systems with high-vacuum option, 115/230 VAC</td>
</tr>
<tr>
<td>004-62109-01</td>
<td>Service kit, for Pfeiffer dry forepump</td>
</tr>
<tr>
<td>004-62023-01</td>
<td>Service kit, for Vaccubrand dry forepump</td>
</tr>
<tr>
<td>062-00001-11</td>
<td>Vacuum pump, oil-sealed, with built-in anti-suckback valve, 100/120 VAC; includes hose kit and alumina oil vapor trap</td>
</tr>
<tr>
<td>062-00001-23</td>
<td>Vacuum pump, oil-sealed, with built-in anti-suckback valve, 220/240 VAC; includes hose kit and alumina oil vapor trap</td>
</tr>
<tr>
<td>062-33002-00</td>
<td>Activated alumina oil vapor trap, for one vacuum pump</td>
</tr>
<tr>
<td>004-16003-01</td>
<td>Vacuum pump oil, 1 liter</td>
</tr>
<tr>
<td>200-25879-00</td>
<td>Vacuum pump oil funnel</td>
</tr>
<tr>
<td>004-27040-00</td>
<td>Vacuum pump exhaust filter</td>
</tr>
<tr>
<td>004-16830-00</td>
<td>Activated alumina, 500 grams, for oil vapor trap</td>
</tr>
<tr>
<td>004-25652-00</td>
<td>O-ring, size 217, for oil vapor trap</td>
</tr>
</tbody>
</table>

**Software**

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Item and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>202-33021-00</td>
<td>Rate of Adsorption Program; includes software and operator’s manual. This program allows you to measure the rate at which gas is adsorbed by the sample.</td>
</tr>
<tr>
<td>202-33024-00</td>
<td>DataMaster; includes software and operator’s manual. This program allows you to generate and manipulate data on a computer other than the one controlling the analyzer.</td>
</tr>
<tr>
<td>202-33025-00</td>
<td>Isotherm Cycling; allows you perform up to 500 adsorption/desorption cycles over a user-defined range. Includes software and operating instructions</td>
</tr>
<tr>
<td>202-33001-00</td>
<td>Software package, ASAP 2020 physisorption; includes current version of software and operator’s manual</td>
</tr>
<tr>
<td>202-33011-00</td>
<td>Software package, CFR Part 11 Confirm, includes current version of software and operator’s manual</td>
</tr>
</tbody>
</table>
Sample Tubes and Components

1/4-in., 3/8-in, and 1/2-in Sample Tubes

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Item and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>004-25466-00</td>
<td>A O-ring, size 010, Buna-N, for 1/4-in. sample tube</td>
</tr>
<tr>
<td>004-25465-00</td>
<td>O-ring, size 010, Kalrez, for 1/4-in. sample tube</td>
</tr>
<tr>
<td>004-25022-00</td>
<td>B O-ring, size 012, Buna-N, for 3/8-in. sample tube</td>
</tr>
<tr>
<td>004-25022-01</td>
<td>O-ring, size 012, Kalrez, for 3/8-in. sample tube</td>
</tr>
<tr>
<td>260-25891-00</td>
<td>C Opener, seal frit, for 1/2-in. sample tube</td>
</tr>
<tr>
<td>240-25803-00</td>
<td>D Ferrule, 1/4 in.</td>
</tr>
<tr>
<td>240-25802-00</td>
<td>E Ferrule, 3/8 in.</td>
</tr>
<tr>
<td>004-25044-00</td>
<td>F O-ring, size 013, Buna-N, for 1/2-in. sample tube</td>
</tr>
<tr>
<td>004-25474-00</td>
<td>O-ring, size 013, Kalrez, for 1/2-in. sample tube</td>
</tr>
<tr>
<td>260-25843-00</td>
<td>G Ferrule, 1/2 in.</td>
</tr>
<tr>
<td>300-25824-00</td>
<td>H Nut, sample tube</td>
</tr>
</tbody>
</table>
### Part Number | Item and Description
---|---
004-32604-00 | I Cap (stopper) for 1/4-in. sample tube (not shown)
004-32004-00 | J Stopper, for 3/8-in. sample tubes
240-32000-00 | K Stopper, for 1/2-in. sample tube
260-25890-00 | L Seal Frit with built-in check valve for air-sensitive samples
202-25901-00 | N Isothermal jacket, 1/4 in.
240-61001-00 | O Sample tube, 1/4 in.
240-61014-00 | P Volume displacement insert, 1/4 in.
202-25902-00 | Q Isothermal jacket, 3/8 in.
240-61002-00 | R Sample tube, 3/8 in.
240-61015-00 | S Volume displacement insert, 3/8 in.
202-25903-00 | T Isothermal jacket, 1/2-in. sample tube
240-61003-00 | U Sample tube, 1/2 in.
240-61016-00 | V Volume displacement insert, 1/2 in.

### 22-mm Sample Tube Kit

### Part Number | Item and Description
---|---
202-33052-00 | 22mm ID Sample Tube Kit
004-25609-02 | O-ring, -022, 70 Buna-N
004-32240-00 | Stopper, rubber, for 22mm ID Tube
202-25868-00 | Fitting, sample port, 25mm sample tube
202-25869-00 | Nut, for 25-mm sample tube
202-25870-00 | Ferrule for 25-mm sample tube
202-25871-00 | Fitting, degas port, 25-mm sample tube
202-25904-00 | Isothermal jacket, for 25-mm OD sample tube
202-31709-00 | Dewar cover, 25-mm OD sample tube
202-61022-00 | Sample tube, 22-mm ID, 25-mm OD
202-61022-01 | Filler rod for 22-mm ID sample tube
Cold Trap Tubes and Components

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Item and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>004-25469-00</td>
<td>A O-ring, Buna-N, size 014</td>
</tr>
<tr>
<td>004-25979-00</td>
<td>B Nut, cold trap</td>
</tr>
<tr>
<td>004-61063-00</td>
<td>C Tube, 1/2-in. OD stem, cold trap</td>
</tr>
</tbody>
</table>
A. FORMS

This appendix contains the following form:

- Sample Data Worksheet

Copy and use this form as needed.
ASAP Series Sample Data Worksheet

This form is provided to assist you in obtaining an accurate sample mass for report calculations. You may use the After Degas value (Step 5) or the After Analysis value (Step 7), provided they are close to the same.

<table>
<thead>
<tr>
<th>Sample tube: __________________________</th>
<th>Sample: __________________________</th>
</tr>
</thead>
</table>

Before Degas:
1. Mass of empty sample tube ________ g
2. Mass of sample tube plus sample ________ g
3. Mass of sample (Step 2) – (Step 1) ________ g

After Degas:
4. Mass of sample tube plus sample ________ g
5. Mass of sample (Step 4) – (Step 1) ________ g

After Analysis:
6. Mass of sample tube plus sample ________ g
7. Mass of sample (Step 6) – (Step 1) ________ g

Compare the sample mass obtained after analysis (Step 7) with the sample mass after degas (Step 5). These two values should be close in range. If a significant difference is noted, analysis problems may exist or the sample may have been improperly degassed.
B. ERROR MESSAGES

Error messages are listed numerically. If the Action response instructs you to contact your service representative, record the error message and make backup copies of any files involved in the operation.

The 1000-series error messages (used primarily for software testing) are not included in this appendix. These errors should not occur during normal operation. If you receive a 1000 series error message or an error message not listed in this appendix: record the error message, make backup copies of any files involved, then contact your service representative.

2200 and 2400 Series

2201- Cannot execute report subsystem.

Cause: Start Report failed to execute the report subsystem (which is a separate process).

Action: Restart the computer. If the problem persists, reinstall the application (this will not affect any of your sample files). If the problem continues, contact a Micromeritics service representative.

2401- FATAL ERROR: (error message).

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error message.

2430- Error accessing file (file name), error code = (number).

Cause A: A computer or network problem occurred.

Action A: Check the performance of your computer devices or network.

Cause B: A software error occurred when the file was accessed.

Action B: Contact your service representative.
2431- Error writing file (file name), error code = (number).

*Cause:* The hard disk does not have enough space left to perform the operation.

*Action:* Copy files not used regularly from the hard disk to a diskette, CD, or network directory, delete them from the hard disk, and then try the operation again.

2432- Invalid response from MMI ‘FILE_READ’ request.

*Cause:* An internal processing and/or hardware error has occurred.

*Action:* Contact your service representative if you continue to receive this error message.

2433- New entries have been found in this directory. Refresh the directory information?

*Cause:* Several ASAP 2020 files (sample information, analysis conditions, adsorptive properties, or report options) have been added to this directory by some function other than the ASAP 2020 program.

*Action:* Select **Yes** to update the directory information with data from each new file. This operation may take a minute.

Select **No** if you do not want to spend the time updating the directory information. This option may be feasible if a large number of files have been copied into the directory and you know the name of the file you wish to access.

2434- File (file name) — Subset # (number) wrote wrong amount of data.

*Cause:* An internal processing and/or hardware error has occurred.

*Action:* Contact your service representative if you continue to receive this error message.
2436- **Path specification (path name) is invalid.**

*Cause:* You entered an invalid path name and/or extension.

*Action:* Type a valid path name (including the proper extension) and press Enter.

2437- **File (file name) does not exist.**

*Cause:* You entered a file specification that does not exist.

*Action:* Enter an existing file specification or select a file name from the list box.

2438- **Disk drive (letter): is inaccessible.**

*Cause:* You selected a disk drive that is not presently accessible.

*Action:* Ensure that the disk is not write-protected.

2439- Could not register file.
2440- Subset not found.
2441- Seek within file failed.
2442- Bad header in subset file.
2443- Subset owner denied access.
2444- Not a valid file format.
2445- Subset wrote the wrong amount of data.
2446- Error reading data.
2447- Error writing data.

*Cause:* An unexpected error occurred when you tried to access a data file.

*Action:* Contact your service representative.

2448- **File directory (path name) is invalid. Resetting to the installation directory.**

*Cause:* A working directory specified in the .INI file is invalid. The directory may have been deleted or moved to a different location.

*Action:* The installation directory will be substituted. The next time you open a file, use the Directories: list to move to the correct directory.
2449- This field does not contain a valid file specification.

Cause: You entered an invalid file name.

Action: See the description of file naming conventions in your DOS or Windows manual and re-enter the name.

2450- Sample Defaults may not be edited while this operation is in progress. Do you wish to save and close the Sample Defaults edit session?

Cause: You are in the process of initiating an automatic analysis (an analysis in which sample files are created using the defaults) while editing the defaults.

Action: Finish your edit session of the defaults and close the dialog. Then restart the automatic analysis.

2452- Attempt to write MICATTR.DIR in read only mode. (file name)
2453- Attempt to append MICATTR.DIR in read only mode. (file name)

Cause: The Read-Only attribute is turned on in the application’s MICATTR.DIR file (this file exists in each folder containing sample or parameter files).

Action: Use Windows Explorer to access the folder containing the MICATTR.DIR file and disable the Read-Only option.

2454- Too many selections for a print-to-file operation. Only the first (number) selections will be processed. Please reselect the remainder.

2455- Too many selections for an export-to-file operation. Only the first (number) selections will be processed. Please reselect the remainder.

Cause: You selected too many files for this operation.

Action: Select only the number of files specified in the message.
2456- Insufficient file handles available. Application cannot continue.

*Cause:* You have more than 50 files open at the same time.

*Action:* Refer to the manual for your operating system and set the limit for open files to 50 or greater.

2457- Results cannot be displayed. More than (number) windows are currently displaying or printing results.

*Cause:* You have too many windows open in the application.

*Action:* Close some of the open windows.

2458- An instrument is performing a critical operation. Wait a few moments before exiting the application.

*Cause:* You attempted to exit the application while the analyzer is performing a critical operation. This operation must be completed before the application can be stopped.

*Action:* Wait a few minutes before attempting to exit the application again.

2459- An instrument is busy. A delay in restarting this application could result in loss of new data. Continue with program Exit?

*Cause:* You attempted to exit the application while the analyzer was performing an operation.

*Action:* Rather than exiting the application you may choose to minimize it.
2460- Fatal Communications error on (unit n).

Cause: Repeated attempts to maintain communication with the analyzer have failed.

Action: Check the communications cable connecting the analyzer to the computer. Confirm that the analyzer is turned on and that the status light is not blinking.

If these checks are okay, exit the analysis program and then restart the application. If this error persists, contact your service representative.

2461- No instruments are in operation. This application will unconditionally terminate.

Cause: At least one analyzer must be active for the application to operate. The initialization of the analyzers configured with the Setup program has failed. The application stops.

Action A: Usually this message is preceded by another message giving the reason for the analyzer’s failure to initialize. See the instructions for that message.

Action B: Check the cable connection between the analyzer and the computer. Verify that the analyzer has the power switch in the ON position and that the light on the front panel is illuminated. If the application continues to fail in its attempts to initialize the analyzer, contact your service representative.

2471- Unit n - S/N; nn has an invalid communications port specified. It cannot be initialized.

Cause: The communications port specified for this analyzer during installation (or configuration) is invalid.

Action: Use the setup program to change the analyzer configuration.
2474- (Unit n) Communications port COM (port number) specified in the program control files is already in use. Unit cannot initialize.

*Cause:* The communications port assigned to the indicated unit is in use by another program.

*Action:* End the program using the busy port or use the Setup program to change the communications port assigned to this program.

2475- (Unit n) Communications port COM (port number) specified in the program control files cannot be accessed. Unit cannot initialize.

*Cause:* The operating system has prevented the application from accessing the communications port.

*Action:* Review the hardware configuration of the computer, ensure that no other application is using the port. Contact your service representative if you continue to receive this error message.

2476- Unit startup failed. Cannot initialize the communications port.

*Cause:* The communications port specified during installation is invalid.

*Action:* Use the setup program to change the analyzer configuration. Contact your service representative if you continue to receive this error message.

2477- (Unit n; Serial nn) did not properly initialize.

*Cause:* The software was unable to initialize the analyzer.

*Action A:* Run the Setup program and ensure that a valid port is specified; if not, specify a valid one when prompted.

*Action B:* Reinstall the software, then restart application.

*Action C:* Contact your Micromeritics service representative if you continue to get this message.
2478- Error copying sequential data segment.

_Cause:_ An internal processing and/or hardware error occurred while accessing a portion of a sample file.

_Action:_ Confirm that the media being accessed does not contain errors; for example, you may wish to use a utility such as ScanDisk. Contact your service representative if you continue to receive this error message.

2479- (Unit n; Serial nn) The instrument is busy performing an operation of which this application is unaware. Do you want to cancel? (Yes, No)

_Cause:_ During initialization of the application, the status of the analyzer was found to be in a different state than expected.

_Action:_ Click **Yes** to cancel the operation in process, allowing the analyzer to reset and continue with initialization.

Click **No** to cancel the initialization process.

If you continue to get this message, verify that files in the application directory structure are not being changed or removed.

2480- File (file name) cannot be analyzed. It is currently being edited.

_Cause:_ You attempted an analysis using a sample file that is being edited.

_Action:_ Save the changes and close the dialog box.

2481- Error accessing the sample information file (file name).

_Cause A:_ You attempted to open a file that is already open, possibly minimized.

_Action A:_ View the minimized icons, locate and maximize the file.

_Cause B:_ A computer or network problem occurred.

_Action B:_ Check the performance of your computer devices or network.
Cause C: A software error occurred when the file was accessed.

Action C: Contact your service representative.

2482- File cannot be opened for writing. It is already in use.

Cause: You are attempting to open a file that is currently being used (either by this application or another).

Action: Locate the application using the file (in the Micromeritics application, use the Windows menu item to get a list of all windows, one of which may contain this file).

2483- An analysis cannot be performed on (file name). It is open for editing and contains errors.

Cause: You attempted to use a sample file containing errors that is currently open.

Action: Go to the window containing the file, correct the errors, and save it.

2484- The edit session for (file name) must be saved before the analysis. Save changes and continue with the analysis.

Cause: You attempted an analysis using a sample file that contains unsaved changes.

Action: Select Yes to save the changes and continue with the analysis.

Select No to abort the analysis and return to the sample file.

2485- The service test file has an invalid status and cannot be used for this analysis.

Cause: The selected service test file has a status other than No Analysis.

Action: Select a different service test file or create a new one and use Replace All to copy parameters from the file you originally selected.
2486- **Cannot construct (name) report type. Program will terminate.**
2487- **Cannot start report generator. Error code (number). Program will terminate.**

**Cause A:** You may not have full rights to the application’s folders and files.

**Action A:** Contact your system administrator and have him grant you full rights.

**Cause B:** An internal processing and/or hardware error has occurred.

**Action B:** Contact your service representative if you continue to receive this error message.

2488- **File (file name) cannot be opened for editing. It is already in use.**

**Cause:** The file you specified is being used in another edit operation.

**Action:** Check the Windows list to locate the other edit session.

2490- **No ‘.INI’ file present. Application will terminate.**

**Cause:** The ASCII (.INI) file containing initialization and system options information cannot be found. The .INI file may have become corrupted. The application cannot operate without this file.

**Action:** Use the Setup CD to uninstall the ASAP 2020 application. When you uninstall the application, only the application files are deleted; data files remain intact.

After the uninstall operation is complete, reinstall the ASAP 2020 application.

2491- **Highlighted fields contain errors. Please correct the errors before closing dialog box.**

**Cause:** The highlighted fields contain invalid entries. You will not be able to close the dialog box until you correct the errors.

**Action:** Check the entries, correct the errors, and close the dialog.
2492- This field's entry is invalid.

_Cause:_ The highlighted field contains an invalid entry.

_Action:_ Check the entry and correct the error.

2493- An entry is required for this field.

_Cause:_ This field requires a valid entry for you to proceed.

_Action:_ Enter or select an appropriate value.

2494- Value is out of the valid range.

2495- Value is out of the valid range. Enter a value between (value) and (value).

_Cause:_ The value you entered in the highlighted field is outside the valid range of values.

_Action:_ Check the entry and enter or select an appropriate value.

2496- Invalid number.

_Cause:_ The number you entered in the highlighted field is invalid.

_Action:_ Check the entry and enter or select a valid number.

2497- This field contains an invalid character.

_Cause:_ You entered an invalid character in the highlighted field.

_Action:_ Check the entry and enter valid characters.
2498- The requested change to the Sample’s status is invalid at this time.

*Cause:* A request to change the file’s status (for example, from automatically collected to manually entered) could not be done.

*Action:* Contact your service representative if you continue to receive this error message. Record the name of the sample file in which the problem occurred.

2499- Sequence number must contain at least 3 digits.

*Cause:* You tried to enter a sequence number that did not contain at least three digits.

*Action:* Enter a sequence number that contains at least three digits.
2500 Series

2500- All sample file names that can be created using the sequence number pattern already exist. You may want to modify the next sequence number.

*Cause:* No more sample information files can be created using the currently entered file name sequence number.

*Action:* Select Options > Sample Defaults from the Main Menu and enter a new sequence number.

2501- System resources have reached a dangerously low level. Please close some windows to avoid the loss of data.

*Cause:* A large number of windows are open and consuming the system resources available to all applications.

*Action:* Close one or more windows on the screen. Contact your service representative if you continue to receive this error message.

2502- Error writing to file (name) during print. Error code: (number).

*Cause:* An error occurred in the file being written to during a print operation.

*Action:* Ensure that there is sufficient space on the drive containing the file.


*Cause A:* Insufficient space is available on the hard disk. The DIO file is placed in the directory specified by the TEMP environment variable.

*Action A:* Determine if there is sufficient space on the drive where the TEMP directory is located.

*Cause B:* An internal processing and/or hardware error has occurred.

*Action B:* Contact your service representative if you continue to receive this error message.
2504- Cannot create output file for sample (sample name).

Cause: Insufficient space may be available on the hard disk.

Action: Ensure that sufficient space is available. Contact your service representative if you continue to receive this error message.

2505- Error Logger cannot be initialized! Error code (number). Program will exit.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative.

2506- (sample file) Output device (name) is not installed. Printing cannot be accomplished.

Cause: The selected output device is not installed in Windows.

Action: Select a different output device in the System Configuration dialog box. Install the device using the Control Panel, Printers operation.

2508- (sample file) Overlay file (name) was not found. It will not be included in the reports.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay does exist.

2509- (sample file) Error opening file (name): (error). Reports cannot be produced.

Cause: An error occurred while the program was opening a file necessary to the report operation.

Action: Use the name given in the error message to investigate. Contact your service representative if you continue to receive this error message.
2510- (sample file) Error parsing reports from file (name). Reports cannot be produced.

Cause A: One or more data entry fields in the sample file may contain an invalid character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and remove the invalid character.

Cause B: The system was unable to create the usual temporary files during the report, possibly due to insufficient disk space.

Action B: Check the space available on the hard disk.

Cause C: An internal processing error occurred.

Action C: Contact your service representative.

2511- Print job (name) has been cancelled due to insufficient disk space. Delete unnecessary files and restart the report.

Cause: The disk drive does not have enough space for the temporary file required by the Windows Print Manager. Therefore, printing of the requested report has been canceled.

Action: Delete unnecessary files from the disk. You will require at least five megabytes of free space for normal operation.

2512- Print job (name) has been cancelled.

Cause: The requested print job was canceled at your request.

Action: None required.
2513- Unable to read the calibration file (file name).

*Cause:* You selected an invalid calibration file or one that cannot be read.

*Action:* Be sure the media containing the calibration file has no problems.

2514- Unable to write the calibration file (file name).

*Cause:* An attempt to Save calibration data has failed due to possible media problems.

*Action A:* Be sure the media you want to Save the file to has no problems.

*Action B:* Choose an alternate media to Save the calibration data.

2515- Warning: Changing the calibration information will affect the performance of the instrument. Only qualified service personnel should do this. Do you wish to proceed?

*Cause:* You have started the process of performing a calibration operation.

*Action:* Calibration operations should only be done by or under the direction of qualified service personnel.

2516- Warning: Keeping a backup copy of the calibration data is recommended by Micromeritics. Would you like to do so now?

*Cause:* You have performed a calibration operation; a backup copy is recommended.

*Action:* Perform a calibration **Save** operation.

2517- Canceling this dialog will reset the calibration state to what it was when this dialog was first opened. Are you sure you want to cancel?

*Cause:* You have not accepted the calibration you performed.

*Action:* If the calibration operation was successful, press **Accept**.
2521- Unable to program controller.

*Cause:* A hardware malfunction has occurred.

*Action:* Contact your local Micromeritics service representative.

2522- Invalid controller application file.

*Cause:* The application’s control file has been corrupted or deleted.

*Action:* Reinstall the ASAP 2020 analysis program.

2523- Programming the controller failed.
2524- CRC check failed on programming controller.
2525- Unknown error programming controller.
2526- Controller download was not successful.
2527- Controller CRC error on boot block.
2528- Controller DRAM error.
2529- Controller Com1: error.
2530- Controller Com2: error.
2531- Controller debug port error.

*Cause:* An internal processing and/or hardware error has occurred.

*Action:* Contact your service representative if you continue to receive this error message.

2532- The instrument contains a different software version. Do you want to reset it?

*Cause:* The application has discovered a different version of software operating in the analyzer.

*Action:* If there are no analyzers other than the ASAP 2020 connected to the computer, select **Yes** and allow the updated software to load.

2533- Analyzer initialization failed.

*Cause:* An internal processing and/or hardware error has occurred.

*Action:* Contact your service representative if you continue to receive this error message.
2534- Error opening file (name) for printing. Error code: (number).

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.
4000 Series

4000- Memory Allocation Error.

*Cause:* An internal processing and/or hardware error occurred during report generation.

*Action:* Contact your service representative if you continue to receive this error message.

4002- Thermal Transpiration correction had no effect.

*Cause:* The Thermal transpiration correction option was selected on the Report Options dialog box. However, the correction did not change any pressure by more than one percent.

*Action:* De-select this option to disable this message. This correction is only meaningful for very low pressures.

4003- Error Converting Pressures.

4004- Error Computing Volume Adsorbed.

*Cause:* An internal processing and/or hardware error occurred during report generation.

*Action:* Contact your service representative if you continue to receive this error message.

4005- Pressures were not smoothed. Not enough pressures below 0.10 P/Po.

*Cause:* The *Smooth pressures below 0.10 P/Po* option was selected on the Report Options dialog. There must be at least 10 pressures within this range for smoothing to occur.

*Action:* Deselect this option to disable this message.
**4006-** Report Type Not Found.

**4007-** Error Processing Report.

*Cause:* An internal processing and/or hardware error occurred during report generation.

*Action:* Contact your service representative if you continue to receive this error message.

**4008-** Report requested on sample file with no data points.

*Cause:* You selected a file for reporting which contains no collected data.

*Action:* Select another file which contains collected data and restart the report.

**4009-** Error, No Reports Selected.

*Cause:* You attempted to generate reports for a sample that has no reports selected in its report options.

*Action:* Select the desired reports in the sample’s report options and save the sample file.

**4010-** Summary Report was not included in the Selected Reports.

*Cause:* You did not select a plot or a table for any of the Selected Reports in the Report Options dialog; you selected the reports only to generate an entry in the summary. However, the Summary was not included in the Selected Reports.

*Action:* Select a plot or table in one or more of the Selected Reports, and/or add the Summary to the Selected Reports.
4011- Analysis gas in sample file does not match analysis gas in unit.

**Cause:** You attempted to start an analysis using a sample information file in which the analysis gas specified does not match the analysis gas entered in the unit configuration.

**Action:** If necessary, attach the appropriate gas bottle, then enter the gas in the Unit Configuration dialog box.

4012- Psat gas in sample file does not match Psat gas in unit.

**Cause:** You attempted to start an analysis using a sample information file in which the Psat gas does not match the Psat gas entered in the unit configuration.

**Action:** If necessary, attach the appropriate gas bottle, then enter the gas in the Unit Configuration dialog box.

4013- The ‘Incremental Dosing’ option is not available on the selected unit.

**Cause:** The MicroPore option is not installed.

**Action:** Install the MicroPore option before starting the analysis.

4014- File (name) is not a valid file for conversion.

**Cause:** The file selected for conversion is not a MICMOS 2000 or 2000 MicroPore file.

**Action:** Select only files that have been created by MICMOS 2000 or 2000 MicroPore programs.
4015- Error creating export file for sample <sample file name>.

Cause: A file error occurred during creation of an export output file.

Action: The output file name may be invalid. Ensure that the target directory exists. Ensure that the target diskette is not full or write protected. The target disk drive may be damaged or inoperative. Verify that other files may be created on the same drive. Contact your service representative if you continue to receive this error message.

4016- Sample (file name) has no data for export.

Cause: The file selected for export has a status of No Analysis. No export file will be created.

Action: Select a file which contains analysis data.

4017- Damage to the instrument will result if the sample has not been manually evacuated. Have you evacuated the sample?

Cause: You did not select Backfill sample at start of analysis on the Sample Backfill Options dialog box. The sample tube is normally at atmospheric pressure when an analysis is started, and it must be backfilled before the analysis begins to prevent sample material from being drawn into the manifold.

Action: If you have manually evacuated the sample tube, select Yes. If you have not, select No and then either perform a manual evacuation or go to the Sample Backfill Options dialog box and select Backfill sample at start of analysis.
4020- Disabling this option may damage the instrument. Are you sure that the sample should not be backfilled?

Cause: You did not select Backfill sample at start of analysis on the Sample Backfill Options dialog. The sample tube is normally at atmospheric pressure when an analysis is started; it must be backfilled before the analysis begins to prevent sample material from being drawn into the manifold.

Action: If you want to manually evacuate the sample prior to the start of the analysis, select Yes. Otherwise, select No, go to the Sample Backfill Options dialog, and select Backfill sample at start of analysis.

4021- The entered Po value (Po and Temperature Options of the Analysis Conditions) is outside the range of the pressures listed in the Psat vs. Temperature Table (Adsorptive Properties).

Cause: The temperature that corresponds to the entered Po cannot be found because the entered Po is outside of the range of values in the Psat vs. T table.

Action A: Enter a Po that is within the range of the table.

Action B: Use a different Psat vs. T table.

4022- The entered bath temperature value (Po and Temperature Options of the Analysis Conditions) is outside the range of the temperatures listed in the Psat vs. Temperature Table (Adsorptive Properties).

Cause: The Po that corresponds to the entered temperature cannot be found because the entered temperature is outside of the range of values in the Psat vs. T table.

Action A: Enter a temperature that is within the range of the table.

Action B: Use a different Psat vs. T table.
4023- The file (sample file) cannot be prepared for analysis. It is open for editing and contains errors.

    Cause:      You attempted an analysis using a sample file that is being edited and has invalid values in one or more of its fields.

    Action:     Enter valid values into the fields that have errors, save the changes, and close the dialog box.

4024- Backfill gas in sample file does not match any gas in unit.

    Cause:      You selected a backfill gas that is not included in the gas configuration.

    Action:     Make sure that gas selections match the gases that are attached to the instrument. Choose one of the gases as the backfill gas, or edit the sample file and choose one of the existing gases as the backfill gas.

4025- There is no Helium attached to the unit.

    Cause:      A measured free space has been requested but Helium does not appear to be available.

    Action:     Make sure the helium cylinder is attached to the unit at its designated port.

4026- Cannot calculate Dubinin-Astkahov: bad least squares data.

    Cause:      Less than two selected data points are within the fitted pressure range.

    Action:     Edit the calculation assignments on the Collected Data dialog, or change the fitted pressure range on the Dubinin report options dialog.

4027- Fewer than two sample files have data suitable for heat of adsorption reports.

    Cause:      Less than two of the sample files you selected for heat of adsorption reports contain appropriate data.

    Action:     Edit the Quantity Adsorbed table, or select other sample files.
4028- Dubinin calculations cannot be performed because the affinity coefficient of the analysis gas is zero.

Cause: Dubinin values could not be calculated because the affinity coefficient of the analysis gas is zero.

Action: Access the Dubinin Report Adsorptive options in the sample file and enter an appropriate value for the analysis gas.

4029- At least two fitted data points are needed for Alpha-S calculations.

Cause: Fewer than two data points fall within the selected Alpha-s range.

Action: Edit the calculation assignments or the fitted Alpha-s range, or use a different reference curve.

4030- Preparations failed in primary data.

Cause: Appropriate data were not available to generate the report.

Action: This message was preceded by a different error message; refer to the cause/action of the preceding message.

4031- Not enough points with a relative pressure in the range (n,n)

Cause: Fewer than two data points selected for the Dubinin report falls within the selected relative pressure range.

Action: Edit the calculation assignments or the fitted relative pressure range.

4032- Some summary reports could not be produced because they require the Micro-pore option.

Cause: Some of the summary reports you requested were not produced because you do not have the micropore option installed.

Action: Edit the summary report and deselect the micropore options.
4033- Not enough points to generate Dubinin Tabular Report.

Cause: There are fewer than two valid data points available for the Dubinin tabular reports.

Action: Examine the calculation assignments in the Collected Data dialog of the sample file. You must have at least two micropore pressures selected for inclusion in the Dubinin report.

4034- Fewer than 2 points available for Dubinin calculations.

Cause: There are fewer than two valid data points available for Dubinin reports in one of the sample files selected for overlaying.

Action: Examine the calculation assignments in the Collected Data dialog of the sample file. You must have at least two micropore pressures selected for inclusion in the Dubinin report.

4035- Cannot calculate optimized Astakhov exponent: Not enough points with a relative pressure in the range [(pressure), (pressure)].

Cause: There are fewer than two valid data points in the relative pressure range specified. Astakhov reports will not be produced.

Action: Examine the calculation assignments in the Collected Data dialog for the sample file. You must have at least two pressures in the given range selected for inclusion in the Dubinin report.

4036- Fewer than 2 points available for Horvath-Kawazoe calculations.

Cause: You must select at least two data points for inclusion in the Horvath-Kawazoe analysis on the Collected Data dialog. No report will be produced.

Action: From the Collected Data dialog, select the data points to be analyzed.
**4037-** Computations failed while processing the primary data set. No reports will be produced.

*Cause:* The preparation of data for reporting could not be successfully completed. No Horvath-Kawazoe reports will be produced. This message will always be preceded with another one containing additional information.

*Action:* Refer to the number of the error message which preceded this one for an explanation.

**4038-** Fewer than 2 points available for the Langmuir Qm computation. Cheng/Yang correction will not be applied.

*Cause:* The Cheng/Yang correction to the Horvath-Kawazoe equation requires the value of the monolayer volume as calculated from the Langmuir equation. The isotherm must include at least two points above 0.02 relative pressure for the Langmuir equation to be applied.

*Action:* The analysis will be performed without the Cheng/Yang correction. Deselect Apply Cheng/Yang correction on the Horvath-Kawazoe Report Options dialog to prevent this message from appearing on future reports.

**4039-** The isotherm does not meet the constraints of the Cheng/Yang assumption. Cheng/Yang correction will not be applied.

*Cause:* The Cheng/Yang correction to the Horvath-Kawazoe equation requires the value of the monolayer volume as calculated from the Langmuir equation. The isotherm does not correlate to the Langmuir assumption with a coefficient of 0.98 or more. The correction is not applicable to this isotherm or to the range of the data points selected.

*Action A:* The analysis will be performed without the Cheng/Yang correction. Deselect Apply Cheng/Yang correction on the Horvath-Kawazoe Report Options dialog to prevent this message from appearing on future reports.

*Action B:* Generate the Langmuir report for the same data points selected for the Horvath-Kawazoe report. If the Langmuir correlation coefficient can be brought above 0.98 by removing some points at high relative pressure, remove them and reproduce the Horvath-Kawazoe reports.
4040- The value of Qm computed from the Langmuir equation is too low. The pore size will not be computed for all data points.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires the value of the monolayer volume as calculated from the Langmuir equation. The computed value is less than the volume adsorbed at the largest relative pressure included in the analysis. The correction is not applicable to this isotherm or to the range of the data points selected.

Action: The analysis will be performed and the Cheng/Yang correction will be applied to all points with a volume adsorbed less than the value of Vm. The pore size will not be calculated for data points with an invalid volume adsorbed. Deselect Apply Cheng/Yang correction on the Horvath-Kawazoe Report Options dialog to clear this message.

4041- Cheng/Yang correction is inappropriate for some P/Po.

Cause: The Cheng/Yang correction is usually inappropriate for any P/Po above the isotherm knee. In some instances, the computed pore sizes may decrease above the knee. While it is possible to include these relative pressures (usually above 0.1 P/Po) in the analysis, the computed pore sizes for these pressures are usually meaningless.

Action: Change the data points selected for the Horvath-Kawazoe report to include only relative pressures at or below the knee of the isotherm, or change the Horvath-Kawazoe report options so that the Cheng/Yang correction is not applied.

4042- 0.0 cannot be a starting or ending pressure for a geometric progression.

Cause: You selected to generate a pressure table from a geometrically progressing range.

Action: Change the 0.0 entered value.
4043- **1.0 cannot be a starting or ending pressure for a geometric progression toward saturation.**

*Cause:* You selected to generate a pressure table from a geometrically progressing range.

*Action:* Change the 1.0 entered value.

4044- **Points in the Langmuir report pressure table lie outside the collected data.**

*Cause:* Calculation assignments are not being used and more than one of the report pressure table points is above the range of the collected data, and more than one is below.

*Action:* Change the report pressure table to be more consistent with the collected data.

4045- **Points in the report pressure table lie outside the collected data.**

*Cause:* Calculation assignments are not being used and more than one of the report pressure table points is above the range of the collected data, and more than one is below.

*Action:* Change the report pressure table to be more consistent with the collected data.

4046- **(file name) could not be opened for reading.**

*Cause:* A thickness curve file could not be opened.

*Action:* If the problem persists, restart your computer and optionally perform a media integrity check (using ScanDisk).

4047- **Warning: An error occurred while reading (file name).**

*Cause:* An error happened during a read operation of a thickness curve file.

*Action:* If the problem persists, restart your computer and optionally perform a media integrity check (using ScanDisk).
4048- Warning: An error occurred while restoring the heat of adsorption report editor.

Cause: The state of the heat of adsorption report editor could not be restored. Default settings will be used.

Action: No action.

4049- The sample (file name) does not have enough data. A minimum of two adsorption points is required.

Cause: A sample file has been included in the Heat of Adsorption report that does not have enough data.

Action: Remove the file from the selected file list.

4050- None of the requested quantities adsorbed is within the range of the collected data of more than one sample file.

Cause: The Heat of Adsorption report failed because the specified quantities are not within the range of the collected data.

Action A: Edit the quantities adsorbed so that they are within the range of the collected data, or select other sample files.

4051- The sample (file name) does not have any data in the range of the requested quantities adsorbed.

Cause: The sample’s data cannot be interpolated to any of the quantities adsorbed.

Action: Edit the quantities adsorbed so that they are within the range of the collected data.

4052- Fewer than two points are selected for this report.

Cause: At least two points are required for the BET calculations.

Action: Edit the calculation assignments for the BET report.
4053- At least two data points must be selected for t-Plot calculations.

*Cause:* At least two points are required for the t-Plot calculations.

*Action:* Edit the calculation assignments for the t-Plot report.

---

4054- Fewer than two data points are inside the fitted thickness range.

*Cause:* At least two points must be within the fitted thickness range for the t-Plot calculations.

*Action A:* Edit the calculation assignments for the t-Plot report.

*Action B:* Edit the fitted thickness range in the t-Plot report editor.

---

4055- The BET surface area could not be calculated.

*Cause:* Fewer than two points were assigned to the requested surface area calculation in the collected data table.

*Action A:* Assign more points to the surface area calculation.

*Action B:* Select a different surface area in the t-Plot report editor.

---

4056- The Langmuir surface area could not be calculated.

*Cause:* Fewer than two points were assigned to the requested surface area calculation in the collected data table.

*Action A:* Assign more points to the surface area calculation.

*Action B:* Select a different surface area in the t-Plot report editor.
4057- At least two data points are needed for Freundlich calculations.

*Cause:* Less than two data points have been selected for the Freundlich report; at least two are required.

*Action:* Select Freundlich points on the Collected Data dialog. If calculation assignments are not being used, edit the Freundlich Report options, **Absolute pressure range** in the sample file.

4058- At least two data points are needed for Temkin calculations.

*Cause:* Less than two data points have been selected for the Temkin report; at least two are required.

*Action:* Select Temkin points on the Collected Data dialog. If calculation assignments are not being used, edit the Temkin Report options, **Absolute pressure range** in the sample file.

*Cause:* You have selected at least one point with a negative pressure value to include in the Temkin report.

*Action:* Negative pressure points void Temkin calculations. Open the sample file and click the Collected Data tab. Locate the negative value(s) in the Temkin column and deselect it (them).

4059- Fewer than 2 points available for MP-Method calculations.

*Cause:* At least two points are required for the MP-Method calculations.

*Action:* Edit the calculation assignments for the MP-Method report.

4060- Sample (file name) contains no data points.

*Action:* An attempt was made to save a sample without collected data as a t-curve or alpha-S curve.

*Cause:* Repeat the save as t-curve or save as alpha-S operation after opening a sample that has collected data.
4061- The t-curve must contain at least 2 points.

_Cause:_ At least two points are required in a thickness curve definition.

_Action:_ Edit the thickness curve.

4062- Error during report generation.

_Cause:_ An internal processing error has occurred.

_Action:_ Contact your Micromeritics service representative.

4063- The data requested on this report are not available.

_Cause:_ There is no information in the sample log to report.

_Action:_ You selected a sample file for which no instrument operations have been used. Select a sample file with a status of **Prepared**, **Preparing**, **Analyzing**, or **Complete** to obtain a valid sample log report.

4064- This report cannot be produced without the Micropore option.

_Cause:_ You requested a report that requires the micropore option.

_Action:_ Deselect the report. Order the Micropore option to install on the analyzer.

4067- No data points are within the range of pressures in the reference isotherm.

_Cause:_ There are no collected data points within the range of pressures in the reference isotherm.

_Action:_ Select data points that are in the range of the reference isotherm, or select a more appropriate reference isotherm.
4068- No points were selected for the f-Ratio report.

*Cause:* The collected data column for the f-Ratio report does not have any points selected.

*Action:* Edit the collected data dialog and select points for the f-Ratio report.

4069- Dosing method choice is invalid. The Analysis Conditions choice of Absolute pressure dosing requires that the Adsorptive Properties (Dosing Method) is set to Normal.

*Cause:* There is an incompatibility between the analysis conditions choice of **Absolute pressure dosing** and the adsorptive properties **dosing** method.

*Action:* Edit one of the choices.

4070- Unable to load deconvolution model (name).

*Cause:* For some reason, the list of available models was corrupted, therefore, the model selected could not be loaded for the deconvolution.

*Action:* Exit the program and reinstall the software, then try again.

4071- The selected pressures points do not form a valid set for deconvolution.

*Cause:* The data points selected for analysis do not contain enough information to allow a DFT data reduction.

*Action A:* Edit data points in the table of the Collected Data dialog, or select another sample file. At least two points with strictly increasing pressures and volumes adsorbed are required for a DFT Plus data reduction.

*Action B:* Edit the pressure range on the DFT report options dialog.
4072- The range of pressures selected is too small to deconvolute using this model.

*Cause:* A null result was found using the selected model.

*Action:* Edit data points in the table of the Collected Data dialog, or select another sample file. At least two points with strictly increasing pressures and volumes adsorbed are required for a DFT data reduction.

4073- The analysis gas (name) does not match the model gas (name).

*Cause:* The model assumes a specific gas and the sample file uses a different one.

*Action:* Select a model that assumes the same gas.

4074- The analysis temperature (nn) does not match the model temperature (nn).

*Cause:* The temperature for the selected model did not match the analysis temperature.

*Action:* Select a different model.

4075- The models cannot be located in the models folder. Reinstall the software.

*Cause:* The models could not be located. They may have been inadvertently deleted or moved.

*Action:* Reinstall the software.
4076- Invalid sample file - Adsorptive Properties “Non-condensing adsorptive” cannot be used unless Analysis Conditions “Absolute pressure dosing” is selected.

Cause: You selected a sample file that has **Non-condensing adsorptive** selected in the Adsorptive Properties but does not have **Absolute pressure dosing** selected in Analysis Conditions.

Action A: If you plan to use a non-condensing adsorptive, select **Absolute pressure dosing** on the Analysis Conditions dialog.

Action B: If you are not using a non-condensing adsorptive, deselect the **Non-condensing adsorptive** option on the Adsorptive Properties dialog, or choose an adsorptive that you are sure in not non-condensing.

4077- Cannot get surface area for: (file name)

Cause: The Isotherm report for the named overlay file has **Per gram** selected for the **Volume Adsorbed**, and the Isotherm report for the primary file has a surface area option selected for the **Volume Adsorbed**.

Action A: Edit the Isotherm report for the named overlay file and select a surface area option for **Volume Adsorbed**.

Action B: Click **Overlays** on the Report options dialog of the primary file and remove the named overlay file from the list.

4078- Slope and Y-Intercept cannot be determined from the selected points.

Cause: The Langmuir report cannot be generated from the selected points.

Action: Edit the calculation assignments in the Langmuir column on the Collected Data dialog.

4079- Points found with negative pressure values will not appear on the graph.

Cause: Collected data contains negative pressure values.

Action: Negative pressure points are automatically removed from isotherm graphs. If you wish to have negative pressure values appear on the graph: Open the sample file and click the **Collected Data** tab. Deselect **Use calculation assignments** and then select the points with negative pressures as Outliers.
6200 Series

6201- ‘GetOpenFile()’ reports error code (number). File selection cannot be made.

Cause: You specified a file name which does not exist.

Action: Confirm that the file name used is valid and that the file exists.

6202- Invalid communications port (port name) specified in the application’s configuration settings. Unit cannot initialize.

Cause A: The communications port assigned to the ASAP 2020 cannot be made available for proper communications.

Action A: Run the ASAP 2020 Setup program, select Change analyzer setup, and enter the correct port information. If the message continues, contact your service representative.

Cause B: The ASAP 2020 control file was manually modified and an invalid communications port was specified.

Action B: Use the ASAP 2020 Setup program to change the communications port assigned to the ASAP 2020.

6203- No serial number available. Unit cannot initialize.

Cause: The ASAP 2020 control file does not contain a serial number for the unit.

Action: Run the ASAP 2020 Setup program, select Change analyzer setup, and define the serial number for the instrument.

6204- The disk does not have enough room for the ROA data. The space required is (number) megabytes.

Cause: The computer’s disk is almost out of disk space.

Action: Delete unwanted files.
6209- Analysis startup failed. (Secondary message number and text.)

Cause: The ASAP 2020 Program was unable to start an analysis with the indicated unit.

Action: Refer to the specified error number and text for instructions.

6212- Calibrating. This action must be completed before the application exits.

Cause: The unit is calibrating.

Action: Do not exit the application until the calibration is complete.

6216- Instrument could not initialize. Reason: (reason).

Cause: An internal processing and/or hardware error has occurred.

Action: The specific reason given may identify a possible corrective action. Contact your service representative if you continue to receive this error message.

6235- (Unit [number]) Analysis canceled: Time limit exceeded while dosing Psat tube to 925 mmHg.

Cause A: A pressure of 925 mmHg was not attained within the allowed time. The Psat gas regulator may be set too low or turned off.

Action A: Set the Psat gas regulator to 10 psig (0.7 bar). Then restart the analysis.

Cause B: The Psat gas bottle is empty.

Action B: Connect a new Psat gas bottle. Then restart the analysis.

Cause C: The Psat tube fitting is loose.

Action C: Check the Psat tube fittings and ensure that the tube is attached securely to the port. Then restart the analysis.
**6237-** (Unit [number]) Analysis canceled: Time limit exceeded while evacuating Psat tube.

*Cause:* The maximum time for evacuating the Psat tube was exceeded before the vacuum set point was achieved.

*Action:* Check the Psat tube fittings. Tighten the connector nut if necessary; then restart the analysis.

**6240-** Leak test failed.

*Cause:* With the sample port valve closed, the sample pressure increased by 0.15 mmHg before the leak test duration was completed.

*Action:* Check sample tube fitting and ensure that it is securely attached to the port. Then restart the analysis.

**6241-** (Unit [number]) Analysis canceled: Maximum time exceeded before the elevator reached the UP (or DOWN) position.

*Cause A:* The maximum time for the analysis was exceeded before the elevator reached the UP (or DOWN) position. Ice may be present in the bottom or the neck of the Dewar.

*Action A:* Check the Dewar and remove ice if necessary. Refer to Checking the Analysis Port Dewar in Chapter 8. Then restart the analysis.

*Cause B:* The Psat tube is interfering with elevator movement.

*Action B:* Make sure the Psat tube is close to the sample tube and the Dewar cover is over both the sample and Psat tubes. Then restart the analysis.
6244- (Unit [number]) Analysis canceled: Time limit exceeded while storing analysis gas in Psat tube.

Cause A: The time limit (10 minutes) was exceeded while storing the analysis gas in the Psat tube. The Psat gas regulator may be set too low or turned off.

Action A: Set the Psat gas regulator to 10 psig (0.7 bar). Then restart the analysis.

Cause B: The Psat gas bottle is empty.

Action B: Connect a new Psat gas bottle. Then restart the analysis.

Cause C: The Psat tube fitting is loose.

Action C: Check the Psat tube fittings and ensure that the tube is attached securely to the port. Then restart the analysis.
6500 Series

6500- Failed to evacuate manifold to VAC SET in (number of) seconds. Calibration canceled.

Cause A: The vacuum set point is set too low.

Action A: Ensure that the vacuum set point is at 5.0 mmHg. If the set point is already at 5.0 mmHg or above, the vacuum gauge may need servicing.

Cause B: Leak in manifold.

Action B: Locate the leak and repair it. Refer to Chapter 9, Troubleshooting and Maintenance. Restart calibration.

Cause C: Valve failure.

Action C: Identify the leaking valve. Contact your service representative.

6501- The 1000 mmHg transducer offset exceeds recommended limits: (number)

Cause: The Pressure Gauge Calibration operation showed the transducer offset exceeds the recommended limit.

Action: Repeat the Pressure Gauge Calibration operation, if this message occurs again contact a Micromeritics service representative.

6502- The 10 mmHg transducer offset exceeds recommended limits: (number)

Cause: The Pressure Gauge Calibration operation showed the transducer offset exceeds the recommended limit.

Action: Repeat the Pressure Gauge Calibration operation, if this message occurs again contact a Micromeritics service representative.
6503- The 1 mmHg transducer offset exceeds recommended limits: (number)

*Cause:* The Pressure Gauge Calibration operation showed the transducer offset exceeds the recommended limit.

*Action:* Repeat the Pressure Gauge Calibration operation, if this message occurs again contact a Micromeritics service representative.

6504- Unable to write the calibration file (name).

*Cause:* A Save to File operation failed.

*Action:* Confirm there is sufficient free space on the media receiving the file and that the media is not corrupted (run ScanDisk). If the problem persists contact a Micromeritics service representative.

6505- Unable to read the calibration file (name).

*Cause:* A Load from File operation failed.

*Action:* Confirm there is sufficient free space on the media receiving the file and that the media is not corrupted (run ScanDisk). If the problem persists contact a Micromeritics service representative.

6506- Calibration file for (file name) is invalid.

*Cause:* A Load From File operation failed due to invalid information in the file.

*Action:* Confirm there is sufficient free space on the media receiving the file and that the media is not corrupted (run ScanDisk). If the problem persists contact a Micromeritics service representative.

6509- The sample has an invalid status and cannot be used for degassing.

*Cause:* A file selected for degassing has a status other then No Analysis or Prepared.

*Action:* Select a different file.
6510- Error evacuating.

*Cause:* An evacuation error occurred during a degas operation.

*Action:* If the problem persists, contact a Micromeritics service representative.

6511- Error dosing.

*Cause:* A dosing error occurred during a degas operation.

*Action:* If the problem persists, contact a Micromeritics service representative.

6512- Error calibrating the servo.

*Cause:* An error occurred while calibrating the servo valve.

*Action:* If the problem persists, contact a Micromeritics service representative.

6513- Error waiting for pressure to drop.

*Cause:* A pressure error occurred during a degas operation.

*Action:* If the problem persists, contact a Micromeritics service representative.

6514- Problem encountered dosing to target [PR2] [PR-U], last pressure = [PR4] [PR-U], elapsed time = [0]:[0].

*Cause:* Dosing during an analysis did not come within the allowed range of the target.

*Action:* Check that the outlet stage of the gas regulator is within specification. If the problem occurs frequently contact a Micromeritics service representative.
6516-(Unit n]) Analysis canceled: Sample pressure greater than (pressure) mmHg is not allowed.

Cause: An absolute pressure greater than (pressure) mmHg was attained during Low pressure dosing (either fixed dose mode or incremental dose mode).

Action: The analysis was canceled. All previously collected data were stored.

6517-(Unit n) Analysis canceled: Total volume dosed greater than (volume) cm³ is not allowed.

Cause A: More than (volume) cm³ has been dosed onto the sample, possibly due to leaks in the system.

Action A: Perform leak checks on the system. Refer to Appendix E, Testing for Leaks.

Cause B: The value for the Po may be too low, causing the instrument to mistake condensation for actual adsorption.

Action B: Change the analysis variables to directly measure the value of Po during the experiment.

Cause C: The amount of sample you used may be too large. Multiply the maximum value from the Volume Adsorbed column of the Isotherm Report by the sample weight. If the result exceeds (volume) cm³, the amount of sample is too large.

Action C: Reduce the amount of sample.

6518-(Unit n) Analysis canceled: Pressure of (pressure point) mmHg exceeds the maximum manifold pressure of (pressure point) mmHg.

Cause: An absolute pressure greater than (pressure) mmHg was attained that exceeded the specified maximum manifold pressure.

Action: The analysis was canceled. All previously collected data were stored. Change the maximum manifold pressure value in the Adsorptive Properties file.
6519- (Unit n) Analysis canceled: Psat gas is not condensing.

**Cause A:** The working Dewar does not contain enough bath liquid.

**Action A:** Retry the operation after filling the Dewar.

**Cause B:** The Psat gas is contaminated.

**Action B:** Replace the Psat gas supply.

**Cause C:** The Psat tubing from the regulator to the instrument is contaminated.

**Action C:** Pump out the tubing.

6520- Power failure detected.

**Cause A:** Main power failed but UPS (if attached) is working.

**Action A:** Restore power to the analyzer.

**Cause B:** The value for the Po may be too low, causing the instrument to mistake condensation for actual adsorption.

**Action B:** Change the analysis variables to directly measure the value of Po during the experiment.

**Cause C:** The amount of sample you used may be too large. Multiply the maximum value from the Volume Adsorbed column of the Isotherm Report by the sample weight. If the result exceeds (volume) cm³, the amount of sample is too large.

**Action C:** Reduce the amount of sample.
6521- **Transducer overrange detected.**

*Cause:* A manifold pressure over 1000 mmHg was detected.

*Action:* Observe caution when operating the analyzer manually. If the problem persists contact a Micromeritics service representative.

6522- **(Unit n) Analysis canceled: Time limit exceeded while evacuating manifold.**

*Cause A:* Maximum manifold evacuation time was exceeded before the vacuum set point was achieved. Vacuum pump may be turned off.

*Action A:* Turn on vacuum pump switch. Then restart the analysis.

*Cause B:* The vacuum pump oil level is low.

*Action B:* Check the vacuum pump oil level and add more oil if necessary. Then restart the analysis.

*Cause C:* The manifold is contaminated or leaking.

*Action C:* Correct the problem. Refer to Appendix D, *Testing for Leaks*. Then restart the analysis.

6523- **(Unit n) Analysis canceled: Time limit exceeded while evacuating sample (unrestricted).**

*Cause:* The maximum time for evacuating the sample through the unrestricted valve was exceeded. Possible causes are a leak in the sample tube fitting or a crack in the sample tube.

*Action:* Check the sample tube and the sample tube fitting; ensure that the tube is securely attached to the port. Then restart the analysis.
6524- (Unit n) Analysis canceled: Time limit exceeded while evacuating sample (restricted).

**Cause:** The maximum time for evacuating the sample through the restricted valve was exceeded. Possible causes are a leak in the sample tube fitting, a crack in the sample tube, or a poorly degassed sample.

**Action:** Check the sample tube and the sample tube fitting; ensure that the tube is securely attached to the port. Verify that the sample is properly degassed; then restart the analysis.

6525- Power failure lasted too long.

**Cause:** A power failure on an analyzer which has an Uninterruptible Power Supply attached has lasted for an hour or more; therefore, the analysis has been canceled.

**Action:** Determine the cause of the power failure and correct it.

6526- Time limit exceeded while backfilling manifold to [PR4] [PR-U] with [G].

**Cause A:** The maximum time was exceeded before the target pressure point was reached. The gas regulator may be set too low or turned off.

**Action A:** Set the gas regulator to 10 psig (0.7 bar). Then resume the analysis.

**Cause B:** The gas bottle is empty.

**Action B:** Connect a new gas bottle. Then resume the analysis.
6527- **(Unit n) Analysis suspended: Time limit exceeded while dosing manifold to (target pressure point) mmHg with (gas name).**

*Cause A:* The maximum time was exceeded before the target pressure point was reached. The nitrogen regulator may be set too low or turned off.

*Action A:* Set the analysis gas regulator to 10 psig (0.7 bar). Then resume the analysis.

*Cause B:* The analysis gas bottle is empty.

*Action B:* Connect a new analysis gas bottle. Then resume the analysis.

6528- **Low pressure gauge offset too high - [PR4] [PR-U].**

*Cause:* A check of the 1000 mmHg gauge’s offset during an automatic operation indicated it was too high.

*Action:* If this message occurs repeatedly, contact a Micromeritics service representative.

6529- **Master pressure gauge offset is too high - [PR1] [PR-U].**

*Cause:* A check of the 10 mmHg or 1 mmHg gauge’s offset during an automatic operation indicated it was too high.

*Action:* If this message occurs repeatedly contact a Micromeritics service representative.

6530- **Volume calibration canceled due to failure (code [0]).**

*Cause:* A problem occurred during volume calibration.

*Action:* Contact a Micromeritics service representative.
6531- The gas configuration file for (unit number) is invalid.

Cause: The contents of the gas configuration file are not valid.

Action A: Exit the application, navigate to the application hardware directory, and delete the <S/N>.SST file. Then restart the application and reassign gasses.

Action B: Confirm there is sufficient free space on the media receiving the file and that the media is not corrupted (run ScanDisk). If the problem persists, contact a Micromeritics service representative.

6532- The instrument is currently running the Physi software. Do you want to reset it?

Cause: The analyzer is under the control of the 2020 Physisorption software.

Action: Selecting Yes will reset the analyzer and download the 2020 Chemisorption control software.

6533- The instrument is currently running the Chemi software. Do you want to reset it?

Cause: The analyzer is under the control of the 2020 Chemisorption software.

Action: Selecting Yes will reset the analyzer and download the 2020 Physisorption control software.

6534- Instrument (unit number) is not calibrated.

Cause: Calibration information for various analyzer components are missing.

Action: Run the application setup program and reinstall calibration information for the specified unit.
6535- Problem encountered evacuating.

*Cause:* Evacuation during the manifold dosing operation did not come within the allowed range of the target.

*Action:* Check that the outlet stage of the gas regulator is within specification. If the problem occurs frequently, contact a Micromeritics service representative.

6536- There is no Nitrogen attached to the unit.

*Cause:* A volume calibration has been requested but N2 is not one of the gases selected in the unit/gas configuration.

*Action:* Make sure the nitrogen cylinder is attached to the unit and edit unit configuration to match the gases that are present.

6537- Error reading SmartVac ADC.

*Cause:* There was a problem reading one of the signals on the SmartVac board.

*Action:* Exit the application, turn off the power switch on the analyzer, then turn the power back on. Restart the application and the degas operation. If the problem persists, contact your service representative.

6538- Power failure detected. The sample is in an unknown condition. A run termination will be performed for safety.

*Cause:* A total power failure occurred (a UPS was not connected) while an analysis was in progress.

*Action:* Allow the analysis to terminate.

6539- Error overheating Current = (no.), Target = (no.), Limit = (no.)

*Cause A:* The heating mantle is reporting a higher temperature than expected.

*Action A:* Ensure that the heating mantle and thermocouple cables are plugged in fully on the port(s).
Cause B: An internal failure of the degas system may have occurred.

Action B: Unplug the heating mantle power connector; do not unplug the thermocouple. Allow the heating mantle to cool down (approximately 15-30 minutes). Then exit the analysis program and turn off the analyzer. Wait a couple of minutes, then turn the instrument on and restart the program. If the problem recurs, contact your Micromeritics service representative.

6540- Error thermocouple unplugged. Current= (no.), Target = (no.)

Cause: The heater was enabled, but the thermocouple was unplugged.

Action: Plug in the thermocouple and try again.

6541- Error: SmartVac is not in a valid state to check degas.

Cause: You clicked Check to check degassing but the sample was not in an appropriate state. You can only check the degassing operation after the vacuum setpoint has been attained, or during a temperature ramp or hold.

Action: Wait until an appropriate time during the degassing operation and check the degassing operation again.

6546- Error: Desorption sample pressure less than 0.050 mmHg is not allowed.

Cause: A desorption target pressure less than 0.050 mmHg was requested. A target absolute pressure less than 0.050 mmHg can correspond to various target relative pressures depending on the value of p0. For example, if p0 = 760 mmHg, a relative pressure less than 0.050 / 760.0 = 0.0000658 will result in an error. The analysis will terminate.

Action: Remove the low target relative pressure from the pressure table.
C. CALCULATIONS

Saturation Pressure (Po)

Po method is selected by the user on the Po and Temperature Options dialog. It may be entered, measured, or calculated from temperature.

If entered, Po = user entered value

If measured, Po = equilibrated pressure reading after saturating Po tube

If calculated from temperature, interpolate Po from the Psat vs Temperature table on the Po and Temperature Options dialog box, given the analysis bath temperature

Relative Pressure

If Po was measured:

For points taken before the previous Po measurement,

\[ P_{O_{I}} = P_{O_{1}} + \frac{(P_{O_{2}} - P_{O_{1}}) \times (T_{I} - T_{O_{1}})}{(T_{O_{2}} - T_{O_{1}})} \]

For points taken after the previous Po, use the previous Po:

\[ P_{O_{I}} = P_{O_{I-1}} \]

If Po was entered, use the entered Po:

\[ P_{O_{I}} = P_{O_{E}} \]

If Po was calculated, use the calculated Po:

\[ P_{O_{I}} = P_{O_{C}} \]

Calculate relative pressure for the I\(^{th}\) data point:

\[ P_{rel_{I}} = \frac{P_{I}}{P_{O_{I}}} \]
where

\begin{align*}
\text{Po}_i & = \text{saturation pressure for the } I^{\text{th}} \text{ data point (mmHg)} \\
\text{Po}_1 & = \text{most previous measured saturation pressure before } I^{\text{th}} \text{ data point (mmHg)} \\
\text{Po}_2 & = \text{first measured saturation pressure after the } I^{\text{th}} \text{ data point (mmHg)} \\
\text{Po}_C & = \text{calculated Po} \\
\text{Po}_E & = \text{entered saturation pressure (mmHg)} \\
T_i & = \text{time when the } I^{\text{th}} \text{ data point was taken (minutes)} \\
T_{o1} & = \text{time when } \text{Po}_1 \text{ was measured (minutes)} \\
T_{o2} & = \text{time when } \text{Po}_2 \text{ was measured (minutes)} \\
P_{\text{rel},i} & = \text{relative pressure for the } I^{\text{th}} \text{ data point (mmHg)} \\
P_i & = \text{absolute pressure for the } I^{\text{th}} \text{ data point, taken at equilibrium (mmHg)}
\end{align*}
Free Space

Free-space volumes are calculated using the following equations:

\[
V_{FW} = \frac{V_{LOW}}{T_1} \times \left[ \frac{P_1}{P_2} - 1 \right] \times T_{STD}
\]

\[
V_{FC} = \frac{V_{LOW}}{T_2} \times \left[ \frac{P_1}{P_3} - 1 \right] \times T_{STD}
\]

\[
V_{ABT} = \frac{V_{FC} - V_{FW}}{1 - \frac{T_{ABT}}{T_{RM}}}
\]

where:

- \(P_1\) = system manifold pressure before dosing helium onto sample (mmHg)
- \(P_2\) = system manifold pressure after dosing helium onto sample (mmHg)
- \(P_3\) = sample pressure after raising Dewar and equilibrating with helium (mmHg)
- \(T_{STD}\) = standard temperature (273.13 K)
- \(T_{RM}\) = approximate room temperature (298 K)
- \(T_1\) = system manifold temperature before dosing helium onto sample (K)
- \(T_2\) = system manifold temperature after raising Dewar and equilibrating with helium (K)
- \(V_{LOW}\) = lower manifold volume (cm\(^3\))
- \(V_{FC}\) = volume of free space, cold (cm\(^3\) at standard temperature)
- \(V_{FW}\) = volume of free space, warm (cm\(^3\) at standard temperature)
- \(V_{ABT}\) = portion of cold free space at analysis bath temperature: used in non-ideality correction (cm\(^3\) at standard temperature)
- \(T_{ABT}\) = analysis bath temperature (K), from the Po and Temperature Options dialog
Equations of State

The ideal gas law relates pressure, volume, temperature, and quantity of gas.

\[ n = \frac{PV}{RT} \]

where

- \( P \) = pressure
- \( V \) = volume
- \( T \) = temperature
- \( R \) = a constant that depends on the units of \( n \).
  - For \( n \) in cm\(^3\)STP, \( R = P_{\text{STD}} / T_{\text{STD}} \)
  - For \( n \) in moles, \( R = 8.3145 \text{ J mol}^{-1} \text{ K}^{-1} \)

The non-ideality correction is made by replacing \( P \) with \( P(1 + \alpha P) \), where \( \alpha \) is the non-ideality factor. This gives

\[ n = \frac{PV}{RT} (1 + \alpha P) \]

The real gas equation of state uses

\[ n = \frac{PV}{RTz(P, T)} \]

where \( z(P,T) \) is the compressibility factor for the gas at the given pressure and temperature.
Quantity Adsorbed

For the $i^{th}$ dose, the quantity dosed is:

$$n_{dosed,i} = n_{dosed,i-1} + n(P_1, V_m, T_1) - n(P_2, V_m, T_2)$$

The real gas equation of state is used to calculate $n$ if compressibility information is available. Otherwise, the ideal gas law is used. The pressure, volume, and temperature are those of the lower manifold before and after expanding into the sample tube.

$$n_{ads,i} = n_{dosed,i} - n_{FS,i}$$

The quantity of gas in the free space is either

$$n_{FS,i} = \frac{P_{s,i} V_{FC}}{T_{STD}} (\alpha P_{s,i} V_{ABT})$$

if the non-ideality correction is used, or

$$n_{FS,i} = \frac{P_{s,i} V_{FA}}{T_{STD}} \left( \frac{V_{FA}}{z(P_{s,i}, T_{FA})} + \frac{V_{ABT}}{z(P_{s,i}, T_{ABT})} \right)$$

with the real gas equation of state. Here, $P_s$ is the sample pressure.

The specific quantity adsorbed is

$$Q_{ads,i} = \frac{n_{ads,i}}{m}$$

where $m$ is the sample mass.
Equilibration

Equilibration is reached when the pressure change per equilibration time interval (first derivative) is less than 0.01% of the average pressure during the interval. Both the first derivative and average pressure are calculated using the Savitzky-Golay\(^1\) convolution method for polynomial functions. The equations below are those used to compute weighted average and first derivative, respectively, for the 6th point of an 11-point window.

\[
P_{AVG} = \frac{-36(P_{11} + P_1) + 9(P_{10} + P_2) + 44(P_9 + P_3) + 69(P_8 + P_4) + 84(P_7 + P_5) + 89(P_6)}{429}
\]

\[
P_{CHG} = \frac{5(P_{11} - P_1) + 4(P_{10} - P_2) + 3(P_9 - P_3) + 2(P_8 - P_4) + (P_7 - P_5)}{110}
\]

where the numerical constants are from the Savitzky-Golay convolution arrays, and

- \(P_{AVG}\) = average pressure (mmHg)
- \(P_{CHG}\) = change in pressure (mmHg)
- \(P_i\) = \(i^{th}\) pressure reading taken at equilibrium intervals (mmHg)

After equilibration has been reached, if the user-entered minimum equilibration time from the Low Pressure Options dialog box has not elapsed, the equilibration continues until the entered time has elapsed.

If the user entered a non-zero maximum equilibration time from the Low Pressure Options dialog box, and this time period has elapsed before equilibration has been reached, the equilibration ends as if equilibration had been reached, and the point is collected.

If a non-zero value that is too small is entered for the maximum equilibration time, the points are collected before equilibration is reached.

If \(P_{AVG}\) is greater than 0.995 times the current Po, equilibration will not take place until the Minimum equilibration delay for \(P/Po 0.995\) has expired, in addition to the standard equilibration criteria.

---

Thermal Transpiration Correction

During data reduction, thermal transpiration correction is applied to the data if the user selected Thermal transpiration correction from the Report Options dialog. Starting with the first collected pressure, the following calculations are performed until the pressure ratio (PC/P) is greater than or equal to 0.99.

\[
Y = \frac{P \times SD \times MD^2}{2.33 \times T} \times 10^3
\]

\[
\mu = \frac{1 + G \times Y}{1 + H \times Y}
\]

\[
F = \frac{1}{(\alpha \times Y^2) + (\beta \times Y) + \mu}
\]

\[
PC = \left\{ 1 - \left[ F - \left( F \left( \frac{T_{ABT}}{T_{RM}} \right)^{0.5} \right) \right] \right\} \times P
\]

where:

- **P** = equilibrated collected pressure measured by gauge at temp \( T_{RM} \) (mmHg)
- **SD** = inside diameter of sample tube (mm), from the Report Options dialog
- **MD** = thermal transpiration hard sphere diameter of gas (Å), from the Adsorptive Properties dialog
- **T** = average temperature \( [T_{ABT} + T_{RM}] / 2 \) (K)
- **\( \alpha \)** = Weber’s coefficient, 0.033
- **\( \beta \)** = Weber’s coefficient, 0.245
- **G** = Weber’s coefficient, 2.5
- **H** = Weber’s coefficient, 2
- **\( T_{ABT} \)** = analysis bath temperature (K), from the Po and Temperature Options dialog
- **\( T_{RM} \)** = room temperature (298 K)
- **PC** = corrected equilibrated pressure at temperature \( T_{ABT} \) (mmHg)
- **F, Y, \mu** = intermediate values for subsequent calculations
BET Surface Area

For each point designated for surface area calculations, the BET\textsuperscript{1} transformation is calculated as follows:

\[
B_1 = \frac{P_{rel_1}}{(1 - P_{rel_1}) \times N_{ads_1}}
\]

where \(B_1\) is in units of g/cm\textsuperscript{3} STP.

A least-squares fit is performed on the \((P_{rel_1}, B_1)\) designated pairs where \(P_{rel_1}\) is the independent variable and \(B_1\) is the dependent variable. The following are calculated:

a. Slope (S g/cm\textsuperscript{3} STP)

b. Y-intercept (\(Y_{INT}\) g/cm\textsuperscript{3} STP)

c. Error of the slope (S ERR g/cm\textsuperscript{3} STP)

d. Error of the y-intercept (\(Y_{INT ERR}\) g/cm\textsuperscript{3} STP)

e. Correlation coefficient (Cc)

Using the results of the above calculations, the following can be calculated:

**BET Surface Area (m\textsuperscript{2}/g):**

\[
SA_{BET} = \frac{CSA \times (6.023 \times 10^{23})}{(22414 \text{ cm}^3 \text{ STP}) \times (10^{18} \text{ nm}^2 / \text{m}^2) \times (S + Y_{INT})}
\]

where

- CSA = analysis gas molecular cross-sectional area (nm\textsuperscript{2}), user-entered on the Adsorptive Properties dialog box

**BET C value:**

\[
C = \frac{S + Y_{INT}}{Y_{INT}}
\]

---

Volume of the Monolayer (cm³/g STP):

\[ V_M = \frac{1}{C \times Y_{INT}} = \frac{1}{S + Y_{INT}} \]

Error of the BET Surface Area (m²/g):

\[ BET_{ERR} = \frac{SA_{BET} \times (S_{ERR}^2 + YI_{ERR}^2)^{0.5}}{Y_{INT} + S} \]

**Langmuir Surface Area**

For each point designated for surface area calculations, the Langmuir\(^1\) transformation is calculated as follows:

\[ L_I = \frac{P_{relI}}{N_{adsI}} \]

where \( L_I \) is in units of g/cm³ STP

A least-squares fit is performed on the \((P_{relI}, L_I)\) designated pairs where \( P_{relI} \) is the independent variable and \( L_I \) is the dependent variable. The following are calculated:

a. Slope (S g/cm³ STP)

b. Y-intercept (\( Y_{INT} \) g/cm³ STP)

c. Error of the slope (\( S_{ERR} \) g/cm³ STP)

d. Error of the y-intercept (\( YI_{ERR} \) g/cm³ STP)

e. Correlation coefficient (Cc)

Using the results of the above calculations, the following can be calculated:

---

Langmuir Surface Area (m²/g):

\[ SA_{LAN} = \frac{CSA \times (6.023 \times 10^{23})}{(22414 \text{ cm}^3 \text{ STP}) \times (10^{18} \text{ nm}^2/\text{m}^2) \times S} \]

where

CSA = analysis gas molecular cross-sectional area (nm²), user-entered on the Adsorptive Properties dialog

Volume of the Monolayer (cm³/g STP):

\[ V_M = \frac{1}{S} \]

Langmuir b Value:

\[ b = (Y_{INT})(V_M) \]

Error of the Langmuir Surface Area (m²/g):

\[ LANE_{ERR} = \frac{SA_{LAN} \times S_{ERR}}{S} \]
t-Plot

For each point designated for t-Plot calculations, the following calculations are done:

**Thickness for the I th point (Å):**

\[
t_I = HP1 \times \left[ \frac{HP2}{\ln(P_{rel})} \right]^{HP3}
\]

(Halsey\(^2\))

\[
t_I = \left[ \frac{HJP1}{HJP2 - \log(P_{rel})} \right]^{HJP3}
\]

(Harkins and Jura\(^3\))

\[
t_I = STSA1 + STSA2(P_{rel}) + STSA3P_{rel}^2
\]

(STSA Carbon Black\(^4\))

\[
\log(P_{rel}) = \frac{BdB1}{t_I^2} + BdB2 \exp(BdB3\times t_I)
\]

(Broekhoff-deBoer\(^5\))

\[
t = \left( \frac{KJS1}{KJS2 - \log P_{rel}} \right)^{KJS3}
\]

where:

- \( t_I \) = thickness for I th point
- HP1 = Halsey parameter #1
- HP2 = Halsey parameter #2
- HP3 = Halsey parameter #3
- HJP1 = Harkins and Jura parameter #1
- HJP2 = Harkins and Jura parameter #2
- HJP3 = Harkins and Jura parameter #3
- STSA1 = statistical thickness surface area parameter #1
- STSA2 = statistical thickness surface area parameter #2
- STSA3 = statistical thickness surface area parameter #3
- BdB1 = Broekhoff-de Boer parameter #1
- BdB2 = Broekhoff-de Boer parameter #2
- BdB3 = Broekhoff-de Boer parameter #3

---

KJS1 = Kruk-Jaroniec-Sayari parameter #1
KJS2 = Kruk-Jaroniec-Sayari parameter #2
KJS3 = Kruk-Jaroniec-Sayari parameter #3

A least-squares analysis fit is performed on the \((t_i, N_{adsi})\) data pairs where \(t_i\) is the independent variable and \(N_{adsi}\) is the dependent variable. Only the values of \(t_i\) between \(t_{MIN}\) and \(t_{MAX}\), the minimum and maximum thickness, are used. The following are calculated:

a. Slope (\(S \text{ cm}^3/\text{g-Å STP}\))
b. Y-intercept (\(Y_{INT} \text{ cm}^3/\text{g STP}\))
c. Error of the slope (\(S_{ERR} \text{ cm}^3/\text{g-Å STP}\))
d. Error of the Y-intercept (\(Y_{IERR} \text{ cm}^3/\text{g STP}\))
e. Correlation coefficient (\(Cc\))

Using the results of the above calculations, the following can be calculated:

**External Surface Area (m²/g):**

\[
SA_{EXT} = \frac{(S \text{ cm}^3/\text{g} - A \text{ STP}) \times (10^{10} \text{ A/m}) \times (D \text{ cm}^3 \text{ liquid/cm}^3 \text{ STP})}{F \times (10^6 \text{ cm}^3/\text{m}^3)}
\]

where

\(F\) = surface area correction factor, user-entered on the t-Plot Report Options dialog
\(D\) = density conversion factor, user-entered on the Adsorptive Properties dialog

**Micropore Surface Area (m²/g):**

\[
SA_{µP} = SA_{TOT} + SA_{EXT}
\]

where \(SA_{TOT}\) is the BET surface area if the user enabled the BET report, or Langmuir surface area if the user enabled the Langmuir report. If neither report has been selected, \(SA_{TOT}\) is the BET surface area value calculated using a set of default parameters.

**Micropore Volume (cm³ liquid/g):**

\[
V_{µP} = (Y_{INT} \text{ cm}^3/\text{g STP}) \times (D \text{ cm}^3 \text{ liquid/cm}^3 \text{ STP})
\]
BJH Pore Volume and Area Distribution

For adsorption data, the relative pressure and volume adsorbed data point pairs collected during an analysis must be arranged in reverse order from which the points were collected during analysis. All calculations are performed based on a desorption model, regardless of whether adsorption or desorption data are being used.

The data used in these calculations must be in order of strictly decreasing numerical value. Points which do not meet this criterion are omitted. The remaining data set is composed of relative pressure ($P_r$), volume adsorbed ($V_a$) pairs from $(P_{r1}, V_{a1})$ to $(P_{rN}, V_{aN})$ where $(P_{rN} = 0, V_{aN} = 0)$ is assumed as a final point. Each data pair represents an interval boundary (or desorption step boundary) for intervals $i=1$ to $i=N-1$ where $N =$ total number of $(P_r, V_a)$ pairs.

Generally, the desorption branch of an isotherm is used to relate the amount of adsorbate lost in a desorption step to the average size of pores emptied in the step. A pore loses its condensed liquid adsorbate, known as the core of the pore, at a particular relative pressure related to the core radius by the Kelvin\(^1\) equation. After the core has evaporated, a layer of adsorbate remains on the wall of the pore. The thickness of this layer is calculated for a particular relative pressure from the thickness equation. This layer becomes thinner with successive decreases in pressure, so that the measured quantity of gas desorbed in a step is composed of a quantity equivalent to the liquid cores evaporated in that step plus the quantity desorbed from the pore walls of pores whose cores have been evaporated in that and previous steps. Barrett, Joyner, and Halenda\(^2\) developed the method (known as the BJH method) which incorporates these ideas. The algorithm used on the ASAP 2020 is an implementation of the BJH method.

Explanation of Terms

A pore filled with condensed liquid nitrogen has three zones:

a. The **core** - evaporates all at once when the critical pressure for that radius is reached; the relationship between the core radius and the critical pressure is defined by the Kelvin equation.

b. The **adsorbed layer** - composed of adsorbed gas that is stripped off a bit at a time with each pressure step; the relationship between the thickness of the layer and the relative pressure is defined by the thickness equation.

---

\(^1\) Kelvin, J. (published under the name of Sir William Thomson), Phil. Mag. 42, 448-452 (1871).

c. The **walls of the cylindrical pore** - the diameter of the empty pore is required to determine the pore volume and pore area. End area is neglected.

### Calculations

The volumes adsorbed \((Va)\) are converted to the liquid equivalent volumes \((V1, \text{cm}^3/\text{g})\):

\[
V_{I1} = (Va)(D)
\]

where \(D\) is the Density Conversion Factor from the Adsorptive Properties dialog box.

The relative pressure \((Pr_I)\) is assumed to be close to unity so that substantially all the pores in the sample are filled.

The corresponding Kelvin core radius is calculated. Only pores smaller than this size will be included:

\[
R_{C_I} = \frac{-A}{(1 + F)[\ln(Pr_I)]}
\]

where

- \(A\) = adsorbate property factor (the BJH Adsorptive Options dialog box)
- \(F\) = fraction of pores open at both ends (from the BJH Adsorption Report Options dialog box or the BJH Desorption Report Options dialog box); assumed to be zero for desorption

This radius will be adjusted for the thickness of the adsorbed layer during subsequent calculation steps.
The thickness of the remaining adsorbed layer at this relative pressure is calculated:

\[ T_{W_1} = HP_1 \left[ \frac{HP_2}{\ln(Pr_1)} \right]^{HP_3} \]

where

HP1, HP2, and HP3 are Halsey Parameters 1, 2, and 3 (respectively) from the Halsey Thickness Equation dialog.

These calculations illustrate the use of the Halsey thickness equation. If the Harkins/Jura equation was selected, substitute the following wherever the thickness equation appears:

\[ T_{W_1} = \left[ \frac{HJ_1}{HJ_2 - \log(Pr_1)} \right]^{HJ_3} \]

where

HJ1, HJ2, and HJ3 are Harkins-Jura Parameters 1, 2, and 3 (respectively) from the Harkins-Jura Thickness Equation dialog.

The following calculations (a-c) are made for each relative pressure interval based on the increment of volume desorbed during that interval. The variable I refers to the interval number, that is I=1 for the first interval from Pr1 to Pr2, and so on. J refers to each previous interval during which new pores were found. K refers to the total number of intervals in which new pores have been found. K is also the number of lines reported on the BJH table for collected data.

a. The thickness of the adsorbed layer at the end of the interval is calculated as follows:

\[ T_{W_{I+1}} = HP_1 \left[ \frac{HP_2}{\ln(Pr_{I+1})} \right]^{HP_3} \]

(For the last pressure interval from the lowest Pr1 to zero relative pressure, \( T_{W_{I+1}} = 0 \).)

For the first pressure interval, there are no previously opened pores so the volume desorbed from walls of previously opened pores is zero (\( V_{d_1} = 0 \), and the remainder of Step a is skipped.

The change in thickness of the wall layer due to desorption from previously opened pores is calculated:

\[ \Delta T_w = T_{W_1} - T_{W_{I+1}} \]
The annular cross-sectional area of the wall layer desorbed is calculated for all previously opened pores:

\[ CSA_J = \pi[(Rc_J + \Delta Tw)^2 - Rc_J^2](10^{-16} \text{ cm}^2/A) \]

The total volume of gas desorbed from walls of previously opened pores is calculated:

\[ Vd_I = \sum (Lp_J)(CSAa_J) \text{ for all previously opened pores} \]

where \( Lp_J \) = length of previously opened pores as calculated in Step b(2).

b. The physical processes occurring for this pressure interval are determined as follows:

(1) If \( Vd_I \) is greater than the current increment of volume desorbed \( (Vl_I - Vl_{I+1}) \), desorption from walls only is occurring. Total surface of walls exposed thus far (cm²/g) is calculated as follows:

\[ SA_{W_I} = \sum \pi(LP_J)(D_{avg_J})(10^{-8} \text{ cm}/A) \text{ for all previously opened pores} \]

where

\( D_{avg_J} = \) weighted average pore diameter calculated below in Step b(2).

A new layer thickness (\( \Delta Tw \)) that will not overcompensate for the actual volume desorbed in this interval is calculated:

\[ \Delta Tw = \frac{(Vl_I - Vl_{I+1})(10^8 \text{ A/cm})}{SA_{W_I}} \]

Since no cores are evaporated in this pressure interval, no new pores are revealed. Thus no ending Kelvin radius and average pore diameter are calculated for this interval. Note that this means the report may have fewer tabulated intervals on the collected data report than experimental pressure intervals.

(2) If \( Vd_I \) is less than the volume increment desorbed during this interval, the remaining volume is due to new pores with core evaporation taking place in this interval. \( K \), the number of intervals with new pores exposed, is increased by 1. (For the interval from the lowest to zero relative pressure, no new pore volume is calculated and the rest of Step b is skipped.)

The volume desorbed from newly opened pores in this interval is calculated as follows:

\[ Vc_I = (Vl_I - Vl_{I+1}) - Vd_I \]
The Kelvin radius for the end of the interval is calculated as follows:

\[ R_{K+1} = \frac{-A}{(1 + F)[\ln(P_{r_{i+1}})]} \]

All new pores opened in this interval are represented by one pore having a length-weighted average pore diameter and a corresponding length sufficient to account for the required volume of adsorbate. The weighted average pore diameter is calculated as follows:

\[ D_{\text{avg}_K} = \frac{(2)(R_{c_K} + R_{c_{K+1}})(R_{c_K})}{R_{c_K}^2 + R_{c_{K+1}}^2} \]

\( D_{\text{avg}_K} \) is the diameter of a pore which would have a surface area that is the average of the areas for pores with radius and, if its length was the mean of the lengths at those radii.

The relative pressure corresponding to is calculated as follows:

\[ P_{\text{avg}_K} = \ln^{-1}\left[\frac{-2A}{(1 + F)(D_{\text{avg}_K})}\right] \]

The thickness of the adsorbed layer at this pressure is calculated as follows:

\[ T_{W_{\text{avg}_K}} = HP\left[\frac{HP2}{\ln(P_{\text{avg}_K})}\right]^{HP3} \]

The decrease in thickness of the wall layer by desorption from the walls of new pores during the lower portion of the pressure interval is calculated as follows:

\[ \Delta Td = T_{W_{\text{avg}_K}} - T_{W_{I+1}} \]

The cross-sectional area of the newly opened pores is calculated as follows:

\[ CSA_{c_K} = \left[\frac{D_{\text{avg}_K}}{2} + \Delta Td\right]^2 (10^{-16} \text{ cm}^2/A^2) \]

The length of the newly opened pores is calculated as follows:

\[ LP_K = \frac{V_{c_I}}{CSA_{c_K}} \]
c. Pore diameters and radii are adjusted for the change in thickness of the adsorbed wall layer during this interval. If new pores were opened during this interval, the average diameter is adjusted by the change in layer thickness during the second portion of the desorption interval as follows:

\[ D_{avg, new} = D_{avg, old} + 2(\Delta Td) \]

The layer thickness change during the whole interval is added to diameters of previously opened pores as follows:

\[ D_{avg, new} = D_{avg, old} + 2(\Delta Tw) \]

(not including \( D_{avg,K} \))

The layer thickness change desorbed during this interval also is added to the radii corresponding to the ends of the pressure intervals as follows:

\[ Rc_{J,new} = Rc_{J,old} + \Delta Tw \]

for all except \( Rc_{K+1} \).

Steps a to c are repeated for each pressure interval.

After the above calculations have been performed, the diameters corresponding to the ends of the intervals are calculated as follows:

\[ Dp_J = 2(rc_J) \]

for all \( Rc_j \) including \( Rc_{K+1} \).

The remaining calculations are based on \( DP_{(I)}, D_{avg(I)}, \) and \( LP_{(I)} \). These calculations are only done for values that fall between the Minimum BJH diameter and the Maximum BJH diameter specified by the operator on the BJH Adsorption Report Options dialog box or the BJH Desorption Report Options dialog box.

1) Incremental Pore Volume (\( Vp_I, \text{cm}^3/\text{g} \)):

\[ Vp_I = \pi(Lp_I)\left(\frac{D_{avg}}{2}\right)^2 10^{16} \text{ cm}^2/\text{A}^2 \]

2) Cumulative Pore Volume (\( Vp_{CUM(I)}, \text{cm}^3/\text{g} \)):

\[ Vp_{CUM(I)} = \sum Vp_J \text{ for } (J \leq 1) \]
3) Incremental Surface Area ($SA_I$, m$^2$/g):

$$SA_I = \pi (LP_I)(10^{-2} \text{ m/cm})(D_{avg,I})(10^{-10} \text{ m/A})$$

4) Cumulative Surface Area ($SA_{CUM,I}$, m$^2$/g):

$$SA_{CUM,I} = \sum_{J=1}^{\infty} SA_J$$

5) $dV/dD$ pore volume ($dV/dD_I$, cm$^3$/g-A):

$$dV/dD_I = \frac{VP_I}{Dp_I - Dp_{I+1}}$$

6) $dV/d\log(D)$ pore volume ($dV/d\log(D)_I$, cm$^3$/g):

$$lDv/d\log(D)_I = VP_I/\log\left(\frac{Dp_{I+1}}{Dp_I}\right)$$

7) $dA/dD$ pore area ($dA/dD_I$, m$^2$/g-A):

$$dA/dD_I = \frac{SA_I}{Dp_I - Dp_{I+1}}$$

8) $dA/d\log(D)$ pore area [$dA/d\log(D)_I$, m$^2$/g]:

$$dA/d\log(D)_I = SA_I/\log\left(\frac{Dp_{I+1}}{Dp_I}\right)$$

For fixed pore size tables (if selected), the following calculations are performed:

1) Average Fixed Pore Size ($DF_{avg,J}$, A):

$$DF_{avg,J} = \frac{Dp_{F,j} + Dp_{F,j+1}}{2}$$

calculated for all intervals in the fixed pore size table.

For the intervals with between the Minimum BJH diameter and the Maximum BJH diameter.
2) Cumulative Pore volume (\( V_{pF_{CUM_i}} \), cm\(^3\)/g):

\[
V_{pF_{CUM_i}} = \text{INTERP}(Dp_{F_{i+1}})
\]

where INTERP(x) is the value interpolated from the function \( X = D_{p_{i+1}} \) and \( Y = V_{pF_{CUM_i}} \), using an AKIMA semi-spline interpolation.

3) Incremental Pore Volume (\( V_{pF_i} \), cm\(^3\)/g):

\[
V_{pF_i} = V_{pF_{CUM_i}} - V_{pF_{CUM_{i-1}}}
\]

where \( V_{pF_{CUM_0}} = 0 \).

4) Cumulative Surface Area (\( SAF_{CUM_i} \), m\(^2\)/g):

\[
SAF_{CUM_i} = \text{INTERP}(Dp_{F_{i+1}})
\]

where INTERP(x) is the value interpolated from the function \( X = D_{p_{i+1}} \) and \( Y = SAF_{CUM_i} \).

5) Incremental Surface Area (\( SAF_i \), m\(^2\)/g):

\[
SAF_i = SAF_{CUM_i} - SAF_{CUM_{i-1}}
\]

where \( SAF_{CUM_0} = 0 \).

6) \( dV/dD \) pore volume (\( dV/dDpF_i \), cm\(^3\)/g-A):

\[
dV/dDpF_i = \text{INTERP}(DpF_{i+1})
\]

where INTERP(x) is the value interpolated from the function \( X = D_{avg_{i}} \) and \( Y = dV/dD_i \).

7) \( dV/d\log(D) \) pore volume [\( dV/d\log(DpF_i) \), cm\(^3\)/g]:

\[
dV/d\log(DpF_i) = \text{INTERP}(DpF_{i+1})
\]

where INTERP(x) is the value interpolated from the function \( X = D_{avg_{i}} \) and \( Y = dV/d\log(D)_i \).
8) \( \frac{dA}{dD} \) pore area \((\frac{dA}{dD_{PF}}, \text{m}^2/\text{g-A})\):

\[
\frac{dA}{dD_{PF}} = \text{INTERP}(D_{PF_{i+1}})
\]

where \( \text{INTERP}(x) \) is the value interpolated from the function \( X = D_{\text{avg}J} \) and \( Y = \frac{dA}{dD_{J}} \).

9) \( \frac{dA}{d\log(D)} \) pore area \([\frac{dA}{d\log(D_{PF})}, \text{m}^2/\text{g}]\):

\[
\frac{dA}{d\log(D_{PF})} = \text{INTERP}(D_{PF_{i+1}}).
\]

where \( \text{INTERP}(x) \) is the value interpolated from the function \( X = D_{\text{avg}J} \) and \( Y = \frac{dA}{d\log(D)} \).

---

**Compendium of Variables**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>( V_a )</td>
<td>quantity adsorbed expressed as a volume ((\text{cm}^3/\text{g STP}))</td>
</tr>
<tr>
<td>( V_l )</td>
<td>liquid equivalent volume of volume adsorbed ((\text{cm}^3/\text{g}))</td>
</tr>
<tr>
<td>( D )</td>
<td>density conversion factor from the Adsorptive Properties dialog box ((\text{cm}^3/\text{cm}^3 \text{ STP}))</td>
</tr>
<tr>
<td>( Pr )</td>
<td>relative pressure</td>
</tr>
<tr>
<td>( D_p )</td>
<td>pore (or core) diameter ((\text{A}))</td>
</tr>
<tr>
<td>( R_c )</td>
<td>Kelvin radius ((\text{A})) of core</td>
</tr>
<tr>
<td>( A )</td>
<td>adsorbate property factor; from the BJH Adsorptive Options dialog box</td>
</tr>
<tr>
<td>( F )</td>
<td>fraction of pores open at both ends; from the BJH Adsorption Report Options dialog box or the BJH Desorption Report Options dialog box</td>
</tr>
<tr>
<td>( \Delta T_w )</td>
<td>thickness of adsorbed layer desorbed during interval ((\text{A}))</td>
</tr>
<tr>
<td>( T_w )</td>
<td>thickness of remaining adsorbed wall ((\text{A}))</td>
</tr>
<tr>
<td>( H_{P1}, H_{P2}, H_{P3} )</td>
<td>Halsey Parameters from the Halsey Thickness Equation dialog.</td>
</tr>
<tr>
<td>( H_{J1}, H_{J2}, H_{J3} )</td>
<td>Harkins and Jura Parameters from the Harkins/Jura Thickness Equation dialog.</td>
</tr>
<tr>
<td>( V_d )</td>
<td>volume of gas desorbed from walls of previously opened pores ((\text{cm}^3/\text{g}))</td>
</tr>
<tr>
<td>( D_{\text{avg}} )</td>
<td>average pore diameter ((\text{A}))</td>
</tr>
<tr>
<td>( C_{SAA} )</td>
<td>annular cross-sectional area of the desorbed layer ((\text{cm}^2))</td>
</tr>
<tr>
<td>( C_{SAC} )</td>
<td>cross-sectional area of opening of newly opened pores ((\text{cm}^2))</td>
</tr>
<tr>
<td>( S_{AW} )</td>
<td>total surface area of walls exposed ((\text{cm}^2/\text{g}))</td>
</tr>
<tr>
<td>( \Delta T_d )</td>
<td>thickness of layer desorbed from walls of newly opened pores ((\text{A}))</td>
</tr>
<tr>
<td>( V_c )</td>
<td>volume desorbed from cores of newly opened pores ((\text{cm}^3/\text{g}))</td>
</tr>
<tr>
<td>( L_p )</td>
<td>length of pore ((\text{cm/g}))</td>
</tr>
</tbody>
</table>
Horvath-Kawazoe

A relative pressure lower limit is determined such that \( L - d_0 \) never equals zero. All pressure points less than this limit are discarded. For each collected relative pressure point, values of \( L \) are chosen in an iterative manner, and the relative pressure \( (P/P_0) \) determined by solving one of the following equations:

- Slit Pore Geometry (original Horvath-Kawazoe)
- Cylinder Pore Geometry (Saito/Foley)
- Sphere Pore Geometry (Cheng/Yang)

**Slit Pore Geometry (original HK)**

When you use the original Horvath-Kawazoe\(^1\) method, the following equation is solved for each value of \( P \). The value of \( L \) is determined when the solved-for relative pressure is within 0.1% of the collected absolute pressure.

\[
\ln \frac{P}{P_0} = \frac{K}{RT} \times \frac{IP \times 10^{32} \cdot JA^4/J \cdot \text{cm}^4}{\sigma^4 \times (L - 2 \times d_0)} \times \left[ \frac{\sigma^4}{3 \times (L - d_0)^3} - \frac{\sigma^{10}}{9 \times (L - d_0)^9} - \frac{\sigma^4}{3 \times d_0^3} + \frac{\sigma^{10}}{9 \times d_0^9} \right]
\]

where

\[
\begin{align*}
K &= \text{Avogadro’s number (6.023 \times 10^{23})} \\
R &= \text{gas constant (8.31441 \times 10^7 \text{ ergs/mole K})} \\
T &= \text{analysis bath temperature (K), from an entered or calculated value on the Po and Temperature Options dialog} \\
\sigma &= \text{gas solid nuclear separation at zero interaction energy (Å),} \quad \frac{Z_S + Z_A}{2}
\end{align*}
\]

where:

\[
\begin{align*}
Z_S &= \text{sample equilibrium diameter at zero interaction energy (Å) from the Horvath-Kawazoe Physical Properties dialog} \\
Z_A &= \text{zero interaction energy diameter from the Horvath-Kawazoe Physical Properties dialog}
\end{align*}
\]

\[ d_0 = \frac{D_A + D_S(A)}{2} \]

where:

- \( D_A \) = molecular diameter (Å) from the Horvath-Kawazoe Physical Properties dialog
- \( D_S \) = diameter of sample atom (Å) from the Horvath-Kawazoe Physical dialog
- \( L \) = pore width (nucleus to nucleus) (Å)
- \( P \) = equilibrium pressure (mmHg)
- \( P_o \) = saturation pressure (mmHg)
- \( IP \) = interaction parameter \((10^{-43} \text{ ergs-cm}^4)\) from the Horvath-Kawazoe Report Options dialog

**Cylinder Pore Geometry (Saito/Foley)**

When you use the Saito-Foley\(^1\) method, the following equation is solved for each value of \( P \). The value of \( L \) is determined when the solved-for relative pressure is within 0.1% of the collected absolute pressure.

\[
\ln \left( \frac{P}{P_o} \right) = \frac{3 \pi K}{4RT} \times IP \times 10^{32} \frac{J A^4 / J \text{ cm}^4}{d_0^4} \times \sum_{k=0}^{\infty} \frac{\left( \frac{1}{k+1} \left( 1 - \frac{d_0}{r_p} \right)^{2k} \right)}{\left( \frac{21}{32} \alpha_k \left( \frac{d_0}{r_p} \right)^{10} - \beta_k \left( \frac{d_0}{r_p} \right)^{4} \right)}
\]

where

- \( K \) = Avogadro’s number \((6.023 \times 10^{23})\)
- \( R \) = gas constant \((8.31441 \times 10^7 \text{ ergs/mole K})\)
- \( T \) = analysis bath temperature (K), from an entered or calculated value on the Po and Temperature Options dialog
- \( L \) = pore width (nucleus to nucleus) (Å)
- \( P \) = equilibrium pressure (mmHg)
- \( P_o \) = saturation pressure (mmHg)
- \( IP \) = interaction parameter \((10^{-43} \text{ ergs-cm}^4)\) from the Horvath-Kawazoe Report Options dialog

\[ d_0 = \frac{D_A + D_S(A)}{2} \]

where:

- \( D_A \) = molecular diameter (Å) from the Horvath-Kawazoe Physical Properties dialog
- \( D_S \) = diameter of sample atom (Å) from the Horvath-Kawazoe Physical dialog

---

\[ \alpha_k = \left( \frac{-4.5 - k}{k} \right)^2 \alpha_{k-1}, \alpha_0 = 1.0 \]

\[ \beta_k = \left( \frac{-1.5 - k}{k} \right)^2 \beta_{k-1}, \beta_0 = 1.0 \]

\[ r_p = \text{radius of the cylindrical pore, } \frac{L}{2} \]

**Sphere Pore Geometry (Cheng/Yang)**

When you use the Cheng/Yang\(^1\) method, the following equation is solved for each value of \(P\). The value of \(L\) is determined when the solved-for relative pressure is within 0.1% of the collected absolute pressure.

\[
n(\frac{P}{P_0}) = \frac{6(N_1 \varepsilon_{12}^* + N_2 \varepsilon_{22}^*)L^3 \times 10^{12} J A^4 / J \text{cm}^4}{RT(L - d_0)^3} \\
[\left[-\left(\frac{d_0}{L}\right)^6 \left(\frac{1}{12} T_4 + \frac{1}{8} T_2\right) + \left(\frac{d_0}{L}\right)^{12} \left(\frac{1}{90} T_3 + \frac{1}{80} T_4\right)\right]}
\]

where

- \(R\) = gas constant \((8.31441 \times 10^7 \text{ ergs/mole K})\)
- \(T\) = analysis bath temperature (K), from an entered or calculated value on the Po and Temperature Options dialog
- \(d_0 = \frac{D_A + D_S(A)}{2}\)

where:

- \(D_A\) = molecular diameter (Å) from the Horvath-Kawazoe Physical Properties dialog
- \(D_S\) = diameter of sample atom (Å) from the Horvath-Kawazoe Physical dialog
- \(L\) = pore width (nucleus to nucleus) (Å)
- \(P\) = equilibrium pressure (mmHg)
- \(P_0\) = saturation pressure (mmHg)
- \(N_1\) = \(4\pi L^2 N_S\), where \(N_S = \text{number of sample atoms/cm}^2\) at monolayer
- \(N_2\) = \(4\pi (L - d_0)^2 N_A\), where \(N_A = \text{number of gas molecules/cm}^2\)
- \(\varepsilon_{12}^*\) = \(\frac{A_S}{4d_S^6}\), where \(A_S = \frac{6 \times MC^2 \times \alpha_S \times \alpha_A}{\chi_S + \chi_A \times \chi_A}\)

$$\epsilon^*_{22} = \frac{A_d}{4D_A}, \text{ where } A_d = \frac{3 \times MC^2 \times \alpha_d \times \chi_d}{2}$$

\[ T_1 = \frac{1}{(1 - S)^3} - \frac{1}{(1 + S)^3} \]

\[ T_2 = \frac{1}{(1 + S)^2} - \frac{1}{(1 - S)^2} \]

\[ T_3 = \frac{1}{(1 - S)^9} - \frac{1}{(1 + S)^9} \]

\[ T_4 = \frac{1}{(1 + S)^8} - \frac{1}{(1 - S)^8} \]

where \( S = \frac{L - d_0}{L} \)

**Cheng/Yang Correction**

This factor corrects for the nonlinearity of the isotherm. It adds an additional term to the equations for the different geometries:

\[
\ln\left(\frac{P}{P_0}\right) = G(L) - \left[1 - \frac{1}{\theta} \ln\left(\frac{1}{1 - \theta}\right)\right]
\]

where

- \( G(L) \) = one of the Horvath-Kawazoe equations given above
- \( \theta \) = degree of void filling; \( \theta \) is estimated by first computing the monolayer capacity \( (V_m) \) with the Langmuir equation over the range of data points from relative pressure 0.02 to 0.2 or the maximum relative pressure included in the Horvath-Kawazoe analysis. \( \theta \) is computed as the volume adsorbed over \( V_m \).
Interaction Parameter

The interaction parameter (IP) results from the following calculations:

The Kirkwood-Muller dispersion coefficients -

\[
A_S = \frac{6 \times MC^2 \times \alpha_S \times \alpha_A}{\alpha_S + \alpha_A}
\]

\[
A_A = \frac{3 \times MC^2 \times \alpha_A \times \chi_A}{2}
\]

where:

- \(MC^2\) = kinetic energy of electron (0.8183 x 10^{-6} erg)
- \(\alpha_S\) = polarizability of sample atoms (cm^3)
- \(\alpha_A\) = polarizability of gas molecule (cm^3)
- \(\chi_S\) = diamagnetic susceptibility of sample atom (cm^3)
- \(\chi_A\) = diamagnetic susceptibility of gas molecule (cm^3)

\[
IP = (N_A \times A_A) + (N_S \times A_S)
\]

where:

- \(N_A\) = number of gas molecules/cm^2 at monolayer from the Horvath-Kawazoe Physical Properties dialog box
- \(N_S\) = number of sample atoms/cm^2 from the Horvath-Kawazoe Physical Properties dialog box

Refer to Interaction Parameter Components later in this Appendix for recommended values.
Additional Calculations

Based on the previous calculations, the following can be calculated:

**Adjusted Pore Width (Å):**
(Shell to Shell)

\[ AL_I = L_I - DS \]

**Cumulative Pore Volume (cm\(^3/\)g):**

\[ V_{CUM_I} = V_I \times D \]

where

\[ D = \text{density conversion factor (cm}^3 \text{ liquid/cm}^3 \text{ STP) on the Adsorptive Properties dialog box} \]

**dV/dD Pore Volume (cm\(^3/\)g-Å):**

\[ \frac{dV}{dD_I} = \frac{V_{CUM_I} - V_{CUM_{I-1}}}{AL_I - AL_{I-1}} \]

**Median Pore Width (Å):**

\[ V_{HALF} = \frac{V_{CUM_{NI}}}{2} \]

\[ D_{MED} = 10 \left[ \log(D_L) + [\log(V_{HALF}) - \log(V_L)] \times \frac{\log(D_G) - \log(D_L)}{\log(V_G) - \log(V_L)} \right] \]

where

\[ V_{CUMN} = \text{total cumulative pore volume (V_{CUMI}) for points designated for Horvath-Kawazoe calculations} \]
\[ V_{HALF} = \text{50% of total cumulative pore volume} \]
\[ V_L = \text{cumulative pore volume (V_{CUMI}) for first point less than V_{HALF}} \]
\[ V_G = \text{cumulative pore volume (V_{CUMI}) for first point greater than V_{HALF}} \]
\[ D_L = \text{pore width (L_I) that corresponds to V_L} \]
\[ D_G = \text{pore width (L_I) that corresponds to V_G} \]
# Interaction Parameter Components

## Table C-1. Interaction Parameters

<table>
<thead>
<tr>
<th>Gas</th>
<th>Bath Temperature (K)</th>
<th>Sample Type</th>
<th>Interaction Parameter Calculated Value*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argon</td>
<td>87.3</td>
<td>Carbon (Ross/Olivier value)</td>
<td>2.61</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Carbon (Horvath/Kawazoe value)</td>
<td>5.89</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zeolite</td>
<td>3.19</td>
</tr>
<tr>
<td>Carbon Dioxide</td>
<td>298.15</td>
<td>Carbon (Ross/Olivier value)</td>
<td>4.20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Carbon (Horvath/Kawazoe value)</td>
<td>9.20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zeolite</td>
<td>5.08</td>
</tr>
<tr>
<td></td>
<td>273.15</td>
<td>Carbon (Ross/Olivier value)</td>
<td>4.34</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Carbon (Horvath/Kawazoe value)</td>
<td>9.35</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zeolite</td>
<td>5.22</td>
</tr>
<tr>
<td></td>
<td>194.65</td>
<td>Carbon (Ross/Olivier value)</td>
<td>4.72</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Carbon (Horvath/Kawazoe value)</td>
<td>9.72</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zeolite</td>
<td>5.60</td>
</tr>
<tr>
<td>Nitrogen</td>
<td>77.15</td>
<td>Carbon (Ross/Olivier value)</td>
<td>2.84</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Carbon (Horvath/Kawazoe value)</td>
<td>6.53</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zeolite</td>
<td>3.49</td>
</tr>
</tbody>
</table>

*The interaction parameter is entered in the Horvath-Kawazoe Report Options dialog in the following field:

**Interaction parameter:** (calculated value) x 10^{-43} ergs-cm^4

The following values were used to calculate the values in Table C-1.

### Carbon-Graphite

- \( D_S = 3.40 \)
- \( N_S = 3.845 \times 10^{15} \)
- \( \chi_S = 1.05 \times 10^{-29} \) (Ross/Olivier)
- \( 13.5 \times 10^{-29} \) (Horvath/Kawazoe, implicit)
- \( \alpha_S = 1.02 \times 10^{-24} \)

### Zeolite

- \( D_S = 3.04 \)
- \( N_S = 3.75 \times 10^{15} \)
- \( \chi_S = 1.94 \times 10^{-29} \)
- \( \alpha_S = 0.85 \times 10^{-24} \)

### Nitrogen

- \( D_A = 3.00 \)
- \( N_A = 6.71 \times 10^{14} \)
- \( \chi_A = 3.6 \times 10^{-29} \)
- \( \alpha_A = 1.76 \times 10^{-24} \)

### Argon

- \( D_A = 2.95 \)
- \( N_A = 7.608 \times 10^{14} \)
- \( \chi_A = 3.22 \times 10^{-29} \)
- \( \alpha_A = 1.63 \times 10^{-24} \)
**Carbon Dioxide**

\[ D_A = 3.23 \]
\[ N_A = 4.567 \times 10^{14} \ (25 \, ^\circ C) \]
\[ 5.45 \times 10^{14} \ (0 \, ^\circ C) \]
\[ 7.697 \times 10^{14} \ (-78 \, ^\circ C) \]
\[ \chi_A = 5.0 \times 10^{-29} \]
\[ \alpha_A = 2.7 \times 10^{-24} \]

\( D_A \) values are from van der Waal’s constant.
\( N_A \) values are from liquid densities.
\( \chi \) and \( \alpha \) values are derived from data found in Ross and Olivier\(^1\).

The physical parameters referenced in Saito/Foley are as follows:

**Aluminophosphate**

\[ D_S = 2.60 \]
\[ N_S = 1.48 \times 10^{15} \]
\[ \chi_S = 1.3 \times 10^{-29} \]
\[ \alpha_S = 2.5 \times 10^{-24} \]

**Aluminosilicate**

\[ D_S = 2.76 \]
\[ N_S = 1.31 \times 10^{15} \]
\[ \chi_S = 1.3 \times 10^{-29} \]
\[ \alpha_S = 2.5 \times 10^{-24} \]

---

Dubinin-Radushkevich

The Dubinin-Radushkevich\(^1\) equation is as follows:

\[
\log(V) = \log(V_0) - \frac{B \times T^2}{\beta} \times \left[ \log\left(\frac{P_0}{P}\right) \right]^2
\]

where:

- \(V\) = volume adsorbed at equilibrium pressure (cm\(^3\)/g STP)
- \(V_0\) = the micropore capacity (cm\(^3\)/g STP)
- \(P_0\) = saturation vapor pressure of gas at temperature T (mmHg)
- \(P\) = equilibrium pressure (mmHg)
- \(B\) = a constant
- \(\beta\) = the affinity coefficient of analysis gas relative to \(P_0\) gas
  (for this application \(\beta\) is taken to be 1)
- \(T\) = analysis bath temperature (K), from the \(P_0\) and Temperature Options dialog

For each point designated for Dubinin-Radushkevich calculations, the following calculations are done:

\[
LV = \log(V)
\]

\[
LP = \log\left(\frac{P_0}{P}\right)^2
\]

The intercept, \(\log(V_0)\) can be found by performing a least-squares fit on the \((LP, LV)\) designated pairs where \(LP\) is the independent variable and \(LV\) is the dependent variable. Assuming the adsorption of gas is restricted to a monolayer, \(V_0\) is the monolayer capacity. Based on this assumption, the following are calculated:

a. Slope (S cm\(^3\)/g STP)

b. Y-intercept (YI cm\(^3\)/g STP)

c. Error of the slope (S\(_{ERR}\) cm\(^3\)/g STP)

d. Error of the y-intercept (YI\(_{ERR}\) cm\(^3\)/g STP)

e. Correlation coefficient (Cc)

---

Using the results of the above calculations, the following can be calculated:

**Monolayer Capacity (cm$^3$/g STP):**

\[ V_o = 10^{VI} \]

**Error of Monolayer Capacity (cm$^3$/g STP):**

\[ V_{o\text{ERR}} = V_o \times (10^{VI_{ERR}} - 1.0) \]

**Micropore surface area (m$^2$/g):**

\[
SDP = \frac{\sigma \times V_o \times (6.023 \times 10^{23})}{22414 \ cm^3 \times (10^{18} \ nm^2/m^2)}
\]

where

\[ \sigma = \text{molecular cross sectional area of gas (nm}^2\text{) from the Adsorptive Properties dialog box} \]
Dubinin-Astakhov

The Dubinin-Astakhov equation is as follows:

\[
\log(V) = \log(V_0) - \left[\frac{RT}{\beta E_0}\right]^N \times \left[\log\left(\frac{P_0}{P}\right)^N\right]
\]

where

- \(V\) = volume adsorbed at equilibrium pressure (cm\(^3\)/g STP)
- \(V_0\) = the micropore capacity (cm\(^3\)/g STP)
- \(P_0\) = saturation vapor pressure of gas at temperature \(T\) (mmHg)
- \(P\) = equilibrium pressure (mmHg)
- \(T\) = analysis bath temperature (K)
- \(R\) = the gas constant (0.0083144 kJ/mol)
- \(E_0\) = characteristic energy (kJ/mole)
- \(N\) = Astakhov exponent, may be optimized or user entered from the Dubinin Report Options dialog box
- \(\beta\) = the affinity coefficient of the analysis gas relative to the Po gas, from the Dubinin Adsorptive Options dialog box

For each point designated for Dubinin-Astakhov calculations, the following calculations are done:

- \(LV = \log(V)\)
- \(LP = \left[\log\left(\frac{P_0}{P}\right)^N\right]\)

A least-squares fit is performed on the \((LP, LV)\) designated pairs where \(LP\) is the independent variable and \(LV\) is the dependent variable. If the user selected yes for the Optimize Astakhov Exponent prompt, a systematic search for the optimum value of \(N\) is conducted by recalculating the linear regression and selecting the value of \(N\) that gives the smallest standard error of the y-intercept. The exponent \(N\) is optimized to within 10\(^{-4}\). If the optimum value for \(N\) is not found in this range, an exponent of 2 is used. The following are calculated:

- a. Slope (S cm\(^3\)/g STP)
- b. Y-intercept (YI cm\(^3\)/g STP)
- c. Error of the slope (SERR cm\(^3\)/g STP)
- d. Error of the y-intercept (YIERR cm\(^3\)/g STP)
- e. Correlation coefficient (Cc)
- f. Optimized Astakhov exponent (N)
Using the results of the above calculations, the following can be calculated:

**Monolayer Capacity (cm³/g STP):**

\[ V_0 = 10^Y_I \]

**Micropore Volume (cm³/g):**

\[ W_I = (V_I \times D) \]

where

\[ D = \text{density conversion factor (cm}^3\text{ liquid/cm}^3\text{ STP) from the Adsorptive Properties dialog box} \]

**Limiting Micropore Volume (cm³/g):**

\[ W_0 = (V_0 \times D) \]

where

\[ D = \text{density conversion factor (cm}^3\text{ liquid/cm}^3\text{ STP) from the Adsorptive Properties dialog box} \]

**Error of Limiting Micropore Volume (cm³/g):**

\[ W_{0\text{ERR}} = W_0 \times (10^{Y_{I\text{ERR}}} - 1.0) \]

**Characteristic Energy (KJ/mole):**

\[ E = \frac{2.303 \times R \times T}{\beta(2.303 \times S)^{1/N}} \]

**Modal Equivalent Pore Width (nm):**

\[ w_{mode} = 2 \times \left[ \frac{3N}{3N + 1} \right]^{1/N} \times \left[ \frac{k}{E_0} \right]^{1/3} \]

where

\[ k = \text{the interaction constant for benzene, 8.969 kJ\textbullet nm}^3\text{/mol} \]
Maximum Differential Pore Volume (cm\(^3/g\)-nm):

This value is also known as frequency of the mode\(^{12}\)

\[
\frac{dV}{dw_{mode}}\text{Max} = 0.5 \times (3N + 1) \times W_0 \times \left[\frac{3N + 1}{3N}\right]^{1/3N} \times \left[\frac{E_0}{k}\right]^{1/3} \times \exp\left(-\frac{3N + 1}{3N}\right)
\]

Mean Equivalent Pore Width (nm):

\[
w_{mean} = 2 \times \frac{k^{1/3}}{\Gamma\left(\frac{3N + 1}{3N}\right)}
\]

Micropore surface area (m\(^2/g\)):

\[
SDA = 1000 \times 2.0 \times W_0 \times \left[\frac{E_0}{k}\right]^{1/3} \times \Gamma\left(\frac{3N + 1}{3N}\right)
\]

\(\Gamma\) is calculated by a polynomial approximation\(^{11}\) over the domain \(0 \leq x \leq 1\) as follows:

\[
\Gamma(x + 1) = 1 + b_1x + b_2x^2 + b_3x^3 + b_4x^4 + b_5x^5 + b_6x^6 + b_7x^7 + b_8x^8 + \varepsilon(x) \mid \varepsilon(x) \mid \leq 3 \times 10^{-7}
\]

where

\[
\begin{align*}
b_1 &= -0.57719 1652 \\
b_2 &= 0.98820 5891 \\
b_3 &= -0.89705 6937 \\
b_4 &= 0.91820 6857 \\
b_5 &= -0.75670 4078 \\
b_6 &= 0.48219 9394 \\
b_7 &= -0.19352 7818 \\
b_8 &= 0.03586 8343
\end{align*}
\]

and where

\[
x + 1 = \left(\frac{3N + 1}{3N}\right)
\]
Equivalent Pore Width (nm):

\[ w_i = 2 \times \left[ \frac{\left( \frac{k}{E_0} \right)^N}{\ln(W_i) - \ln(W_0)} \right]^{1/3N} \]

dV/dw Pore Volume (cm³/g-nm):

\[ \frac{dV}{dw_i} = 0.5 \times W_0 \times 3N \times \left[ \frac{k}{E_0} \right]^N \times \left( \frac{w_i}{2} \right)^{(3N + 1)} \times \exp \left[ -\left( \frac{k}{E_0} \right)^N \times \left( \frac{w_i}{2} \right)^{-3N} \right] \]
MP-Method

For each point designated for MP-method\(^1\) calculations, the following calculations are done:

Thickness for the I\(^{th}\) point (Å):

\[
t_I = HPI \times \left[ \frac{HP2}{\ln(P_{rel,i})} \right]^{HP3}
\]

(or)

\[
t_I = \left[ \frac{HJP1}{HJP2 - \log(P_{rel,i})} \right]^{HJP3}
\]

where:

- \(t_I\) = thickness for I\(^{th}\) point
- HP1 = Halsey parameter #1
- HP2 = Halsey parameter #2
- HP3 = Halsey parameter #3
- HJP1 = Harkins and Jura parameter #1
- HJP2 = Harkins and Jura parameter #2
- HJP3 = Harkins and Jura parameter #3
- \(P_{rel,i}\) = relative pressure for the I\(^{th}\) point (mmHg)

With the \((t_I, V_I)\) data pairs, the Akima semi-spline interpolation method is used to interpolate volume adsorbed values based on thickness values that are evenly spaced 0.2 Angstrom apart starting at the first outlier point. Outliers are defined as those points have the maximum instantaneous slope within an iteratively shrinking subset of all points. The remaining pore surface area calculation result is the slope of the line defined by two consecutive interpolated points. The slopes of each pair of consecutive points from the origin to the last point must be monotonically decreasing and non-negative. With the interpolated points set the following can be calculated:

**Average pore hydraulic radius (Å):**

\[
R_I = \frac{t_I + t_{I-1}}{2}
\]

---

Remaining pore surface area for the I\textsuperscript{th} point (m\textsuperscript{2}/g):

\[ S_I = \frac{(V_I - V_{I-1}) \times (D \times 10^{-6} \text{ m}^3/\text{cm}^3)}{(t_I - t_{I-1}) \times 10^{-10} \text{ m/Å}} \]

where

\[ D = \text{ density conversion factor (cm}^3 \text{ liquid/cm}^3 \text{ STP) on the Adsorptive Properties dialog box} \]

Incremental pore surface area occluded for the I\textsuperscript{th} point (m\textsuperscript{2}/g):

\[ S_{INC_I} = S_{I-1} - S_I \]

Cumulative pore surface area occluded for the I\textsuperscript{th} point (m\textsuperscript{2}/g):

\[ S_{CUM_I} = S_{INC_I} + S_{INC_{I-1}} + \ldots + S_{INC_1} \]

dA/dR pore surface area for the I\textsuperscript{th} point (m\textsuperscript{2}/g-Å):

\[ \frac{dA}{dR_I} = \frac{S_{INC_I}}{t_I - t_{I-1}} \]

Incremental pore volume occluded for the I\textsuperscript{th} point (cm\textsuperscript{3}/g):

\[ V_{INC_I} = (S_{INC_I} \times 10^4 \text{ cm}^2/\text{m}^2) \times (R_I \times 10^{-8} \text{ cm/Å}) \]

Cumulative pore volume occluded for the I\textsuperscript{th} point (cm\textsuperscript{3}/g):

\[ V_{CUM_I} = V_{INC_I} + V_{INC_{I-1}} + \ldots + V_{INC_1} \]

dV/dR pore volume for the I\textsuperscript{th} point (cm\textsuperscript{3}/g-Å):

\[ \frac{dV}{dR_I} = \frac{V_{INC_I}}{t_I - t_{I-1}} \]
Freundlich Isotherm

The Freundlich isotherm has the form:

\[ \frac{Q}{Q_S} = CP^{1/m} \]

where

- \( Q \) = quantity of gas adsorbed
- \( Q_S \) = quantity of gas in a monolayer
- \( C \) = temperature-dependent constant
- \( m \) = temperature-dependent constant

The pressure is absolute; typically, \( m > 1 \). In terms of quantity adsorbed,

\[ Q = Q_S CP^{1/m} \]

Taking the log of both sides yields:

\[ \log Q = \log Q_S + C \frac{1}{m} \log P \]
Temkin Isotherm

The Temkin isotherm has the form,

\[
\frac{Q}{Q_S} = \frac{RT}{q_0 \alpha} \ln(A_0 P)
\]

where

- \(Q\) = quantity of gas adsorbed
- \(Q_S\) = quantity of gas in a monolayer
- \(q_0\) = the differential heat of adsorption at zero surface coverage
- \(A_0\) = \(a_0 \exp\{-q_0/RT\}\), where \(a_0\) and \(a_0\) are adjustable constants

In terms of quantity adsorbed,

\[
Q = \frac{RTQ_S}{q_0 \alpha} \left[ \ln A_0 + \ln \left( \frac{P}{P_0} \right) \right]
\]

Thus, the plot of the natural log of absolute pressure vs. quantity adsorbed yields a straight line with slope \(RTQ_S/q_0\) and intercept \((\ln A_0) RTQ_S/q_0 \alpha\).
DFT (Density Functional Theory)

The adsorption isotherm is known to convey a great deal of information about the energetic heterogeneity and geometric topology of the sample under study. The data of physical adsorption have been used for many years as the basis for methods to characterize the surface area and porosity of adsorbents. Real solid surfaces rarely approach ideal uniformity of structure. It is accepted that in general, the surface of even a nonporous material presents areas of greater or lesser attraction for adsorbed molecules.

This energetic heterogeneity greatly affects the shape of the adsorption isotherm with the result that simple theories such as the Langmuir and BET formulas can, at best, give only approximate estimates of surface area. Porous solids virtually are never characterized by a single pore dimension, but instead exhibit a more or less wide distribution of sizes. The observed adsorption isotherm for a typical material is therefore the convolution of an adsorption process with the distribution of one or more properties which affect that process. This was first stated mathematically by Ross and Olivier for the case of surface energy distribution and has become known as the integral equation of adsorption.

The Integral Equation of Adsorption

In a general form for a single component adsorptive, the integral equation of adsorption can be written as

\[ Q(p) = \int da \; db \; dc \ldots q(p, a, b, c \ldots) \; f(a, b, c \ldots) \quad (1) \]

where

- \( Q(p) \) = the total quantity adsorbed per unit weight at pressure \( p \),
- \( a, b, c, \ldots \) = a set of distributed properties,
- \( f(a, b, c, \ldots) \) = the distribution function of the properties, and
- \( q(p, a, b, c, \ldots) \) = the kernel function describing the adsorption isotherm on unit surface of material with fixed properties \( a, b, c, \ldots \).

Equation (1), a Fredholm integral of the first kind, is a member of a class of problems known as ill-posed, in that there are an infinite number of functional combinations inside the integral that will provide solutions. Even when the kernel function is known, experimental error in the data can make solving for even a single distribution function a difficult task. Solving for multiple distribution functions requires more data than provided by a single adsorption isotherm.
Application to Surface Energy Distribution

Under certain conditions, an energetically heterogeneous surface may be characterized by a distribution of adsorptive energies. The conditions are that the sample is not microporous, i.e., that adsorption is taking place on essentially a free surface with no pore filling processes at least to about 0.2 relative pressure. Secondly, that each energetically distinct patch contributes independently to the total adsorption isotherm in proportion to the fraction of the total surface that it represents. This condition is satisfied if the patches are relatively large compared to an adsorptive molecule, or if the energy gradient along the surface is not steep. In mathematical terms, this concept is expressed by the integral equation of adsorption in the following form.

\[ Q(p) = \int d\varepsilon \ q(p, \varepsilon) \ f(\varepsilon) \]  

(2)

where

\begin{align*}
Q(p) &= \text{the experimental quantity adsorbed per gram at pressure } p, \\
q(p, \varepsilon) &= \text{the quantity adsorbed per unit area at the same pressure, } p, \text{ on an ideal free surface of energy } \varepsilon, \text{ and} \\
f(\varepsilon) &= \text{the total area of surface of energy } \varepsilon \text{ in the sample}
\end{align*}

The exact form of the energy-dependent term depends on the form of the model isotherms expressed in the kernel function and is provided in the library model description in Chapter 5.

Application to Pore Size Distribution

Similarly, a sample of porous material may be characterized by its distribution of pore sizes. It is assumed in this case that each pore acts independently. Each pore size present then contributes to the total adsorption isotherm in proportion to the fraction of the total area of the sample that it represents. Mathematically, this relation is expressed by

\[ Q(p) = \int dH \ q(p, H) \ f(H) \]  

(3)

where

\begin{align*}
Q(p) &= \text{the experimental quantity adsorbed at pressure } p, \\
q(p, H) &= \text{the quantity adsorbed per unit area at the same pressure, } p, \text{ in an ideal pore of size } H, \text{ and} \\
f(H) &= \text{the total area of pores of size } H \text{ in the sample.}
\end{align*}

Numerical values for the kernel functions in the form of model isotherms can be derived from modern statistical mechanics such as density functional theory or molecular simulations, or can be calculated from one of various classical theories based on the Kelvin equation. Several types are found in the models library.
Performing the Deconvolution

The integrations in equations (2) and (3) are carried out over all surface energies or pore sizes in the model. The functions \( q(p,e) \) and \( q(p,H) \), which we call the kernel functions, are contained in numeric form as model isotherms. Because, in general, there is no analytic solution for equation (1), the problem is best solved in a discrete form; the integral equation for any distributed property \( Z \) becomes a summation:

\[
Q(p) = \sum_i q(p, Z_i) f(Z_i)
\]  

Given a set of model isotherms, \( q(p,Z) \), from a model chosen from the models library and an experimental isotherm, \( Q(p) \), contained in a sample information file, the software determines the set of positive values \( f(Z) \) that most nearly, in a least squares sense, solves equation (4). The distributed property, surface energy or pore size, is then displayed on the Report Options dialog box as a selection of tables or graphs.

Regularization

DFT reports allow a selectable regularization (also referred to as smoothing) constraint to be applied during the deconvolution process to avoid over-fitting in the case of noisy data or ill-fitting models. The method used is based on co-minimization of the second derivative of the distribution. The relative weight given to this term is determined by the value of the regularization parameter, which is set on the DFT Pore Size or Surface Energy dialog box and also is shown in the header of reports. The value of the regularization parameter varies from zero (for no second derivative constraint) to ten (indicating a weight equal to minimizing the residuals), or even larger. When the distribution and residuals obtained change little with the value of the regularization parameter, it indicates that the chosen model provides a good representation of the data. Conversely, a large sensitivity to the regularization parameter might indicate inadequate data or a poor choice of model to represent the data.
Heat of Adsorption

The adsorption isostere is represented by

\[ \ln \left( \frac{P}{P_0} \right) = \frac{q_i}{RT} + C \]

where

\[ q_i = \text{isosteric heat of adsorption} \]
\[ C = \text{unknown constant} \]

The isosteric heat of adsorption, \( q_i \), is determined by finding the slope of \( \ln \left( \frac{P}{P_0} \right) \) as a function of \( 1/RT \) for a set of isotherms measured at different temperatures.

Summary Report

The following calculations and the results of previous calculations (as noted) are used to generate the summary report:

a. BET Surface Area

See BET Surface Area Calculations

b. Langmuir Surface Area

See Langmuir Surface Area Calculations

c. Single Point Surface Area (m²/g)

\[ S_{1,Pr} = \left( \frac{V_a \times (1 - Pr)}{CSA} \times \frac{6.023 \times 10^{23}}{22414 \text{ cm}^3 \text{ STP} \times 10^{18} \text{ nm}^2 / \text{m}^2} \right) \]

where

\[ Pr = \text{pressure closest to 0.3 of the relative pressure points designated for surface area calculations.} \]
\[ V_a = \text{volume corresponding to Pr} \]

d. Micropore Area

See t-Plot calculations.
e. Micropore Volume

See t-Plot calculations.

f. Horvath-Kawazoe Maximum Pore Volume

See Horvath-Kawazoe Calculations

g. Horvath-Kawazoe Median Pore Diameter

See Horvath-Kawazoe Calculations

h. Dubinin-Radushkevich Micropore Surface Area

See Dubinin-Radushkevich Calculations

i. Dubinin-Radushkevich Monolayer Capacity

See Dubinin-Radushkevich Calculations

j. Dubinin-Astakhov Micropore Surface Area

See Dubinin-Astakhov Calculations

k. Dubinin-Astakhov Micropore Volume

See Dubinin-Astakhov Calculations

l. MP-Method Cumulative Surface Area of Pores

\[ MPS_{TOT} = S_{CUM} \] (see MP-method Calculations) for the last collected data point used in the MP-method Calculations, and the range of hydraulic pore radii over which the cumulative surface area was computed.

m. MP-Method Cumulative Pore Volume of Pores

\[ MPV_{TOT} = V_{CUM} \] (see MP-method Calculations) for the last collected data point used in the MP-method Calculations, and the range of hydraulic pore radii over which the cumulative pore volume was computed.

n. Average Pore Hydraulic Radius (A)

\[ MP_{DAVER} = \frac{MPV_{TOT}}{MPS_{TOT}} \times 10^{-6} \text{m}^3/cm \times 10^{10} \text{Å/m} \]
SPC Report Variables

Regressions Chart Variables

The line of best fit for the Regression Chart is calculated by the usual Least Squares method. (Refer to BASIC Scientific Subroutines Vol II, by F.R. Ruckdeschel, Copyright 1981 BYTE Publications/McGraw Hill, p. 16.) If there is only a single point or all N points have the same x-value, there can be no line of best fit in the standard form.

\[
\begin{align*}
X_{Ave} &= \frac{\sum x_i}{N} \\
X_{Ave} &= \frac{\sum y_i}{N} \\
Slope &= \frac{\sum (x_i - X_{Ave})(y_i - X_{Ave})}{\sum (x_i - X_{Ave})^2}
\end{align*}
\]

The coefficient of Correlation for this line is also calculated in the usual way. (Refer to Mathematical Handbook for Scientists and Engineers, by Granino A. Korn and Theresa M. Korn, Copyright 1961, 1968 McGraw Hill, Sec. 18.4.)

\[
\begin{align*}
\sigma_x &= \sqrt{\frac{\sum (x_i - X_{Ave})^2}{N}} \\
\sigma_y &= \sqrt{\frac{\sum (y_i - X_{Ave})^2}{N}} \\
Cov(x, y) &= \frac{\sum (x_i - X_{Ave})(y_i - X_{Ave})}{N} \\
Correlation Coefficient &= \frac{Cov(x, y)}{\sigma_x \sigma_y}
\end{align*}
\]
Control Chart Variables

\[ Mean = \frac{\sum y_i}{N} \]

\[ StdDev = \frac{\sum (y - Mean)^2}{N - 1} \]

\[ CoefVar = \frac{StdDev}{Mean} \]

\[ PlusNSig = Mean + n \cdot StdDev \]

\[ MinusNSig = Mean - n \cdot StdDev \]
D. TESTING FOR LEAKS

This appendix contains general instructions for testing the ASAP 2020 and the SmartVac degasser (if installed) for leaks. If the analyzer successfully performs a blank tube analysis using nitrogen, you do not need to test for leaks.

These procedures may be performed individually or sequentially. Record pressure readings on the Valve Test Data Sheet included at the end of this appendix. After you finish testing for leaks, replace any leaking valves.

You will need the following items to perform tests:

- Stopwatch
- Valve Test Data Sheet (included in this appendix)

An automated method of performing a leak test can be found in “Performing a Leak Test” on page 9-16.

Testing Individual Valves

Analysis Valves

This procedure removes differential pressure from all valves in the analysis system and establishes that there are no leaks in the analysis system. It should be performed before testing for individual valves.

1. Ensure that the analyzer is idle.

2. Close the regulator outlet valve for each gas supply line to the analyzer.

3. Attach the Po tube to the Po port.

4. Insert a plug (or attach a clean, empty sample tube) into the analysis port.

5. Insert a plug into the vapor inlet (if the vapor option is not installed).
6. Select **Show Instrument Schematic**, then **Enable Manual Control** from the Unit menu. (For clarity, this illustration shows only the valve portion of the schematic.) Table D-1 lists descriptions of the analysis valves.

![Diagram of analysis valves]

**Table D-1. Analysis Valve Descriptions**

<table>
<thead>
<tr>
<th>Valve</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Unrestricted vacuum</td>
</tr>
<tr>
<td>2</td>
<td>Restricted vacuum</td>
</tr>
<tr>
<td>3</td>
<td>Helium inlet port valve</td>
</tr>
<tr>
<td>4</td>
<td>Restricted analysis gas</td>
</tr>
<tr>
<td>5</td>
<td>Unrestricted analysis gas</td>
</tr>
<tr>
<td>7</td>
<td>Lower manifold isolation</td>
</tr>
<tr>
<td>8</td>
<td>Vapor inlet port</td>
</tr>
<tr>
<td>9</td>
<td>Sample port</td>
</tr>
<tr>
<td>10</td>
<td>Restricted Psat tube port</td>
</tr>
<tr>
<td>11</td>
<td>Unrestricted Psat tube port</td>
</tr>
<tr>
<td>P1 through P6</td>
<td>Gas inlet port valves</td>
</tr>
<tr>
<td>PS</td>
<td>Supply valve for physisorption gases</td>
</tr>
<tr>
<td>PV</td>
<td>Vacuum valve for physisorption gases</td>
</tr>
</tbody>
</table>

7. Open valves 1, 2, 4, 5, and 7; close all other manifold valves.

8. Open valve PS.

9. Open valve 3 and allow the pressure to drop below 1000 \(\mu\text{mHg}\) (1 mmHg).

10. Repeat Step 9 for valves P1 through P6.

12. Open valves 10 and 11.


14. Open valve PV.

15. Allow the system to evacuate for a minimum of one hour; a four-hour or overnight evacuation is preferred.

16. Obtain the manifold outgassing rate:

   Use the pressure transducer with the lowest range. For example, if you have a 1 mmHg transducer, it is the first choice. Next is the 10 mmHg transducer. If you have neither, use the Vacuum Gauge.

   a. Close valves 3, 4, 5, 8, 9, 10, 11, and P1 through P6.

   b. Evacuate manifold for another 30 minutes.

   c. Take a pressure reading; record it as P1 for the manifold.

   d. Close valves 1 and 2.

   e. Wait 10 minutes and take another pressure reading; record it as P2 for the manifold.

   f. Subtract P1 from P2 and divide the difference by 10 to obtain the outgassing rate per minute;

   \[
   \text{Outgassing rate} = \frac{P_2 - P_1}{10}
   \]

   Record this value as the outgassing rate for the manifold. This value should be less than 0.5 \( \mu \text{mHg/min.} \) for the lower manifold alone and less than 0.7 \( \mu \text{mHg/min.} \) for the upper and lower manifolds combined.

17. Obtain the gas inlet valve outgassing rate:

   a. Open valves PS and 5; valve 7 should still be open.

   b. Take a pressure reading; record it as P1 for the gas inlet valve.

   c. Wait 10 minutes and take another pressure reading; record it as P2 for the gas inlet valve.

   d. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing rate for the gas inlet valve. This value should be less than 10 \( \mu \text{mHg/min.} \).
Valves 3 and P1 through P6

1. Open the regulator outlet valve for the gas connected to port 3.
2. Take a pressure reading; record it as P1 for valve 3.
3. Wait 10 minutes and take another pressure reading; record it as P2 for valve 3.
4. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing rate for Valve 3. This value should be less than 0.7 μmHg/min.
5. Repeat Steps 1 through 4 for valves P1 through P6 to which a gas is attached. Record the values on the Valve Test Data Worksheet in the spaces provided.

Valves PS, 5, and 7

1. Close valve PS.
2. Open valve P1 for 60 seconds, then close it.
3. Take a pressure reading; store it as P1 for valve PS.
4. Wait 10 minutes and take another pressure reading; record it as P2 for valve PS.
5. Subtract P1 from P2 and divide the difference by 10; record the value as the outgassing rate for Valve PS. This value should be less than 0.7 μmHg/min.
7. Open valve PS.
8. Open valve P1 for 30 seconds, then close it.
9. Take a pressure reading; record it as P1 for valve 5.
10. Wait 10 minutes and take another pressure reading; record it as P2 for valve 5.
11. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing rate for Valve 5. This value should be less than 0.7 μmHg/min.
12. Close valve 7; open valve 5.
13. Open valve P1 for 30 seconds, then close it.
14. Take a pressure reading; record it as P1 for valve 7.
15. Wait 10 minutes and take another pressure reading; record it as P2 for valve 7.
16. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing rate for Valve 7. This value should be less than 0.5 μmHg/min.
**Valves 1, 2, 8, 9, 10, 11, and PV**

**Valves 10 and 11**

1. Open valve PV; wait 5 minutes (Valves PS and 5 should be open.).
2. Open valve 7; allow the system to evacuate to below 10 \( \mu \text{mHg} \).
3. Close valves PV, PS, and 5.
4. Open valves 1 and 2; allow the system to evacuate for 30 minutes.
   
   Valves 1, 2, and 7 should be the only valves open at this time.
5. Remove the Po tube.
6. Take a pressure reading; record it as \( P_1 \) for valves 10 and 11.
7. Wait 10 minutes and take another pressure reading; record it as \( P_2 \) for valves 10 and 11.
8. Subtract \( P_1 \) from \( P_2 \) and divide the difference by 10; record this value as the outgassing rate for Valves 10 and 11. This value should be less than 0.7 \( \mu \text{mHg/min} \).

**Valve 9**

9. Remove the sample tube from the analysis port.
10. Take a pressure reading; record it as \( P_1 \) for valve 9.
11. Wait 10 minutes and take another pressure reading; record it as \( P_2 \) for valve 9.
12. Subtract \( P_1 \) from \( P_2 \) and divide the difference by 10; record this value as the outgassing rate for valve 9. This should be less than 0.7 \( \mu \text{mHg/min} \).

**Valve 8**

13. With valve 8 closed, remove the plug from the vapor inlet port on the side of the analyzer.

   If the vapor accessory is installed, disconnect it from the analyzer.
14. Take a pressure reading; record it as \( P_1 \) for valve 8.
15. Wait 10 minutes and take another pressure reading; record it as \( P_2 \) for valve 8.
16. Subtract \( P_1 \) from \( P_2 \) and divide the difference by 10; record this value as the outgassing rate for valve 8. This value should be less than 0.7 \( \mu \text{mHg/min} \).
17. Before proceeding, reinstall the sample tube, the Po tube, and the plug from the vapor inlet (or the vapor accessory).
Valves 1, 2, and PV

18. Open valves 1 and 2.

19. Open valves 4, 5, and PS.

20. Allow the system to evacuate for 15 minutes.

21. Close valves 1 and 2. Valve PV should be closed; if not, close it.

22. Take a pressure reading; record it as P1 for valves 1, 2, and PV.

23. Wait 10 minutes and take another pressure reading; record it as P2 for valves 1, 2, and PV.

24. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing rate for valves 1, 2, and PV. This value should be less than 0.7 \text{\mu}Hg/min.

25. Fill the manifold to 800 mmHg with \text{N}_2, then close the nitrogen port valve.


27. Take a pressure reading; record it as P1 for valve PV.

28. Wait 10 minutes and take another pressure reading; record it as P2 for valve PV.

29. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing rate for valve PV. This value should be less than 50 \text{\mu}Hg/min.

If the pressure drops more than 0.05 mmHg, close valve 5, the PV valve may be leaking.

30. Take another pressure reading; record it as P1 for valves 1 and 2.

31. Wait 10 minutes and take another pressure reading; record it as P2 for valves 1 and 2.

32. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing rate for valves 1 and 2. This value should be less than 50 \text{\mu}Hg/min.

If the pressure drops more than 0.05 mmHg, close valve 7, valves 1 or 2 may be leaking.

33. Take another pressure reading; record it as P1 for valve 1.

34. Wait 10 minutes and take another pressure reading; record it as P2 for valve 1.

35. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing rate for valve 1. This value should be less than 50 \text{\mu}Hg/min.

If the pressure drops more than 0.05 mmHg, valve 1 may be leaking.
Degas Valves

Perform the following steps to measure the degas manifold outgas rate.

1. Ensure that the degas system is idle.
2. Close the regulator outlet valve for the backfill gas.
3. Insert a plug (or attach a clean, empty sample tube) into each degas port.
4. Select Degas, Show Degas Schematic, then Degas, Enable Manual Control from the Unit menu. (For clarity, this illustration shows only the valve portion of the schematic.) Table D-2 lists descriptions of the degas valves.

![Degas Schematic Diagram]

Table D-2. Degas Valve Descriptions

<table>
<thead>
<tr>
<th>Valve</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1 and D2</td>
<td>Degas port valves</td>
</tr>
<tr>
<td>D5</td>
<td>Vacuum valve</td>
</tr>
<tr>
<td>D6</td>
<td>Servo isolation valve</td>
</tr>
<tr>
<td>D7</td>
<td>Gas inlet port valve</td>
</tr>
</tbody>
</table>

5. Open Valves D5, D1, D2, and then D7.
7. Allow the degas system to evacuate below 10 μmHg, then evacuate for 60 minutes.
8. Close Valves D1, D2, D5, D6, and D7.
9. Take a pressure reading and record it as P1 for the preliminary test.
10. Wait 10 minutes and take another reading; record it as P2 for the preliminary test.
11. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing rate for the preliminary test. This value should be less than 10 μmHg/min.
What To Do If You Detect a Leaking Valve

If you determine that a specific valve is leaking, remove differential pressure from the valve and continue testing the remaining valves for leaks.

As an alternative, you may repair or replace the leaking valve after removing the differential pressure on the valve. However, opening the analysis system to replace or repair a valve exposes the analyzer manifold to atmospheric gases and moisture. These gases and moisture greatly increase the time required to evacuate the analyzer and prepare it for further testing or operation.

Removing Differential Pressure from a Leaking Valve

1. Select either of the following actions:
   • Close the regulator outlet valve for the gas supply line to the valve.
   • Reinstall the plug that was removed to test the valve.

2. Open the leaking valve.

3. Evacuate the analyzer until you obtain an outgas rate of less than 0.7 μmHg per minute. Refer to Testing Individual Valves on page D-1 for detailed instructions on determining the outgas rate for specific valves.

Repairing or Replacing a Leaking Valve

Whether you repair or replace a valve depends on the type of valve that is leaking.

• Valves on the Analysis manifold should be repaired
• Valves on the Degas and inlet manifold should be replaced.

Repairing Valves on the Analysis Manifold

1. Backfill the manifold with nitrogen to approximately 800 mmHg.
   • Close off the helium gas supply if you are repairing the helium inlet valve.
   • Turn off the vacuum pump system if you are repairing a vacuum valve.

2. Remove and replace the plunger and the thin gasket on the leaking valve.
3. Closely inspect the valve seat area for any debris which may cause another leak.

4. Reassemble the valve.
   - Reopen the helium supply if you are repairing the helium inlet valve.
   - Turn on the vacuum pump system if you are repairing a vacuum valve.

5. Open and close the repaired valve approximately 20 to 30 times; this allows the valve to seat properly.

6. Evacuate the analyzer until the outgas rate is less than 0.7 μmHg per minute. Refer to Testing Individual Valves on page D-1 for detailed instructions.
Replacing Valves on the Degas and Gas Inlet Manifold

1. Backfill the manifold with nitrogen to approximately 800 mmHg.
2. Turn off the gas supply for the gas inlet valves.
3. Turn off the vacuum pump system for degas valves D5 and D6.
4. Carefully remove the wires to the valve coil.
5. Unscrew and remove the valve from the manifold.
6. Install the new valve, then reconnect the wiring.
7. Turn on the gas supply and vacuum pump system.
8. Evacuate the analyzer until the outgas rate is less than 0.7 μmHg/min. for inlet valves or 10 μmHg/min. for degas valves. Refer to Testing Individual Valves on page D-1 for detailed instructions.
Valve Data Test Sheet

Make a copy of this form to record pressure readings and outgassing rates when leak-testing system valves.

<table>
<thead>
<tr>
<th>VALVE(s)</th>
<th>P1</th>
<th>P2</th>
<th>OUTGASSING RATE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(1st pressure reading)</td>
<td>(2nd pressure reading)</td>
<td></td>
</tr>
<tr>
<td>Analysis Valves</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manifold</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gas inlet valve</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 and 11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1, 2, and PV</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1, 2, and PV</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 and 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Degas Valves</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manifold</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
E. CALCULATING FREE-SPACE VALUES FOR MICROPOROUS ANALYSES

Many microporous materials, such as zeolites and activated carbons, trap and hold helium in their complex pore structures for many hours after being exposed to helium. Helium trapped in micropores can interfere with the analysis at low pressures, causing an “S”-shaped curve at the lower end of the isotherm. For this reason, it is recommended that you enter the warm and cold free-space volumes when performing micropore analyses, therefore avoiding exposure of the sample to helium. Two techniques can be used for determining warm and cold free-space values.

The first method is to perform a short analysis on the sample after partial degassing (one pressure point with no incremental dosing), but prior to final sample preparation. Measure the free space during this analysis. The measured free-space values will be printed on the report and may then be entered into the sample file after more thorough sample preparation.

The second method requires prior tests using empty tubes that will be employed later for the sample analyses. The measured free-space data can be used thereafter on every analysis performed using these sample tubes. This small initial investment of time will save considerable time later. Perform an empty tube analysis on each sample tube you intend to use for micropore analysis. Measure the free space of each sample tube, taking only one pressure point. Four important things to remember are: 1) be consistent in using seal frits; for example, use the same seal frits for the analysis as you did for the empty tube test; 2) since the cold free space is dependent on bath temperature, perform a test for each bath temperature to be used; 3) the isothermal jacket must be in the same position for the sample analysis as it was for the empty tube test; and 4) correct the free-space volumes obtained for the volume displaced by the sample when you use them.

To make the correction, subtract the amount of gas displaced by the sample. The calculations are simple and are given here with a brief explanation of their derivation. Remember to employ the appropriate free-space values for each bath temperature used, stating all temperatures in Kelvin.

To correct warm free space:

\[
V_{ws} = V_{wm} - \left(\frac{M_s}{r_s} \times \frac{T_{std}}{T_{amb}}\right)
\]

where

- \(V_{ws}\) = calculated warm free space with sample present (in standard cm\(^3\))
- \(V_{wm}\) = warm free space measured for the empty tube (in standard cm\(^3\))
- \(M_s\) = mass of sample to be analyzed (in grams)
- \(r_s\) = approximate sample true density (in grams/cm\(^3\))
- \(T_{amb}\) = ambient temperature (in Kelvin)
- \(T_{std}\) = standard temperature (273.15 Kelvin)
To correct cold free space:

where

\[ V_{cs} = \text{calculated cold free space with sample present (in standard cm}^3\text{)} \]
\[ V_{cm} = \text{cold free space measured for the empty tube (in standard cm}^3\text{)} \]
\[ M_s = \text{mass of the sample to be analyzed (in grams)} \]
\[ r_s = \text{approximate sample true density (in grams/cm}^3\text{)} \]
\[ T_{bath} = \text{analysis bath temperature (in Kelvin)} \]
\[ T_{std} = \text{standard temperature (273.15 Kelvin)} \]

When you later analyze a sample, select Enter Free Space, and use the values calculated above.

Example:
The sample is 0.2345 grams of activated carbon with a density of 2.0000 g/cm\(^3\). The room temperature is 22 °C or 295.15 K. The analysis tube has been measured previously in an argon bath. The measured warm and cold free spaces are 29.1234 and 89.4567 cm\(^3\) STP atm\(^{-1}\), respectively. The analysis will be performed with argon at liquid argon temperature, 87.3 K.

With this information, enter the corrected warm free space as follows:

\[
V_{ws} = 29.1234 \text{ cm}^3 \text{ STP} - \left( \frac{0.2345 \text{ g}}{2.0000 \text{ g/cm}^3} \times \frac{273.2 \text{ K}}{295.2 \text{ K}} \right) = 29.0149 \text{ cm}^3 \text{ STP atm}^{-1}
\]

and enter the corrected cold free space as follows:

\[
V_{cs} = 89.4567 \text{ cm}^3 \text{ STP} - \left( \frac{0.2345 \text{ g}}{2.0000 \text{ g/cm}^3} \times \frac{273.2 \text{ K}}{87.3 \text{ K}} \right) = 89.0898 \text{ cm}^3 \text{ STP atm}^{-1}
\]
### F. DEFAULT FILES AND SYSTEM FILES

The following table describes the default analysis conditions files provided with the ASAP 2020 software. The values in these files may not be universally accepted. You may change them if necessary.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>13XARLAR.ANC</td>
<td>13x reference material, argon, @ 87.29 K</td>
</tr>
<tr>
<td>13XARLN2.ANC</td>
<td>13x reference material, argon, @ 77.35 K</td>
</tr>
<tr>
<td>ALUMINA.ANC</td>
<td>Alumina reference material, krypton, @ 77.35 K</td>
</tr>
<tr>
<td>BJHADS42.ANC</td>
<td>BJH 42-point adsorption</td>
</tr>
<tr>
<td>BJHDES43.ANC</td>
<td>BJH 43-point desorption</td>
</tr>
<tr>
<td>CHARCOAL.ANC</td>
<td>Charcoal reference material, carbon dioxide, @ 273.15 K</td>
</tr>
<tr>
<td>KBLANK.ANC</td>
<td>Krypton blank tube run</td>
</tr>
<tr>
<td>KSTDRD.ANC</td>
<td>Krypton standard</td>
</tr>
<tr>
<td>NBLANK.ANC</td>
<td>Nitrogen blank tube run</td>
</tr>
<tr>
<td>NSTDRD.ANC</td>
<td>Nitrogen standard</td>
</tr>
<tr>
<td>SILALUMF.ANC</td>
<td>Silica-alumina reference material, nitrogen; adsorption/desorption</td>
</tr>
<tr>
<td>SILALUMS.ANC</td>
<td>Silica-alumina reference material, nitrogen; adsorption only</td>
</tr>
<tr>
<td>SURF1.ANC</td>
<td>One-point surface area, nitrogen</td>
</tr>
<tr>
<td>SURF3.ANC</td>
<td>Three-point surface area, nitrogen</td>
</tr>
<tr>
<td>SURF5.ANC</td>
<td>Five-point surface area, nitrogen</td>
</tr>
<tr>
<td>SURF5LOW.ANC</td>
<td>Five-point low surface area, nitrogen</td>
</tr>
<tr>
<td>T-PLOT.ANC</td>
<td>19-point t-Plot using nitrogen, nitrogen</td>
</tr>
<tr>
<td>VOLUME.ANC</td>
<td>Volume ball run</td>
</tr>
</tbody>
</table>
The following table describes the default adsorptive properties files provided with the ASAP 2020 software. The values in these files may not be universally accepted. You may change them if necessary.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARLAR.ADP</td>
<td>Argon, liquid argon temperature @ 87.29 K</td>
</tr>
<tr>
<td>ARLN2.ADP</td>
<td>Argon, liquid nitrogen temperature @ 77.35 K</td>
</tr>
<tr>
<td>CO2.ADP</td>
<td>Carbon dioxide @ 273.15 K</td>
</tr>
<tr>
<td>KR_SOLID.ADP</td>
<td>Krypton @ 77.35 K (Solid Psat vs. Temperature)</td>
</tr>
<tr>
<td>KRYPTON.ADP</td>
<td>Krypton @ 77.35 K</td>
</tr>
<tr>
<td>NITROGEN.ADP</td>
<td>Nitrogen @ 77.35 K</td>
</tr>
<tr>
<td>OXYGEN.ADP</td>
<td>Oxygen @ 77.35 K</td>
</tr>
</tbody>
</table>

The following table describes the default report options files provided with the ASAP 2020 software. The values in these files may not be universally accepted. You may change them if necessary.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BJHADS.RPO</td>
<td>BJH adsorption</td>
</tr>
<tr>
<td>BJHDES.RPO</td>
<td>BJH desorption</td>
</tr>
<tr>
<td>FULL.RPO</td>
<td>Full: includes Isotherm, BET, Langmuir, BJH adsorption, BJH desorption, t-Plot</td>
</tr>
<tr>
<td>SURF.RPO</td>
<td>Isotherm, BET, Langmuir</td>
</tr>
<tr>
<td>T-Plot.RPO</td>
<td>t-Plot</td>
</tr>
</tbody>
</table>
The following table describes the files created by the ASAP 2020 software.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>* ASAP2020.INI</td>
<td>ASCII file containing initialization information used during program startup as well as system options information.</td>
</tr>
<tr>
<td>* ASAP2020.SMP</td>
<td>Binary file containing 2020 sample defaults.</td>
</tr>
<tr>
<td>2020-N.STS</td>
<td>Binary file containing 2020 instrument status information and calibration data. The letter N in the file name represents the unit number of the instrument for which information applies.</td>
</tr>
<tr>
<td>* ASAP 2020.LOG</td>
<td>ASCII file containing a recorded log of all error messages displayed on the screen.</td>
</tr>
<tr>
<td>* N.LOG</td>
<td>Binary log file for analyzer with serial number contents accessible using the Show Instrument Log option on the Unit menu.</td>
</tr>
</tbody>
</table>

*Do not attempt to edit this file. Personal injury or damage to the ASAP 2020 could result because the operator may be given erroneous status information.*

*Back up these files periodically to ensure data integrity. You may want to store each backup set on a separate CD so you have access to different versions of the files. For example, ASAP 2020.SMP contains the default sample information. Any time the sample defaults are changed, an updated ASAP2020.SMP is created. Keeping version backups of this file by storing each on a separate CD allows restoration of any version desired.*
G. DFT MODELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In the experimental physical sciences, theories are often expressed in terms of a model that can be visualized and described mathematically. Early models of physical adsorption were quite simple, both conceptually and mathematically, for very practical reasons — hand computations were required. Today we can explore complex models that describe adsorption systems on the atomic scale of size and sub-picosecond time frame. This is not because scientists are smarter, but because of available tools. The DFT models are created by classical approaches to adsorption as well as models based on modern statistical thermodynamics.

Models Based on Statistical Thermodynamics

Included in this group are methods that model the adsorption system in terms of forces acting between individual molecules.

Theoretical Background

Traditional adsorption theories attempt to describe experimental adsorption isotherms with an isotherm equation containing a small number of parameters. At a minimum, these parameters include the extent of the surface, such as the monolayer capacity (Vm), and the molar intensity of the gas-surface interaction, such as the Langmuir “K” constant or the BET “C” constant. In some equations, additional parameters take into account the lateral interaction of adsorbed molecules with each other. Other theories, such as the Dubinin-Astakhov approach, also include parameters for the effect of adsorbent porosity.

Instead of this classical kinetic or phenomenological approach, we can use a molecular-based statistical thermodynamic theory that allows us to relate the adsorption isotherm to the microscopic properties of the system: the fluid-fluid and fluid-solid interaction energy parameters, the pore size, the pore geometry, and the temperature.

The following example is given so that you may understand how such a theory is constructed.

A clean sample of a solid material containing slit-shaped pores of a single width is placed in an evacuated space. It is kept at a fixed temperature as a known quantity of pure argon gas is admitted into the space surrounding the sample. The pressure within the space is recorded over time. In this situation, the pressure falls rapidly from its initial value and gradually approaches a steady reading, called the equilibrium pressure. The amount adsorbed corresponds to the quantity of gas effectively removed from the gas phase by the solid surface. A graph that plots amount adsorbed versus equilibrium pressure is called an adsorption isotherm.

Under such conditions, the argon atoms that randomly enter the pore space feel the presence of the solid surface as the action of an external attractive force (the dispersion forces or Van der Waal’s forces) and spend more time near the surface. As a result, the space near the surface acquires a greater average density of argon atoms than regions farther removed.
If the equilibrium distribution of the gas atoms near the surface could be described as a function of pressure and the molecular properties of the components of the system, then a model could be constructed for the adsorption isotherm for the system. Modern physical chemistry provides several ways to calculate this distribution. All these methods are based on the fundamental thermodynamic law that such a system adopts a configuration of minimum free energy at equilibrium. Also needed is a description of the pairwise interaction energy between atoms, $U(s)$, commonly given by a Lennard-Jones potential:

$$U(s) = \left( \frac{\sigma}{s} \right)^{12} - \left( \frac{\sigma}{s} \right)^{6}$$

where

- $\varepsilon$ = a characteristic energy of the adsorptive,
- $\sigma$ = the diameter of the adsorptive molecule, and
- $s$ = the separation distance.

### Molecular Simulation Methods

Two simulation techniques are commonly used to determine the distribution of gas molecules in a system in equilibrium: the molecular dynamics method and the Monte Carlo method. Both of these are used as reference methods because their results are considered exact.

#### Molecular Dynamics Method

In the molecular dynamics method, the position and velocity of individual gas particles are calculated over time at very short intervals. This method takes into account both the forces acting between the gas particles themselves and those acting between the gas particles and the atoms of the simulated surface. As the simulated particles collide with each other and with the surface, the average concentration of particles in the space near the surface is calculated; this calculation yields the amount of gas adsorbed.

This method can be thought of as a way to determine the chronological record of the movement of each particle in the system using time steps of 10-14 seconds. Although the mathematics are simple, the number of calculations required for a system of even a few hundred particles is astronomical and challenges even the fastest computers.

#### Monte Carlo Method

In the Monte Carlo method, determination of the system equilibrium distribution begins with an assumption (which may be only approximate) about the initial configuration of particles in the system. The system is “equilibrated” through a process of randomly selecting one particle and conditionally moving it a random distance in a random direction.

If the move results in a configuration of lower total energy, then the move is completed and another particle is randomly selected to be moved.
If the move results in a configuration of higher energy, a probability for that event is calculated, and a random number between zero and one is generated. If the generated number is smaller than the probability of the event, then the move is accepted; otherwise, another particle is selected and the process is repeated. This process continues until the average total energy of the system no longer decreases; at this point, average configuration data are accumulated to yield the mean density distribution of particles in the system.

Monte Carlo simulations require considerably less computation time than molecular dynamic simulations and can yield the same results; however, neither method provides a really practical way to calculate complete isotherms.

**Density Functional Formulation**

*Density functional theory* offers a practical alternative to both molecular dynamic and Monte Carlo simulations. When compared to reference methods based on molecular simulation, this theory provides an accurate method of describing inhomogeneous systems yet requires fewer calculations. Because the density functional theory provides accuracy and a reduced number of calculations, it is the basis embodied in the DFT models.

The system being modeled consists of a single pore represented by two parallel walls separated by a distance H. The pore is open and immersed in a single component fluid (adsorptive) at a fixed temperature and pressure. Under such conditions, the fluid responds to the walls and reaches an equilibrium distribution. In this condition (by the definition of equilibrium), the chemical potential at every point equals the chemical potential of the bulk fluid. The bulk fluid is a homogenous system of constant density; its chemical potential* is determined by the pressure of the system using well-known equations. The fluid near the walls is not of constant density; its chemical potential is composed of several position-dependent contributions that must total at every point to the same value as the chemical potential of the bulk fluid.

As noted previously, at equilibrium, the whole system has a minimum (Helmholtz) free energy, known thermodynamically as the grand potential energy (GPE). Density functional theory describes the thermodynamic grand potential as a functional of the single-particle density distribution; therefore, calculating the density profile that minimizes the GPE yields the equilibrium density profile. The calculation method requires the solution of a system of complex integral equations that are implicit functions of the density vector. Since analytic solutions are not possible, the problem must be solved using iterative numerical methods. Although calculation using these methods still requires supercomputing speed, the calculation of many isotherm pressure points for a wide range of pore sizes is a feasible task. The complete details of the theory and the mathematics can be found in the papers listed under References at the end of this appendix.

The following graphs and accompanying text illustrate the results of using density functional theory to predict the behavior of a model system.

---

*Chemical potential may be thought of as the energy change felt by a probe particle when it is inserted into the system from a reference point outside the system. It can also be defined as the partial derivative of the grand potential energy with respect to density (or concentration).
Figure G-1 shows the density profile for argon at a carbon surface as calculated by density functional theory for a temperature of 87.3 K and a relative pressure of about 0.5.

This figure represents a cross-section of the region near the surface. Note the layerwise distribution of adsorbate; the first monolayer is sharply defined and a third layer can be distinguished. The area under the profile curve represents the amount adsorbed per unit area at this pressure. The positions of the maxima are separated by a distance determined by the size of the adsorptive atom.

Given the density profile, the amount adsorbed at the stated pressure can be easily calculated as the integral over the profile. Repeating this calculation over a range of pressures yields the adsorption isotherm for the model. If the value of $H$ is very large, the isotherm obtained corresponds to that of an external, or free, surface. If $H$ is smaller, a range of pressures is reached where two minima exist for the grand potential, showing the presence of two metastable phases having different density distributions but the same chemical potential. The phase with the lower GPE is the stable one. As the pressure is increased, a point is reached where the other phase becomes the stable one. This phase transition reflects condensation of adsorbate in the pore; the pressure at which it occurs is called the critical pore-filling pressure. This pressure is analogous to the condensation pressure predicted by the Kelvin equation in the classical model of pore filling.

Figure G-2 shows how the profiles change with pressure for a model pore with $H = 40$ angstroms. The insets show the density profiles for the corresponding points of the isotherm.
Figure G-2. Model Isotherm for Argon at 87.3 K in a 40 Å Slit in a Carbon Substrate

The profiles show the density distribution from one wall to the center of the slit; the other half of the distribution is a mirror image of the profile shown.

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position close to the surface.

- Inset a shows the profile corresponding to point a on the isotherm where the surface is about half covered.

- At point b, the first layer is so full that it is more favorable for atoms to start a new layer.

- At point c, a third layer is forming. Point c, for this size slit, is the critical pore-filling pressure. In inset c, the profile shows the density decreasing to near zero (actually the bulk gas density) at 4 or 5 molecular diameters from the surface.

- Inset d shows the profile converging on a density similar to that of bulk liquid argon in the center of the pore, indicating a phase transition.

Note that the adsorption isotherms for pores larger than the one shown in Figure G-2 is identical up to point c. The lower branch of the isotherm simply continues to a higher pressure for larger pores. This trend is illustrated in Figure G-3, where isotherms for some larger size pores are shown. It is clear that pore size is uniquely characterized by a corresponding critical pore-filling pressure. At large pore sizes, density functional theory produces results for the critical filling pressures that are in good agreement with those produced by the Kelvin equation.
Figure G-3. Model Isotherms for Some Larger Pore Widths Argon on Carbon at 87.3 K

Figure G-4 shows model isotherms for pores in the micropore size range. Note the logarithmic scale for pressure.

Figure G-4. Model Isotherms in the Micropore Size Range of Pore Width Argon on Carbon at 87.3 K
Pores of 4 Å width, barely larger than the argon atom (3.38 Å), fill at pressures below 1 millitorr. Pores below 15 Å fill before a monolayer is completed on the surface of the larger pores. In the micropore size range, the pore volume fills more gradually with pressure and the total shape of the isotherm is important in characterizing the pore size.

### Models Included

#### Non-Local Density Functional Theory with Density-Independent Weights

- **N2 - DFT Model**
- **AR - DFT Model**

<table>
<thead>
<tr>
<th>Geometry:</th>
<th>Slit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substrate:</td>
<td>Carbon (graphite)</td>
</tr>
<tr>
<td>Category:</td>
<td>Porosity</td>
</tr>
<tr>
<td>Method:</td>
<td>Nitrogen at 77 K; Argon at 87 K</td>
</tr>
</tbody>
</table>

Using the methods of non-local density functional theory, two sets of isotherms have been calculated to serve as kernel functions for the characterization of porous solids from adsorption data. The model isotherms are stored in binary format files. These models assume a *slit-like pore geometry*. The pore size range from 4.0 to 4000 Å is covered in 91 classes in a geometric progression. The class intervals are rounded to the nearest 0.02 molecular diameters. A model for the free or external surface is included to account for unfilled pores. Each of the 92 model isotherms has been calculated at 181 pressure points from near $1 \times 10^{-6}$ to near 1.00 relative pressure.

These models are identical to those supplied with the original DOS version of DFT software. Some slight difference from the DOS results may be noted when they are applied to the same data due to improvements in the deconvolution algorithm and better regularization of the current software.

#### Non-Local Density Functional Theory with Density-Dependent Weights

- **N2 - Modified Density Functional**

<table>
<thead>
<tr>
<th>Geometry:</th>
<th>Free surface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substrate:</td>
<td>Surface energy</td>
</tr>
<tr>
<td>Method:</td>
<td>Nitrogen at 77K</td>
</tr>
</tbody>
</table>

Using the modified Tarazona prescription described by Olivier (refer to References, references 3 and 4), model isotherms were calculated for a wide range of adsorptive energies to a relative pressure of 0.6. The model makes no provision for pore filling in the micropore region. If the sample solid contains small mesopores, the isotherm data should be truncated (using the Select Data Points dialog box) to a suitably low relative pressure to avoid trying to fit this region; mesopore filling reports as a large area of low energy in the calculated distribution of adsorptive potential.
The surface energy is reported in terms of the effective Lennard-Jones interaction parameter, \( e \), for the adsorptive/adsorbent pair divided by Boltzmann’s constant. The units are therefore Kelvins.

**N2 - Cylindrical Pores - Oxide Surface**  
**AR - Cylindrical Pores - Oxide Surface**

<table>
<thead>
<tr>
<th>Geometry:</th>
<th>Cylinder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substrate:</td>
<td>Oxide</td>
</tr>
<tr>
<td>Category:</td>
<td>Porosity</td>
</tr>
<tr>
<td>Method:</td>
<td>Nitrogen at 77 K; Argon at 87 K</td>
</tr>
</tbody>
</table>

Model isotherms were calculated using a combination of statistical mechanical calculations and experimental observations for macroporous silicas and MCM-41 mesoporous silicas as well as zeolites. The pore-filling pressures were determined as a function of the pore size from adsorption isotherms on MCM-41 materials characterized by X-ray and other techniques. The variation of the pore fluid density with pressure and pore size has been accounted for by density functional theory calculations. The N2 model reports pore sizes ranging from 3.8 to 387 angstroms and the AR model from 3.8 to over 500 angstroms.


**N2 – Cylindrical Pores – Pillared Clay Surface (Montmorillonite)**

<table>
<thead>
<tr>
<th>Geometry:</th>
<th>Cylinder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substrate:</td>
<td>Crystalline Silicate</td>
</tr>
<tr>
<td>Category:</td>
<td>Porosity</td>
</tr>
<tr>
<td>Method:</td>
<td>Nitrogen at 77 K</td>
</tr>
</tbody>
</table>

Model isotherms were calculated using a combination of statistical thermodynamic Non-Local Density Functional Theory (NLDFT) calculations and experimental isotherms for reference samples of montmorillonite. The construction method for the hybrid models was analogous to that described in the first reference below (Jaroniec et al,1999). The additional references add additional theoretical details as well as examples of the application of the model to pillared clay catalysts. This model reports pore widths from 3.8 to 387 angstroms.


C02 - DFT Model

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Carbon dioxide at 273 K

Model isotherms were calculated, using the non-local prescription of Tarazona, employing molecular parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional Model

Geometry: Free Surface
Substrate: Any
Category: Surface energy
Method: Argon at 87 K

This model was produced in the same manner as the N2 Modified Density Functional model listed earlier, except applicable to argon adsorbed at 87.3 K.
**N2 - Tarazona NLDFT, Esf = 30.0K**

**Geometry:** Cylinder  
**Substrate:** Oxide  
**Category:** Porosity  
**Method:** Nitrogen at 77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting functions and a cylindrical pore geometry. The wall potential used is $k = 30 \text{ K}$, typical for a silica or alumina surface.

This model file is particularly useful for sizing zeolites or zeolite containing materials that have substantial micropore volume. The reported pore size range is 3.8 to 387 angstroms.


**N2 - Carbon Slit Pores by NLDFT**  
**Ar - Carbon Slit Pores by NLDFT**

**Geometry:** Slit  
**Substrate:** Carbon  
**Category:** Porosity  
**Method:** Nitrogen at 77 K; Argon at 87 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting functions and a slit-like pore geometry. These models are slightly different from N2-DFT and Ar-DFT models that were calculated using NLDFT with density independent weighting functions.

The reported pore size range is from 3.5 to 1000 angstroms.


**N2 - Carbon Finite Pores, As=6, 2D-NLDFT**  
**Ar - Carbon Finite Pores, As=6, 2D-NLDFT**

**Geometry:** Finite Slit  
**Substrate:** Carbon  
**Category:** Porosity  
**Method:** Nitrogen at 77 K; Argon at 87 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting functions assuming 2D model of finite slit pores having a diameter-to-width aspect ratio of 6.
This model is particularly useful for microporous carbon materials. The reported pore size range is from 3.5 to 250 angstroms.


### N2 - Carbon Finite Pores, As=12, 2D-NLDFT

**Ar - Carbon Finite Pores, As=12, 2D-NLDFT**

- **Geometry:** Finite Slit
- **Substrate:** Carbon
- **Category:** Porosity
- **Method:** Nitrogen at 77 K; Argon at 87 K

Model isotherms were calculated using the same methods and assumptions that were used in the model above except in this model, the aspect ratio is equal to 12.

These two finite pore models may be used as a research tool in conjunction with independent analytical techniques such as high-resolution transmission electron microscopy (HRTEM) and/or X-ray diffraction (XRD) to obtain comprehensive information about the structure of studied carbon material.

**Reference:** See above reference.

### N2 - Carbon Cylinder, single-wall nanotube by NLDFT

**Ar - Argon Cylinder, single-wall nanotube by NLDFT**

- **Geometry:** Cylinder
- **Substrate:** Carbon
- **Category:** Porosity
- **Method:** Nitrogen at 77 K; Argon at 87K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting functions and cylindrical pore geometry. The pore wall potential is described by the Lennard-Jones potential of interaction between a gas molecule and the graphitic surface of an infinitely long cylinder.

This model is particularly useful for characterizing carbon single-wall nanotubes. The reported pore size range is from 3.5 to 1000 angstroms.

N2 - Carbon Cylinder, multi-wall nanotube by NLDFT
Ar - Argon Cylinder, multi-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting functions and cylindrical pore geometry. The pore wall potential is described by the Lennard-Jones potential of interaction between a gas molecule and multiple concentric graphitic surfaces of infinitely long cylinders.

This model is particularly useful for characterizing carbon multi-wall nanotubes. The reported pore size range is from 3.5 to 1000 angstroms.

Reference: See above reference.

Ar - Zeolites H-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting functions and cylindrical pore geometry. The pore wall potential is described by the Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an infinitely long cylinder.

This model is particularly useful for characterizing oxides and H\(^+\) and (NH\(_4\))\(^+\) exchanged zeolites. The reported pore size range is from 3.5 to 300 angstroms.

Ar - Zeolites Me-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting functions and cylindrical pore geometry. The pore wall potential is described by the Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an infinitely long cylinder.

This model is similar to the model above but it more appropriate is for characterizing alkali metal exchanged zeolites. The reported pore size range is from 3.5 to 300 angstroms.
Models Based on Classical Theories

Both surface energy distribution and pore size distribution may be evaluated using classical approaches to model kernel functions for use with equation (1) of the DFT Theory in the calculations appendix. Be aware that the deconvolution method only provides a fitting mechanism; it does not overcome any inherent shortcomings in the underlying theory.

Surface Energy

The use of classical theories to extract adsorptive potential distribution is mostly of historical interest. At a minimum, the equation must contain a parameter dependent on adsorption energy and another dependent on monolayer capacity, or surface area. This is sufficient to permit the calculation of the set of model isotherms that is used to create a library model. The Langmuir equation has been used in the past, as have the Hill-de Boer equation and the Fowler-Guggenheim equation. All of these suffer from the fact that they only describe monolayer adsorption, whereas the data may include contributions from multilayer formation.

Pore Size

It is well established that the pore space of a mesoporous solid fills with condensed adsorbate at pressures somewhat below the prevailing saturated vapor pressure of the adsorptive. When combined with a correlating function that relates pore size with a critical condensation pressure, this knowledge can be used to characterize the mesopore size distribution of the adsorbent. The correlating function most commonly used is the Kelvin equation. Refinements make allowance for the reduction of the physical pore size by the thickness of the adsorbed film existing at the critical condensation pressure. Still further refinements adjust the film thickness for the curvature of the pore wall.

The commonly used practical methods of extracting mesopore distribution from isotherm data using Kelvin-based theories, such as the BJH method, were for the most part developed decades ago and were designed for hand computation using relatively few experimental points. In general, these methods visualize the incremental decomposition of an experimental isotherm, starting at the highest relative pressure or pore size. At each step, the quantity of adsorptive involved is divided between pore emptying and film thinning processes and exactly is accounted for. This computational algorithm frequently leads to inconsistencies when carried to small mesopore sizes. If the thickness curve used is too steep, it finally will predict a larger increment of adsorptive for a given pressure increment than is actually observed; since a negative pore volume is non-physical, the algorithm must stop. Conversely, if the thickness curve used underestimates film thinning, accumulated error results in the calculation of an overly large volume of (possibly nonexistent) small pores.

The use of equation (1) represents an improvement over the traditional algorithm. Kernel functions corresponding to various classical Kelvin-based methods have been calculated for differing geometries and included in the list of models.
Models Included

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

The kernel function is calculated using the Halsey equation with standard parameters:

\[ t = 3.54 \left( \frac{-5.00}{\ln(P/P_0)} \right)^{1/3} \]

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm\(^{-1}\)
Molar density = 0.02887 g cm\(^{-3}\)

N2 - Halsey Thickness Curve

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

The calculation is the same as above except that cylindrical geometry is assumed.


Kelvin Equation with Harkins and Jura Thickness Curve

N2 - Harkins and Jura Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

The kernel function is calculated using the Harkins and Jura equation with standard parameters:
The nitrogen properties used in the Kelvin equation are:

\[
\begin{align*}
\text{Surface tension} & \quad = \quad 8.88 \text{ dynes cm}^{-1} \\
\text{Molar density} & \quad = \quad 0.02887 \text{ g cm}^{-3}
\end{align*}
\]

**N2 - Harkins and Jura Thickness Curve**

- **Geometry:** Cylinder
- **Substrate:** Average
- **Category:** Porosity
- **Method:** Nitrogen at 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

**References:**

- W. D. Harkins and G. Jura, J.A.C.S. 66, 1366 (1944)
- J. H. DeBoer et al., J. Colloid and Interface Sci. 21, 405 (1966)

**Kelvin Equation with Broekhoff-de Boer Thickness Curve**

**N2 - Broekhoff-de Boer Model**

- **Geometry:** Slit
- **Substrate:** Average
- **Category:** Porosity
- **Method:** Nitrogen at 77 K

The kernel function is calculated using the Broekhoff-de Boer equation with standard parameters:

\[
t = \left( \frac{13.99}{0.034 - \log(P/P_0)} \right)^{1/2}
\]

The nitrogen properties used in the Kelvin equation are:

\[
\begin{align*}
\text{Surface tension} & \quad = \quad 8.88 \text{ dynes cm}^{-1} \\
\text{Molar density} & \quad = \quad 0.02887 \text{ g cm}^{-3}
\end{align*}
\]

**N2 - Broekhoff-de Boer Model**

- **Geometry:** Cylinder
- **Substrate:** Average
- **Category:** Porosity
- **Method:** Nitrogen at 77 K
The calculation is similar to the above except that cylindrical geometry is assumed, and the film thickness depends on pore size (see reference).


---

**References**

The papers listed below provide additional information on DFT models:


INDEX

Symbols
$ symbol, 8-6, 8-9

A
Absolute pressure tolerance, 5-27
Add log entry, 8-11
Adding an analyzer, 2-17
Adsorption isotherm, G-1
Adsorptive Properties dialog, 5-31
Adsorptive properties file, 5-31
defining, 4-13
listing file statistics, 4-32, 5-99
printing contents, 4-31
Advanced format, 8-2
creating sample file, 4-6
establishing sample defaults, 4-4
Sample information file, 4-3
Alpha-S curve, saving, 5-96
Alpha-S Method dialog, 5-55
Alpha-S report, 5-55
Alumina, replacing in oil vapor traps, 9-11
Ambient temperature, 5-23
Analysis
bath, 4-28
details, 6-13
Dewar, checking, 9-4
Dewar, installing, 4-28
dialog, 6-3
performing, 4-29, 6-3
program, installing, 2-12
skipping steps, 6-6
status, 6-13
suspending, 6-6
viewing options, 6-3
Analysis Conditions dialog, 5-16
Analysis conditions file, 5-16
defining, 4-11
identification, 5-16
listing file statistics, 4-32, 5-99
printing contents, 4-31
Analysis program
exiting, 5-104
installing upgrade, 2-16
subsequent installation, 2-16
uninstalling, 2-24
Analyzer
adding another, 2-17
changing setup, 2-22
cleaning, 9-22
description, 1-10
front panel, 3-1
lifting, 2-1
moving to a different computer, 2-18
removing, 2-21
Ar Carbon Finite Pores, As=12, 2D-NLDFT model, G-11
Ar Carbon Finite Pores, As=6, 2D-NLDFT model, G-10
Ar Carbon Slit Pores by NLDFT model, G-10
AR Cylindrical Pores - Oxide Surface model, G-8
AR DFT model, G-7
AR Modified Density Functional Model, G-9
Argon Cylinder, multi-wall nanotube by NLDFT model, G-12
Argon Cylinder, single-wall nanotube by NLDFT model, G-11
ASAP 2000 files, converting for 2020 program, 5-102
ASAP 2010 sample files, opening, 5-102
ASCII text
saving reports, 7-21
Automatic Degas dialog, 6-8
Autoscale x- and y-axis, 5-46
Avogadro's number, C-22
Axis
coordinates, viewing, 7-27
properties, editing, 7-26
Axis Properties dialog, 7-26

B
Backfill
gas, 5-30
options, 5-30
Backfill gas, 4-19
Bar code, 4-5, 5-7, 8-10
Basic format, 8-2, 8-3
creating sample file, 4-8
Sample information file, 5-9
specifying sample defaults, 4-1, 8-5
Bath temperature, 6-5
BET Surface Area report, 5-42
BET surface area report
calculations, C-8
BET Surface Area Report, example, 7-32
BJH Adsorption Report, example, 7-36
BJH Adsorption/Desorption plot options dialog, 5-67
BJH Adsorption/Desorption report, 5-60
calculations, C-13
plot, 5-67
tabular, 5-64
Index

BJH Adsorption/Desorption Report Options dialog, 5-60
BJH Adsorptive Options dialog, 5-62
BJH correction, 5-63
BJH Desorption Report, example, 7-39
Boltzmann’s constant, G-8
Bookmarks tab, 1-4
Broekhoff-de Boer equation, 5-52
Broekhoff-de Boer thickness curve, C-11

C
Cables, connecting, 2-10
Calculated free space, 5-23
Calculated mass, 4-3, 4-5, 5-7, 5-10, 8-6, 8-10
Calibrate Manifold Temperature dialog box, 9-16
Calibrate Pressure Scale dialog box, 6-21
Calibrate Servo Valve dialog box, 6-30
Calibration
details, 6-16
file, loading, 6-25
files, reinstalling, 2-23
Load from File, 6-25
pressure offset, 6-21, 9-22
pressure scale, 6-21, 9-23
settings, saving, 6-25
temperature, 6-22, 9-15
Vacuum gauge, 6-20
Volume, 6-22
Calibration command, 6-20
Calibration Manifold Temperature dialog box, 6-22
Calibration Vacuum Gauge dialog box, 6-30
Cancel push button, 3-10
Carbon Black STSA equation, 5-53
Carbon Cylinder, multi-wall nanotube by NLDFT model, G-12
Carbon Cylinder, single-wall nanotube by NLDFT model, G-11
Cascade windows, 3-15
Cautions, 1-3
Check box, 3-9
Chemical potential, G-3
Cheng/Yang
calculations, C-25
correction, 5-70
Pore Geometry, C-24
Circuit breaker, valve, 9-2
location, 3-5
Cleaning
analyzer, 9-22
filler rods, 4-17
sample tubes, 4-17
Close All command, 5-97
Close command, 5-96
Close push button, 3-10
Close Reports command, 7-5
CO2 DFT Model, G-9
Cold free space
for micropore analyses, E-2
Cold trap, 1-10
Dewar, installing, 4-26
location, 3-3
tubes, cleaning, 9-14
tubes, installing, 2-5
Collected Data dialog, 5-92
Columns, editing on onscreen reports, 7-23
Computer
power input, 2-7
requirements, 1-15
Control Chart command, 7-11
Control Chart Graph Options dialog, 7-12
Control Chart Options dialog, 7-11
Control Chart report, 7-11
defining the Y-axis, 7-12
recalculating archived results, 7-12
Control Chart Sample Selection dialog, 7-13
Controls, indicators, and connectors, 3-1
front panel, 3-1
rear panel, 3-6
side panel, 3-4
Conventions
operator’s manual, 1-3
Convert command, 5-102
Cross-hair, axis, 7-27
Cross-references, 1-7
Cryogen, 4-26
Cumulative Reports, 5-62
Curve Properties dialog, 7-25

D
Data
isotherm, exporting, 5-100
selecting display options, 8-12
type, 5-8
Date Range push button, 3-11
Dates dialog box, 3-11
Dates push button, 5-4
Default Basic Sample Information dialog, 8-5
Default files
adsorptive properties, F-2
analysis conditions, F-1
report options, F-2
Degas
Calibrate pressure offset, 6-29
Calibrate servo, 6-30
Calibrate vacuum gauge, 6-30
dialog, 6-8
Enable manual control, 6-26
monitoring, 6-28
sample, 6-26
Show instrument Schematic, 6-27
Show status, 6-28
Degas command, 6-26
Degas conditions file, 5-14
creating, 4-10
listing file statistics, 4-32
printing contents, 4-31
Degas port
location, 3-3
replacing filter, 9-7
Degassing
sample, 4-22
Density
sample, 5-8, 5-10
Density Functional theory, G-3
Destination, 5-98
Dewar
analysis, installing, 4-28
checking, 9-4
cold trap, installing, 4-26
precautions, 4-26
raising and lowering, 6-10
DFT models, G-1
See Models
DFT Pore Size Report Options dialog, 5-77
DFT report
Pore size, 5-77
surface energy, 5-80
DFT Surface Energy Report Options dialog, 5-80
Diagnostics
gas line test, 9-19
Diagnostics command, 6-18
Dialog box, 3-9
closing, 3-10
Directory, 5-4
limitations, 5-5
Dollimore-Heal Adsorption/Desorption report, 5-69
Dosing Options dialog, 5-25
Dubinin report, 5-81
pore volume, 5-84
tabular, 5-83
transformed isotherm, 5-83
Dubinin Report Options dialog, 5-81
Dubinin Transformed Isotherm Plot Options dialog, 5-83
Dubinin-Astakhov
calculations, C-32, C-34, C-35
Dubinin-Radushkevich
calculations, C-30

E
Electrical requirements, 1-14

F
File
listing statistics, 3-8
name, including with file identification, 8-6, 8-9
opening, 3-8
printing to, 7-4
See also Sample information file status, 3-12, 5-4
File menu, 5-1
Close All command, 5-97
Close command, 5-96
Convert command, 5-102
Exit command, 5-104
Export command, 5-100
Export Sample File dialog box, 5-100
Export Settings dialog, 6-6
Folder
directory, 5-5
Format of exported data, 5-101
Forms, A-1
f-Ratio Method dialog, 5-58
f-Ratio report, 5-58
Free space, 6-5
  calculated, 5-8, 5-10, 5-23
  calculations, C-3
  for micropore analyses, E-1
Free Space dialog, 5-22
Freundlich report, 5-45
  calculations, C-38
Freundlich Report Options dialog, 5-45
Front panel description, 3-1
Function keys
  See Shortcut keys

G
Gas
  connecting to analyzer, 2-8
  connection ports, 3-4
  inlet ports, 3-4
  line, clean and verify, 9-19
  regulator pressure, 4-29
  regulators, 1-11
  requirements, 1-11
  specifying ports in software, 2-25
Graph
  copying as metafile, 7-26
  copying report data as text, 7-27
  editing onscreen, 7-24
  grid lines, 8-12
  legend, editing, 7-26
  Graph Grid Lines command, 8-12
  Graph Grid Lines dialog, 8-12
  Graph Overlay Samples, 5-36
  Graph overlays, 4-34
  Graphic, showing in report title, 5-36
  Grid lines, 8-12

H
Halsey Thickness Equation, 5-51
Harkins and Jura Thickness Equation, 5-52
Heat of Adsorption dialog box, 7-14
Heat of Adsorption report, 7-14
Heating mantle
  connector, 3-3
  installing, 4-23
  thermocouple, 3-3
Help menu, 3-15
High vacuum pump, 3-2
  indicators, 3-4
  specifications, 1-12
Horvath-Kawazoe calculations
  Cylinder pore geometry (Saito/Foley), C-23
  Slit pore geometry (original HK), C-22
  Sphere pore geometry (Cheng/Yang), C-24
  Horvath-Kawazoe Physical Properties dialog, 5-72
  Horvath-Kawazoe Plot Options dialog, 5-75
  Horvath-Kawazoe report, 5-70
    calculations, C-22
    plot, 5-75
    tabular, 5-74
  Horvath-Kawazoe Report Options dialog, 5-70

I
Ideal gas law with non-ideality correction, 4-14, 5-33
Index, online, 1-7
Indicators, 3-1
Information bar, 3-9
Installing
  cold trap tubes, 2-5
  Po tube, 2-6
  software, 2-12
  vacuum pump, 2-3
Instrument schematic
  analyzer, 6-12
  degasser, 6-26
Interaction parameter, C-26
Isotherm heat of adsorption, 7-14
Isotherm, G-1
Isotherm data
  exporting, 4-33, 5-100
  Isotherm report, 5-40
  Isotherm Report Options dialog, 5-40
  Isotherm Report, example, 7-29
  Isothermal jacket, 4-24

K
Kernel function, G-13, G-14
Kruk-Jaroniec-Sayari Thickness Equation, 5-51

L
Langmuir Surface Area report, 5-42
Langmuir surface area report
calculations, C-9
Leak test
  blank tube analysis (nitrogen), D-1
  Data sheet for recording values, D-11
  removing differential pressure, D-8
  Valve 9, D-5
  Valves 10 and 11, D-5
  Valves P1 through P6, D-4
  Valves PS, 5, and 7, D-4
Legend Properties dialog, 7-26
Lennard-Jones, G-2, G-8
Links, 1-6
List command, 5-99
Listing file statistics, 5-99
Load from File command, 6-25

M
Main Menu bar, 3-14
Maintenance, 9-1
Manifold
temperature transducer, 1-13
Manifold temperature
calibrating, 6-22, 9-15
Manual control, 6-9
enabling for analyzer, 6-9
Mass, 4-3, 5-7, 5-10, 6-8, 8-10
MCM-41 materials, G-8
Menu structure, 3-14
Metafile, copying graph as, 7-26
Micropore analyses, 5-27
free-space values, E-1
Models, G-1
Ar Carbon finite pores by NLDFT, As=12, G-11
Ar Carbon finite pores by NLDFT, As=6, G-10
Ar Carbon slit pores by NLDFT, G-10
AR Cylindrical Pores - Oxide Surface, G-8
AR DFT model, G-7
AR Modified Density Functional, G-9
Argon Cylinder, multi-wall nanotube by NLDFT, G-12
Argon Cylinder, single-wall nanotube by NLDFT model, G-11
based on classical theories, G-13
based on statistical thermodynamics, G-1
Carbon Cylinder, multi-wall nanotube by NLDFT, G-12
CO2 DFT Model, G-9
N2 Broekhoff-de Boer Model, G-15
N2 Carbon Cylinder, single-walled nanotube by NLDFT model, G-11
N2 Carbon finite pores by NLDFT, As=12, G-11
N2 Carbon finite pores by NLDFT, As=6, G-10
N2 Carbon slit pores by NLDFT, G-10
N2 Cylindrical Pores - Oxide Surface, G-8
N2 Cylindrical Pores - Pillared Clay Surface, G-8
N2 DFT model, G-7
N2 Halsey Thickness Curve model, G-14
N2 Harkins and Jura Thickness Curve model, G-15
N2 Modified Density Functional model, G-7
N2 Tarazona NLDFT, Esf = 30.0K model, G-10
Notes, 1-3

O
Oil vapor traps
replacing alumina, 9-11
Online manual
cross references, 1-7
index, 1-7
printing options, 1-9
using, 1-4
See also Operator’s manual
Open Adsorptive Properties File dialog box, 4-13
Open Analysis Conditions File dialog box, 4-11
Open command, 5-3
Open Report Options File dialog box, 4-14
Open Sample Information File dialog, 4-6
Open Sample Information File dialog box, 4-6, 4-8
Operator’s manual
conventions, 1-3
online, 1-4
organization, 1-1
Option Presentation command, 8-2
Options menu, 8-1
Graph Grid Lines command, 8-12

Molecular dynamics, G-2
Molecular simulation methods, G-2
Monolayer capacity, 5-45
Monte Carlo, G-2
Montmorillonite, G-8
MP-Method Plot Options dialog, 5-88
MP-Method report, 5-86
calculations, C-36
plot, 5-88
tabular, 5-88
MP-Method Report Options dialog, 5-86
MP-Method Tabular Report Column Options dialog, 5-88

N
N2 Broekhoff-de Boer model, G-15
N2 Broekhoff-de Boer Model model, G-15
N2 Carbon Finite Pores, As=12, 2D-NLDFT model, G-11
N2 Carbon Finite Pores, As=6, 2D-NLDFT model, G-10
N2 Carbon Slit Pores by NLDFT model, G-10
N2 Cylindrical Pores - Oxide Surface model, G-8
N2 Cylindrical Pores - Pillared Clay Surface model, G-8
N2 DFT model, G-7
N2 Halsey Thickness Curve model, G-14
N2 Harkins and Jura Thickness Curve model, G-15
N2 Modified Density Functional model, G-7
N2 Tarazona NLDFT, Esf = 30.0K model, G-10
Notes, 1-3
Option Presentation command, 8-2
Parameter Files Directory, 8-13
Sample Defaults command, 8-4
Options report, 5-90
Ordering information, 10-1
Overlays
  for multiple samples, 4-34
  generating, 4-34

P
Parameter files, 4-9
  Adsorptive properties, 5-31
  Adsorptive properties, creating, 4-13
  Analysis conditions, 5-16
  Degas conditions, 5-14
  Degas conditions, creating, 4-10
  listing file statistics, 4-32, 5-99
  printing contents, 4-31
  printing contents of, 5-98
  Report options, 5-35
  Report options, creating, 4-14
  Sample tube, 5-12
Parameter files directory, 8-13
Parameters, user, 8-11
Parts, ordering, 10-1
Pass/Fail Options dialog, 5-39
Password, 8-3
  Restricted format, 8-3
Po and Temperature Options dialog, 5-24
Po port, 3-4
Po tube, installing, 2-6
Pore filling pressure, G-4
Pore Geometry
  cylinder (Saito-Foley), C-23
  slit (original Horvath-Kawazoe), C-22
  sphere (Cheng/Yang), C-24
Pore size, G-13
Port filter, degas, 9-7
Ports
  gas connection, 3-4
Preparing samples, 4-16
Pressure
  measurement, 1-12
  relative, calculations, C-1, C-2
  table, 5-17
Pressure offset
  calibrating, 6-21, 9-22
  calibrating (Degasser), 6-29
Pressure scale
  calibrating, 6-21, 9-23
  calibrating (Degasser), 6-29
Preventive maintenance schedule, 9-3
Print command, 5-98
Index

Rate of Adsorption command, 7-17
Regression Report command, 7-7
SPC Report Options command, 7-6
Start Report command, 7-3
Reports to Generate dialog, 7-4
Restricted format, 8-2, 8-3
creating sample file, 4-8
password, 8-3
Sample information file, 5-11
specifying sample defaults, 8-5
Returned Materials Authorization (RMA), 2-2
ROA data, collecting, 5-17
RS232 port, 3-5

S
Saito-Foley
calculations, C-23
Pore Geometry, C-23
Sample
degassing, 4-22, 6-26
determining amount to use, 4-20
determining weight, 4-20
information, defining, 4-6
preparing, 4-16
Sample Analysis command, 6-3
Sample Backfill Options, 5-30
Sample defaults, 8-4
establishing for Advanced format, 8-7
establishing for Basic format, 8-5
Sample information file
converting 2000 files to 2020 files, 5-102
creating, 4-6
default values, 4-1
exporting isotherm data, 4-33
listing file statistics, 4-32, 5-99
printing contents, 4-31, 5-98
specifying defaults, 4-1
Sample Log report, 5-90
Sample port, 3-4
Sample tube
choosing, 4-16
cleaning, 4-17
displayed on schematic, 6-11
installed, 4-24
installing on sample port, 4-24
labeling, 4-17
replacing O-ring, 9-5
set, 4-16
Sample Tube dialog, 5-12
Sample tube file, 5-12
listing file statistics, 4-32
printing contents, 4-31
Saturation pressure
calculations, C-1
tube, installing, 2-6
Save All command, 5-96
Save As command, 5-95
Save as Default button, 7-13
Save command, 5-94
Save push button, 3-10
Save to File command, 6-25
Schematic
analyzer, 6-12
degasser, 6-26
Select Dates dialog, 5-4
Service Test command, 6-31
Servo valve, calibrating (Degasser), 6-30
Setup program
adding an analyzer, 2-17
changing an analyzer setup, 2-22
moving an analyzer to a different computer, 2-18
reinstalling analysis program, 2-16
reinstalling calibration files, 2-23
removing an analyzer from the computer, 2-21
uninstalling the software, 2-24
using for other functions, 2-15
Shortcut keys, 3-7
list of, 3-8
Shortcut menu, 3-7
for graphs, 7-24
for tabular reports, 7-23
Show Instrument Log command, 6-14
Show Instrument Schematic command
analyzer, 6-12
degasser, 6-27
Show Status command
analyzer, 6-13
degasser, 6-28
Software
installing, 2-12
installing upgrade, 2-16
SPC report
user parameters, 5-8, 8-11
SPC Report Options command, 7-6
SPC Report Options dialog, 7-6
Specifications
ASAP 2020, 1-12
SmartVac degas system, 1-13
Spreadsheet format
saving reports in, 7-21
Start Degas command, 6-8
Start Report command, 7-3
Start Report dialog box, 7-3
Status drop-down list, 3-12
Status list, 7-3
STSA thickness curve, C-11
STSA Thickness equation, 5-53
Summary report, 5-38
  calculations, C-43
Summary Report Options dialog, 5-38
Surface Energy, G-13
Surface Energy report, 5-80
System
  valves, 6-10
System volume
  calibrating, 6-22

T
Table of Contents, online, 1-6
Tarazona, G-7
t-Curve
  entered, 5-50
  saving, 5-96
Temkim Report Options dialog, 5-47
Temkin report, 5-47
  calculations, C-39
Temperature
  calibrating, 6-22, 9-15
  calibration details, 6-16
  displayed on schematic, 6-11
Text, copy graph data as, 7-27
Thermal transpiration correction, 4-16
  calculations, C-7
  choosing, 5-37
Thermodynamic law, G-2
Thumbnails tab, 1-9
Tile windows, 3-15
Title Properties dialog, 7-26
t-Plot report, 5-49
  calculations, C-11
t-Plot Report Options dialog, 5-49
t-Plot, example, 7-34
Transducer
  adjusting scale, 6-21
  calibration details, 6-16
  displayed on schematic, 6-11
  zeroing, 9-22
Transformed Isotherm report, 5-83
Troubleshooting, 9-1

U
Unit Configuration command, 6-16
Unit menu, 6-1
  Calibration command, 6-20
  Degas command, 6-26
  Diagnostics, 6-18
  Enable Manual Control command, 6-9
  Sample Analysis command, 6-3
  Save to File command, 6-25
Service Test command, 6-31
Show Instrument Log command, 6-14
Show Instrument Schematic command, 6-12
Show Status command, 6-13
Start Degas command, 6-8
Unit configuration command, 6-16
Units Selections dialog, 8-12
Units, selecting, 8-12
Unpacking the equipment, 2-1
User parameters, 5-8
  specifying, 8-11

V
Vacuum gauge
  calibrating, 6-20
  calibrating (Degasser), 6-30
  calibration details, 6-16
  pressure, 6-11
Vacuum pump
  exhaust filter, replacing, 9-7
  fluid, changing, 9-9
  fluid, inspecting, 9-9
  installing, 2-3
  panel, 3-2
  placement, 3-6
Vacuum system, 1-12
Validation report, 5-91
Valves
  degassing, 6-27
  description, D-2
  failure, 9-2
  opening and closing, 6-9
  system, 6-10
  testing for leaks, D-1
Van der Waal force, G-1
Vapor gas port, 3-4
Viewing options, 6-3
Voltage
  selecting, 2-5, 3-5
Volume
  calibrating, 6-22
  calibration details, 6-16

W
Wall potential, G-10
Warm free space
  for micropore analyses, E-1
Warnings, 1-3
Windows
  Cascade, 3-15
  tile, 3-15
Windows menu, 3-15
Z

Zeolites H-Form by NLDFT model, G-12
Zeolites Me-Form by NLDFT model, G-12
Zoom feature, 7-27